Vision
Operator’s Manual

Software Issue: v18.0 MD
Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

**Protective Earth** — This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.

**Warning** — The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

**Caution** — The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

**Warning Hazardous Voltages** — This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.

**ESD Susceptibility** — This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.

Important Safety Instructions

**Warning**

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with a dry cloth.
7. Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.
8. Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10. Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11. Only use attachments/accessories specified by the manufacturer.

12. Unplug this apparatus during lightning storms or when unused for long periods of time.

13. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14. Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15. To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16. The mains plug of the power supply cord shall remain readily operable.

17. The Octane/QMD-X, MD-X, QMD, and MD (Live Production Engine) chassis is to be rack mounted only.

**Warning**

18. **Indoor Use: WARNING:** To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19. The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20. **WARNING:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21. **CAUTION:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so (Engineering Manual only).

**Caution**

22. These apparatus contain Lithium batteries, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23. Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24. Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25. This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.
26. To reduce the risk of fire, replacement fuses must be the same type and rating.

27. Use only power cords specified for this product and certified for the country of use.

28. The safe operation of this equipment requires that the user heed and adhere to all installation and servicing instruction contained within the equipment’s Engineering Manuals.

29. For applicable V-100/V-100A Touchscreen Panel power supplies, see user instructions contained within the Product’s Engineering Manual.

30. **WARNING**: Batteries shall not be exposed to excessive heat such as sunshine, fire or the like.

31. **WARNING**: This product includes an “Ethernet Port” which allows this product to be connected to a local area network (LAN). Only connect to networks that remain inside the building. Do not connect to networks that go outside the building.

**EMC Notices**

**United States of America**

**FCC Part 15**

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Notice** — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

**CANADA**

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

**EUROPE**

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

**INTERNATIONAL**

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

**Notice** — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

**General Handling Guidelines**

- Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.

**A Word About Static Discharge**

Throughout the many procedures in this Engineering Manual, please observe all static discharge precautions.

| Caution — Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards. |
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEAR from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
<table>
<thead>
<tr>
<th>Company Address</th>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
<td></td>
</tr>
<tr>
<td>Iroquois, Ontario, K0E 1K0</td>
<td>Ogdensburg, New York</td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>USA 13669-0880</td>
<td></td>
</tr>
</tbody>
</table>

| General Business Office: | (+1) 613 • 652 • 4886 |
| Fax:                     | (+1) 613 • 652 • 4425 |
| Technical Support:       | (+1) 613 • 652 • 4886 |
| After hours emergency:   | (+1) 613 • 349 • 0006 |

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
E-mail (Documentation): solutions@rossvideo.com
Website: [http://www.rossvideo.com](http://www.rossvideo.com)
# Contents

## Introduction

<table>
<thead>
<tr>
<th>Part</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Manual</td>
<td>Ops 1-2</td>
</tr>
<tr>
<td>Documentation Conventions</td>
<td>Ops 1-3</td>
</tr>
<tr>
<td>Documentation Terms</td>
<td>Ops 1-4</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>Related Publications</td>
<td>Ops 1-6</td>
</tr>
<tr>
<td>A Word About Technical Support</td>
<td>Ops 1-7</td>
</tr>
</tbody>
</table>

## Control Panel Introduction

<table>
<thead>
<tr>
<th>Part</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Panel Modules</td>
<td>Ops 2-2</td>
</tr>
<tr>
<td>Resetting the Switcher</td>
<td>Ops 2-11</td>
</tr>
<tr>
<td>Software Reset</td>
<td>Ops 2-11</td>
</tr>
<tr>
<td>Full Restart</td>
<td>Ops 2-13</td>
</tr>
<tr>
<td>Default State</td>
<td>Ops 2-14</td>
</tr>
<tr>
<td>Control Panel Timeout</td>
<td>Ops 2-15</td>
</tr>
</tbody>
</table>

## Using the Menu System

<table>
<thead>
<tr>
<th>Part</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touchscreen Interface</td>
<td>Ops 3-2</td>
</tr>
<tr>
<td>Menu System Basics</td>
<td>Ops 3-5</td>
</tr>
<tr>
<td>Using a Keyboard</td>
<td>Ops 3-7</td>
</tr>
<tr>
<td>Using the Punchpad</td>
<td>Ops 3-7</td>
</tr>
<tr>
<td>Using the Positioner with the Menu System</td>
<td>Ops 3-9</td>
</tr>
<tr>
<td>Quick Navigation Buttons</td>
<td>Ops 3-11</td>
</tr>
<tr>
<td>Help Features</td>
<td>Ops 3-13</td>
</tr>
<tr>
<td>Online Manuals</td>
<td>Ops 3-13</td>
</tr>
<tr>
<td>Pop-up Help</td>
<td>Ops 3-13</td>
</tr>
<tr>
<td>SoftPanel</td>
<td>Ops 3-14</td>
</tr>
<tr>
<td>Installing SoftPanel</td>
<td>Ops 3-14</td>
</tr>
<tr>
<td>Screen Captures</td>
<td>Ops 3-17</td>
</tr>
</tbody>
</table>

## Switcher Basics

<table>
<thead>
<tr>
<th>Part</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switcher Operation Overview</td>
<td>Ops 4-2</td>
</tr>
<tr>
<td>Video Routing</td>
<td>Ops 4-2</td>
</tr>
<tr>
<td>Video Layering</td>
<td>Ops 4-3</td>
</tr>
<tr>
<td>Panel Row</td>
<td>Ops 4-5</td>
</tr>
<tr>
<td>Crosspoint Buses</td>
<td>Ops 4-5</td>
</tr>
<tr>
<td>Display</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>Panel Row Select Button</td>
<td>Ops 4-8</td>
</tr>
</tbody>
</table>
Contents Vision Operator's Manual (v18.0 MD)

Transitions 5

Transition Module ............................................................................................................Ops 5-2
  Fader ...........................................................................................................Ops 5-2
  Next Transition Select ................................................................................Ops 5-3
Transition Parameters ..............................................................................................Ops 5-3
  Transition Type Buttons ...........................................................................Ops 5-5
  Transition Buttons ..................................................................................Ops 5-6
Transition Types ...........................................................................................................Ops 5-7
  Cut ...........................................................................................................Ops 5-7
  Dissolve ..................................................................................................Ops 5-7
  Wipe .........................................................................................................Ops 5-8
  Squeeze & Tease Wipe ...........................................................................Ops 5-8
Independent Key Transitions ..........................................................................................Ops 5-9
Transition Rates ...........................................................................................................Ops 5-10
  Setting the MLE Rate ............................................................................Ops 5-10
  Setting the Keyer Rate ...........................................................................Ops 5-11
  Setting the Rate From the Global Memory Module .....................................Ops 5-12
Performing Transitions ..............................................................................................Ops 5-13
Transition Restrictions and Rules .............................................................. Ops 5-13
Performing a Fader Transition ................................................................. Ops 5-13
Performing an Auto Transition ................................................................. Ops 5-15
Transition Limits ......................................................................................... Ops 5-17
  Setting a Transition Limit .......................................................................... Ops 5-17
  Using a Transition Limit ............................................................................. Ops 5-17
WhiteFlash ................................................................................................... Ops 5-19
  Setting Up a WhiteFlash Transition .......................................................... Ops 5-19
Key Priority Transitions ............................................................................ Ops 5-21
  Key Priority Transition ............................................................................... Ops 5-21
  Manual Key Priority Cuts ......................................................................... Ops 5-22

Wipes, Patterns, Washes, and Mattes ....................................................... 6

Pattern Generators ................................................................................... Ops 6-2
Wipes ........................................................................................................... Ops 6-3
  Wipe Transitions ...................................................................................... Ops 6-3
  Assigning User Wipes .............................................................................. Ops 6-4
Pattern Parameters ..................................................................................... Ops 6-5
  Position and Size ...................................................................................... Ops 6-5
  Border Size and Softness ......................................................................... Ops 6-5
  Aspect ........................................................................................................ Ops 6-6
  Rotation ...................................................................................................... Ops 6-7
  Horizontal and Vertical Multiplication ................................................... Ops 6-8
  Matrix Tile Size ......................................................................................... Ops 6-9
  Wipe Modulation ...................................................................................... Ops 6-9
Washes and Mattes ...................................................................................... Ops 6-11
  Creating Washes ..................................................................................... Ops 6-11
  Creating Mattes ...................................................................................... Ops 6-13

Keying ........................................................................................................... 7

Keyers Module ............................................................................................. Ops 7-2
  Key Type Buttons and Mnemonics ............................................................ Ops 7-3
  Key Modifier Buttons ............................................................................... Ops 7-3
  Key Preview Buttons ................................................................................ Ops 7-4
  Key Transition Buttons ............................................................................ Ops 7-5
  Channel Management Button ................................................................... Ops 7-6
Self Key .......................................................................................................... Ops 7-7
Auto Select Key ............................................................................................ Ops 7-9
Chroma Key .................................................................................................... Ops 7-11
  UltraChrome Operating Modes ............................................................... Ops 7-11
  Initializing UltraChrome ........................................................................ Ops 7-11
  Basic UltraChrome Settings .................................................................... Ops 7-13
  Advanced UltraChrome Settings ............................................................ Ops 7-16
  UltraChrome Alpha and Color Map ........................................................ Ops 7-22
Preset Pattern Key ........................................................................................ Ops 7-24
MultiDSK Keys ............................................................................................. Ops 7-26
  MultiDSK Operation ................................................................................ Ops 7-26
  MultiDSK Key Setup ................................................................................ Ops 7-26
AuxKeys ........................................................................................................ Ops 7-28
  AuxKey Operation ................................................................................... Ops 7-28
  AuxKey Setup ......................................................................................... Ops 7-28

Key Modifiers .................................................................................................. 8

DVE Keys (Fly Key) ..................................................................................... Ops 8-2
2D DVE Keys ............................................................................................... Ops 8-3
Contents

Managing Stills .........................................................................................................Ops 10-14
Transferring Stills......................................................................................................Ops 10-11
Capturing Stills............................................................................................................Ops 10-6
Still-Store Image Specifications................................................................................Ops 10-10
Adjusting On-Air Properties .......................................................................................Ops 10-8
Loading Stills ..............................................................................................................Ops 10-3
Still-Store Overview..................................................................................................Ops 10-2
Assigning a Default Still .........................................................................................Ops 10-3
Viewing/Clearing Still-Store Cache .........................................................................Ops 10-4
Capturing Stills...........................................................................................................Ops 10-6
Adjusting On-Air Properties .......................................................................................Ops 10-8
Still-Store Image Specifications .................................................................................Ops 10-10
Image Specifications .................................................................................................Ops 10-10
File Naming Specifications .......................................................................................Ops 10-10
Transferring Stills.......................................................................................................Ops 10-11
Transferring Stills Using WebDAV ...........................................................................Ops 10-11
Transferring Stills Using USB .....................................................................................Ops 10-12
Managing Stills ...........................................................................................................Ops 10-14
Renaming and Renumbering Stills ............................................................................Ops 10-14
Creating and Renaming Directories ........................................................................Ops 10-15

Memory Functions

Memory System ............................................................................................................Ops 9-2
Effects Memory Modules ............................................................................................Ops 9-2
Global Memory Module ...............................................................................................Ops 9-4
Storing and Recalling Memories................................................................................Ops 9-6
Storing Memories ........................................................................................................Ops 9-6
Recalling Memories.....................................................................................................Ops 9-7
Naming and Adding a Description to a Memory.........................................................Ops 9-8
Locking Memories........................................................................................................Ops 9-8
MLE Memory Attributes.............................................................................................Ops 9-10
To Set Memory Attributes ........................................................................................Ops 9-10
Effects Dissolve .........................................................................................................Ops 9-13
To Create an Effects Dissolve .....................................................................................Ops 9-13
Effects Rate .................................................................................................................Ops 9-14

DVE Channel Management .......................................................................................Ops 10-8
2D DVE Channel Management ..................................................................................Ops 10-8
Squeeze & Tease DVE Channel Management ............................................................Ops 11-8
Frontside/Backside Video (Squeeze & Tease DVE Only) ............................................Ops 8-13
Frontside/Backside Video and S&T Wipes and Sequences ......................................Ops 8-13
XFX Borders ..............................................................................................................Ops 8-15
Key Trails..................................................................................................................Ops 8-17
Soft Trails ....................................................................................................................Ops 8-17
Hard Trails..................................................................................................................Ops 8-18
Key Trails ...................................................................................................................Ops 8-19
Key Smear Trails .......................................................................................................Ops 8-20
Split Keys ....................................................................................................................Ops 8-22
Performing a Split Key ..............................................................................................Ops 8-22
Key Masks..................................................................................................................Ops 8-23
Box Masks .................................................................................................................Ops 8-23
Pattern Mask ..............................................................................................................Ops 8-23
Utility Mask .................................................................................................................Ops 8-24
Defaulting..................................................................................................................Ops 8-26

Still-Store

Still-Store Overview..................................................................................................Ops 10-2
Loading Stills ..............................................................................................................Ops 10-3
Assigning a Default Still .........................................................................................Ops 10-3
Viewing/Clearing Still-Store Cache .........................................................................Ops 10-4
Capturing Stills...........................................................................................................Ops 10-6
Adjusting On-Air Properties .......................................................................................Ops 10-8
Still-Store Image Specifications .................................................................................Ops 10-10
Image Specifications .................................................................................................Ops 10-10
File Naming Specifications .......................................................................................Ops 10-10
Transferring Stills.......................................................................................................Ops 10-11
Transferring Stills Using WebDAV ...........................................................................Ops 10-11
Transferring Stills Using USB .....................................................................................Ops 10-12
Managing Stills ...........................................................................................................Ops 10-14
Renaming and Renumbering Stills ............................................................................Ops 10-14
Creating and Renaming Directories ........................................................................Ops 10-15
Peripheral Control

GPI Interface Control .............................................................................................. Ops 11-2
External Still Store Interface Control ...................................................................... Ops 11-3
VTR Clip Control ...................................................................................................... Ops 11-4
  Clip Control Overview ......................................................................................... Ops 11-4
  Cueing a Clip Using the Keypad .......................................................................... Ops 11-4
  VTR Remote Control Menu .................................................................................... Ops 11-4
Audio Server Clip Control ....................................................................................... Ops 11-6
  Cueing a Cut Using the Keypad ............................................................................ Ops 11-6
  Audio Server Menu ................................................................................................ Ops 11-6
Video Server Clip Control ....................................................................................... Ops 11-7
  Clip Control Overview ......................................................................................... Ops 11-7
  Cueing a Clip Using the Keypad ............................................................................ Ops 11-7
  Video Server Remote Control Menu ..................................................................... Ops 11-7
Router Matrix Control .............................................................................................. Ops 11-9
Audio Mixer Control ................................................................................................ Ops 11-10
  Audio Follow Video ............................................................................................. Ops 11-10
  Audio Overrides .................................................................................................... Ops 11-10
  Audio Transitions ................................................................................................ Ops 11-10
  Audio Only Transitions ....................................................................................... Ops 11-11
  Audio Level Adjustment ....................................................................................... Ops 11-11
Robotic Camera Control ........................................................................................... Ops 11-13
  Robotic Camera Commands .................................................................................. Ops 11-13
  Camera Shotbox .................................................................................................... Ops 11-15
  Camera ShotBox (FlexCAM) ................................................................................ Ops 11-16
Character Generator Control ................................................................................... Ops 11-20
  Character Generator Commands .......................................................................... Ops 11-20
Editor Interface Control ............................................................................................ Ops 11-22
OverDrive Interface Control ...................................................................................... Ops 11-23
Monitor Wall Interface Control ................................................................................ Ops 11-24
  Layouts ................................................................................................................... Ops 11-24
  Input Channels ....................................................................................................... Ops 11-24
  Dynamic Text ........................................................................................................ Ops 11-24

Auxiliary Panels

Auxiliary Control Panel Operation ............................................................................ Ops 12-2
Remote Aux Panel Operation ..................................................................................... Ops 12-4
  Remote Aux Panel Overview ................................................................................ Ops 12-4
  Using a Remote Aux Panel ..................................................................................... Ops 12-4

Squeeze & Tease Basic Operation

Operational Overview ............................................................................................... Ops 13-2
Working in 3D Space ................................................................................................. Ops 13-3
  Image Location in 3D Space .................................................................................. Ops 13-3
  Position Coordinates .............................................................................................. Ops 13-3
  Screen and Image Location ................................................................................... Ops 13-4
  Perspective ................................................................................................................ Ops 13-5
  Image Rotation ........................................................................................................ Ops 13-7
  Image Centering ...................................................................................................... Ops 13-9
  Conclusion ................................................................................................................ Ops 13-9
DVE Sequences and Wipes 14

Sequence Overview ............................................................................................................Ops 14-2
Creating and Editing 2D DVE Sequences ............................................................................Ops 14-3
DVE Sequences Menu ........................................................................................................Ops 14-3
To Create or Edit a 2D DVE Sequence ................................................................................Ops 14-3
Creating and Editing Squeeze & Tease Sequences .............................................................Ops 14-5
S&T MD Sequences Menu .................................................................................................Ops 14-5
To Create or Edit a Squeeze & Tease Sequence .................................................................Ops 14-5
ToModifyMultipleKeyframes ............................................................................................Ops 14-9
DVE Wipes .......................................................................................................................Ops 14-10
Saving and Loading Sequences and Wipes .......................................................................Ops 14-11
Saving and Naming a Sequence .........................................................................................Ops 14-11
Loading a Sequence ...........................................................................................................Ops 14-12
DVE Wipe Pattern Button Assignment ..............................................................................Ops 14-13
Using DVE Wipes and Sequences .....................................................................................Ops 14-14
DVE Wipe Transitions .......................................................................................................Ops 14-14
Running a Sequence .........................................................................................................Ops 14-15

Lighting & Preprocessor Effects 15

Lighting ................................................................................................................................Ops 15-2
Applying Lighting Effects ..................................................................................................Ops 15-2
Preprocessor Effects ..........................................................................................................Ops 15-5
Defocus ................................................................................................................................Ops 15-5
Mosaic .................................................................................................................................Ops 15-5
Posterize .............................................................................................................................Ops 15-6
Colorize ...............................................................................................................................Ops 15-7
Strobe ..................................................................................................................................Ops 15-7

WARP Effects 16

WARP Resources ................................................................................................................Ops 16-2
Using WARP Resources ......................................................................................................Ops 16-2
Selecting a WARP Effect .....................................................................................................Ops 16-3
Film WARP ..........................................................................................................................Ops 16-4
Globe WARP .........................................................................................................................Ops 16-7
Heart WARP ........................................................................................................................Ops 16-10
Lens Flare WARP ................................................................................................................Ops 16-13
Magnify WARP ....................................................................................................................Ops 16-16
Melt WARP ..........................................................................................................................Ops 16-18
Obscure WARP ...................................................................................................................Ops 16-20
Page Roll WARP ..................................................................................................................Ops 16-22
Pixie Dust WARP ................................................................................................................Ops 16-23
Ripple WARP .........................................................................................................................Ops 16-25
Sand WARP ..........................................................................................................................Ops 16-27
Split WARP ..........................................................................................................................Ops 16-29
Star WARP ............................................................................................................................Ops 16-30
Stretch WARP .......................................................................................................................Ops 16-33

Appendix A: Pre-loaded Effects 17

DVE Wipes and Sequences ....................................................................................................Ops 17-2
Copying Sequences to the Switcher .....................................................................................Ops 17-5
Standard Wipes ...................................................................................................................Ops 17-6
Classic Wipes .......................................................................................................................Ops 17-6
Rotary Wipes .........................................................................................................................Ops 17-6
Matrix Wipes ........................................................................................................................Ops 17-7
### Appendix B: Color Correction Parameters

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Correction Overview</td>
<td>18-2</td>
</tr>
<tr>
<td>Proc Amp Color Correctors</td>
<td>18-3</td>
</tr>
<tr>
<td>Gain</td>
<td>18-3</td>
</tr>
<tr>
<td>Offsets</td>
<td>18-4</td>
</tr>
<tr>
<td>Gamma</td>
<td>18-6</td>
</tr>
<tr>
<td>Hue Rotate</td>
<td>18-6</td>
</tr>
<tr>
<td>RGB Color Correctors</td>
<td>18-8</td>
</tr>
<tr>
<td>Gain</td>
<td>18-8</td>
</tr>
<tr>
<td>Offsets</td>
<td>18-9</td>
</tr>
<tr>
<td>Gamma</td>
<td>18-10</td>
</tr>
</tbody>
</table>

### Glossary of Terms

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>IX</td>
</tr>
</tbody>
</table>
Introduction

A Word of Thanks

Congratulations on choosing the Ross Vision Multi-Definition Digital Production Switcher. You have purchased the power and versatility of a digital Multi-Level Effects (MLE®) switcher that is ready to take on all creative challenges in today’s competitive live production environment. You’ll be pleased at how easily your Vision switcher fits into your overall working environment.
About This Manual

This manual takes you through the operation of the Vision control panel and Octane/QMD-X, MD-X, QMD, or MD frame.

If, at any time, you have a question pertaining to the installation of your Ross Vision switcher, please contact us at the numbers listed in the front of this manual. Our technical staff are always available for consultation, training, or service.

For information on operating external devices from your Vision switcher, refer to the Ross Video External Device Setup Sheet for your device.
Documentation Conventions

The following conventions are used throughout this manual:

- Navigation procedures in this manual state the button you are to press, followed by the menu that the button appears on. For example, the following navigation procedure shows you how to navigate from the Main Menus to the Installation Menus. In this case, you press More, and then Setup on the Main Menu 2-2, then you press Installation on the Setup Menu 1-2.
  - Press HOME ➔ Setup ➔ Installation.

- References in this manual to navigation buttons, such as HOME, UP ONE, and HOLD, refer to the buttons on the Touchscreen Display located immediately to the left of the Display Region that you are interacting with.

- Rear panel connectors are indicated in bold-faced upper case letters. For example:
  - The AUX 1 connector is …

- Control Panel buttons are indicated in bold-faced upper case letters, using a sans-serif font. For example:
  - Press WIPE to …

- Menu names on the integral display panel are indicated in bold-faced text. For example:
  - The Aux Bus Setup Menu allows you to …

- Softkey labels on the integral display are indicated in bold-faced text, using a sans-serif font. They are not indicated by the function key below the display that you press. For example:
  - Press Accept New Name to register …

- Each module, or group of buttons, on the control panel is shown in bold-faced text. For Example:
  - Press the UNDO button in the Global Memory Module to …

- The “Operating Tip” and “Note” boxes are used throughout this manual to provide customers with additional useful information. For example:

  Operating Tip — When the DHCP is set to On, you can use the Refresh button to poll the server for the current network address information.

  Note — If the DHCP option in On, the remaining settings are automatically configured. If the DHCP is Off, you will have to manually enter values into all the fields.
Documentation Terms

The following terms are used throughout this guide:

- **“Switcher”** refers to the entire Vision Multi-Definition Production Switcher, consisting of its electronics frame and control panel.
- **“Frame”** and **“Electronics Frame”** both refer to the Octane/QMD-X, MD-X, QMD, and MD Multi-Definition Digital Production Switcher chassis.
- **“Operator”** and **“User”** refer to the person who uses the Vision Multi-Definition Production Switcher.
- **“Control Panel”** refers to the large multi-button control panel of the Vision Multi-Definition Production Switcher.
- **“Master Panel”** refers to the panel in a MultiPanel application that can control and can be connected to external devices.
- **“Satellite Panel”** refers to the panels in a MultiPanel application that cannot be connected to an external device.
- **“SDI”** refers to Serial Digital Video, a digital video signal that is distributed via a single coaxial cable with BNC connectors.
- **“Video System”** refers to the mix of interconnected digital equipment (including the edit controller, VTRs, DVEs, etc.) in which the Vision Multi-Definition Production Switcher is included.
- **“Storage device”** refers to the hardware used to save and recall Setups, configurations and registers of the Vision Multi-Definition Production Switcher. Examples of storage devices are the internal hard drive and a USB flash drive.
- **“Bottom MLE”** refers to the lowest, or Program/Preset, MLE on each switcher. This MLE is typically the MLE that provides the main program output of the switcher, and includes the Downstream Keyers. On a Vision 2, for example, this would be MLE 2.
- **“Half MLE”** refers to the bottom, or Program/Preset, MLE on the Vision x.5 switchers. The Mix/DSK option is applied to this MLE.
- **“Full MLE”** refers to the full featured MLEs of a switcher. On a Vision 2.5, for example, MLEs 1 and 2 are Full MLEs, because they are fully functional, but MLE 3 is a Half MLE.
- **“Setup”** refers to a group, or set, of registers that are stored together either on the switcher, or on an external computer. Setups can be stored and recalled to quickly configure the switcher for different productions.
Abbreviations

The following table (Table 1.1) abbreviations are used throughout the text.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-D</td>
<td>Analog-to-Digital</td>
</tr>
<tr>
<td>AUX</td>
<td>Auxiliary</td>
</tr>
<tr>
<td>CG</td>
<td>Character Generator</td>
</tr>
<tr>
<td>D-A</td>
<td>Digital-to-Analog</td>
</tr>
<tr>
<td>DA</td>
<td>Distribution Amplifier</td>
</tr>
<tr>
<td>DDR</td>
<td>Digital Disk Recorder</td>
</tr>
<tr>
<td>DSK</td>
<td>Downstream Keyer</td>
</tr>
<tr>
<td>DVE</td>
<td>Digital Video Effects</td>
</tr>
<tr>
<td>DVR</td>
<td>Digital Video Recorder</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>HD</td>
<td>High Definition</td>
</tr>
<tr>
<td>MD</td>
<td>Multi-definition</td>
</tr>
<tr>
<td>MLE</td>
<td>Multi-level Effects</td>
</tr>
<tr>
<td>PGM</td>
<td>Program Bus</td>
</tr>
<tr>
<td>PST</td>
<td>Preset Bus</td>
</tr>
<tr>
<td>PST PATT</td>
<td>Preset Pattern</td>
</tr>
<tr>
<td>PV</td>
<td>Preview</td>
</tr>
<tr>
<td>RU</td>
<td>Rack Unit</td>
</tr>
<tr>
<td>SD</td>
<td>Standard Definition</td>
</tr>
<tr>
<td>TD</td>
<td>Technical Director</td>
</tr>
<tr>
<td>VCR</td>
<td>Video Cassette Recorder</td>
</tr>
<tr>
<td>VDCP</td>
<td>Video Disk Communications Protocol</td>
</tr>
<tr>
<td>VTR</td>
<td>Video Tape Recorder</td>
</tr>
</tbody>
</table>
Related Publications

All Vision switchers come with a complete set of system documentation that includes an Operator’s Manual and an Engineering Manual.

For a complete operational overview of the Vision product line, refer to the following publications:

- *Ross Video External Device Setup Sheets Compendium*, Ross Part Number: 4800DR-404
A Word About Technical Support

At Ross Video, we take pride in the quality of our products, but if a problem does occur, help is as close as the nearest telephone.

Our 24-Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support are provided directly by Ross Video personnel. During business hours (eastern standard time), technical support personnel are available by telephone. Outside of normal business hours and on weekends, a direct emergency technical support phone line is available. If the technical support personnel who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. Our Technical support staff are available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
Control Panel Introduction

In This Chapter

This chapter provides a basic introduction to the Vision switcher, including an overview of the boards in the control panel and frame, as well as an introduction to the various ports, and video buses.

The following topics are discussed in this chapter:

- Control Panel Modules
- Resetting the Switcher
- Control Panel Timeout
Control Panel Modules

The Vision control panel consists of a number of removable modules. These modules include all the interface buttons on the control panel. Refer to the section below for information on your specific control panel.

The 4-Keyer option that is available for the Octane/QMD-X, and QMD frames adds two additional keyers to each MLE of the switcher. Included with this option is a 4-Keyer, Keyers Module for each MLE.

Vision 4 Control Panel

The Vision 4 control panels (Figure 2.1) have 4 Panel Rows, 40 Crosspoint Buttons per Bus, 40 Custom Control Buttons, a Transition Module, Effects Memory Module and Keyer Module per MLE and a Positioner Module as standard.

Figure 2.1 Vision 4 Control Panel (4-Keyer Shown)
Vision 3 Control Panel

The Vision 3 control panels (Figure 2.2) have 3 Panel Rows, 32 Crosspoint Buttons per Bus, 32 Custom Control Buttons, a Transition Module, an Effects Memory Module and Keyer Module per MLE, and a Positioner Module as standard.

![Figure 2.2 Vision 3 Control Panel (4-Keyer Shown)](image)

Vision 2X Control Panel

The Vision 2X control panels (Figure 2.3) have 2 Panel Rows, 32 Crosspoint Buttons per Bus, 32 Custom Control Buttons, a Transition Module, an Effects Memory Module and Keyer Module per MLE, and a Positioner Module as standard.

![Figure 2.3 Vision 2X Control Panel (4-Keyer Shown)](image)
Vision 3M Control Panel

The Vision 3M control panels (Figure 2.4) have 3 Panel Rows, 24 Crosspoint Buttons per Bus, 24 Custom Control Buttons, a Transition Module, an Effects Memory Module and Keyer Module per MLE, and a Positioner Module as standard.

Figure 2.4 Vision 3M Control Panel (4-Keyer Shown)

Vision 2M Control Panel

The Vision 2M control panels (Figure 2.5) have 2 Panel Rows, 24 Crosspoint Buttons per Bus, 24 Custom Control Buttons, a Transition Module, and Keyer Module per MLE, and a Positioner Module as standard.

Figure 2.5 Vision 2M Control Panel (4-Keyer Shown)
Vision 2 Control Panel

The Vision 2 control panels (Figure 2.6) have 2 Panel Rows, 16 Crosspoint Buttons per Bus, 16 Custom Control Buttons, a Transition Module, and Keyer Module per MLE, and a Positioner Module as standard.

Vision 1M Control Panel

The Vision 1M control panel (Figure 2.7) has 1 Panel Row, 24 Crosspoint Buttons per Bus, 24 Custom Control Buttons, a Transition Module, a Keyer Module, and a Positioner Module as standard.
Vision 1 Control Panel

The Vision 1 control panel (Figure 2.8) has 1 Panel Row, 16 Crosspoint Buttons per Bus, 16 Custom Control Buttons, a Transition Module, a Keyer Module, and a Positioner Module as standard.

![Vision 1 Control Panel (4-Keyer Shown)](image)

1. Effects Memory Module

The Effects Memory Module allows you to store and recall memory registers within each MLE. On the Vision 1, 1M, 2, and 2M control panels, the Global Memory Module is used to store and recall memories. Unlike the Global Memory Module, the Effects Memory Module applies only to the individual MLE it is assigned to, and not the entire control panel.

In addition to memory register functions, you can assign MLE transition rates and key transition rates for the MLE. The display above the keypad on the Effects Memory Module shows the current auto transition rate, key transition rate, and current memory register.

For More Information...

- on storing and recalling memories, refer to the section “Storing and Recalling Memories” on page Ops 9-6.

2. Transition Module

The Transition Module allows you to select the type of transition, what is transitioned, and how the transition is performed on the selected MLE.

- Transition Type Buttons — These buttons allow you to select the type of transition that you want to perform during the next transition. You can choose between the following:
DISS — Select this transition type to have a Dissolve performed during the next transition.

WIPE — Select this transition type to have a Wipe performed during the next transition.

DVE — Select this transition type to have a Squeeze & Tease Wipe performed during the next transition.

SEQ — Select this button to use the Transition Module to run a Sequence. A sequence does not perform a transition and will not transition any sources on or off-air.

Next Transition Buttons — These buttons allow you to select what is transitioned during the next transition. You can transition almost any combination of keys and background at the same time. You can choose between the following:

- BKGD — Toggle this button On to have a transition performed between the Background and Preset buses.
- KEY1 — Toggle this button On to have Key 1 transitioned on-air or off-air with the next transition. If Key 1 is on-air, it will be transitioned off-air.
- KEY2 — Toggle this button On to have Key 2 transitioned on-air or off-air with the next transition. If Key 2 is on-air, it will be transitioned off-air.
- KEY3 — Toggle this button On to have Key 3 transitioned on-air or off-air with the next transition. If Key 3 is on-air, it will be transitioned off-air.
- KEY4 — Toggle this button On to have Key 4 transitioned on-air or off-air with the next transition. If Key 4 is on-air, it will be transitioned off-air.

Transitions are performed manually using the Fader, or automatically using the AUTO TRANS button.

For More Information...
- on transition types, refer to the section “Transition Types” on page Ops 5-7.
- on the next transition buttons, refer to the section “Next Transition Select” on page Ops 5-3.

3. Keyers Module

The Keyers Module allows you to select the key type and associated parameters for all the keys on the selected MLE. You can choose between Self Key, Auto Select (Linear) Key, UltraChrome Advanced Chroma Key, and Preset Pattern Key. You can also select a variety of parameters and key transitions for the selected key.

The Keyers Module is assigned to a key by pressing the associated SEL button for the Keyer. When the SEL button for a Keyer is selected, the Key Bus on the MLE, and the Keyer Module, are assigned to that key.

The Vision switcher supports a 2-Keyer and 4-Keyer, Keyers Module for each MLE, depending on whether the 4-Keyer option has been installed.

For More Information...
- on the Keyers Module, refer to the section “Keyers Module” on page Ops 7-2.
- on key priority, refer to the section “Video Layering” on page Ops 4-3.
- on performing a key over transition, refer to the section “KEY PRIOR” on page Ops 5-4.

4. Preview Module

The Preview Module allows you to select what video signal is fed out of the Preview output of the switcher. You can select either the Program or Preview output of each MLE on the switcher, or you can select a specific video source.
5. Preview Overlay Module

The **Preview Overlay Module** allows you to control specific overlay information that is shown on the over top of the preview output. This information includes **VTR Timecodes**, **Countdown Timers**, **Source ID**, and **Safe Title**.

---

For More Information...
- on using the Preview Overlay Module, refer to the section “**Preview Overlay**” on page Ops 4-17.

---

6. Fade to Black Module

The **Fade to Black Module** allows you to fade, or cut, the output of the switcher to black. This can be set up for all MLEs, or just the Program output of the switcher. The display on the module shows the current fade-to-black transition rate.

A USB port on the **Fade to Black Module** allows you to store and recall switcher setups onto a USB flash drive.

If you have the SmartConversion™ option installed, you can have this display show the number of free converters on the switcher.

---

For More Information...
- on setting up SmartConversion, refer to the section “**Switcher Setup**” on page Eng 16-5.
- on storing and recalling files, refer to the section “**Storing and Recalling Files and Setups**” on page Eng 13-4.

---

7. Keyers Module (Downstream)

The **Keyers Module (Downstream)** allows you to select the key type and associated parameters for all the keys on the Program/Preset MLE. You can choose between **Self Key**, **Auto Select (Linear) Key**, **UltraChrome Advanced Chroma Key**, and **Preset Pattern Key**. You can also select a variety of parameters and key transitions for the selected key.

The **Keyers Module (Downstream)** operates the same as the **Keyers Module**, with the addition of Keyers 5-8 that are used for the MultiDSK option.

If you have a **Half MLE** switcher, only **Self Keys** and **Auto Select Keys** can be performed on the **MultiDSK Keys**.

The **Keyers Module** is assigned to a key by pressing the associated **SEL** button for the Keyer. When the **SEL** button for a Keyer is selected, the Key Bus on the MLE, and the Keyer Module, are assigned to that key.

An 8-Keyer, Keyers module is available for switchers that have both the 4-Keyer and MultiDSK options installed.

---

For More Information...
- on the **Downstream Keyer Module**, refer to the section “**Keyers Module**” on page Ops 7-2.
- on MultiDSK, refer to the section “**MultiDSK Keys**” on page Ops 7-26.
- on performing a key over transition, refer to the section “**KEY PRIOR**” on page Ops 5-4.
- on key priority, refer to the section “**Video Layering**” on page Ops 4-3.
8. Global Memory Module

The **Global Memory Module** allows you to store and recall memory registers within any, or all, MLEs on the switcher, or load clips or stills. Unlike the **Effects Memory Module**, the **Global Memory Module** can be used to load clips and stills to the internal Still-Store (Global-Store or MLE-Store) and external VTRs, Video Servers, and Still Stores.

In addition to memory registers functions, you can assign MLE transition rates and key transition rates for the MLE. The display above the keypad on the **Global Memory Module** can show the current auto transition rate, key transition rate, and current memory register. The content of the display depends on the mode you are currently in.

**For More Information...**
- on storing and recalling memories, refer to the section “Storing and Recalling Memories” on page Ops 9-6.

9. Positioner Module

The **Positioner Module** allows you to use a positioner, or joystick, to control various aspects of the switcher, including wipe position, as well as external devices, such as robotic cameras.

The display at the top of the module shows you where the **Positioner Module** is assigned, including the MLE, key and channel, as well as what the positioner is controlling, such as position or rotation of a Fly Key.

**For More Information...**
- on the **Positioner Module**, refer to the section “Using the Positioner with the Menu System” on page Ops 3-9.

10. Crosspoint Group

A **Crosspoint Group** is composed of three buses, or rows, of crosspoint buttons. These buses are the Key Bus, the Background Bus and the Preset Bus.

- **Key Bus** — This bus is used to select key sources that can be electronically cut, or keyed, into the background video. The **Key Bus** is shared between all keyers on the MLE, and the Utility Buses. The Key Bus can also be assigned to an Aux Bus.
- **Background Bus** — This bus is used to select the source that is used as the background video that the keys will appear on top of. The background video is the basis for the Program output of each MLE, or AuxKey.
- **Preset Bus** — This bus is used to select the source that you want to transition to with the next Background transition. The transition can be a Cut, Dissolve, Wipe, or DVE transition.

Depending on how the **Crosspoint Group** is assigned, these buses could be for an MLE, Aux Bus, AuxKey, or an extension of another MLE. An MLE can be thought of as an individual video layer that can be combined with other video signals, keys, and MLEs to form the composite switcher output.

In addition to the crosspoint buses, each **Crosspoint Group** has a module display and a SEL, or select, button. The display is used to show which MLE, Aux Bus, or AuxKey the Crosspoint Group is assigned to, and what the Key Bus is currently assigned to. The SEL button is used to cycle through which key the Key Bus is assigned to on an MLE, default the group, or assign the group to another MLE.

Pressing the SEL button displays a menu that allows you to assign the Key Bus to a Keyer, Aux Bus, or a Utility Bus, or the entire Crosspoint Group of **MLE 1** to an AuxKey, or another MLE.

**For More Information...**
- on the **Crosspoint Group**, refer to the section “Panel Row” on page Ops 4-5.
11. Custom Control Group

The Custom Control Group features an array of buttons that can be programmed to perform specific functions, such as peripheral device control, switcher memory recalls, running a sequence, or a series of button presses on the control panel.

For More Information...

- on the Custom Control Group, refer to the section “Custom Controls” on page Eng 10-2.
Resetting the Switcher

If required, the Vision switcher can be reset from the control panel. This can be either a software based reset, or a restart of the entire switcher.

- **Software Reset** — A Software Reset affects software only, returning the switcher to the default state.
- **Full Restart** — The Full Restart affects hardware and software simultaneously, physically powering down the switcher and powering it back up again.

**For More Information...**

- on shutting down the switcher, refer to the section “Powering Down the Switcher” on page Eng 4-3.
- on restarting the control panel, refer to the section “Control Panel Restart” on page Eng 4-24.
- on the control panel power supplies, refer to the section “Control Panel Power Supply” on page Eng 18-10.
- on the frame power supplies, refer to the section “Frame Power Supply” on page Eng 18-12.
- on completely shutting down or powering up the switcher, refer to the section “Powering Up and Powering Down the Switcher” on page Eng 4-2.

**Software Reset**

The software reset function can be performed from either the Global Memory System Module or any individual MLE Memory System Module on the control panel. Both methods are described below.

**Resetting from the Global Memory Module**

From the Global Memory Module you can reset either all of the MLEs assigned by your control panel at once, or each one individually.

Use one of the following methods to reset MLEs from the Global Memory Module:

- **All MLEs** — To reset all MLEs, press and hold both the ALL button in the Recall area and the ALL button in the Store areas (Figure 2.9). Only the MLEs assigned to the control panel are reset.

![Figure 2.9 Press to Reset All MLEs at Once](image)
• **Individual MLEs (1-4)** — To reset MLEs 1-4 individually, press and hold both the **MLE #** button in the **Recall** and the **MLE #** button in the **Store** areas (Figure 2.10). Where the # is the number of the MLE you want to reset. For example, to reset MLE 1, you would press and hold the **MLE 1** buttons. You can only reset MLEs that are assigned to your control panel.

• **Individual MLEs (5-8)** — To reset MLEs 5-8 individually, toggle +4 on and press and hold both the **MLE #** button in the **Recall** and the **MLE #** button in the **Store** areas (Figure 2.10). Where the # is the number of the MLE you want to reset. For example, to reset MLE 5, you would toggle +4 on, and press and hold the **MLE 1** buttons. You can only reset MLEs that are assigned to your control panel.

**Note** — You cannot reset an individual MLE from the 1-4 MLE and the 5-8 MLE at the same time.

This completes the method for resetting an individual MLE, or all MLEs, from the **Global Memory System Module**.

**Resetting from an Individual MLE**

From each individual **Effects Memory Module** you can reset the MLE individually.

Use the following method to reset an MLE from the **Effects Memory Module**:

• Press and hold both the **Recall** and **Store** buttons in the **Effects Memory Module** (Figure 2.11).

---

**Figure 2.10** Press to Reset an Individual MLE

**Figure 2.11** Press to Reset an individual MLE
This completes the method for resetting an individual MLE from the Effects Memory Module.

## Resetting From the Positioner Module

You can also reset the Crosspoint Group individually from the Positioner Module. This allows you to reset an MLE or an Aux bus, depending on what is assigned to the Crosspoint Group.

Use the following procedure to reset a Crosspoint Group from the Positioner Module:

1. Press and hold the SEL button on the Crosspoint Group that you want to reset. Refer to the section “Panel Row” on page Ops 4-5 for more information on the Crosspoint Group.
2. Press the CLEAR button on the Positioner Module. The Crosspoint Group will return to the default state.

This completes the procedure for resetting an individual MLE from the Positioner Module.

*For More Information...*

- on the Positioner Module, refer to the section “Using the Positioner” on page Ops 4-37.

## Full Restart

This function performs both a hardware and a software reset simultaneously. Switcher memory registers, personality registers, installation registers, and custom control registers are not affected by the reset, but all other switcher parameters (for example, the current state of the panel) are reset. **BLACK** will be selected on all buses.

A full restart can only be performed from the Master Panel in a MultiPanel application.

**Important** — *It is not recommended to reset the frame by turning the power off and then on again, as this may damage the hard disk.*

Use the following procedure to perform a full restart of the switcher:

1. Navigate to the System Shutdown Menu as follows:
   - Press HOME ⇒ More ⇒ System Shutdown.

   ![System Shutdown Menu](image)

**Note** — The control panel will not start up properly if there is a USB flash drive in the USB port on the control panel. You must remove the USB flash drive from the USB port on the control panel before powering the control panel up.

2. Press Restart.
3. The system will prompt you to confirm the restart. Once confirmed, the frame and control panels power down and boot up again.

This completes the procedure for performing a full restart of the switcher.

**Default State**

When you reset an MLE, the entire switcher, or perform a complete restart, the switcher will return to the default state.

All transition rates shown are for the indicated video format. The switcher automatically calculates the transition rates, depending on the video format it is operating in.

---

**Note** — If you reset an individual MLE, only that MLE will be returned to the default state. All other MLEs will be unaffected.

The default state consists of the following:

- The first crosspoint button (Black by default) is selected on the Key, Background, and Preset buses.
- All Keys will be taken off-air.
- In the **Preview Bus Module**, the PV and the MLE button for the Program/Preset MLE are selected.
- In the **Transition Modules**, **Background (BKGD)** is selected as included in the next transition, and **Dissolve (DISS)** is selected as the transition type.

---

**Note** — If the Default Transition Rate Active personality option is turned on, you must set the default values from the Personality Menu. Refer to the section "Personality List" on page Eng 11-2 for more information.

- In the **Effects Memory Module**, the following memories and rates are set:
  - REG:00 — Memory register 00 is preset
  - Memory00 — Memory register 00 was last recalled
  - MLE:015 — MLE transition rate is 15 frames (Interlaced at 59.94 Hz)
  - Key:008 — Key transition rate is 8 frames (Interlaced at 59.94 Hz)
- In the **Global Memory Module**, the following memories and rates are set:
  - REG:00 — Memory register 00 is preset
  - Memory00 — Memory register 00 was last recalled
  - M:015 — MLE transition rate is 15 frames (Interlaced at 59.94 Hz)
  - D:008 — DSK transition rate is 8 frames (Interlaced at 59.94 Hz)
  - F:20 — DSK fade-to-black transition rate is 20 frames (Interlaced at 59.94 Hz)
- **Auto Select** is selected as the key type in each Keyer.
- The Default MLE Map will be loaded.
Control Panel Timeout

The Vision switcher goes into a timeout mode if no buttons are touched, or faders are moved, for a preset amount of time. The factory default interval is 30 minutes.

If the timeout occurs, press any button to bring the control panel back to full operation. The switcher will not act upon the button press.

For More Information...

- on setting the switcher timeout, refer to the section “Personality List” on page Eng 11-2.
Using the Menu System

In This Chapter

This chapter provides information on using the menu system and adjusting and using the touchscreen display of the Vision switcher.

The following topics are discussed in this chapter:

• Touchscreen Interface
• Menu System Basics
• Quick Navigation Buttons
• Help Features
• SoftPanel
• Screen Captures
Touchscreen Interface

Each large Vision control panel comes with an adjustable Touchscreen Display (Figure 3.1) that is used to interface with the menu system of the switcher. As you operate the switcher, the menu system will follow what you are doing, displaying the appropriate menu. For example, if you select a crosspoint that has been assigned to a robotic camera that is controlled from the switcher, the Camera Head Control Menu for that camera is displayed. Similarly, if you fly a key, the Squeeze & Tease Position/Crop Menu is displayed.

Note — The Touchscreen Display is an option with the Vision 1 and 2 control panels. If you do not have the Touchscreen Display, an LCD computer monitor with a DVI-D connector is required.

Figure 3.1 Touchscreen Display for the Vision Control Panel

1. Control Buttons

To the left of the upper and lower displays there are three buttons that allow you to navigate the menu system in the adjacent display. These buttons are as follows:

- **HOME** — Press this button to display the Main Menus. Pressing the HOME button next to a display region shows the Main Menu 1-2 in that display region. The other display region remains the same.

- **UP ONE** — Press this button to take the display region next to the button up one level in the menu tree. For example, if you navigate to the Disk Menu and press UP ONE, you return to the Main Menus. Pressing the UP ONE button next to a display region shows the menu from the next level up the menu tree in that display region.

- **HOLD** — Press this button to lock the displays to the current menus. Pressing the HOLD button next to the upper display region locks the upper display region to the current menu. The lower display region remains unlocked. It is still possible to go down levels of...
the menu tree, but you are not able to go up past the level at which you pressed the HOLD button.

- **MORE** — This button, located at the bottom right of the display, lights to indicate when it can be used to navigate to additional pages of the current menu in the lower display region. A soft More button is also present on the menu. Pressing the More button on a menu, shows the next page of the menu in that display region.

2. **Control Knobs**

To the right of the upper and lower display regions there are three knobs that allow you to make menu selection on the adjacent display. Each knob adjusts the menu item that is next to it.

If the Punchpad functionality is available for a menu item, pressing the knob next to a menu item jumps the value to the nearest 10. If you double-press the knob, the value is defaulted.

**Operating Tip** — If you are using a mouse with the switcher, you can hover the mouse over the knob and use the scroll wheel to make adjustments.

3. **Quick Navigation Buttons**

The Quick Navigation Buttons allow you to navigate to commonly used menus with a single button press. Additional Quick Navigation Buttons can be accessed by using the Quick Navigation More Button.

4. **Upper Display Region**

The Upper Display Region is one of the two areas on the touchscreen that contain a menu.

When you use the Online Help, the text is shown in the upper display region.

5. **Lower Display Region**

The Lower Display Region is one of the two areas on the touchscreen that contain a menu.

6. **Function Buttons**

The six Function Buttons allow you to select items on the Lower Display Region directly above the physical buttons. Selections on the lower display region can be made using either the function buttons, or by using the touchscreen directly.

7. **Quick Navigation More Button**

The Quick Navigation More Button allows you to cycle through all the sets of Quick Navigation Buttons that have been programmed on the switcher.

8. **System Power Button**

The System Power button allows you to quickly shut down the switcher without having to navigate through the menus. When pressed, you are taken to the System Shutdown Menu. When the switcher is powered on, the button is lit.

9. **Touchscreen Display Power Button**

This button turns the touchscreen display on or off. The touchscreen display must be on in order to view and interact with the menu system on the switcher.

10. **Frame Fail Indicator**

The Frame Fail Indicator lights if there is a problem with one of the power supplies or cooling fans in the frame. Refer to the section “Fail Indicators Diagnosis” on page Eng 17-10 for more information.

11. **Panel Fail Indicator**

The Panel Fail Indicator lights if there is a problem with one of the power supplies in the control panel. Refer to the section “Fail Indicators Diagnosis” on page Eng 17-10 for more information.
12. Touchscreen Adjustment Buttons

The Touchscreen Adjustment Buttons allow you to adjust the characteristics, such as brightness and contrast, of the touchscreen display.
Menu System Basics

The menu system on the Vision switcher allows you to set up the switcher, interface with external equipment, set up and perform complex shots or sequences, and record and edit custom controls.

The menu system is set up with a branching architecture, with the Main Menus as the starting point of all menus. This is the menu that is displayed when you press the HOME button next to a display region. Pressing the HOME button next to a display region shows the Main Menu 1-2 in that display region. The other display region remains the same. If you do not have the Touchscreen Display, you must use the Home Quick Navigation button to navigate to the Main Menu 1-2.

From the Main Menus you can move down the tree by selecting one of the other menus in the Navigation Area, or you can move laterally to additional pages of the menu by pressing the More button. Pressing the More button on a display region displays the Main Menu 2-2 in that display region. The other display region remains the same.

You can tell when there are additional pages to a particular menu by the title of the menu, whether it is page 1-3 or 3-3, and whether the More button is lit or not. If the More button is not grayed out, that indicates that there are additional pages to the current menu that are not displayed.

The touchscreen allows you to show two independent menus at once. By default, the lower region is main auto-follow menu for the switcher, and the upper region is a user mountable menu. For example, you can mount the Global-Store Menu on the upper region and use the bottom region for normal operation (Figure 3.2). This will allow you to manage the Global-Store Menu without having to navigate to the menu every time.

![Figure 3.2 Menus](image)

Every menu on the switcher has the same layout, with a Menu Title, Main Area, Selection Area and Navigation Area (Figure 3.3).
1. **Back and Forward Buttons**

These buttons allow you to move back and forth between menus you have already navigated to, much like the Forward and Back button on your internet browser. For example, pressing the Back button takes you to the last menu that was displayed in that display region. If you press the Forward button, you navigate back to the original menu.

2. **Menu Titles**

The menu title gives you the title of the current menu, as well as the current page and total number of pages of the menu. For example, Main Menu 1-2 is the first page of the Main Menu, and Main Menu 2-2 is the second, and last, page of the Main Menu.

3. **Copy Down and Copy Up Buttons**

These buttons allow you to copy the currently displayed menu from one display region to the other.

4. **Swap Buttons**

These buttons allow you to swap the menus currently displayed between the upper and lower display regions. The menu in the upper display region is displayed in the lower, and the menu in the lower display region is displayed in the upper.

5. **Selection Areas**

The selection area of the menu can contain up to three items that are adjusted using the Selection Knobs adjacent to the display. These knobs are where the majority of the selection on the menu system are made. In some cases, these items can be adjusted using the positioner.

If the Punchpad functionality is available for a menu item, pressing the knob next to a menu item jumps the value to the nearest 10. If you double-press the knob, the value is defaulted.

If you hover the mouse pointer over a knob value, the scroll wheel on the mouse can be used to adjust the knob value. The scroll wheel acts as if you are turning the knob.
6. **Main Areas**

The main area of the menu is where the bulk of the information is displayed. This includes helpful tips about using the menu, or information on the current state of the switcher. For example, on the **Main Menu 1-2** the main area provides the software version, whether the control panel is a Master Panel or Satellite Panel, the video format that the switcher is currently operating in, the input reference format, and the status of the Remote Enables and Video Correctors.

7. **Navigation Areas**

The navigation area of the menu contains up to six items that can be either a navigation button to another menu, a toggle for a feature, or displays a sub-menu that changes the items in the **Selection Area**.

- **Navigation Buttons** have a down pointing arrow next to the name, indicating that if you select this item you will be taken to another menu.
- **Toggle Buttons** have a highlighted item beneath the title, indicating what is currently active. This can be an on versus off, or one feature versus another. Turning a feature on may also activate different option for the same menu.
- **Option Buttons** change the items currently available in the **Selection Area**, and the **Main Area**. For example, selecting items in the **Navigation Area** of the **Communications Menu** does not take you to another menu, but changes the items in the **Selection Area**.

**Using a Keyboard**

When a keyboard is connected, specific keys are mapped to functions on the menus.

*Table 3.1 Keyboard Shortcuts*

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Same as pressing UP ONE on the touchscreen.</td>
</tr>
<tr>
<td>F1</td>
<td>Same as pressing F1 on the touchscreen.</td>
</tr>
<tr>
<td>F2</td>
<td>Same as pressing F2 on the touchscreen.</td>
</tr>
<tr>
<td>F3</td>
<td>Same as pressing F3 on the touchscreen.</td>
</tr>
<tr>
<td>F4</td>
<td>Same as pressing F4 on the touchscreen.</td>
</tr>
<tr>
<td>F5</td>
<td>Same as pressing F5 on the touchscreen.</td>
</tr>
<tr>
<td>F6</td>
<td>Same as pressing F6 on the touchscreen.</td>
</tr>
</tbody>
</table>

**Using the Punchpad**

When you select specific installation and operational menus, **Punchpad Icons** ( presses) appear next to the **Selection Knobs** (Figure 3.4), indicating that you can press the button next to the **Selection Knobs** to use the Punchpad to enter values.
When the punchpad icon is present, you can press the button next to the Selection Knob to display the Punchpad (Figure 3.5). The Punchpad remains on screen until you close it or you navigate away from the menu. Selecting another option on the menu, or pressing More does not close the Punchpad.

1. **New Value Field**
   This field shows the new value for the selected knob. Values can be entered into the Punchpad using the keypad on the Punchpad, a keyboard, or the keypad on the Global Memory Module. Global Memory Number Entry must be turned on to use the keypad to enter values. Refer to the section “Personality List” on page Eng 11-2 for information on the Global Memory Number Entry feature.

   New values must be within the range for the selected knob. If the new value is outside the range for the knob the closest valid value is entered instead. For example, if the knob goes from 0.0% to 100.0%, and you enter -0.1% or 109.0%, the value enter for the knob will be 0.0% or 100.0% respectively.

2. **Keypad**
   The keypad allows you to enter new values for the selected knob. The value appears in the New Value Field. Press ENTER on the keypad to use the new value, or CLR to clear the new value without changing the current knob value.

   You can close the Punchpad by pressing ENTER again without entering another value.
3. **Knob Selection**

The items in the knob selection area represent the knobs on the menu and their current values. The highlighted item represents the knob that the Punchpad is currently assigned to.

Only items that can use the Punchpad to enter values appear in the knob selection area.

4. **Copy/Paste Buttons**

The copy and paste buttons allow you to copy a single, or all, the values for the current knobs and paste them to other knobs. Knob values can be copied between knobs on the same menu, or on different menus, as long as the values are in the same format. A decimal value, such as 25.5%, cannot be pasted into a field that requires a whole number, such as 2 Frames.

To copy a specific knob value, select the knob you want to copy and press **Copy**. The value appears in the Mem: field.

To copy all knob values, press **Copy All**. The values for each knob appear in the Mem 1:, Mem 2:, and Mem 3: fields.

5. **Default and Close Buttons**

The **Default** button resets the currently selected knob to the default value. All other knob values remain unchanged. This is the same functionality as double-pressing the knob.

The **Close Window** button closes the Punchpad.

---

**Using the Positioner with the Menu System**

When you select specific installation and operational menus, **Positioner Icons** appear next to the knobs (Figure 3.6) on the lower display region, indicating that moving the positioner in that axis will adjust the selection for that knob. Typically, two or three icons are shown, depending upon the selected menu and function.

When these icons appear, you can adjust the selected function or parameter either with the Selection Knobs or with the Positioner.

---

*Figure 3.6 The Positioner can be used to make selections on the menu system*

- When the left-right positioner icon ( ) appears, you can move the Positioner left and right to make adjustments to this value.
- When the up-down positioner icon ( ) appears, you can move the Positioner up and down to make adjustments to this value.
- When the circular positioner icon ( ) appears, you can twist the Positioner knob clockwise and counter-clockwise to make adjustments to this value.
For More Information...

- on using the positioner, refer to the section “Using the Positioner” on page Ops 4-37.
Quick Navigation Buttons

The Quick Navigation buttons (Figure 3.7) allow you to control the display region next to the buttons, or navigate to commonly used menus with a single button press. The additional Quick Navigation buttons are displayed by pressing the Next button. Refer to the section “Touchscreen Interface” on page Ops 3-2 for more information on the buttons on the Touchscreen Display.

The Quick Navigation buttons display the menu in the lower display region.

![Quick Navigation Buttons](image)

**Figure 3.7 Quick Navigation Buttons**

The default settings for these buttons are as follows:

**First Tab**

- **Home** — The Home button displays the Main Menu 1-2 on the adjacent display region.
- **UP One** — The Up One button displays the menu up one level in the menu tree.
- **Hold** — The Hold button locks the adjacent display region to the current menu.
- **Next** — The Next button toggles between the first and second tab of Quick Navigation Buttons.

**Second Tab**

- **Install** — The Install button displays the Installation Menus.
- **Pers** — The Pers button displays the Personality Menu.
- **Scheme** — The Color Scheme button displays the Color Scheme Menus. From these menus, you can set the color of the buttons on the control panel, as well as the skin used for the menus.
- **Diags** — The Diag button displays the Panel Diagnostics Menu.
- **Manuals** — The Manuals button displays the welcome screen for the Online Help. If you have already accessed the online help, this button will display the help at the same page that it was last viewed. If you hold the Help button, and press another button on the control panel, you can view specific help information on that button, or group of buttons.
Refer to the section “Help Features” on page Ops 3-13 for more information on using the help.

- **Aux Bus** — The Aux Bus button displays the Aux Bus Outputs Menus.
- **DVE** — The DVE button displays the S&T MD Main Menu. From this menu you can access any of the Squeeze & Tease Menus.
- **CustCtrl** — The Custom Control button displays the Custom Control ShotBox Menus. From these menus you can run any custom control on the switcher.
Help Features

The Vision switcher provides a complete set of online manuals and a function-specific help system that can be viewed on the touchscreen display. In addition to this, an extensive pop-up system is provided to help you quickly and easily diagnose operational problems that may occur.

Online Manuals

A complete set of the Vision Manuals are provided on the switcher and can be viewed on the touchscreen display or downloaded to a USB drive.

Use the following procedure to access the online manuals:

1. Press Manuals on the Quick Navigation Bar on the Touchscreen Display. The online manuals (Figure 3.8) are displayed in the Upper Display Region.

2. Press the Manuals button again to close the help.

Operating Tip — To save a copy of the manuals in PDF format to a USB drive, insert a USB drive into the USB port on the Vision control panel and press HOME ⇒ More ⇒ Help ⇒ Copy Manuals To USB.

This completes the procedure for accessing the online manuals.

Pop-up Help

The Pop-up Help feature is designed to alert you when an illegal function is attempted. When the illegal button or combination of buttons is pressed, the Pop-up Help window is displayed. This window provides a brief explanation of why the operation cannot be performed, and a reference number that can be used when contacting Ross Technical support.

Example of Pop-up Help
SoftPanel

The Vision SoftPanel allows you to run the menu system of the Vision switcher from a computer. The switcher treats the SoftPanel interface as a satellite panel, allowing it to control all aspects of the switcher that the menu system of a satellite panel can control.

Keep the following in mind when using SoftPanel:

- SoftPanel and the switcher must be on the same version of software.
- Upgrading the switcher will not upgrade SoftPanel. You must download a newer version of the SoftPanel that is compatible with the new switcher software.
- SoftPanel is an application running on a Fedora® system on the Oracle® VM VirtualBox Virtual Machine. Refer to the documentation that came with VirtualBox for information on configuring the virtual machine.
- Ross Video recommends using a static IP address on the computer running SoftPanel.
- SoftPanel is treated like a satellite panel by the switcher. All satellite panel permissions apply.
- SoftPanel obtains an IP address from the VirtualBox. If you want to set up a specific IP address, you must set it up in VirtualBox.
- The Oracle VM VirtualBox will prompt you to download and install new versions of the VirtualBox application. When you install the new version, the VirtualBox GuestAdditions that SoftPanel uses to interface with your computer hardware must be updated as well.
- Not all menus and functionality are available when using SoftPanel. Panel Diagnostics and Calibration, MLE Maps, and Positioner control are a few of the menus and functions that are not available.

Installing SoftPanel

The SoftPanel application uses the Oracle® VM VirtualBox to interface with the computer hardware and operating system, and connect to the switcher frame.

To install SoftPanel on your computer, you need the following:

- Oracle® VM VirtualBox 4.1 or higher installed on your computer
- Ross Vision SoftPanel_Installer

To Install SoftPanel

1. If you have not already done so, download and install the Oracle VM VirtualBox on your computer.
2. Run the SoftPanel_Installer.exe on your computer.

   **Operating Tip** — Once the install has started, click Show details. If there are any errors in the installation, they will appear in the details.

3. Follow the onscreen instructions. Once SoftPanel is installed, you must update the GuestAdditions.
To Update Guest Additions

1. Run Vision_SoftPanel.
2. Press Host + D on the keyboard. By default, VirtualBox maps the Host button to the right Ctrl button on a Windows system.
3. On the Removable medium is inserted window, select Open in File Manager, and click OK.
4. Right-click on the autorun.sh file and click %f. The root password is password.
5. Wait for the Guest Additions to install. This will take a few minutes.
6. Right-click on VBOXADDITIONS and click Eject Removable Media before closing the window.

To Set Up SoftPanel

1. Run Vision_SoftPanel. After SoftPanel loads up, the Network Setup Menu will be displayed.

![Network Setup Menu](image)

2. Enter the IP address of the LAN 1 port on the frame in the IP Address field using the keyboard.

Operating Tip — If you have already connected to the frame before, you can select it using the Prev. Frame IPs knob.

3. Use the Panel ID knob to select the Satellite Panel ID that you want to use. You must select the same Satellite Panel ID on the QMD/X Web Interface.
4. Press Save to store the new network setup information.
5. Press Yes to reboot SoftPanel and apply the new network settings.
6. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.
7. Enter your username and password when the Login Dialog Box appears. The default Name is user and Password is password.
8. Click Other... → Network to display the Network Page. This page allows you to change the network configuration of the frame network ports, as well as enter the current IP Address of the Master Panel, and Satellite Panels.
9. Enter the SoftPanel computer IP address in the IP Address Satellite X field. The satellite number is the Panel ID that is set on the SoftPanel.
**Important** — Pressing Change and Reboot will reboot the switcher. Do not do this when the switcher is being used on-air.

10. Press Change and Reboot to restart the switcher and apply the new settings. After the frame reboots the Main Menu is shown on the SoftPanel.
Screen Captures

The Vision switcher allows you to take screen captures of the current state of the active menu. Screen captures are stored to your removable USB flash drive.

Use the following procedure to capture the current state of the menu system:

1. Insert a USB flash drive into the USB port on the Fade to Black Module of the Vision control panel.

2. Navigate to the menu you want to capture. The switcher will only capture the active, or last used, menu.

3. Take a screen capture as follows:
   - Press and hold the STORE ALL button on the Global Memory Module.
   - Press the FADE RATE button on the Global Memory Module.

4. The control panel will beep and the file will be stored to the USB flash drive.

This completes the procedure for taking a screen capture.
Switcher Basics

In This Chapter

This chapter provides a basic introduction to the Vision switcher, including an overview of the boards in the control panel and frame, as well as an introduction to the various ports, and video buses.

The following topics are discussed in this chapter:

• Switcher Operation Overview
• Panel Row
• Panel Row Select Button
• Re-entry
• Video Preview
• MultiPanel Operation
• GPI Output Control
• SmartConversion™
• Color Correction
• Fade to Black
• Using the Positioner
• Copy MLE
• Copy and Swap Buses
• Copy and Swap Keyers
• Copy Squeeze & Tease Channels
Switcher Operation Overview

The Vision switcher operates by routing video signals through the various boards and cards in the frame and feeding them out of the assigned Output BNCs. Which MLE a source is selected on, or which key on that MLE, determines how each of those video signals is layered in the video output.

Video Routing

How video is routed through the Vision switcher depends on the frame you have.

Video Routing Through the Octane/QMD-X and MD-X Frame

Video routing for the Octane/QMD-X and MD-X frame is handled by the various boards installed in the frame. The boards primarily responsible for video routing are the Crosspoint Board, the Video Processor Board, and the Squeeze & Tease MD Carrier Board (Figure 4.1). Each of these boards work together with the Midplane and the Video Input and Output Boards to take an input video signal, manipulate it, and route it to the desired output.

![Figure 4.1 Frame — Video Routing](image)

From the Video Input Board, all the video signals are routed to the Crosspoint Board. The video signals can include Global-Store images from the Frame CPU Board and the MLE-Store images from the XFX Card on the Video Processor Board. Depending on what is selected on the crosspoint buses of the switcher, the video signals are routed to the Video Processor Board to be mixed for a transition, or keyed. If a Squeeze & Tease effect is selected, the video signals will be routed to the Squeeze & Tease Carrier Board. After all the video has been manipulated, it is sent back through the Crosspoint Board to be routed to the required output on the Video Output Board. All this happens in real-time.

Video Routing Through the QMD and MD Frame

Video routing for the QMD and MD frame is handled by the various boards installed in the frame. The boards primarily responsible for video routing are the Video Input with Crosspoint Board, the Video Processor Board, and the Squeeze & Tease MD Carrier Board (Figure 4.2). Each of these boards work together with the Midplane and the Video Output Board to take an input video signal, manipulate it, and route it to the desired output.
All the video signals are routed to the **Video Input with Crosspoint Board**. The video signals can include Global-Store images from the **Frame CPU Board** and the MLE-Store images from the **XFX Card** on the **Video Processor Board**. Depending on what is selected on the crosspoint buses of the switcher, the video signals are routed to the **Video Processor Board** to be mixed for a transition, or keyed. If a Squeeze & Tease effect is selected, the video signals will be routed to the **Squeeze & Tease Carrier Board**. After all the video has been manipulated, it is sent back through the **Video Input with Crosspoint Board** to be routed to the required output on the **Video Output Board**. All this happens in real-time.

*For More Information...*
- on video routing, refer to the section “Video Routing” on page Eng 2-20.

**Video Layering**

How video is layered in the output of the Vision switcher depends on how each MLE is re-entered onto the other, and what keyers are on-air for the MLE. If we assume that each MLE has all keyers on-air, and that each MLE is re-entered into the MLE below, the layering will start with **MLE 1 Background** and progress to **MLE 4 Keyer 4** (Figure 4.3).

*Note — Re-entry chains of more than 4 MLEs can cause line drops. Any combination of MLEs can be re-entered safely, as long as there are less than 5 MLEs in the chain.*

The priority of the MLEs on the switcher, or how they are layered, can be altered by changing how the MLEs are re-entered on the switcher. For example, if **MLE 3** is re-entered into **MLE 1**, then **MLE 3** will appear behind **MLE 1** in the video layering.
As with MLEs, the priority of keys can be altered. The priority of keys can be changed using a Key Over transition.

For More Information...

- on re-entering an MLE, refer to the section “Re-entry” on page Ops 4-13.
- on performing a key over, refer to the section “KEY PRIOR” on page Ops 5-4.
Panel Row

The Panel Row (Figure 4.4) is used to select video sources for the Background, Preset and Keyers of the MLE, Aux Bus or AuxKey that the panel row is assigned to. Video sources, external and internal, are assigned to buttons on the Panel Row using a Bus Map. When a Bus Map is assigned to a bus in a Panel Row, selecting one of those buttons on a bus tells the switcher to use the corresponding video source for that bus. For example, if you select a crosspoint button on the Keyer 1 bus of MLE 3 that is assigned to Camera 1, the switcher will use the Camera 1 video source for that keyer.

Each Panel Row is made up of three buses of crosspoint buttons, a display, a select button, Keyers Module, Memory Module, and Transition Module (Figure 4.4). The functionality of each of these components depends on what the Panel Row is assigned to, an MLE or Aux Bus for example.

The number of crosspoint buttons and modules that are assigned to the Panel Row depends on how the individual modules are mapped. Refer to the section “Mapping a Module to a Row” on page Eng 17-5 for information on assigning modules to Panel Rows.

Crosspoint Buses

The Crosspoint Buses (Figure 4.5) are where you select what video sources are selected on each bus. Each Panel Row contains a Key Bus, Background Bus, and a Preset Bus.
Between the Key Bus and Background Bus is a row of mnemonic displays that show the name of the video source that is assigned to each crosspoint button on the Background Bus. If you are using a different Bus Map for the Key Bus, the mnemonics only list the video sources for the Background Bus. The Mnemonic Display option must be installed.

If you have the Panel Glow option installed, the Crosspoint Buses are lit with the color you have assigned to that MLE when they are assigned to an MLE.

If the Panel Row is assigned to an Aux Bus, the mnemonics for the Panel Row show the sources for the Aux Bus, or AuxKey, and not the MLE.

**Key Bus**

The Key Bus is used to select the video source that you want to use as the key. The Key Bus is shared among all the keyers on the MLE or AuxKey. If the Panel Row is assigned to an MLE, the keyer that is selected on the Effects Keyer Module sets which keyer the Key Bus is assigned to. For example, if the SEL button for Keyer 2 is lit on the Effects Keyer Module, then the Key Bus is assigned to Keyer 2. The key that the Key Bus is currently assigned to can also be seen on the second line of the display.

If the Panel Row is assigned to an AuxKey, the Key Bus is assigned to the keyer of the AuxKey. If the Panel Row is assigned to an Aux Bus, the Key Bus is assigned to the background of the Aux Bus.

**Background Bus**

The Background Bus is used to select the video source that is used as the background video that the keys will appear on top of. The Background Bus is dedicated and always represents what is going to be the basis of the MLE or AuxKey output.

When the Crosspoint Bus is assigned to an AuxKey, the Background Bus is used to select the video source you want to use on the selected AuxKey.

**Preset Bus**

The Preset Bus is used to select the video source that you want to transition to with the next Background transition.

If the Panel Row is assigned to an AuxKey, the Preset Bus is assigned to the preset of the AuxKey.

**Display**

The display on the Panel Row shows what the Panel Row and Key Bus of the group are assigned to (Figure 4.6). What is shown on the display depends on what the Panel Row is assigned to.

**Assigned to MLE**

When the Panel Row is assigned to an MLE, the first line of the display shows the MLE that the Panel Row is assigned to, which keyer and Squeeze & Tease channel the Key Bus is assigned to, and what is selected on the Key Bus.

---

**Figure 4.6 Assigned to MLE — Panel Row Display**

In the example shown (Figure 4.6), the Panel Row is assigned to MLE 1 and Camera 5 is selected on Keyer 2.
The second line of the display shows which Keyer, or Utility Bus, the Key Bus is assigned to. You can cycle through all the keyers by pressing the SEL button. If you have the MultiDSK option installed, the additional keyers are shown on the display.

**Assigned to Aux Bus**

When the Panel Row is assigned to an Aux Bus or AuxKey, the display shows the Aux Bus that the Panel Row is assigned to, and what is selected on the Aux Bus.

![AuxKey 3:5-Server3](image)

**Figure 4.7 Assigned to AuxKey — Panel Row Display**

In the example shown (Figure 4.7), the Panel Row is assigned to Aux Bus 5 on Bank 3 and Server3 is selected on the Background. The video source that is selected for the key of the AuxKey is not shown.

**For More Information...**

- on Frontside/Backside video, refer to the section “Frontside/Backside Video (Squeeze & Tease DVE Only)” on page Ops 8-13.
Panel Row Select Button

When you press the Select (SEL) button on the Panel Row, the Key Bus is toggled between the Keyers, and the Utility Bus, and the MLE SEL Button Menu is displayed. This menu allows you to assign the Key Bus to a keyer, a utility bus, or an Aux Bus, or the entire Panel Row and accompanying Transition, Keyers, and Memory Modules to an AuxKey or another MLE.

On the left side of the menu are 4 Quick Presets that are used to quickly assign the Panel Row to a keyer, Aux, or MLE. To set up a quick navigation button, you must first set up the assignment you want to use, and then save it to one of the Quick Preset buttons.

You can lock the Panel Row to the current assignment by toggling the Lock Bus button on the MLE SEL Button Menu to On. This prevents the Key Bus from auto following a key selection, or other button press, on the Effects Keyer Module that is associated with the Panel Row. It also prevents the SEL button on the Panel Row from cycling through the keyers.

For More Information...

• on storing a Quick Preset, refer to the section “Assigning a Quick Preset” on page Ops 4-12.
• on editing a bus map, refer to the section “Creating Bus Maps” on page Eng 7-13.
• on assigning a bus map, refer to the section “Assigning Panel Bus Maps” on page Eng 7-19.
• on setting up default MLE maps, refer to the section “Default MLE Map Assignment” on page Eng 12-5.
• on selecting sources for a transition, refer to the section “Performing Transitions” on page Ops 5-13.
• on Frontside/Backside video, refer to the section “Frontside/Backside Video (Squeeze & Tease DVE Only)” on page Ops 8-13.

Selecting a Key or Utility Bus

The SEL button cycles through all the keyers and utility buses available on the Panel Row, unless the Lock Bus feature is on. The utility buses that are available depend on what the Key 4 Flexi Mode is set to.
To Select a Key Bus or Utility Bus

1. Press the SEL button on the Panel Row that you want to set the Key Bus assignment on. The MLE SEL Button Menu for the selected Panel Row is displayed.

2. Press Select Key/Util Bus.

Key and Utility Bus Selection — MLE SEL Button Menu

3. Press the Key X or Util X button to select the Keyer or Utility Bus that you want to assign to the Key Bus, where X is the number of the key or utility bus. If the MultiDSK option is installed, the 2 additional keyers, Key 3 and Key 4, are shown next to the existing Keyers.

For More Information...

• on the Key 4 Flexi Mode, refer to the section “Selecting an MLE Mode” on page Ops 4-10.

Selecting an Aux Bus

From the MLE SEL Button Menu you can assign the Key Bus of the Panel Row to an Aux Bus or the entire Panel Row to an AuxKey. When you select an Aux for a Panel Row, the Key Bus of the Panel Row changes to the Aux glow color and the mnemonics for the Panel Row show the sources for the Aux Bus.

To Select an Aux Bus

1. Press the SEL button on a Panel Row that you want to assign to an Aux Bus. The MLE SEL Button Menu is displayed.

2. Press Select Aux Bus.

Aux Bus Selection — MLE SEL Button Menu
3. Press the Bank X button to select the Aux Bus Bank that you want to use, where X is the number of the bank.

4. Press the Aux X or AuxKey X button to select the Aux Bus that you want to use, where X is the number of the aux bus.

5. Toggle the Locked button to lock or unlock the selected Aux Bus. When locked, you cannot change the source selected on the bus, and the Bus Hold crosspoint button is lit.

**Operating Tip — You can also use the Aux Bus Outputs Menu 1-2 (HOME ➔ Setup ➔ Installation ➔ Aux Bus) to assign the Key Bus to an Aux.**

Selections made on the Key Bus will now be applied to the selected Aux. You can quickly assign the Key Bus back to the Keyer by pressing the SEL button.

**Selecting an MLE Mode**

From the MLE SEL Button Menu you can assign the Key 4 Flexi Mode and MLE Layer Mode for the selected MLE. Both of these selections are stored and recalled with memories.

**Key 4 Flexi Mode** — This selects the sources and functions available to Keyer 4 when it is in Flexi Mode. Key 4 must be set to Flexi Mode to be able to set Key 4 to Internal or External.

This option is only available on the QMD/X frames.

**MLE Layer Mode** — The MLE Layer Mode uses an MLE Clean Feed to create a composite alpha from the keyers on that MLE that is then available to another MLE as a single alpha source. This allows you to re-enter the background of an MLE into the keyer of another MLE as a single Auto Select key. The key video comes from the output of the source MLE and the key alpha comes from the clean feed of the source MLE.

Key 4 Mode must be set to Flexi, External, or Internal to select Layer Mode.

**To Select a Key 4 Flexi Mode**

1. Press the SEL button on the Panel Row that is assigned to MLE 1. The MLE SEL Button Menu is displayed.

2. Press MLE Mode.

3. Set Key 4 to External or Internal mode as follows:

   - **Key 4 External** — Select this option to allow Key 4 access to all sources and two Clean Feeds. Utility Buses or Aux Bus color correctors are unavailable.
4. Set the MLE to MLE or Layer Mode as follows:

- **MLE Mode** — Select this option to have the selected MLE operate normally.
- **Layer Mode** — Select this option to have the combined key alphas of the MLE used as the video source for the Clean Feed. This allows you to use the key alphas from one MLE on another MLE, as an alpha for an auto select key for example. When you set up an Auto Select key with an MLE program and the Clean Feed in Layer mode for that MLE, you can re-enter an MLE as an Auto Select key on another MLE. You must have all the keyers selected as part of the next transition on the MLE that the keys are set up on.

*For More Information...*
- on setting the Key 4 Mode, refer to the section “**Key 4 Mode**” on page Eng 12-8.
- on clean feed output, refer to the section “**Clean Feed**” on page Eng 8-7.
- on auto key setup, refer to the section “**Configuring Auto Keys**” on page Eng 7-8.

**Selecting an MLE**

From the **MLE SEL Button Menu** you can assign the Panel Row to an MLE. The number of MLEs you have to assign depends on the MLE options you have purchased, and the hardware you have installed. Assigning Panel Rows to different MLEs does not change the default MLE Map.

Keep the following in mind when assigning MLEs to Panel Rows:

- If you assign a Panel Row to a different MLE, the accompanying Transition, Keyers, and Memory Modules are also assigned to that MLE.
- If you assign the Program/Preset MLE to a Panel Row that does not have the Downstream Keyer Module associated with it, the MultiDSK keys will not be available.
- If you assign an MLE to an External Panel Row that has an Auxiliary Control Panel on it, the Auxiliary Control Panel will remain assigned to the select Aux Bus. MLE assignments do not apply to Auxiliary Control Panels.
- If an MLE is not assigned to your control panel, you cannot select it.
- If the **Assign MLE** personality feature is set to **Off**, you cannot assign a different MLE to a panel row.

**To Select an MLE**

1. Press the **SEL** button on the **Panel Row** that you want to assign the MLE to. The **MLE SEL Button Menu** for the selected **Panel Row** is displayed.
2. Press **Assign MLE**.
3. Select the **Internal** panel row (Row 1-8) or **External** panel row (Extern Row 1-16) on the **MLE Sel Button Menu** that you want to assign an MLE to.

4. Press the **MLE X** button to select the MLE that you want to assign to the Panel Row.

### Assigning a Quick Preset

To save a Panel Row assignment to one of the Quick Presets, you must first have the Panel Row set up as you want it. Once set up, you can save the current bus assignment to a Quick Preset.

You cannot assign an MLE to a Quick Preset. Only Aux Buss, Keyers, Utility and AuxKeys can be assigned to a Quick Preset.

1. Press the **SEL** button on the **Panel Row** that you want to assign the bus to. The **MLE SEL Button Menu** for the selected **Panel Row** is displayed.

2. Set up the Panel Row as you want to store it.

3. Press **Assign as Preset**.

4. Press the preset button to store the current Panel Row setup to that Quick Preset.
Re-entry

Re-entry is the term used to describe the process of selecting another MLE on an MLE. For example, if you select MLE 5 on MLE 1, MLE 5 is said to be re-entered onto MLE 1. Re-entry takes the output of an MLE and uses it as the background or key on the other MLE. If you select an MLE on the background bus, the MLE becomes background video source of the other MLE. If you select an MLE on a Key Bus, the MLE becomes the key source of the other MLE.

When working with re-entries, there are a number of rules that specify what can and cannot be done. These rules are as follows:

- You cannot re-enter an MLE onto an MLE that is re-entered into the first MLE unless Re-entry Loops is turned on. For example, MLE 1 cannot be re-entered into MLE 3 when MLE 3 is already re-entered into MLE 1.
- You cannot re-enter an MLE, or the Clean Feed of an MLE, into itself.
- The Program/Preset MLE cannot be re-entered into another MLE if the Mix/DSK or MultiDSK options are installed.
- Re-entry chains of more than 4 MLEs can cause line drops. Any combination of MLEs can be re-entered safely, as long as there are less than 5 MLEs in the chain.
- You cannot create a re-entry chain of more than 4 MLEs unless the Re-entry Depth personality option is set to Warn or Allow.

To Re-Enter an MLE

1. Set up MLE 1 with a background and a key (Figure 4.8).

![MLE 1](MLE1.png)

*Figure 4.8 MLE 1*

2. Set up MLE 2 with a key (Figure 4.9).

![MLE 2](MLE2.png)

*Figure 4.9 MLE 2*

3. Select MLE 1 as a source on the Background Bus of MLE 2 (Figure 4.10). Notice that the output of MLE 1 is now being used as the background of MLE 2.
Figure 4.10  MLE 1 Re-entered onto MLE 2

For More Information...

- on the Re-entry Loops option, refer to the section “Personality List” on page Eng 11-2.
- on the Re-entry Depth option, refer to the section “Personality List” on page Eng 11-2.
Video Preview

Video preview allows you to use an additional monitor to preview what the next shot is going to be. The preview for an MLE shows what is selected for the next transition on that MLE. This includes the keys and background video sources that will be on-air after the next transition.

In addition to the preview of the next shot, preview overlay elements, such as a timeclock, safe title and source ID, can be put up over the preview output. These elements are only visible on the preview with overlay output.

Preview Module

The Preview Module (Figure 4.11) allows you to select which MLE you are previewing, and either the Program or Preview of that MLE. In addition to the preview of an MLE, you can also assign a single video source to a button on the Preview Module, allowing you to bring that source up on the preview without selecting it for the next transition.

The Preview Module controls the preview output of the highest number MLE in the switcher. If your control panel does not have that MLE assigned to it, the Preview Module on your control panel does not affect the preview output of the switcher.

On the Vision 1, the Preview Bus and Preview Overlay functions are located on the same module (Figure 4.12).

![Figure 4.11 Preview Module — Vision 4 Control Panel](image1)

![Figure 4.12 Preview Module — Vision 1 Control Panel](image2)

The buttons on the Preview Module are as follows:

- **MLE X** — These buttons allow you to select which MLE you want to assign to the preview output, where X represents the number of the MLE. When you select an MLE, you must select either the PV or PGM to assign that signal to the preview.

- **+4** — This button, in combination with the MLE X button, selects an MLE over MLE 4. For example, to select MLE 6, toggle +4 on and press MLE 2.

- **SRC** — This button can be programmed to assign a specific video source to the preview. Refer to the section “Assigning a Source to the SRC Button” on page Ops 4-16 for more information.

- **PV** — This button assigns the Preview output of the selected MLE to the preview output. For the Vision 1, the PV button shows the main Preview output of the switcher.

- **MLE PV** — (Vision 1 only) This button assigns the Preview output of the selected MLE to the preview output. The MLE is selected from the Preview Overlay Menu.

- **PGM** — This button assigns the Program output of the selected MLE to the preview output. For the Vision 1, the PGM button shows the main Program output of the switcher.

- **MLE PGM** — (Vision 1 only) This button assigns the Program output of the selected MLE to the preview output. The MLE is selected from the Preview Overlay Menu.
Operating Tip — On the Vision 1, pressing MENU displays the Preview Overlay Menu. On this menu you can select the MLE that you want to view the preview or program from. Refer to the section “Vision 1/1M Preview Output” on page Ops 4-16 for more information.

Vision 1/1M Preview Output

The Preview Overlay Menu allows you to select which MLE you want to view the program or preview for on the preview output of the switcher. This menu also allows you to turn Preview Overlay elements on and off.

1. Press MENU on the Preview Bus Module.

2. Change the preview output of the switcher as follows:
   - Press Preview MLE X to assign the preview output of MLE X to the preview output of the switcher, where X is the number of the MLE.
   - Press Program MLE X to assign the program output of MLE X to the preview output of the switcher, where X is the number of the MLE.

Assigning a Source to the SRC Button

The Source (SRC) button on the Preview Bus Module can be programmed with a specific video source. When the SRC button is selected, the video source that is assigned to the button is fed out of the preview. This source overrides the preview video but is not taken to air with the next transition. When the SRC button is de-selected, the video previously being fed out of the preview is restored.

1. Press and hold the SRC button on the Preview Bus Module. The video source that is currently assigned to the button will light up on the Preset Bus of the Program/Preset MLE.

2. Select a source on the Preset Bus of the Program/Preset MLE to assign that video source to the SRC button.

Look Ahead Preview

The Look Ahead Preview feature allows you to view different preview outputs, depending on whether or not the MLE is on-air. Look Ahead preview works differently than the standard Preview, as, instead of displaying the output of just the Program or Preview, the output of the Look Ahead preview changes depending on the on-air status of the MLE.
Note — Any Output BNC can be assigned as the Look Ahead preview for an MLE, except for the Program/Preset MLE.

The output of the Look Ahead preview depends on whether the MLE is on-air or not:

- **MLE Off-Air** — The Look Ahead preview displays the Program output for the assigned MLE. This is what is displayed when you take this MLE to air.

- **MLE On-Air** — The Look Ahead preview displays the Preview output for the assigned MLE. This is what is taken to air if you transition this MLE.

For example, if you have MLE 4 on-air, the Look Ahead preview monitors display the Program output for MLE 1, MLE 2 and MLE 3. If you re-enter MLE 3 into MLE 4, the Look Ahead preview for MLE 1 and MLE 2 remain unchanged, but the Look Ahead preview for MLE 3 shows the Preview output for MLE 3.

For More Information...

- on assigning an Output BNC to Look Ahead preview, refer to the section “Configuring Video Outputs” on page Eng 8-2.

### Preview Overlay

The **Preview Overlay Module** (Figure 4.13) allows you to turn on and off specific elements of the preview overlay. The menu systems will follow the activation of preview overlay elements, allowing you to adjust each one.

The Preview Overlay is only available to the highest number MLE. If your control panel does not have that MLE assigned to it, the Preview Overlay is not available.

Note — If the Global-Store 4 Mode personality option is set to Still-Store the preview overlay is not available.

![Figure 4.13 Preview Overlay Module — Vision 4 Control Panel](image)

**Operating Tip** — On the Vision 1 (Figure 4.14), the Preview Overlay functions can be turned off and on from the Preview Menus. Navigate to the Preview Menu by pressing MENU on the Preview Overlay Module.

![Figure 4.14 Preview Overlay Module — Vision 1 Control Panel](image)

For More Information...

- on assigning an Output BNC to Preview, or Preview with Overlay, refer to the section “Configuring Video Outputs” on page Eng 8-2.
Source ID

The Source Identification overlay (Figure 4.15) displays the name of the current program source, the current transition and direction, followed by the name of the current preview source.

VTR 1 -W-> CAM 2
CAM 1 -D-> MLE 3

Figure 4.15 Source ID

The Program Source (in red) is displayed on the left, and shows what is currently on-air and will be taken off-air with the next transition. The Preview Source (in green) is displayed on the right and shows what will be taken on-air during the next transition.

Between the Program Source and the Preview Source is the Transition Type. The Transition Type shows the type of transition that will be performed for the next transition. The Transition Types are as follows:

• D — Dissolve
• W — Wipe
• DV — DVE Wipe
• SQ — Sequence

For More Information...

• on changing the size or location of the Source ID overlay, refer to the section “Source ID” on page Eng 12-32.

VTR TC

The VTR Timecode overlay (Figure 4.16) displays the timecode of the VTR, DDR, Video Server, or other external device that is on-air and/or will be transitioned on-air. The device must be controlled from the switcher in order for the timecode information to be available.

BNC C10 On-air  00:59:29:59
BNC C06 Prep’d 00:01:02:03

Figure 4.16 VTR TC

By default, the timecode is red if it is on-air, yellow if it is selected, but not on-air, and gray if it is not selected or on-air. Only two timecodes can be displayed at the same time on the preview overlay.

The VTR Timecode overlay is made up of three elements, the input source of the clip, the on-air status, the timecode of the clip, or time remaining in the clip. The timecode or the time remaining can be shown, depending on how the VTR POL Displays features are set.

When you select VTR TC, VTR TC Position is shown on the display on the Positioner Module, indicating that the positioner can be used to move the VTR Timecode element around on the screen.

For More Information...

• on changing the size or location of the VTR Timecode overlay, refer to the section “VTR Timecode” on page Eng 12-32.
• on the VTR POL Display features, refer to the section “Personality List” on page Eng 11-2.
**Safe Title**

The Safe Title overlay shows guides for Safe Title, Safe Action, and Minimum Text Size (Figure 4.17) using the SMPTE standards. A number of pre-defined Safe ID setups are stored on the switcher. The size and position of the elements for these Safe ID setups can be adjusted and stored.

![Figure 4.17 Safe Title Preview Overlay Elements](image)

For More Information...

- on changing the Safe Title, refer to the section “Safe Title” on page Eng 12-33.

**Center**

The Center overlay shows a crosshairs on the Preview Overlay to indicate the center of the picture. The position of the crosshairs can be adjusted and stored.

For More Information...

- on changing the location of the Center, refer to the section “Center” on page Eng 12-34.

**Time Clock**

The Time Clock overlay shows a count-down, count-up, or count-down-then-up timer on the Preview Overlay. The Time Clock can be set up to start counting down, or up, on every transition, from a preset start time. This can be tied to any MLE, or just a particular MLE, or Fade to Black transition.

For More Information...

- on changing the Time Clock, refer to the section “Time Clock” on page Eng 12-35.

**Mask PV**

The Preview Mask overlay places an outline around any active box mask, but cannot be applied to a pattern mask. This function makes it easy to identify various masks, particularly when one may be placed near the edge of the screen.

![Figure 4.18 Mask PV Preview Overlay Element](image)
Hide OVLY

The **Hide Overlays** button turns off all preview overlays that are currently enabled. When the button is lit, all overlays are hidden, but your total setup is retained. When the button is turned off again, all overlays are restored to the monitor.

When the **HIDE OVLY** button is active, all enabled overlay buttons will remain active so that the overlays can be turned on or off without showing them on the preview.
MultiPanel Operation

MultiPanel allows you to connect up to nine Vision control panels to a QMD/X, or MD/X, frame (Figure 4.19). Connected to each frame there is a single Master Panel, and up to eight Satellite Panels.

Each MultiPanel system is made up of a single (1) Master Panel, and up to eight (8) Satellite Panels, all connected to a single frame. The frame provides the MLEs that are assigned to each control panel. This MLE assignment is done on the Master Panel from the MultiPanel Configuration Menu, and can be viewed on Satellite Panels. You can assign one, or all, MLEs to each control panel in the system. The highest number MLE assigned to a control panel is the Program MLE for that control panel, and is tallied for that panel. The highest number MLE assigned to any control panel in the system is the Program MLE that has the MultiDSK, Half MLE, and Preview Overlay options.

For More Information...

- on assigning MLEs to panel and setting a Program MLE, refer to the section “MultiPanel Setup” on page Eng 4-9.

Using MultiPanel with External Panel Rows

In a MultiPanel configuration, the sixteen external panel rows are shared across all panels connected to the frame. This means that when you assign an external module, such as a SideBox, to an external panel row, it is assigned to that external panel row on all control panels connected to the frame. In the case of a Shot Box SideBox, all the SideBoxes on the same external panel row have the same custom control shot box page assigned to them. The content of each custom control shot box page can be unique to each control panel.
MultiPanel Operational Notes

The following is a list of MultiPanel operational notes that you should keep in mind when using either a Master Panel, or Satellite Panel, in a MultiPanel configuration:

- Each control panel can have a separate Program MLE, but only the highest number MLE used by a control panel in the system can use the MultiDSK, Half MLE, or Preview Overlay options, as well as the Preview Bus.
- If you change the Program MLE for a control panel, you must set the MLE Program output for that MLE to the Output BNC you want to use.
- If multiple control panels have the same MLE assigned to them, conflicts are decided on a last button press wins basis.
- Satellite Panels cannot perform the following tasks:
  - Disk/USB Operations
  - Remote Enables for Editors
  - System Restart or Shutdown
  - Device Control
  - Install Software Options
  - Set System Time
- OverDrive and Editors can only interface with the Master Panel.
- Each control panel in a MultiPanel system, must have a unique IP Address and Panel ID (such as Satellite 1).
- Memories, Custom Controls, Bus Maps, Installation Settings, and Personalities are shared across all control panels.
- Memory recalls only affect the MLEs that are assigned to the control panel that they are recalled on; however, if the memory is recalled as part of a custom control, it will affect the MLEs that were assigned to the control panel that the custom control was recorded on.
- Different Bus Maps can be assigned to the same MLE from different control panels.
GPI Output Control

A GPI output can be triggered either through a custom control or manually through the GPI Output Control Menu. The GPI Output Control Menu shows all GPI outputs with the name, trigger type, and level for each GPI output. If a GPI output is active, the button is lit.


2. Select the Output \( X \) button for the GPI output that you want to trigger or toggle, where \( X \) is the number of the GPI output. Active GPI outputs are shown as lit buttons.

For More Information...

- on GPI custom controls, refer to the section “Programming Special Functions” on page Eng 10-15.
- on setting up GPI inputs and outputs, refer to the section “Standard GPI Setup” on page Eng 12-10.
SmartConversion™

The Vision switcher can only operate in a single video format at a time. In order to mix and manipulate video signals of different video formats, the SmartConversion option is required. Once set up, SmartConversion™ automatically assigns up/down converters to the various inputs to ensure that all the video signals are in the same format. SmartConversion can also be applied to outputs to convert the output of an MLE or Aux Bus to a different video format.

SmartConversion operates automatically when you select a source on an MLE or Aux Bus. SmartConversion determines if there is a video format mismatch between the selected source and the MLE or Aux Bus output formats. If there is a video format mismatch, the appropriate Conversion Loop is used to convert the input source to the correct output format to match the MLE or Aux Bus.

For More Information...

- on setting up a SmartConversion, refer to the section “Setting Up a Conversion Loop” on page Eng 16-2.

Viewing SmartConversion Status

You can view the status of all the up/down converters that SmartConversion is managing either in the display on the Fade to Black Module, or on the Converter Status Menu. The Fade to Black Module must be set up to display the number of free up/down converters from the Personality Menu.

1. Double-press the crosspoint button for the video source that you want to view the up/down converter status for. This can be on an MLE or an Aux Bus. The Video Correction Menus are displayed.
2. Press SmartConversion.

Up/Down Converter Status

The Converter Status shows all the up/down converters that SmartConversion is controlling.

![Converter Status Menu]

The main portion of the Converter Status Menu shows a summary of up/down converter usage. The following information is displayed:

- Converter — The up/down converter (displayed as the Aux Bus that is connected to the up/down converter).
• **Input** — The name of the input source currently being converted. If the source is not currently on-air, this displays the last source that was converted and on-air.

• **In Use** — Displays **Yes** if the current source is on-air and the up/down converter is unavailable for use by another source. Displays **No** if the source is not on-air and the up/down converter is available for use.

• **Locked** — Displays the name of the bus-pair the up/down converter is locked to. If the up/down converter is not locked to a specific bus-pair, **Not Locked** is displayed.

• **Converters** — Displays the number of assigned up/down converters out of the total number of each specific video format.

### Up/Down Converter Allocation

The **Allocation Status** shows how SmartConversion is allocating up/down converters.

![Converter Status Menu](image)

**Allocation — Converter Status Menu**

The main portion of the **Converter Status Menu** shows a summary of up/down converter allocation. The following information is displayed:

- **Bus** — The bus that is using the converter.
- **Converter** — The up/down converter being used by the specified bus (displayed as the Aux Bus that is connected to the up/down converter).
- **Input** — The name of the input source currently being converted. If the source is not currently on-air, this displays the last source that was converted and on-air.

### SmartConversion Override

You can change the conversion setting for an input source without having to change the installation settings for that input source by temporarily overriding the SmartConversion settings for that source.

**Note** — If you attempt to override a video source that is currently on-air, a warning message is displayed.

1. Double-press the crosspoint button for the video source that you want to override. This can be on an MLE or an Aux Bus. The **Video Correction Menus** are displayed.

2. Press **SmartConversion**.
3. Select the video format by pressing the associated button. If the video format is not displayed, press **Input is Other Type** and use the **Type** knob to select the video format.
Color Correction

Color correction in the Vision switcher is performed by either Processing Amplifiers (Proc Amps) in the HSL (Y-Cr-Cb) color space or by RGB Color Correctors in the RGB color space. Both Proc Amps and RGB Color Correctors allow you to apply color correction to video sources on the fly to input video signals, entire buses, or Aux Bus outputs.

- **Input-Based Correction** — This type of color correction is applied to the video input regardless of which MLE or Aux Bus it is selected on. Input-based color correction is not stored in switcher memories.
- **Bus-Based Correction** — This type of color correction is applied to the output of the assigned bus. Unlike the input-based color correction, bus-based color correction is stored and recalled with memories. This allows you to include a color correction element as part of an effects dissolve.
- **Aux Bus Correction** — This type of color correction is applied to the output of an Aux Bus, but can only be applied to a limited number of Aux Buses. You must have an MLE for each Aux Bus that you want to apply a color corrector to. If you have 4 MLEs, you can only color correct 4 Aux Buses. Like input-based color correction, Aux Bus color correction is not stored in switcher memories.

Color correction is additive, allowing you to apply any combination of Proc Amp and RGB Color Corrector based adjustment to a video signal on the input, as well as on the bus. If multiple color corrections are applied, the input-based correction is applied first, and the bus-based correction is applied after that.

*For More Information...*

- on Aux Bus color correction, refer to the section “Aux Bus Color Correction” on page Ops 4-33.
- on the principles behind color correction, refer to the section “Color Correction Overview” on page Ops 18-2.
- on memory recalls, refer to the section “Storing and Recalling Memories” on page Ops 9-6.
- on the Proc Amp or RGB Color Corrector software option, refer to the section “Installing Software Options” on page Eng 6-11.

**Active Video Correctors**

You can view the active video correctors from the Video Correction Menu.

- Press HOME ⇒ More ⇒ Effects ⇒ More ⇒ Video Correction.

![Video Correction Menu](image-url)
Proc Amp Color Correction

The Proc Amp video correction allows you to adjust the gain, offset, black level, and gamma of the video signal.

1. Double-press the crosspoint button for the video source, or bus, that you want to apply the Proc Amp to. The current selection is displayed in the upper left corner of the menu.

2. Select the type of Proc Amp video correction you want to apply as follows:

Note — Both the Input Proc Amp Mode Menu and Bus Proc Amp Mode Menu work the same. The rest of this procedure shows the Input Proc Amp Mode Menu, but the procedures apply to both.

• Input Proc Amp — Select this option to perform an input-based color correction. The input source that is displayed on the menu is used. The Proc Amp Input Mode Menu is displayed.

• Bus Proc Amp — Select this option to perform a bus-based color correction. The MLE and bus that is displayed on the menu is used. The Proc Amp Bus Mode Menu is displayed.

Operating Tip — You can revert the color correction back to the default settings by pressing the Default button on the Proc Amp Menu.

3. Adjust the Gain as follows
   • Press Gain.

   Gain Settings — Proc Amp Menu
   • Use the Gain knob to adjust the luminance and chrominance gain simultaneously.
   • Use the Chroma Gain knob to adjust just the chrominance gain.
   • Use the Lum Gain knob to adjust just the luminance gain.

4. Adjust the Cr as follows:
   • Press Cr Adjust.
5. Adjust the Cb as follows:
   - Press \textbf{Cb Adjust}.

6. Adjust the \textbf{Hue Rotation} as follows:
   - Press \textbf{Hue/Black Level}.

   - Use the \textbf{Hue Rotate} knob to adjust the hue. Increasing the \textbf{Hue Rotation} turns the color wheel clockwise, and decreasing the \textbf{Hue Rotation} turns the color wheel counter-clockwise. The graphs are not affected by hue adjustments.
7. Adjust the **Black Level** as follows:
   - Press **Hue/Black Level**.

![Hue/Black Level — Proc Amp Menu](image)

- Use the **Black Level** knob to adjust the black level. The **Lum** graph updates to reflect the changes you are making. Black level acts as a luminance offset and moves the line towards the top left or bottom right corner.

8. Adjust the **Luminance Gamma** as follows:
   - Press **Lum Gamma**.

![Gamma Adjustment — Proc Amp Menu](image)

- Use the **Gamma Value** knob to adjust the luminance gamma value.
- Use the **Gamma Offset** knob to adjust the luminance gamma offset.

**RGB Color Correction**

The RGB Color Correctors allow you to adjust the red, green, and blue component gain of the video signal.

1. Double-press the crosspoint button for the video source, or bus, that you want to apply the RGB Color Corrector to. The current selection is displayed in the upper left corner of the menu.

2. Select the type of RGB Color Corrector video correction you want to apply as follows:

---

**Note** — *Both the Input RGB Mode Menu and Bus RGB Mode Menu work the same. The rest of this procedure shows the Input RGB Mode Menu, but the procedures apply to both.*
• **Input RGB** — Select this option to perform an input-based color correction. The input source that is displayed on the menu is used. The **Input RGB Mode Menu** is displayed.

• **Bus RGB** — Select this option to perform a bus-based color correction. The MLE and bus that is displayed on the menu is the bus that the corrector is applied to. The **Bus RGB Mode Menu** is displayed.

**Operating Tip** — You can revert the color correction back to the default settings for an RGB component by pressing the corresponding **Default** button on the **RGB Menu 2-2**. The **Default RGB** returns all RGB components to their default values.

3. Adjust the **RGB Color Components** simultaneously as follows:
   • Adjust the **RGB Components** as follows:
     › Press **RGB Adjust**.

     **RGB Adjustment — RGB Menu 2-2**
     › Use the **Gain** knob to adjust the gain of all the components. The graphs update to reflect your selection.
     › Use the **Offset** knob to adjust the offset of all the components. The graphs update to reflect your selection. Offset moves the line towards the top left or bottom right corner.
     › Use the **Lower Offset** knob to adjust the lower offset of all the components. The graphs update to reflect your selection. The lower offset moves the minimum point on the graph along either the vertical axis or horizontal axis.

   • Adjust the **Gamma** of the **RGB Component** as follows:
     › Press **RGB Gamma**.

     **RGB Gamma — RGB Menu 2-2**
     • Use the **Gamma Value** knob to adjust the gamma of all the components.
• Use the **Gamma Offset** knob to adjust the offset of the gamma of all the components. The gamma offset value moves the offset point along the graph line and the gamma value alters how much perpendicular offset is applied to the offset point.

---

**Note** — The **Green** and **Blue** components are adjusted in the same way as the **Red**. Use the information provided in **Step (4.)** to adjust either of these components.

---

4. Adjust the **Red Component** as follows:

   • Adjust the **Red Component** as follows:
     › Press **Red Adjust**.

### Red Adjustments — RGB Menu 1-2

› Use the **Gain** knob to adjust the gain of the red component.

› Use the **Offset** knob to adjust the offset of the red component. Offset moves the line towards the top left or bottom right corner.

› Use the **Lower Offset** knob to adjust the lower offset of the red component. The lower offset moves the minimum point on the graph along either the vertical axis or horizontal axis.

• Adjust the **Gamma** of the **Red Component** as follows:
  › Press **Red Gamma**.

### Red Gamma — RGB Menu 1-2

• Use the **Gamma Value** knob to adjust the gamma of the red component.

• Use the **Gamma Offset** knob to adjust the offset of the gamma of the red component. The gamma offset value moves the offset point along the graph line and the gamma value alters how much perpendicular offset is applied to the offset point.
Aux Bus Color Correction

The Vision switcher has a set number of color correctors that can be assigned to Aux Buses, based on the number of MLEs that your switcher has. For example, if you have 4 MLEs, you will have 4 color correctors available to your Aux Buses.

Aux Bus color correction works similar to Bus-based color correction. Color Correction settings are applied to the output of the Aux Bus, and not to the selected video sources on the bus. If the Aux Bus is set up as an AuxKey, the color correction will include the keys.

Assigning Aux Bus Color Correctors

1. Double-press a crosspoint button on the Aux Bus that you want to assign the color corrector to. Refer to the section “Selecting an Aux Bus” on page Ops 4-9 for more information in selecting an Aux Bus. The Video Correction Menus is displayed.

2. Press Assign Corrector to assign an available color corrector to the current Aux Bus.

3. Press Bus Proc Amp or Bus RGB to set up the color corrector for the Aux Bus.

Removing Aux Bus Color Correctors

1. Double-press a crosspoint button on the Aux Bus that you want to remove the color corrector from. Refer to the section “Selecting an Aux Bus” on page Ops 4-9 for more information in selecting an Aux Bus. The Video Correction Menus is displayed.

2. Press Remove Corrector to remove the color corrector from the current Aux Bus.

Defaulting Color Correctors

You can default each color corrector element as you are adjusting them, or you can default all the inputs or buses that you have applied color correction to.

1. Double-press the crosspoint button for the video source, or bus, that you want to default. The current selection is displayed in the upper left corner of the menu.


Note — If all the available color correctors have already been assigned, the Assign Corrector button appears gray. You must free up one of the color correctors assigned to another Aux Bus to assign it to the selected one. The list on the left side of the menu displays where all the color correctors are assigned to Aux Buses. Refer to the section “Removing Aux Bus Color Correctors” on page Ops 4-33 for more information.
3. Default the current Input and Buses as follows:
   - Press **Default Bus & Input**. A confirmation message is displayed prompting you to either confirm or cancel the defaulting procedure.

4. Default all the Inputs as follows:
   - Press **Default All Inputs**. A confirmation message is displayed prompting you to either confirm or cancel the defaulting procedure.

5. Press **Confirm** to accept the changes. If you press **Cancel**, none of the color correctors are defaulted.

### Copying and Pasting Color Correctors

Once you have applied Proc Amp and RGB Color Corrector adjustments to a specific input or video bus, you can copy these settings to other inputs or buses.

1. Double-press the crosspoint button for the video source, or bus, that you want to copy. The current selection is displayed in the upper left corner of the menu.

2. Press **More**.

3. Copy an **Input Color Corrector** as follows:
   - Press **Copy Input** to copy the input-based Proc Amp and RGB color corrector settings for the selected input.
   - Press a crosspoint button to select the video source that you want to copy the color corrector settings to. The current selection is displayed in the upper left corner of the menu.
• Press **Paste Input** to paste the color corrector settings to the destination input. A new color corrector is assigned to the input if one was not already assigned.

4. Copy a **Bus Color Corrector** as follows:

   • Press **Copy Bus** to copy the bus-based Proc Amp and RGB color correctors settings for the selected bus. A brief message appears confirming the copy.
   • Press a crosspoint button to select the bus that you want to copy the color corrector settings to. The current selection is displayed in the upper left corner of the menu.
   • Press **Paste Bus** to paste the color corrector settings to the destination bus. A new color corrector is assigned to the bus if one was not already assigned.
Fade to Black

The **Fade To Black Module** (Figure 4.20) allows you to cut or fade the entire output of the control panel to black. This can include just the MLEs assigned to the control panel, depending on how you have Fade to Black set up, and what MLEs are assigned to your panel. Downstream Keyers are also affected by the Fade to Black.

If you are controlling an Audio Mixer from the switcher, performing a Fade to Black will not change the level of the on-air audio channel. Instead, Fade to Black turns off the Master Audio Control on the Audio Mixer.

![Fade To Black Module](image)

**Figure 4.20** Fade to Black

The **Fade to Black Module** has a **CUT** and **FADE** button that are used to transition the switcher output to black, or out of black. The display to the right of the buttons shows either the current transition rate of the Fade to Black, or the number of Up/Down Converters that are installed on the switcher.

### Setting the Fade to Black Rate

The **Fade to Black** rate, as shown in the display on the **Fade to Black Module**, is set from the **Global Memory Module**. Each control panel has a unique fade to black rate.

1. Press **FADE RATE** on the **Global Memory Module**.
2. Use the keypad on the **Global Memory Module** to enter the new Fade to Black rate, in frames. The **ENTER** button lights up.
3. Press **ENTER** on the **Global Memory Module** to change the Fade to Black rate. The display on the **Fade to Black Module** updates to show the new rate.

### Performing a Fade to Black

A **Fade to Black** is performed as either a cut, using the **CUT** button, or a transition, using the **FADE** button on the **Fade to Black Module**. Once at black, the same procedure is used to take the switcher out from black.

**Note** — **Fade to Black** only affects the MLEs that are assigned to your control panel, and that Fade to Black is turned on for. If more than one control panel has the same MLE assigned to it, performing a fade to black sets that MLE to black on all control panels.

When the switcher is at black, the **FADE** button is lit with the on-air color, and all the on-air indicators for MLEs or Keyers that were on-air are flashing.

**For More Information...**

- on setting up Fade to Black, refer to the section “**Fade to Black**” on page Eng 8-9.
- on setting a default Fade to Black rate, refer to the section “**Personality List**” on page Eng 11-2.
- on setting the Fade to Black display, refer to the section “**Fade to Black Display Mode for Up/Down Converters**” on page Eng 16-7.
Using the Positioner

The Positioner Module (Figure 4.21) allows you to manipulate wipes, patterns, flying keys, and interface with some external equipment, such as a robotic camera. The module automatically follows what is currently selected on the crosspoint buses and menu. For example, if you select a robotic camera that is controlled by the switcher on a crosspoint bus, the Positioner Module is assigned to the camera automatically. Similarly, if you are on the Squeeze & Tease Menus, you can use the positioner to manipulate the key, instead of entering X, Y, and Z values manually.

![Figure 4.21 Vision 4 Positioner Module](image)

Positioner Module Display

The display on the Positioner Module shows you where the positioner is assigned, and what it is controlling. The first line of the display shows where the Positioner Module is assigned. In this example (Figure 4.22), the positioner is assigned to Channel 1, on Key 1 of MLE 2. The second line of the display shows you what the positioner is controlling. In this example, the positioner is controlling the Position of a flying key.

![Figure 4.22 Positioner Module Display](image)

Positioner Control

The 3-axis positioner (Figure 4.23), or joystick, allows you to manipulate the position and orientation of on-screen elements and external devices.

![Figure 4.23 Positioner Control](image)
Buttons

The Positioner Module has three buttons that allow you to default the position of key, pattern, or menu selected, link the positioner to multiple elements so that it will control them all at once, and lock the positioner to a specific element. The buttons on this module are as follows:

- **HOLD** — This button locks the Positioner Module to the element that it is currently controlling. When locked (held), the button is lit, and the Positioner Module does not act on the normal auto follow commands, such as when you select a robotic camera.

- **LINK** — This button allows you to add and remove elements that are being controlled by the Positioner Module. To add an element, press and hold the LINK button, and then press the SEL or crosspoint button for the element you want to add. The LINK button lights if more than one element is being controlled by the Positioner Module. If you select another element that the Positioner Module would auto follow, the current link settings are lost. An example of linking would be to link two flying keys together from separate Keyers. Double-press the LINK button on the Positioner Module to display the Positioner Menu.

**Note** — You can link together up to a maximum of 64 items.

- **CLEAR** — The Clear, or default, button can be used to center the position and location of a flying key, or what is selected on a keyer, MLE, or Aux Bus.
  - Defaulting Fly Keys — Defaulting a flying key puts the key back to the starting position. To default a flying key, select the key you want to default, it is shown on the display, and press the CLEAR button.
  - Defaulting Panel Row — Defaulting a Panel Row clears all the selections on the buses and sets the Panel Row to the default state.
  - Default Current — Pressing the CLEAR button without holding another defaults whatever the Positioner Module is currently controlling.

- **Positioner Button** — The button on the top of the positioner is used to cycle through what the Positioner Module is controlling. The options for what the positioner can control is shown on the second line of the display. When you press the button, the names switch. What you are controlling is always shown on the left side on the display.

---

*For More Information...*
- on defaulting a flying key, refer to the section “Defaulting” on page Ops 13-14.
Copy MLE

The Copy MLE function allows you to copy the entire contents of an MLE to another MLE. This includes crosspoint selections, matte generator values, fader positions, on-air status, and key active status.

The following rules apply to the Copy MLE function:

- If a re-entry selection is invalid on the destination MLE, black is automatically selected.
- If a transition type is invalid on the destination MLE, a dissolve is automatically selected.
- If a specific option is not installed on the destination MLE, the function is automatically turned off.
- When copying from the Program/Preset MLE to another MLE, the downstream keyer selections are converted into effect keyer selections.
- If a specific keyer was active in the source MLE, it becomes active in the destination.

Copy MLE Using Control Panel

You can copy the contents of one MLE to another quickly using the buttons on the Vision control panel.

1. Press and hold the BKGD button on the Transition Module on the destination Panel Row (MLE).
2. Press the BKGD button on the Transition Module on the source Panel Row (MLE).
3. Release both buttons.

Copy MLE Using Menu

The menus can be used to copy the contents of an MLE to another, just like using the buttons on the control panel.

1. Press HOME ➔ Attributes ➔ Copy MLE.

   ![Copy MLE Menu](image)

   **Copy MLE Menu**

2. In the Source area, select the MLEs that you want to copy from. You can only select one MLE to copy from.
3. In the Destination area, select the MLEs that you want to copy to.

   **Note** — You cannot have the same bus selected for the Destination and Source to perform a Copy.

4. Press Copy on the Copy MLE Menu to perform the copy.
Copy and Swap Buses

The menus can be used to copy or swap the contents of a bus to another. The following restrictions apply to all bus copy and swap functions:

- You cannot copy or swap multiple source buses to different destination buses.
- You cannot copy or swap multiple source Aux buses. You can only select a single Aux bus at a time.
- You cannot swap a source bus with multiple destination buses.
- You cannot copy or swap if the source and destination buses are the same.

To Copy or Swap a Bus

1. Press HOME ⇨ Attributes ⇨ Copy Buses.

2. In the Source area, select the MLE or Aux Bank, and Buses, that you want to copy or swap from.

3. In the Destination area, select the MLE or Aux Bank, and Buses, that you want to copy or swap to.

4. Perform the copy or swap as follows:
   - Press Copy to perform the copy.
   - Press Swap to perform the swap.
Copy and Swap Keyers

The Copy and Swap Keyers functions allow you to copy the entire contents of a keyer to another keyer, or multiple keyers. Copy and Swap cannot be performed on a MultiDSK key.

Copy a Keyer Using Control Panel

The Copy Keyer function allows you to copy the entire contents of a Keyer to another Keyer in the same MLE, or in a different MLE.

When you copy a keyer to another keyer, the entire contents of the source keyer is copied to the destination, including the selected crosspoint and setting for all the key types. For example, if you have an AUTO SELECT key enabled, the CHROMA KEY settings are also copied.

1. Press and hold any SEL button on the Effects Keyers Module for the keyer that you want to copy the keyer to.
   
2. Press the SEL button on the Effects Keyers Module for the keyer that you want to copy.
   
3. Release both buttons.

Copy and Swap Keyer Using Menu

The menus can be used to copy or swap the contents of a keyer to another, just like using the buttons on the control panel. The contents of one source keyer can be copied to multiple destination keyers. A swap can only be performed between two keyers.

1. Press HOME ⇒ Attributes ⇒ Copy Keyers.

   ![Copy Keyers Menu]

   Copy Keyers Menu

2. In the Source area, select the keyer on the MLE that you want to copy or swap from.

3. In the Destination area, select the keyer, or keyers, you want to copy or swap to.

   **Note** — You cannot have the same keyer selected for the Destination and Source to perform a Copy. Only one Destination and one Source keyer can be selected to perform a Swap.

4. Perform the copy or swap as follows:

   • Press Copy to perform the copy.
   
   • Press Swap to perform the swap.
Swap Keyer

The Key Swap function allows you to swap the entire contents of a keyer with another keyer, on the same or a different MLE.

1. Press and hold any SEL button on the Effects Keyers Module for the keyer that you want to swap.

2. Press the KEYX button on the Transition Module of the second Keyer. This can be the same MLE or a different MLE. The button that you select is the Keyer that is swapped.

3. Release both buttons. Both selected Keyers swap their contents.
Copy Squeeze & Tease Channels

The Squeeze & Tease channel copy function allows you to copy the contents of a Squeeze & Tease channel from one channel to another within the same keyer. You cannot copy a Squeeze & Tease channel from one keyer to a channel in another keyer.

1. Press the SEL button on the Keyers Module for the Keyer that you want to copy the Squeeze & Tease channel for. The S&T MD Position/Crop Menu 1-2 is displayed. The key must already be flying.

2. Toggle Channel to select the Squeeze & Tease channel that you want to copy from.

3. Press and hold the PST PATT button on the Keyers Module.

Operating Tip — Instead of the PST PATT button, you can use the SEL button on the Keyers Module for the Keyer that you want to copy the Squeeze & Tease channel for.

4. Press the KEYX button on the Transition Module for the keyer that you are copying the Squeeze & Tease channel in.
Transitions

In This Chapter

This chapter provides a basic introduction to the Vision switcher, including an overview of the boards in the control panel and frame, as well as an introduction to the various ports, and video buses.

The following topics are discussed in this chapter:

- Transition Module
- Transition Types
- Independent Key Transitions
- Transition Rates
- Performing Transitions
- Transition Limits
- WhiteFlash
- Key Priority Transitions
Transition Module

The Transition Module (Figure 5.1) allows you to set and perform all key and background transitions on the assigned MLE or AuxKey. This includes the type of transition, as well as whether the transition is a cut, auto-transition, or a manual transition using the fader.

The Transition Module is available in either a 2-Keyer version or a 4-Keyer version.

![Figure 5.1 2-Keyer and 4-Keyer Transition Modules](image)

Each Transition Module has a Fader for performing manual transition, a series of Next Transition Select buttons, Transition Parameter buttons, Transition Type buttons, and two Transition buttons.

Fader

The Fader (Figure 5.2) allows you to manually perform a wipe, dissolve, or Squeeze & Tease transition by moving the fader handle from one limit to the other. The progress of the transition is shown on the progress bar to the left of the fader handle. As you move the fader from one limit to the other, the indicators light up, showing you how far through the transition you are.

![Figure 5.2 Fader — Transition Module (4-Keyer Shown)](image)

Aside from transitions, the fader can also be used to manually run a sequence. As with performing a transition, the progress bar next to the fader handle lights up to show how far through the sequence you are.
Next Transition Select

The Next Transition Select buttons allows you to select what will be included in the next transition that is performed on the Transition Module. Above each of the Key X buttons is an indicator that lights to show which keyers are on-air, or active. The indicators light red if the keyer is on-air, or another color if the keyer is active on the MLE or AuxKey, but is not part of the Program out. The active, but not part of the Program output, color is user definable.

![Figure 5.3 Next Transition Select — Transition Module (4-Keyer Shown)](image)

Operating Tip — Double-press the BKGD button to select background and all of the on-air keys. The BKGD Double Press personality option must be set to On.

A transition can include almost any combination of Background and Keyers, depending on what type of transition you are trying to perform. The Next Transition Select buttons do not indicate what keyers will be going on-air, only that a keyer is going to be transitioned. To determine if a keyer is going to be transitioned on-air or off, you must look at the indicators above the Key X buttons.

For More Information...

- on including a keyer in a transition, refer to the section “Performing Transitions” on page Ops 5-13.
- on assigning colors to the indicators and buttons, refer to the section “Control Panel Button Color Schemes” on page Eng 11-17.

Transition Parameters

The Transition Parameter buttons (Figure 5.4) allow you to have the next transition perform a preset black or key over transition, set a transition limit, or preview the transition.

![Figure 5.4 Transition Parameters — Transition Module (4-Keyer Shown)](image)
PST BKGD

The Preset Background allows you to insert a transition to black as the next transition without losing what is currently selected as the next transition.

When you select PST BKGD on the Transition Module, the MLE, or AuxKey is set as follows:

- The current Next Transition settings for the Transition Module are stored. This includes what keyers were set to transition, and which ones were on-air.
- The current video sources selected on all buses are stored.
- Background (BKGD) plus any keyers (KEY X) that are on-air are selected for the Next Transition.
- Dissolve (DISS) is set as the Transition Type.

Performing a transition on this Transition Module will dissolve to black. Once the transition is performed, the PST BKGD is de-selected, and the Next Transition and video source settings are recalled, with the exception of the Background bus, which remains at black.

Performing a second transition on this Transition Module will recall the video source settings from the Background bus onto the Preview bus.

TRANS PV

The Transition Preview (TRANS PV) allows you to preview a complete transition on the Preview output of the switcher. Instead of performing a standard transition on the Program output, the transition is performed on the Preview output.

**Note** — A Transition Preview cannot include a key with a Squeeze & Tease transition. Only a DISS or WIPE can be performed with a key.

When you select TRANS PV on the Transition Module, the current video shown on the Program Output is also shown on the Preview Output. Performing a transition on this Transition Module takes place entirely on the Preview Output, with the Program Output not being effected. The Preview Output remains in Transition Preview mode until the TRANS PV is toggled off.

KEY PRIOR

The Key Priority (KEY PRIOR) allows you to change the priority of the keyers on the MLE. For each MLE, the output of Keyer 4 appears over top of Keyer 3, which appears over top of Keyer 2, which appears over top of Keyer 1 (Figure 5.5). With the Key Priority you can have the output of any keyer appear over the other keyers on the same MLE. This can be performed as a transition, for on-air Keyers, or a cut for off-air MLEs. Refer to the section “Key Priority Transitions” on page Ops 5-21 for more information performing a Key Priority transition.

For More Information...

- on key priority, Refer to the section “Video Layering” on page Ops 4-3.
TRANS LIMIT

The Transition Limit (TRANS LIMIT) allows you to set the point where a transition will stop. This allows you to have a transition proceed only half way and stop. The next transition is performed from that stop point, back to the original starting point. With a Transition Limit in place, a transition will not proceed to the other end of the transition.

*For More Information...*

- on setting up a Transition Limit, refer to the section “Transition Limits” on page Ops 5-17.

ROLL CLIP

The Roll Clip allows you to tie the playout of a VTR, Video Server, or Audio Server to the next transition, or have the clip play immediately. Roll Clip only works with external devices that are being controlled by the Vision switcher. The Roll Clip operates in one of two modes as follows:

- **Play** — In Play mode, pressing the ROLL CLIP button immediately plays the cued clip on the external device that is tied into the Transition Module. This includes devices on MLEs that are re-entered onto this MLE. Only one device per bus can be played using the Roll Clip.

- **Arm** — In Arm mode, selecting ROLL CLIP tells the switcher to play all cued clips that are part of the next transition when the transition is performed. When a transition is performed, all cued clips start to play, including clips on MLEs that are re-entered onto this MLE.

- **Armed Always** — In Armed Always mode, the switcher locks the ROLL CLIP button in Arm Mode and does not allow it to be turned off.

*Note* — If a pre-roll time has been set up for your device, the Roll Clip will hold the transition for that amount of time before it starts the transition. The pre-roll time is not applied if the Roll Clip is set to Play Mode.

Transition Type Buttons

The Transition Type buttons (Figure 5.6) allow you to select what type of transition you want to perform. You can select a Dissolve (DISS), Wipe (WIPE), Squeeze & Tease transition (DVE), or run a Sequence (SEQ) from the Transition Module.

*Figure 5.6 Transition Type — Transition Module (4-Keyer Shown)*

Unlike the other transition types, a Sequence does not take a source on-air or off-air. Instead, the sequence is run as created with the key going from the start position to the end position with no transition at the end.
Operating Tip — Double-press the DISS button to set a WhiteFlash dissolve as the transition type. The WhiteFlash Menu Setup is displayed.

For More Information...

- on the transition types, refer to the section “Transition Types” on page Ops 5-7.
- on running a sequence, refer to the section “Using DVE Wipes and Sequences” on page Ops 14-14.
- on WhiteFlash, refer to the section “WhiteFlash” on page Ops 5-19.

Transition Buttons

The Transition buttons (Figure 5.7) allow you to perform a wipe, dissolve, or Squeeze & Tease transition using the Auto Transition (AUTO TRANS) button or a cut using the Cut (CUT) button. The progress of the auto transition is shown on the progress bar to the left of the fader handle.

The rate at which the auto transition is performed is shown on the display to the right of the AUTO TRANS button. The duration is shown in frames.

![Figure 5.7 Transition Buttons — Transition Module (4-Keyer Shown)](image)

Aside from transitions, the AUTO TRANS button can also be used to run a sequence. As with performing a transition, the progress bar next to the fader handle lights up to show how far through the sequence you are. When a sequence is selected, the display to the right of the AUTO TRANS button shows the sequence rate in frames.

For More Information...

- on performing a transition, refer to the section “Performing Transitions” on page Ops 5-13.
Transition Types

The Vision switcher can perform 4 different types of transitions. These include Cuts, Dissolves, Wipes, and Squeeze & Tease Wipes. When a transition is performed, the switcher uses the transition type to replace the on-air video source with the one you are transitioning to.

For More Information...

- on performing a transition, refer to the section “Performing Transitions” on page Ops 5-13.
- on performing a Fade to Black, refer to the section “Fade to Black” on page Ops 4-36.

Cut

A Cut is an instantaneous transition between video sources. Unlike all the other transition types, there are no intermediate steps between the video source that is on-air, and the video source you are transitioning to (Figure 5.8).

![Figure 5.8 Cut Transition — Program Output](image)

Dissolve

A Dissolve is a gradual transition between video sources. For a Background transition, the video signal on the Background bus and the video signal on the Preset bus are mixed together until the Preset bus video signal completely replaces the Background bus video signal (Figure 5.9). During the transition, both the Background bus and the Preset bus are on-air. Only after the transition has completed do the crosspoint selection flip-flop between the buses.

![Figure 5.9 Dissolve Transition — Program Output](image)

For Key transitions, the key is faded on or off-air with the transition, and the background remains untouched.

The duration of a dissolve transition depends on either the transition rate for the MLE, or the rate at which the fader is moved.

For More Information...

- on setting up and performing a WhiteFlash dissolve, refer to the section “WhiteFlash” on page Ops 5-19.
Wipe

A Wipe is a gradual transition where one video signal is replaced with another according to a wipe pattern. For a Background transition, the video signal on the Background bus is replaced by the video signal on the Preset bus according to the wipe pattern. In the example below (Figure 5.10), a line wipe is being used. During the transition, both the Background bus and the Preset bus are on-air. Only after the transition has completed do the crosspoint selection flip-flop between the buses.

![Image of Wipe Transition]

For Key transitions, the key is wiped on or off-air with the transition, and the background remains untouched. The duration of a wipe transition depends on either the transition rate for the MLE, or the rate at which the fader is moved.

For More Information...

- on using wipe patterns, refer to the section “Wipe Transitions” on page Ops 6-3.
- on the pre-loaded wipe patterns, refer to the section “DVE Wipes and Sequences” on page Ops 17-2.

Squeeze & Tease Wipe

A Squeeze & Tease Wipe is based on a Squeeze & Tease Sequence that uses a combination of flying keys and WARP effects to transition between video signals. For a Background transition, the video signal on the Background bus is replaced by the video signal on the Preset bus according to the sequence (Figure 5.11). Only after the transition has completed do the crosspoint selection flip-flop between the buses.

![Image of Squeeze & Tease Wipe Transition]

For Key transitions, the key is taken on or off-air with the transition, and the background remains untouched. The duration of the transition depends on either the transition rate for the MLE, or the rate at which the fader is moved.

For More Information...

- on using wipe patterns, refer to the section “DVE Wipe Transitions” on page Ops 14-14.
- on the wipe patterns, refer to the section “DVE Wipes and Sequences” on page Ops 17-2.
Independent Key Transitions

Keys can be transitioned independently using the dedicated key transition buttons on the Keyers Module (Figure 5.12). This allows you to dissolve keys on/off-air while the fader is off-limit, or an Auto Transition is in progress from the Transition Module.

**Note** — This feature is only available on the 4800AR-041-02 and 4800AR-043-03 Video Processor Boards.

Keep the following in mind when performing independent key transitions:

- Only dissolves or cuts can be used for an independent key transition.
- If the key is part of the next transition, the key will be dissolved off-air and is removed from the next transition. This applies even if the key was not on-air.
- Independent key transitions are performed at the key rate, and not the MLE rate.
- Each keyer has an independent key rate.
- This feature is not compatible with OverDrive and is disabled when Editor is enabled.
- Independent key transitions do not apply to MultiDSK or half MLE keys.
Transition Rates

Transition rates set how much time, in frames, the switcher takes to perform an Auto Transition. For example, with a dissolve, the transition rate is how long it takes for the first video source to be replaced by the second.

Transition rates are set for the MLE and the keyers on the MLE, or AuxKey. The rate for an MLE is shown on the display on the Effects Memory Module (Figure 5.13), and on the Transition Module.

**Figure 5.13** Current Transition Rates — Effects Memory Modules

For the Program/Preset MLE, the transition rates are shown on the display on the Global Memory Module (Figure 5.14), and also include the transition rate for a Fade to Black.

**Figure 5.14** Current Transition Rates — Global Memory Modules

You can set a default keyer and MLE rate that is used when an MLE, or the switcher, is defaulted.

*For More Information...*

- on the default keyer and MLE rates, refer to the section “Personality List” on page Eng 11-2.

Setting the MLE Rate

The MLE rate, or background transition rate, is set from the Effects Memory Module for all upper MLEs and Global Memory Module for the Program/Preset MLE.

If the Crosspoint Group that you are setting the MLE rate on is assigned as an Aux Bus, the MLE rate will set the background transition rate of the AuxKey.

Use the following procedure to set the MLE transition rate for an MLE:

1. Press MLE RATE on the Effects Memory Module for the MLE that you want to set the background transition rate for (Figure 5.15).
2. Use the keypad in the center of the module to enter the new duration, in frames. The new rate appears on the top line of the display as you enter it (Figure 5.16).

![New MLE rate:030 MLE:015 Key:008](image)

**Figure 5.16** New MLE Rate — Effects Memory Module Display

3. Press ENTER on the Effects Memory Module to accept the new rate. This completes the procedure for setting the MLE transition rate for an MLE.

### Setting the Keyer Rate

The Keyer rate is set from the Effects Memory Module for all upper MLEs and Global Memory Module for the Program/Preset MLE.

If the Crosspoint Group that you are setting the keyer rate on is assigned as an Aux Bus, the keyer rate will set the key transition rate of the AuxKey.

Use the following procedure to set the keyer transition rate for an MLE:

1. Press KEY RATE on the Effects Memory Module for the MLE that you want to set the keyer transition rate for (Figure 5.17).

![Figure 5.17 Keyer Rate — Effects Memory Module](image)

2. Use the keypad in the center of the module to enter the new duration, in frames. The new rate appears on the top line of the display as you enter it (Figure 5.18).

![New Key rate:015 MLE:015 Key:008](image)

**Figure 5.18** New Keyer Rate — Effects Memory Module Display

3. Press ENTER on the Effects Memory Module to accept the new rate. This completes the procedure for setting the keyer transition rate for an MLE.
Setting the Rate From the Global Memory Module

The Keyer, Effects, and MLE rates for an MLE can also be set from the Global Memory Module. This allows you to set the MLE 1 rates on the Vision 2 switcher, which does not have an Effects Memory Module.

1. Press and hold the KEY RATE, EFF RATE, or MLE RATE button on the Global Memory Module. The MLE button on the Recall area indicates which MLE you are currently setting the rate for.

2. Press the MLE X button in the Store or Recall area of the Global Memory Module to set the rate for that MLE, where X represents the MLE number. You cannot use the ALL button to set the rate across multiple MLEs at the same time.

3. Use the keypad in the center of the module to enter the new duration, in frames. The new rate appears on the top line of the display as you enter it.

4. Press ENTER on the Global Memory Module to accept the new rate.
Performing Transitions

A transition can be performed on almost any combination of the background and keyers, depending on the type of transition you are performing, and what you are transitioning. These factors include the number of Squeeze & Tease resources you have, and if you are trying to perform a background and keyer transition at the same time.

Transition Restrictions and Rules

The following restrictions apply to all transitions performed on and MLE or an AuxKey:

- The time duration of a transition will vary, depending on the video format the switcher is operating in. Transition rates are set in frames, not seconds.
- If there are not enough Squeeze & Tease resources available to perform a Squeeze & Tease Wipe transition, a dissolve is performed instead.
- The Program Output BNC is only fed from the Program/Preset MLE. Any other MLE will have to be re-entered onto that MLE to be part of the Program Output.
- If an auto transition includes both the background and a keyer, the MLE Rate is used for the transition.
- If the fader is moved during an auto transition, control of the transition is passed to the fader. You must complete the transition with the fader. This allows you to override any auto transition in progress with the fader.

Performing a Fader Transition

A fader, or manual, transition is performed by moving the fader handle from one limit to the other. The speed at which you move the fader determines the rate at which the transition is performed in real time. Fader transitions also allow you to hold a transition at any point, as well as reversing the transition back to the starting point.

Note — Key transitions are performed in the same way as Background transitions. To perform a key transition, select the video sources you want on the Keyer bus, and select the keyer on the Transition Modules.

1. Select a video source on the Background bus of a Program/Preset MLE. This is the on-air video signal.

Note — If a non-synchronous source is selected on a crosspoint bus, the crosspoint button flashes, indicating that the source is mis-timed. Refer to the section “Non-Sync Detection” on page Eng 7-10 for more information on non-sync detection.

2. Select the video source that you want to transition to on the Preset bus of the same MLE (Figure 5.19).
3. Select **BKGD** as the next transition selection on the Transition Module (Figure 5.20). The **BKGD** button lights up and the video source selected on the Preset bus is shown on the Preview output.

**Operating Tip** — Double-press the **BKGD** button to select background and all of the on-air keys. The Double-Press **BKGD** personality option must be set to **Trans Clean**.

4. Select the transition type that you want for this transition. In this example, a **Dissolve (DISS)** is selected (Figure 5.20).

5. Move the fader from one limit to the other to perform the transition. The progress bar to the left of the fader handle shows your progress through the transition (Figure 5.21).

6. After the transition is complete, notice that the video sources you selected on the **Background** and **Preset** buses have swapped, or flip-flopped (Figure 5.22). What was on the **Preset** bus is now on the **Program** bus.
Performing an Auto Transition

An auto transition is performed by pressing the AUTO TRANS button on the Transition Module or Keyers Module. From the Transition Module you can transition multiple keyers, plus the background. From the Keyers Module, you can only transition each keyer individually.

The speed at which the transition is performed is determined by the MLE or Key rate. Refer to the section “Transition Rates” on page Ops 5-10 for more information.

**Note** — Key transitions are performed in the same way as Background transitions. To perform a key transition, select the video sources you want on the Keyer bus, and select the keyer on the Transition Modules.

1. Select a video source on the Background bus of a Program/Preset MLE. This is the on-air video signal.

**Note** — If a non-synchronous source is selected on a crosspoint bus, the crosspoint button flashes, indicating that the source is mis-timed. Refer to the section “Non-Sync Detection” on page Eng 7-10 for more information non-sync detection.

2. Select the video source that you want to transition to on the Preset bus of the same MLE (Figure 5.23).

3. Select BKGD as the next transition selection on the Transition Module (Figure 5.24). The BKGD button will be lit and the video source selected on the Preset bus will be shown on the Preview output.

**Operating Tip** — Double-press the BKGD button to select background and all of the on-air keys. The Double-Press BKGD personality option must be set to Trans Clean.

Figure 5.22 Video Sources Selected — After Transition

For More Information...

- on setting up a wipe transition, refer to the section “Wipe Transitions” on page Ops 6-3.
- on setting up for a Squeeze & Tease transition, refer to the section “Using DVE Wipes and Sequences” on page Ops 14-14.
4. Select the transition type that you want for this transition. In this example, a Dissolve (DISS) has been selected (Figure 5.24).

5. If you want to select a different MLE rate or Key rate, set it now. Refer to the section “Transition Rates” on page Ops 5-10 for more information on setting transition rates.

6. Press AUTO TRANS on the Transition Module to perform the transition. The progress bar to the left of the fader handle shows the progress of the transition (Figure 5.21).

7. After the transition is complete, notice that the video sources you selected on the Background and Preset buses have swapped, or flip-flopped (Figure 5.26). What was on the Preset bus is now on the Program bus.

You can use the same procedure to perform a transition on any other MLE or AuxKey.

For More Information...

- on setting up a wipe transition, refer to the section “Wipe Transitions” on page Ops 6-3.
- on setting up a Squeeze & Tease transition, refer to the section “Using DVE Wipes and Sequences” on page Ops 14-14.
**Transition Limits**

The Transition Limit (TRANS LIMIT) allows you to set the point where a transition will stop. This allows you to have all transitions on an MLE proceed only half way and stop. The next transition is performed from that stop point, back to the original starting point. With a Transition Limit in place, a transition will not proceed to the other end of the transition.

**Setting a Transition Limit**

A transition limit is set using the fader on the Transition Module of the MLE that you want to use the transition limit on. The transition limit must be set up for each MLE that you want to use the transition limit on.

1. Move the fader on the Transition Module to the upper or lower limit. This is the start position. The fader handle must be returned to this position in Step (5.).

2. Select a Dissolve (DISS), Wipe (WIPE), or Squeeze & Tease Wipe (DVE) as the next transition.

3. Move the fader handle to the desired position. This is the point where you want the transition to stop.

4. Press TRANS LIMIT on the Transition Module (Figure 5.27) to select the current point in the transition as the transition limit. There is no visual feedback that the transition limit point has been set.

5. Move the fader back to the original position. If you move the fader ahead to the opposite limit, the transition limit will not be set properly. You must return the fader handle to the original position.

Refer to the next section for information on using the Transition Limit.

**Using a Transition Limit**

A transition limit can be used with any Auto Transition on the Transition Module of the MLE that the limit was set on. The transition limit will not work on cuts or manual transitions.

---

**Note** — *Because a transition limit stops a transition before it completes, a transition that uses a transition limit does not transition to the next shot. The transition progresses part-way through the transition, and then returns to the original point.*
1. Ensure that a transition limit has been set for the MLE that you are performing a transition on.

2. Ensure that the fader handle is at one of the limits.

3. Select **TRANS LIMIT** on the **Transition Module** for the MLE that you want to perform the transition limit on. The button lights up, indicating that the next transition will stop at the transition limit.

4. Press **AUTO TRANS** on the **Transition Module** to perform the transition. The transition stops at the transition limit.

5. Press **AUTO TRANS** on the **Transition Module** to perform the second part of the transition. The transition progresses back to the starting point.
WhiteFlash

The WhiteFlash feature allows you to perform a two-step transition where a dissolve to and from white, or other selected color, is performed in the middle of the transition (Figure 5.28). The video signal on the Background bus is transitioned to a Color Background of the selected WhiteFlash color. The Color Background is then transitioned to the Preset bus. WhiteFlash consumes a background generator for the transition.

Figure 5.28 WhiteFlash Transition — Program Output

Setting Up a WhiteFlash Transition

A WhiteFlash transition is performed just like a normal dissolve, except that you must set the color for the flash, and the rates for the onset, hold, and fade.

Note — If a MultiDSK key is on-air when a WhiteFlash transition is performed, it will remain on top of the WhiteFlash effect, even if it is included in the transition.

1. Double-press DISS on the Transition Module. The DISS button on the Transition Module flashes, indicating that WhiteFlash is set as the transition type.

WhiteFlash Setup Menu

2. Toggle the MLE Rate to Yes or No to use the transition rate for the MLE as the WhiteFlash rate.
   - Yes — Select this option to use the MLE Rate as the transition rate for the WhiteFlash. The Onset, Hold, and Fade rates represent proportional values of the total MLE Rate.
   - No — Select this option to not use the MLE Rate as the transition rate for the WhiteFlash. The Onset, Hold, and Fade rates are the number of frames for each part of the WhiteFlash. The MLE Rate is not used for this transition.

3. Set the Onset, Hold, and Fade rates as follows:

Note — If the MLE Rate is set to No, the Onset, Hold, and Fade rates are shown in frames. If the MLE Rate is set to Yes, the Onset, Hold, and Fade rates are a proportion of the MLE Rate.
• Use the **Onset** knob to set the duration that the Background dissolves to the WhiteFlash color.
• Use the **Hold** knob to set the duration that the WhiteFlash color is held.
• Use the **Fade** knob to set the duration that the WhiteFlash color dissolves to the Preset.

4. Press **Color** on the **WhiteFlash Menu**.

![WhiteFlash — Color Selection Menu](image)

5. Select the color you want for the WhiteFlash using the knobs, positioner, punchpad, or by selecting a point on the **Color Wheel**.

**Operating Tip** — Press **Assign As Default** on the **WhiteFlash Setup Menu** to store your current settings as the default settings for WhiteFlash.

6. Perform the transition as desired.
Key Priority Transitions

Key Over transitions allow you to change the priority, or order, that keys are displayed on screen for an MLE. This can be between keyers that are on-air, or keyers that are not on-air. You cannot change the priority of MultiDSK keys.

On-air key over transitions are performed by using the KEY PRIOR button on the Transition Module. This allows you to set up the new priority, or order, for each of the keyers, and then perform a transition to change the keyer priority.

**Important** — Key Priority transition can only be performed between keyers that are in the same state. For example, to change the priority of Keyer 1 and Keyer 3, both keyers must be on-air, or off-air, for the MLE.

Key Priority can be set either manually using the buttons on the Transition and Keyers Modules, or using the Key Priority Setup Menu.

**Key Priority Transition**

The Key Priority Setup Menu allows you to visually verify, or change, what the current key priority is, and set up a new key priority for a key priority transition.

1. Press KEY PRIOR on the Transition Module for the MLE that you want to change the priority of the keyers for. If a key is not currently on-air, a warning is displayed.

**Operating Tip** — You can navigate to the Key Priority Setup Menu without selecting a key priority transition by pressing HOME ➔ Effects ➔ More ➔ More ➔ Key Priority.

2. Use the MLE knob to select the MLE that you want to set the key priority for.
3. Set the current key priority as follows:

   **Important** — Ensure that all your keys are off-air before changing the Current key priority. Changing the Current key priority of on-air keys may produce undesired effects.

   - Press the Key X button in the Current area for the desired keyer at the layer you want the key to appear, where X is the number of the keyer. The remaining keys shift layers to accommodate the change. Keys at the same layer, or above, the selected layer are shifted up.

4. Set the next key priority as follows:
• Press the **Key X** button in the **Next** area for the desired keyer at the layer you want the key to appear, where X is the number of the keyer. The remaining keys shift layers to accommodate the change. Keys at the same layer, or above, the selected layer are shifted up.

**Note** — **A Key Priority** transition can only be performed when all affected keyers are on-air, or active on the MLE, with a **DISS** or **WIPE**. A Squeeze & Tease transition cannot be used for a key priority transition.

5. Press **CUT** or **AUTO TRANS**, or use the fader, to perform the key over transition.

Remember to deselect **KEY PRIOR** on the **Transition Module** when you have completed your key priority transitions.

*For More Information...*

• on key priority, Refer to the section “**Video Layering**” on page Ops 4-3.

**Manual Key Priority Cuts**

You can manually set the key priority for the keyers from the **Transition** and **Keyers Modules**. Manually setting the key priority changes the Current key priority, and cannot be applied with a key priority transition.

1. Press and hold the **KEY PRIOR** button on the **Transition Module**.

2. Press the **SEL** button for **Keyer 3** on the **Keyers Module**. This places **Key 3** on top of all the other keys.

3. Press the **SEL** button for **Keyer 2** on the **Keyers Module**. This places **Key 2** on top of all the other keys, including **Key 3**.

4. Both **Key 1** and **Key 4** remain in their original order, with **Key 4** on top of **Key 1** (Figure 5.29).

5. Release the **KEY PRIOR** button.
Wipes, Patterns, Washes, and Mattes

In This Chapter

This chapter provides information and instruction on working with wipes, patterns, washes, and mattes on the Vision switcher.

The following topics are discussed in this chapter:

• Pattern Generators
• Wipes
• Pattern Parameters
• Washes and Mattes
Pattern Generators

The Vision switcher has 4 Pattern Generators per MLE that provide wipes, preset patterns, washes, and masks. The Pattern Generators are used as follows:

- **Complex Pattern Generators** — These two (2) pattern generators provide Wipe transition patterns, as well as Preset Patterns or Masks for keyers. These pattern generators float between the transition area and keyers. Complex Pattern Generators can generate all types of wipes.

- **Simple Wash Pattern Generators** — These two (2) additional pattern generators provide all the Wash resources for the MLE.
Wipes

A Wipe is a type of transition that uses a preset pattern to replace one video signal with the other. When a wipe transition is selected, the Pattern Selection Menu is displayed, allowing you to select the pattern for the wipe you want to use. The Pattern Selection Menu shows 32 pre-assigned patterns, plus 8 user assignable patterns.

Wipe Transitions

A wipe transition is set up and performed in the same way as a standard transition, except that a wipe pattern must be selected.

1. Select the video sources on the buses that you want to transition.
2. Select Background or a Keyer as the next transition on the Transition Module of the MLE.
3. Press the WIPE button on the Transition Module.
4. Select the pattern you want to use for the transition on the Pattern Selection Menu. You can also use the keypad on the memory module to select the pattern button number (#xx).
5. Toggle Direction to select either Rev or Fwd. For example, if the circle pattern is used, toggling between Rev and Fwd toggles whether the transition starts as a circle in the center of the screen and expands out, or the circle starts off-screen and shrinks down to the center.
6. Toggle Flip Flop to select either On or Off. With Flip/Flop toggled On, the sequence runs forward and then reverse. For example, the wipe could be performed from left to right across the screen the first time, and then right to left for the second.
7. Press Modify Pattern to adjust the pattern parameters as required. Refer to the section “Pattern Parameters” on page Ops 6-5 for more information.

Operating Tip — If you want to add a border to the wipe, press Modify Pattern  Size/Soft Border and increase the border size. Refer to the section “Border Size and Softness” on page Ops 6-5 for information on adjusting a border.
8. Perform the transition using the fader, or by pressing the AUTO TRANS button on the Transition Module.

Assigning User Wipes

The User Wipe feature allows you to select from the pre-loaded additional wipes and assign them to the user wipe buttons. The user wipe buttons are essentially presets that can be programmed to your favorite patterns. Once set up, the user wipe button operates in the same manner as any of the other wipe pattern buttons.

Note — Pattern modifiers cannot be applied to user wipes. You must use memories to store pattern modifiers with the user wipe.


2. Use the User Wipe knob to select the user wipe button (1 through 8) that you want to assign the wipe pattern to.

3. Use the Category knob to select the category of wipe you want to assign to the user wipe button.

4. Use the Pattern knob to select the wipe pattern that you want to assign to the selected user wipe button.

For More Information...

- on transitions, refer to the section “Performing Transitions” on page Ops 5-13.
- on the pre-loaded patterns, refer to the section “DVE Wipes and Sequences” on page Ops 17-2.
- on the different categories and wipes available, refer to the section “Standard Wipes” on page Ops 17-6.
Pattern Parameters

The Pattern Parameters Menus allow you to assign different parameters to the patterns for each pattern generator on the MLE. This can be for either a Wipe, Preset Pattern, Wash, or Mask.

Pattern parameters, including wipe settings, are stored in memories.

Position and Size

The Position and Size feature allows you to alter the aspect ratio of the pattern. For example, circles can be made into ovals and squares can be made into rectangles.

1. Press X/Y Size.

2. Use the X knob to adjust the horizontal position of the wipe pattern or preset pattern.
3. Use the Y knob to adjust the vertical position of the wipe pattern or preset pattern.
4. Use the Size knob to adjust the size of the wipe pattern or preset pattern.

Border Size and Softness

The Pattern Border and Softness and Size features allows you to apply borders to the pattern, and soften the borders and edges of the pattern.

Note — You cannot apply a Pattern Border and an XFX Border to the same key. You must turn off the XFX Border in order to be able to turn on the Pattern Border. The Pattern Border turns off automatically when you apply an XFX Border.
1. Press Size/Soft/Border.

2. Use the Border knob to adjust the size of the border on the pattern. A Border of 0.0% turns the border effect off.

3. Use the Softness knob to adjust the softness of the border or edge of the pattern. If there is no border applied, the softness is applied to the edges if the pattern.

**Note** — If you are adjusting a Preset Pattern key, the Size knob allows you to adjust the size of the pattern. Size does not apply to a pattern that is being used for a transition.

4. Use the Size knob, or the positioner, to adjust the size of the pattern. The positioner is also used to adjust the position of the pattern.

5. Select a matte or wash color for the border as follows:
   - Press Border Matte.
   - Select the Matte or Wash 1/2 generator you want to assign to the border.
   - Press Modify Color or Modify Wash to adjust the color of the border. Refer to the section “Washes and Mattes” on page Ops 6-11 for information on selecting a color for a matte or wash.

**Aspect**

The Aspect feature allows you to alter the aspect ratio of the pattern. For example, circles can be made into ovals and squares can be made into rectangles.

1. Toggle Aspect to On.
2. Use the Aspect knob to adjust the aspect ratio of the wipe pattern or preset pattern.

Rotation

The Rotation features allows you to set the pattern, or wipe, to a specific angle (User Rotation), or apply a moving rotation, or spin, to the pattern (Continuous or Transition Rotation).

You can apply multiple rotation types to the same pattern at the same time.

1. Press Rotation.

2. Toggle Rotation to On.

3. Apply a continuous rotation to the pattern as follows:
   • Press Continuous Rotation.

   - Use the Speed knob to select the rate at which the pattern continuously rotates. Selecting a positive value rotates the pattern clockwise, and selecting a negative value rotates the pattern counter-clockwise.

4. Apply a transitional rotation to the pattern as follows
   • Press Transition Rotation.
Pattern Rotation Menu

- Use the Rotation knob to select the amount of rotations of the pattern that occurs during a transition. Selecting a positive value rotates the pattern clockwise, and selecting a negative value rotates the pattern counter-clockwise.

5. Apply a fixed rotation to the pattern as follows:
   - Press User-Controlled Rotation.

Pattern Rotation Menu

- Use the Degrees knob to adjust the rotation of the pattern.

**Horizontal and Vertical Multiplication**

The Horizontal and Vertical Multiplication features allow you to multiply the current pattern up to 5 times both horizontally and vertically. For example, if you select the circle pattern and apply 5 horizontal and vertical multiples, there will be 5 circles across the screen by 5 down.

- **Horizontal Multiplication** — Press H-Mult until the required number of multiples is reached. A maximum of 5 multiples can be used.
- **Vertical Multiplication** — Press V-Mult until the required number of multiples is reached. A maximum of 5 multiples can be used.
Matrix Tile Size

The Matrix Tile Size feature allows you to set the shape of the tiles in the matrix wipe, as well as the number of tiles used.

1. Press More ➔ Pattern Options ➔ Matrix Tile Size on the Patterns Menu.

2. Select the shape of the tiles used in the matrix as follows:
   - **Square** — Press Square to use square tiles in the matrix.
   - **Tall** — Press Tall to use rectangular tiles in the matrix taller than they are wide.
   - **Wide** — Press Wide to use rectangular tiles in the matrix that are wider than they are tall.

3. Use the Size knob to select the number of tiles that are used in the matrix. The available selection depends on the shape of the tile selected.

Wipe Modulation

The Wipe Modulation feature allows you to add a ripple effect to the pattern wipe. You can adjust the height and width of ripples both vertically and horizontally, as well as animate the ripples.

1. Press More ➔ Pattern Options ➔ Wipe Modulation on the Patterns Menu.
2. Toggle Modulation to On.
3. Adjust the ripples on the left and right sides of the pattern as follows:
Operating Tip — Press Clear on the Wipe Modulation Menu to return all the pattern modulation setting to the default values.

- Press Vertical Params.

Vertical Params — Wipe Modulation Menu

- Use the Amplitude knob to adjust the height of ripples.
- Use the Wavelength knob to adjust the width of the ripples used, or the number of the ripples.

4. Adjust the ripples on the top and bottom sides of the pattern as follows:
   - Press Horizontal Params.
   - Use the Amplitude knob to adjust the height of ripples.
   - Use the Wavelength knob to adjust the width of the ripples used, or the number of the ripples.

5. Animate the ripples as follows:
   - Toggle Animate to On.

Operating Tip — Toggling Animate to Off while the pattern is moving freezes the pattern without affecting the rate.

- Press Vertical Params.
- Use the Rate knob to adjust the speed that the ripples move along the vertical sides of the pattern. A positive value moves the ripples right to left and negative values move the ripples left to right. A value of 0 causes the ripples not to move.
- Press Horizontal Params.
- Use the Rate knob to adjust the speed that the ripples move along the horizontal sides of the pattern. A positive value moves the ripples top to bottom and negative values move the ripples bottom to top. A value of 0 causes the ripples not to move.
Washes and Mattes

A Background Generator allows you to fill a border, color background, or preset pattern with wash video effects. Wash video effects include generated noise, SuperBlack, a pattern, matte color, a wash, or video.

There are no Background Generators on the PGM/PST MLE of the half MLE switchers.

You can apply a wash or matte in the following ways:

- **WIPE** — Select the WIPE button on the Transition Module to apply the wash to a border on a wipe. Press Border Matte on the Pattern Parameters Menu 1-2.
- **COLOR BKGD X** — Select the crosspoint button mapped to Color Background 1 or 2 to apply the wash to either of these sources.
- **MATTE FILL** — Select the MATTE FILL button on the Effects Keyers Module to apply a Matte Fill key to the selected keyer.
- **PST PATT** — Select the PST PATT button on the Effects Keyers Module to apply a wash to a pattern. Press Border Matte on the Pattern Parameters Menu 1-2.

Creating Washes

To fill a border, color background or a pattern with a wash, you must first set up the border, or preset pattern that you want to apply the wash to, and then apply the wash. A wash is a gradient effect where one color is progressively replaced with another. In a typical wash, one color will start at one end, and the other color at the other end of the screen.

1. Press Wash 1 or Wash 2 on the Mattes Selection Menu to select the wash that you want to use. Two washes are provided per MLE.
2. Press Modify Wash.
3. Create a Pattern wash as follows:
   - Press BKGD Type.
   - Use the Type knob to select Pattern.
   - Press Pattern Selection. Use these menus to select and set up the pattern you want to use. Refer to the section “Pattern Parameters” on page Ops 6-5 for more information on this menu.
   - Proceed to Step (7.) to apply the color wash effect.
4. Create a Video wash as follows:
   - Use the Type knob to select Video.
Operating Tip — Press Default Colors on the Modify Wash Menu to go back to the original, default colors. The color selections for the MLE and Wash will be set back to default.

- Use the Video Bus knob to select the crosspoint bus you want to use to select the video source from. You can choose between the following:
  - **Key X** — Select this option to use the video source currently selected for Keyer X as the video wash, where X is the number of the keyer.
  - **Program** — Select this option to use the video source currently selected on the Program Bus of the MLE as the video wash.
  - **Preset** — Select this option to use the video source currently selected on the Preset Bus of the MLE as the video wash.
  - **Utility 1** — Select this option to use the video source currently selected on the Utility Bus as the video wash. The Utility Bus for the MLE is automatically selected. Refer to the section “Selecting a Key or Utility Bus” on page Ops 4-8 for more information on selecting a Utility Bus.
  - **Utility 2** — Select this option to use the video source currently selected on the Utility Bus as the video wash. The Utility Bus for the MLE is automatically selected. Refer to the section “Selecting a Key or Utility Bus” on page Ops 4-8 for more information on selecting a Utility Bus.
- Use the Fill Type knob to select how the video wash will be displayed. You can choose between the following:
  - **ColorWash** — Select this option to apply a gradient color wash to the selected video signal. Proceed to Step (7.) to apply the color wash effect.
  - **Video** — Select this option to apply an unaltered video signal with no color effects applied. Proceed to Step (8.) to complete the procedure.

5. Create a Noise wash as follows:
   - Use the Type knob to select Noise.
   - Proceed to Step (8.) to complete the procedure.

6. Create a SuperBlack wash as follows:
   - Use the Type knob to select SuperBlack.
   - Proceed to Step (8.) to complete the procedure.

7. Adjust the colors of the wash as follows:
   - Press Modify Color 1. You can switch between Color 1 and Color 2 on the Color Selection Menu.
Wash Color 2 — Color Selection Menu

Note — If the Matte Limit feature is active, the RGB color space is not available. You will only be able to make color selection in the HSL color space. Refer to the section ‘Personality List’ on page Eng 11-2 for more information.

• Select the color you want to use for Color 1 using the knobs, positioner, or by selecting a point on the Color Wheel.
• Toggle Color to 2.
• Select the color you want to use for Color 2 using the knobs, positioner, or by selecting a point on the Color Wheel.

8. The wash effect is now stored for the selected Wash button on the current MLE.

Creating Mattes

To fill a border, color background, or a pattern with a matte, you must first set up the border, or preset pattern, that you want to apply the matte to. A matte is like a wash, but has only one color.

1. Press Matte on the Mattes Selection Menu.
2. Press Modify Color.

Note — If the Matte Limit feature is active, the RGB color space is not available. You will only be able to make color selection in the HSL color space. Refer to the section ‘Personality List’ on page Eng 11-2 for more information.

3. Select the color you want to use for Color 1 using the knobs, positioner, or by selecting a point on the Color Wheel.
In This Chapter

This chapter provides a basic introduction to the concepts behind keying. This includes performing different types of keys, as well as using MultiDSK and AuxKeys.

The following topics are discussed in this chapter:

- Keyers Module
- Self Key
- Auto Select Key
- Chroma Key
- Preset Pattern Key
- MultiDSK Keys
- AuxKeys
Keying is the term used to describe when you insert (or electronically cut) portions of one scene into another, or place titles over background images. Keys are made up of two basic components, an alpha, that cuts the hole in the background video, and a fill, that fills the hole with different video.

The number of Keyers you have per MLE depends on the Keyer option you have installed.

**Note** — The **Downstream Keyers Module** has the same functionality as the **Keyers Modules**, with the addition of two Keyers to support the **MultiDSK** option.

The following rules and tips apply when working with keys:

- All MLEs have 2 or 4 **Keyers** that display over top of the **Background** of that MLE.
- The **Keyers** of the **Downstream Keyer Module**, or DSK, display over top of the **Program** output of the switcher.
- Each full Keyer can generate a **Self Key**, **Auto Select Key**, **Preset Pattern Key**, or **Chroma Key**. The Keyers of the **Mix/DSK**, half MLE, or MultiDSK keyers, option can only generate **Auto Select Keys** and **Self Keys**.
- The MultiDSK Keyers can only be controlled from the **Downstream Keyers Module**. If you assign one of the other panel rows to the **PGM/PST MLE**, you will not be able to control the MultiDSK Keyers directly.

The **Keyer Module** (Figure 7.1) allows you to perform all the Key type, Key modifier, and Key transitions for the assigned MLE. Each Keyer Module can be broken down into groups of buttons that perform certain functions, such as selecting the key type, or selecting key parameters for the active Keyer.

![Figure 7.1 Keyers Module (4-Keyer Shown)](image)

The **Keyers Module** controls all keyers for the MLE. The Keyer that the module is assigned to is indicated by the lit **SEL** button. For example, if the **SEL** button above the 3 is lit, the **Keyers Module** is being controlled by **Keyer 3**. Pressing either **SEL** button assigns the **Keyer Module** to that Keyer.

**For More Information...**
- on layering, or key priority, refer to the section “**Video Layering**” on page Ops 4-3.
Key Type Buttons and Mnemonics

The Key Type buttons (Figure 7.2) allow you to select the type of key you want the Keyer to produce. There are four basic key types, Self Keys, Auto Select Keys, Chroma Keys, and Preset Pattern Keys. Each of these key types has different applications and effects that can be applied to them. The key type selection is indicated by a triangle in the corner of the mnemonic for the Keyer.

![Figure 7.2 Key Type Buttons and Mnemonics — Keyers Module (4-Keyer Shown)](image)

The mnemonic on each Keyer can be used to identify what key type each Keyer is set up as. A small triangle appears in the corner of the mnemonic for each Keyer. The location of this triangle corresponds to the location of the key type button on the Keyers Module (Figure 7.3). For example, if there is a triangle in the upper right corner of the mnemonic for keyer 2, then keyer 2 is set up as Self Key.

![Figure 7.3 Key Type Triangles — Keyer Mnemonic](image)

Key Modifier Buttons

The Key Modifier buttons (Figure 7.4) allow you to apply different effects or modifiers to the key, such as a mask, border, or flying the key.

![Figure 7.4 Key Modifier Buttons — Keyers Module (4-Keyer Shown)](image)
MATTE FILL

The Matte Fill button allows you to fill the active key with a matte color. Refer to the section “Creating Mattes” on page Ops 6-13 for more information on creating a matte.

KEY MEM

The Key Memory button applies to Auto Select keys and provides a single memory register for storing clip and gain settings for the key. Key memories are stored for the key source, so that when you store a key memory in one MLE, that key memory is used when you select that same key source on any MLE.

The KEY MEM button turns on automatically when this key type is selected, indicating that the Auto Select key memory for the selected key source is being used. If the selected key source has not been set up with a proper alpha, the KEY MEM button will not light. Refer to the section “Auto Select Key” on page Ops 7-9 for more information on this key type.

KEY INV

The Key Invert button reverses the polarity of the key alpha. For example, if a Self Key, such as a title camera, has white letters on a black background, the white letters will normally cut the key hole. When the Key Invert feature is used, the polarity of the key is inverted so that black lettering is used to cut the hole.

MASK

The Mask button allows you to apply a mask to the selected key. When this button is pressed, the Mask Setup Menu is displayed, which allows you to create a box, pattern, or utility mask. Refer to the section “Key Masks” on page Ops 8-23 for more information on masking a key.

BORD ON/OFF

The Border buttons allow you to apply a border to the selected key using the optional XFX Extra Effects Dual Border Generator. If this option is installed, pressing the BORDER ON button will turn on the border and display the menus for setting it up. Refer to the section “XFX Borders” on page Ops 8-15 for more information on bordering a key.

The Border Off button turns the border feature off for the selected key.

FLY KEY

The Fly Key button allows you to apply internal DVE resources to the selected Keyer. These can be either 2D DVE or Squeeze & Tease resources. Refer to the section “DVE Keys (Fly Key)” on page Ops 8-2 for more information on flying a key.

Key Preview Buttons

The Key Preview buttons (Figure 7.5) allow you to preview different aspects of the selected key. This functionality includes previewing a transition on the preview output, or showing the alpha signal that is being used to cut the key.

Note — The Key Preview and Show Alpha features cannot be used at the same time. If you want to use one, you must deactivate the other first.
KEY PV

The Key Preview feature allows you to temporarily force the program output of the selected Keyer to the preview output of the switcher. The MLE remains in the Key Preview state for as long as you hold the KEY PV button, and returns to normal as soon as you release the button. You can also double-press the KEY PV button to latch the MLE in the Key Preview state until the button is double-pressed again.

MultiDSK keyers do not support the Key Preview feature.

SHOW ALPHA

The Show Alpha feature allows you to view the black and white alpha signal for the selected key. This alpha signal can either be routed to the main preview output of the switcher, or to the preview output of the selected MLE.

Note — The Show Alpha feature cannot be applied to Preset Pattern keys at this time.

• Switcher Preview Output — Press and hold the SHOW ALPHA button, for the selected Keyer and MLE, to show the alpha for that Keyer on the main preview output of the switcher.

• MLE Preview Output — Double-press the SHOW ALPHA button, for the selected Keyer and MLE, to have the alpha signal for that Keyer fed out of the preview for that MLE. The main preview output for the switcher is unaffected. This allows you to record the alpha signal for a selected Keyer independent of the fill. The Show Alpha feature remains active until the button is pressed again.

Key Transition Buttons

The Transition buttons (Figure 7.6) allow you to perform a dissolve transition using the Auto Transition (AUTO TRANS) button or a cut using the Cut (CUT) button.

The rate at which the auto transition is performed is shown as the Key Rate on the Memory System Module for the MLE, or the Global Memory System Module for the Program/Preset MLE.
For More Information...

- on performing a transition, refer to the section “Performing Transitions” on page Ops 5-13.

Channel Management Button

The Channel Management button (Figure 7.7) lights to indicate if multiple DVE channels are being used by the selected Keyer. Pressing the CHNL MGMT button displays the Channel Management Menu for the selected Keyer.
Self Key

A Self Key is a key in which the luminance, or brightness, values of the key source is used as the alpha for the key.

A Self Key can be used by an MLE Keyer, or an AuxKeyer. Refer to the section “AuxKeys” on page Ops 7-28 for more information on AuxKeys.

1. Press the SEL button on the Keyers Module for the Keyer you want to set up the Self Key on. The Key Bus for the selected crosspoint group is now assigned to the Keyer you selected.

2. Select the video signal you want to use for the key on the key bus of the crosspoint group. The video source name appears on the Keyer mnemonic on the Keyers Module.

3. Press SELF KEY on the Keyers Module to select the key type. The Self Key Setup Menu is displayed for the selected Keyer and a small triangle appears in the top right corner of the Keyer mnemonic.

4. Adjust the Clip and Gain of the key as follows:
   • Use the Clip knob to adjust the clip level.
   • Use the Gain knob to adjust the gain, or softness.

5. Set the transition rate for the selected keyer as follows:

   Note — The Editor remote enable must be set to off to be able to set an independent transition rate for the keyer.

   • Press Trans Rate.
   • Use the Trans Rate knob to set the keyer transition rate, in frames.

6. Adjust the Transparency of the key as follows:
   • Toggle Transparency to On.
   • Use the Transp. knob to adjust the transparency of the key from opaque (0%) to fully transparent (100%).

7. Toggle Additive to temporarily override the shaped/unshaped key settings for the selected source.
On — Select this option to turn shaped keying on for the source.
Off — Select this option to turn unshaped keying on for the source.

8. Select additional key modifiers as desired, using the buttons on the Keyers Module. The available modifiers are as follows:

- MATTE FILL (not available on the Downstream Keyers of a half MLE switcher)
- KEY INV
- MASK
- FLY KEY
- BORD ON (XFX Dual Border Generator only)

Once set up, the key can be taken on-air using the transition button on the Keyers Module, or using the Transition Module.

For More Information...

- on setting up your preview monitors to view your key, refer to the section “Video Preview” on page Ops 4-15.
- on performing transitions, refer to the section “Performing Transitions” on page Ops 5-13.
- on working with DVE Keys, refer to the section “DVE Keys (Fly Key)” on page Ops 8-2.
Auto Select Key

An Auto Select Key is a key in which two video signals are required to make the key. The Alpha is used to cut the hole in the video and the fill is used to fill the hole. These signals often originate from external devices such as character generators, external still stores, or other graphics systems.

An Auto Select Key can be used by an MLE Effects Keyer, or an AuxKeyer. Refer to the section “AuxKeys” on page Ops 7-28 for more information on AuxKeys.

1. Press the SEL button on the Keyers Module for the Keyer you want to set up the Auto Select Key on. The Key Bus for the selected crosspoint group is now assigned to the Keyer you selected.

2. Select the video signal you want to use for the key on the key bus of the crosspoint group. The video source name appears on the Keyer mnemonic on the Keyers Module.

3. Press AUTO SELECT on the Keyers Module to select the key type. The Auto Key Setup Menu is displayed for the selected Keyer and a small triangle appears in the top left corner of the Keyer mnemonic. The KEY MEM button on the Keyers Module lights up.

4. Adjust the Clip and Gain of the key as follows:

   **Note** — If you have set up an MLE program and clean feed, in Layer mode, as an auto select key, the **Clip** and **Gain** selections are locked.

   • Toggle Key Mem to Off. This allows you to override the clip and gain values that are stored with the key.
   • Use the Clip knob to adjust the clip level.
   • Use the Gain knob to adjust the gain, or softness.

   **Operating Tip** — To save the new clip and gain settings for the auto select key, press and hold the AUTO SELECT button and then press the KEY MEM button. The current settings are stored for the selected key source.

5. Set the transition rate for the selected keyer as follows:

   **Note** — The Editor remote enable must be set to off to be able to set an independent transition rate for the keyer.

   • Press Trans Rate.
• Use the **Trans Rate** knob to set the keyer transition rate, in frames.

6. Adjust the Transparency of the key as follows:
   • Toggle **Transparency** to **On**.
   • Use the **Transp.** knob to adjust the transparency of the key from opaque (0%) to fully transparent (100%).

7. Toggle **Additive** to temporarily override the shaped/unshaped key settings for the selected source.
   • **On** — Select this option to turn shaped keying on for the source.
   • **Off** — Select this option to turn unshaped keying on for the source.

8. Select additional key modifiers as desired, using the buttons on the **Keyers Module**. The available modifiers are as follows:
   • **MATTE FILL**
   • **KEY INV**
   • **MASK**
   • **FLY KEY**
   • **BORD ON** (XFX Dual Border Generator only)

Once set up, the key can be taken on-air using the transition button on the **Keyers Module**, or using the **Transition Module**.

**For More Information**...

• on setting up your preview monitors to view your key, refer to the section “**Video Preview**” on page Ops 4-15.
• on performing transitions, refer to the section “**Performing Transitions**” on page Ops 5-13.
• on working with DVE Keys, refer to the section “**DVE Keys (Fly Key)**” on page Ops 8-2.
Chroma Key

An UltraChrome™ Chroma Key is a key in which the hole is cut based on a color value, or hue, rather than a luminance value or alpha signal. The color is removed and replaced with background video from another source.

A Chroma Key can only be used by an MLE Effects Keyer.

UltraChrome Operating Modes

The UltraChrome Chroma Key operates in one of two modes, Basic or Advanced, depending on the complexity of the Chroma Key you are setting up.

- **Basic Mode** — In basic mode, UltraChrome provides a simple background/foreground chroma key with adjustment for background spill and edge softness.
- **Advanced Mode** — In advanced mode, UltraChrome provides advanced background shadow and translucency control, as well as control over background/foreground transition areas.

Although it is possible to switch back and forth between advanced and basic mode, the additional image correction of the advanced mode is only applied in the advanced mode. For example, if you use the basic mode to set up the Chroma Key and then switch to the advanced mode, the entire image may change as the image correctors provided by the advanced mode are applied at their default settings.

From the **Personality Menu**, you can set UltraChrome to always start in one of these modes. Refer to the section “**Personality List**” on page Eng 11-2 for more information on setting the default mode.

Initializing UltraChrome

This section describes how to initialize UltraChrome. The setup and operation of UltraChrome depends on the mode you select to operate in.

1. Press the SEL button on the **Keyers Module** for the Keyer you want to set up the Chroma Key on. The Key Bus for the selected crosspoint group is now assigned to the Keyer you selected.

2. Select the video signal you want to use for the key on the Key Bus of the crosspoint group. The video source name will appear on the Keyer mnemonic on the **Keyers Module**. You cannot use an MLE-Store as a source for a Chroma Key.

3. Press CHROMA KEY on the **Keyers Module** to select the key type. The UltraChrome Menu is displayed for the selected Keyer and a small triangle appears in the bottom right corner of the Keyer mnemonic.
4. Select the operating mode as follows:
   • Use the **Key Mode** knob on the UltraChrome Menu 1-2 to select the operating mode you want to use. You can choose between the following:
     › **Basic** — Select this option to operate UltraChrome in basic mode.
     › **Advanced** — Select this option to operate UltraChrome in advanced mode.

5. Select the color to key out as follows:
   • Use the **Color** knob on the UltraChrome Menu 1-2 to select the color you want to key out. This is the background color of your Chroma Key that will be replaced. From the Personality Menu, you can change the default color that UltraChrome uses. Refer to the section “Personality List” on page Eng 11-2 for more information on setting the default mode.

6. Press **Initialize Key** on the UltraChrome Menu 1-2 to initialize the chroma key. Every time the **Initialize Key** is pressed, the switcher resets all the Chroma Key parameters to their default settings.

7. Make adjustments to the chroma key as required. How you adjust the chroma key depends on the mode you are in.
   › **Basic** — Refer to the section “Basic UltraChrome Settings” on page Ops 7-13 for setup information.
   › **Advanced** — Refer to the section “Advanced UltraChrome Settings” on page Ops 7-16 for setup information.

---

**Operating Tip** — To save the new chroma key setting for the Keyer, press and hold the **CHROMA KEY** button and then press the **KEY MEM** button. The current settings, including the selected video source, is stored for the selected Keyer.

---

8. Select additional key modifiers as desired, using the buttons on the **Keyers Module**. The available modifiers are as follows:
   • **MATTE FILL**
   • **MASK**
   • **FLY KEY**
   • **BORD ON** (XFX Dual Border Generator only)

Once set up, the key can be taken on-air using the transition button on the **Keyers Module**, or using the **Transition Module**.
Basic UltraChrome Settings

Once you have initialized the chroma key in basic mode, you can make adjustments to the background and foreground ranges, the spill suppression, and the edge softness.

Operating Tip — The Color Map feature gives you a visual representation of the areas in the video signal that fall within all the adjustment ranges. Refer to the section “UltraChrome Alpha and Color Map” on page Ops 7-22 for more information.

To Adjust a Basic UltraChrome Chroma Key

1. If the UltraChrome Menu is not displayed, press the CHROMA KEY button on the Keyers Module for the Keyer you are adjusting the chroma key for.

2. Adjust the Background as follows:
   • Press Background.
     
     ![Background Gain — UltraChrome Menu 1-2]

     • Use the Gain knob to adjust the background gain as follows:
       › Increasing the Gain value causes the background to appear more opaque. This results in less of the background color being removed.
       › Decreasing the Gain value causes the background to appear more transparent. This results in more of the background color being removed.

3. Adjust the Foreground colors, or hues, as follows:
   • Press Foreground.
     
     ![Foreground — UltraChrome Menu 1-2]

     • Use the Clip knob to adjust the foreground clipping as follows:
Increasing the Clip value removes lower-saturated colors from the foreground image.
Decreasing the Clip value includes lower-saturated colors in the foreground image.

- Use the **Hue** knob to select the central, or base, color for the foreground as follows:
  - Increasing the Hue value moves counter-clockwise around the color wheel to select a base color.
  - Decreasing the Hue value moves clockwise around the color wheel to select a base color.
- Use the **Reject** knob to include or reject hues adjacent to the base color as follows (Figure 7.8):
  - Increasing the Reject value decreases the amount of adjacent hues that are included in the foreground.
  - Decreasing the Reject value increases the amount of adjacent hues that are included in the foreground.

**Figure 7.8** UltraChrome Color Wheel — Effects of Clip, Hue, and Reject

4. Adjust the amount of background color that is spilling over into the foreground as follows (green color cast on the foreground from a green screen for example):
   - Press **Spill Supress**.

**Spill Supress — UltraChrome Menu 1-2**

- Use the **Range** knob to remove any color cast onto the foreground as follows:
  - Increasing the Range value causes more of the foreground colors to be corrected for background color spill.
5. Adjust the edges of the foreground as follows:
   - Press **Edge Softness**.

**Operating Tip** — The default Width and Sensitivity settings can be adjusted using the **Edge Width Default** setting on the **Personality Menu**. Refer to the section “**Personality List**” on page Eng 11-2 for more information.

---

**Note** — The **Width** adjustment is only available for MLEs supported by a 4800AR-041 Video Processor Board.

---

**Note** — If the **Width** adjustment is set greater than **Off**, the **Sensitivity** is automatically set to **Low**. The **Sensitivity** is set back to what it was before when **Width** is set back to **Off**.

---

- Use the **Softness** knob to add or remove edge softening of the foreground image and alpha channel as follows:
  - Increasing the Softness value increases the amount of softness applied to the foreground edges and alpha channel.
  - Decreasing the Softness value decreases the amount of softness applied to the foreground edges and alpha channel.

**Note** — The **Width** adjustment is only available for MLEs supported by a 4800AR-041 Video Processor Board.

---

- Use the **Width** knob to adjust the outside edge of the foreground image and alpha channel as follows:
  - Increasing the Width value increases the amount that the key encroaches onto the foreground image.
  - Decreasing the Width value decreases the amount that the key encroaches onto the foreground image.

**Note** — If the **Width** adjustment is set greater than **Off**, the **Sensitivity** is automatically set to **Low**. The **Sensitivity** is set back to what it was before when **Width** is set back to **Off**.

---

- Use the **Sensitivity** knob to set the edge sensitivity as follows:
  - **Low** — Select this option to reduce the level of detail in the edges of the chroma key. This option will reduce the overall noise in the key image that can be the result of certain lighting conditions or high detail camera settings. This is the default setting.
  - **High** — Select this option to include the maximum detail in the edges of the chroma key.
UltraChrome Chroma Key Fine Tuning Tips

The following are some helpful fine tuning tips and tricks that can help you improve the quality of your chroma key. These tips assume you are using the Basic Mode to adjust your chroma key.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The foreground key is semi-transparent, showing unwanted background.</td>
<td>If the semi-transparent areas are white (grey areas that don’t have saturated colors) adjust the <strong>Foreground-Clip</strong>. This moves non-saturated (greys) from the background to the foreground. You can use the <strong>Color Map</strong> to help determine which areas are background, and which are foreground. If the semi-transparent areas are due to background color spill, reduce the <strong>Foreground-Reject</strong>. This moves saturated colors from the background to the foreground spill suppress area of the color wheel.</td>
</tr>
<tr>
<td>The background isn’t cleanly keyed out.</td>
<td>Reduce the <strong>Background-Gain</strong>. You can use the <strong>Show Alpha</strong> feature to see how well the background is being keyed out. If adjusting the <strong>Background-Gain</strong> is not enough, change the <strong>Edge-Sensitivity</strong> to <strong>Low</strong>.</td>
</tr>
<tr>
<td>Foreground key has unwanted color shifts.</td>
<td>Reduce the <strong>Spill Suppress-Range</strong>.</td>
</tr>
</tbody>
</table>

**Advanced UltraChrome Settings**

Once you have initialized the chroma key in advanced mode, you can make adjustments to the background and shadow, translucent, foreground, and transition ranges, as well as the spill suppression.

---

**Operating Tip** — The **Color Map** feature gives you a visual representation of the areas in the video signal that fall within all the adjustment ranges. Refer to the section “UltraChrome Alpha and Color Map” on page Ops 7-22 for more information.

---

An UltraChrome chroma key, in advanced mode, breaks the image into five elements which determine, or partially determine, which part of the image is keyed out, or removed.

- **Background** — Background elements are those pixels in the source video that are the same color as the one you chose to key out. Note that the Shadow and translucent areas (see below) are completely contained within the Background area.

- **Shadow** — Shadow elements are those pixels in the source video with colors that are within the Background range, but with lower luminance values, depending on the shadow range. You modify the Shadow range to cover darker areas of the background (e.g. where the foreground is casting a shadow on the background screen).

- **Translucency** — Translucent elements are those pixels in the source video that are in the Background range, but with higher luminance values than the Shadow range. You can control the upper-end of the Translucency range by setting a wider hue-range to constrain the area. You can also control the transparency of the Translucent area.

- **Transition** — Transition elements are those pixels in the source video with colors that are not within any of the previous three ranges and are also not considered part of the Foreground area. These are typically the pixels near the edge of the foreground, where it blends into the background.
• **Foreground** — Foreground elements are those pixels that are not within the Background, Shadow, Translucency, or Transition ranges. This is the area with colors that will not be keyed out and will remain solid.

The remaining three adjustments that can be made to an Advanced UltraChrome chroma key allow you to adjust spill suppression, edge softness and luminance.

• **Spill Suppress** — Spill Suppression elements are those pixels in the Foreground that have a noticeable tint of the Background color. This typically occurs around the edge of the foreground subject as glow from the background blue-screen or green-screen “spills” onto them.

• **Edge Softness** — Edge Softness lets you apply varying degrees of softening to the Foreground edges to help it blend in with the underlying background image that it is being keyed over.

• **Luminance** — Luminance allows you to control the overall brightness of Shadow, Translucency, and Transition areas as well as partial reflections to more closely match the Foreground brightness.

**To Adjust An Advanced UltraChrome Chroma Key**

1. If the **UltraChrome Menu** is not displayed, press the **CHROMA KEY** button the **Keyers Module** for the Keyer you are adjusting the chroma key for.

   **Operating Tip** — If you only want to adjust the **Foreground** area of the chroma key, proceed to **Step 6**.

2. Adjust the Shadow area as follows:
   - Press **Shadow**. The Shadow adjustment allows you to extract a shadow from the background. This is the actual shadow that the foreground subject is casting onto the screen.

   - Use the **Range** knob to adjust the range of the Shadow colors as follows:
     - Increasing the Range value widens the Shadow area by including lower-luminance background colors. The increased range comes as a result of colors moving from the Translucent area to the Shadow area.
     - Decreasing the Range value narrows the Shadow area by excluding high-luminance colors. These excluded colors move back into the Translucent area.

   - Use the **Gain** knob to adjust the Shadow appearance as follows:
     - Increasing the Gain value creates darker shadows.
     - Decreasing the Gain value creates lighter shadows.
3. Adjust the Translucency area as follows:
   - Press Translucency. The Translucency settings allow you to adjust the appearance of clear items such as eye-glass lenses.

   ![Translucency — UltraChrome Menu 1-2](image)

   - Use the Range knob to adjust the range of the Translucent colors as follows:
     › Increasing the Range value widens the Translucent area by including more hues from the Background range (the lower-end of the range is defined by the Shadow range you just set).
     › Decreasing the Range value narrows the Translucent area by excluding hues.
   - Use the Gain knob to adjust the appearance of the Translucent colors as follows:
     › Increasing the Gain value causes the translucent colors to appear more opaque.
     › Decreasing the Gain value causes the translucent colors to appear more transparent.

4. Adjust the Transition area as follows:
   - Press Transition. The Transition area is the range of pixels that are left over (i.e. not in the Shadow or Translucency area). The Transition settings allows you to adjust the appearance of the Transition area.

   ![Transition — UltraChrome Menu 1-2](image)

   - Use the Gain knob to adjust the appearance of the Transition colors as follows:
     › Increasing the Gain value makes the Transition area pixels more opaque.
     › Decreasing the Gain value makes the Transition area pixels more transparent.

5. Adjust the Background area as follows:
   - Press Background. Background elements are those pixels in the source video that are the same color as the one you chose to key out. Note that the Shadow and translucent areas (see below) are completely contained within the Background area.
Use the **Sat Range** knob to adjust the saturation range of the background color as follows:

- Increasing the Saturation Range value includes a wider range of saturation values to be included in the background.
- Decreasing the Saturation Range value includes a narrower range of saturation values to be included in the background.

Use the **Positive Hue** knob to adjust the range of hues that are included in the Background, expanding clockwise around the color wheel.

Use the **Negative Hue** knob to adjust the range of hues that are included in the Background, expanding counter-clockwise around the color wheel.

**6. Adjust the Foreground area as follows:**

- Press More ⇒ Foreground. The Foreground settings allow you to adjust the range of colors which are considered Foreground colors, and thus keyed fully on.

Use the **Clip** knob to adjust the foreground clipping as follows:

- Increasing the Clip value removes lower-saturated colors from the Foreground image.
- Decreasing the Clip value includes lower-saturated colors in the Foreground image.

Use the **Hue** knob to select the central, or base, color for the foreground as follows:

- Increasing the Hue value moves counter-clockwise around the color wheel to select a base color.
- Decreasing the Hue value moves clockwise around the color wheel to select a base color.
• Use the **Reject** knob to include or reject hues adjacent to the base color as follows (Figure 7.8):
  › Increasing the Reject value decreases the amount of adjacent hues that are included in the foreground.
  › Decreasing the Reject value increases the amount of adjacent hues that are included in the foreground.

7. Adjust the amount of background color that is spilling over into the foreground (green color cast on the foreground from a green-screen for example) as follows:
   • Press **Spill Suppress**.

   ![Spill Suppress — UltraChrome Menu 2-2](image)

   • Use the **Clip** knob to adjust spill suppress clipping as follows:
     › Increasing the clip value removes higher-saturated colors from spill suppress correction.
     › Decreasing the clip value includes higher-saturated colors in spill suppress correction. If your foreground image contains bright-colored areas that are suffering from background spill, decrease the clip value to have it corrected.

   • Use the **Hue** knob to select the central, or base, color for spill suppress correction. If the color spill does not appear to be the same color as the background, use this control to adjust which hue is considered to be “spilled” into the foreground:
     › Increasing the hue value moves counter-clockwise around the color wheel while selecting a base color.
     › Decreasing the hue value moves clockwise around the color wheel while selecting a base color.

   • Use the **Reject** knob to include or reject adjacent hues to the base.
     › Increasing the reject value increases the amount of adjacent hues that are included in spill correction.
     › Decreasing the reject value decreases the amount of adjacent hues that are included in spill correction.

8. Adjust the edges of the foreground as follows:
   • Press **Edge Softness**.
Use the **Softness** knob to add or remove edge softening of the foreground image and alpha channel as follows:

- Increasing the Softness value increases the amount of softness applied to the foreground edges and alpha channel.
- Decreasing the Softness value decreases the amount of softness applied to the foreground edges and alpha channel.

**Note** — The **Width** adjustment is only available for MLEs supported by a 4800AR-041 Video Processor Board.

Use the **Width** knob to adjust the outside edge of the foreground image and alpha channel as follows:

- Increasing the Width value increases the amount that the key encroaches onto the foreground image.
- Decreasing the Width value decreases the amount that the key encroaches onto the foreground image.

**Note** — If the **Width** adjustment is set greater than **Off**, the **Sensitivity** is automatically set to **Low**. The **Sensitivity** is set back to what it was before when **Width** is set back to **Off**.

Use the **Sensitivity** knob to set the edge sensitivity as follows:

- **Low** — Select this option to reduce the level of detail in the edges of the chroma key. This option will reduce the overall noise in the key image that can be the result of certain lighting conditions or high detail camera settings. This is the default setting.
- **High** — Select this option to include the maximum detail in the edges of the chroma key.

9. Adjust the luminance, or brightness, as follows:

- Press **Luminance**. The luminance settings allow you to adjust the overall brightness of the Shadow, Translucent, and Transition areas to change the appearance of reflections from semi-transparent objects and to match Shadow and Transition area brightness with the Foreground brightness.
Luminance — UltraChrome Menu 2-2

- Use the **Reflections** knob to change the brightness of semi-transparent reflections (like reflections from glasses) as follows:
  - Increasing the Reflections value increases the brightness of semi-transparent reflections.
  - Decreasing the Reflections value decreases the brightness of semi-transparent reflections.
- Use the **Bkgd Luma** knob to change the overall brightness of Shadow, Translucent, and Transition areas as follows:
  - Increasing the Background Luminance value increases the brightness of Background, Translucent, and Transition areas.
  - Decreasing the Background Luminance value decreases the brightness of Background, Translucent, and Transition areas.

UltraChrome Alpha and Color Map

Adjusting a chroma key can be difficult when looking at the actual video signals as some adjustments have very subtle effect on the image. Using an Alpha or Color Map preview gives you a visual representation of the various parts of your UltraChrome chroma key and makes for easier adjustments. The Alpha and Color Map previews use the Preview output of the selected MLE to show a representation of the Alpha (used by the Keyer to mix the key with the underlying background video) or a color-coded representation of the different UltraChrome regions. The Preview output shows the representation in the foreground of the Preview, but not over top of the Preview Overlay.

The Alpha and Color Map can be assigned to a clean feed output. Refer to the section “Clean Feed” on page Eng 8-7 for more information.

To Display the Alpha or Color Map Previews

1. If the UltraChrome Menu is not displayed, press the **CHROMA KEY** button the **Keyers Module** for the Keyer you are adjusting the chroma key for.

   Note — The **Color Map** and **Show Alpha** features are mutually exclusive. For example, if you turn the Color Map feature on, the Show Alpha feature turns off.

2. Turn on the Color Map feature as follows:
   - Press **More**.
• Toggle **Color Map** to **On** to display the Color Map on the Preview output of the selected MLE. The areas that the colors represent depend on whether you are performing a Basic or Advanced UltraChrome (*Table 7.1*).

<table>
<thead>
<tr>
<th>Color</th>
<th>Basic</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>n/a</td>
<td>Background and Shadow</td>
</tr>
<tr>
<td>Green</td>
<td>n/a</td>
<td>Translucent</td>
</tr>
<tr>
<td>Black</td>
<td>Foreground</td>
<td>Foreground</td>
</tr>
<tr>
<td>Blue</td>
<td>Spill Suppression</td>
<td>Spill Suppression</td>
</tr>
<tr>
<td>Gray</td>
<td>Background</td>
<td>Transition</td>
</tr>
</tbody>
</table>

3. Turn on the Show Alpha feature as follows:

  • Toggle **Alpha** to **On** to display the Alpha on the Preview output of the selected MLE.

**For More Information...**

- on setting up your preview monitors to view your key, refer to the section “**Video Preview**” on page Ops 4-15.
- on performing transitions, refer to the section “**Performing Transitions**” on page Ops 5-13.
- on working with DVE Keys, refer to the section “**DVE Keys (Fly Key)**” on page Ops 8-2.
- on setting default color or mode for UltraChrome, refer to the section “**Personality List**” on page Eng 11-2.
Preset Pattern Key

A Preset Pattern Key is a key in which a hole is cut based on a wipe pattern that you select. The pattern, which acts like the alpha used by the Auto Select key, is filled with video.

1. Press the SEL button on the Keyers Module for the Keyer you want to set up the Preset Pattern Key on. The Key Bus for the selected crosspoint group is now assigned to the Keyer you selected.

2. Select the video signal you want to use for the key on the key bus of the crosspoint group. The video source name appears on the Keyer mnemonic on the Keyers Module.

3. Press PST PATT on the Keyers Module to select the key type. The PST Key Setup Menu is displayed for the selected Keyer and a small triangle appears in the bottom left corner of the Keyer mnemonic.

   Note — If you have the 2D DVE/Squeeze & Tease option installed for the selected MLE, the FLY KEY turns on when you select PST PATT. Toggle FLY KEY off, unlit, to assign a Preset Pattern Key to the keyer.

4. Press Copy Up to display the PST Key Setup Menu in the upper display region.

5. Press Pattern Selection.

6. Select the pattern you want to use on the Pattern Selection Menu. You can select the pattern on the menu directly, or use the keypad on the memory module to enter the pattern button number (#xx). The Keyer applies the pattern selection as the alpha for the key.

7. Adjust the size and softness of the key as follows:
   - Use the Positioner to adjust the position of the pattern on screen. Not all patterns can be adjusted for position.
   - Use the Size knob, or twist the knob on the Positioner, to adjust the size of the pattern.
   - Use the Softness knob to adjust the softness of the edges of the pattern.

8. Adjust the parameters of the selected pattern as follows:
   - Press Modify Pattern.
     - A Preset Pattern Key supports the following pattern parameters. Refer to the section “Pattern Parameters” on page Ops 6-5 for more information on setting pattern parameters.
       - Aspect
9. Select additional key modifiers as desired, using the buttons on the Keyers Module. The available modifiers are as follows:

- **KEY INV**
- **MASK**
- **FLY KEY**
- **BORD ON** (XFX Dual Border Generator only)

**Note** — The Fly Key function can be regarded as a key modifier, but it is important to note that it creates a different type of key when used with a preset pattern. When **FLY KEY** is enabled, the switcher creates a bordered box around the selected pattern, which can be manipulated in 2D space. Special DVE key modifiers are enabled, such as size, position, mirror, and crop, but the Preset Pattern key modifiers, such as clip, gain, aspect, border, and softness, are disabled.

Once set up, the key can be taken on-air using the transition button on the Keyers Module, or using the Transition Module.

**For More Information...**

- on setting up your preview monitors to view your key, refer to the section “Video Preview” on page Ops 4-15.
- on performing transitions, refer to the section “Performing Transitions” on page Ops 5-13.
- on working with DVE keys (Fly Keys), refer to the section “DVE Keys (Fly Key)” on page Ops 8-2.
**MultiDSK Keys**

The MultiDSK™ option adds two additional Downstream Keyers to the Vision switcher.

**MultiDSK Operation**

Although the operation of the MultiDSK Keyers is similar to that of the existing Keyers, there are some notable differences as follows:

- MultiDSKs can only perform **Cuts** or **Dissolves**. If a MultiDSK key is included in a **Wipe** transition, the MultiDSK performs a **Dissolve**.
- When the MultiDSK option is active, the **SEL** button on the bottom MLE allows you to assign the key bus to all Keyers.
- MultiDSKs have independent transition rates from the **Key Rate** of the MLE and are set from the **MultiDSK Menu**.
- MultiDSKs can be locked, preventing the key type or crosspoint from being changed. The clip, gain, and key invert settings can still be changed.
- Memory recalls performed when the MultiDSK is locked only recall the on-air status.
- MultiDSKs do not support Key Preview (**KEY PV**).
- MultiDSKs do not support selection of MLE-Store, colored BKGDs, or MLE re-entry.
- MultiDSKs do not support the WhiteFlash transition type. If a MultiDSK key is on-air when a WhiteFlash transition is performed, it will remain on top of the WhiteFlash effect.

**MultiDSK Key Setup**

MultiDSK **Self Keys** and **Auto Select Keys** are both set up using the **MultiDSK Menu**. This menu allows you to adjust all the same elements as the **Self Key Setup Menu** and **Auto Key Setup Menu**, with the addition of the Transition Rates for the MultiDSK Keyers.

1. Press the **SEL** button on the **Keyers Module** for the MultiDSK Keyer you want to set up the key on. The Key Bus for the selected crosspoint group is now assigned to the Keyer you selected.

2. Select the video signal you want to use for the key on the Key Bus of the crosspoint group. The video source name appears on the Keyer mnemonic on the **Keyers Module**.

3. Press **SELF KEY** or **AUTO SELECT** on the **Keyers Module** to select the key type. The **MultiDSK Menu** is displayed for the selected Keyer.

![MultiDSK Menu (4-Keyer Shown)](image-url)
Operating Tip — If the Clip and Gain values are locked, you can unlock them by toggling the KEY MEM button on the Keyers Modules to OFF.

4. Adjust the Clip and Gain of the key as follows:
   • Press Clip/Gain.
   • Use the Clip knob to adjust the clip level.
   • Use the Gain knob to adjust the gain, or softness.

Operating Tip — You can return the Clip and Gain values to the default setting by pressing the Make Key Linear button on the Self Key Setup Menu.

5. Adjust the Transparency of the key as follows:
   • Toggle Transparency to On.
   • Use the Transparency knob to adjust the transparency of the key from opaque (0%) to fully transparent (100%).

6. Adjust the Transition Rates for the MultiDSK Keyers as follows:
   • Press Trans Rate.
   • Use the Trans Rate knob to adjust the transition rate of the keyer in frames.

7. Lock the selected MultiDSK as follows:
   • Toggle Locked to Yes to lock the selected MultiDSK Keyer. When locked, you cannot change the video source or key type of the key.

8. Toggle Additive to temporarily override the shaped/unshaped key settings for the selected source.
   • On — Select this option to turn shaped keying on for the source.
   • Off — Select this option to turn unshaped keying on for the source.

9. Select additional key modifiers as desired, using the buttons on the Keyers Module. The available modifiers are as follows:
   • KEY INV
     Once set up, the key can be taken on-air using the transition button on the Keyers Module, or using the Transition Module.

For More Information...
   • on performing transitions, refer to the section “Performing Transitions” on page Ops 5-13.
   • on setting up the MultiDSK option, refer to the section “MultiDSK” on page Eng 8-22.
AuxKeys

The AuxKey™ option turns a Crosspoint Group into an Aux Mixer, or Mixer/Keyer. In the AuxKey mode, you set up transitions using the Background, Preset, and Key buses and then perform transitions and key effects using the Transition and Keyers Modules of the Crosspoint Group.

There are two types of AuxKeys, AuxKey Mixers and AuxKey Mixer/Keyers. Depending on which one is assigned to the aux bus you are using, you will have different functionality.

AuxKey Operation

Although the operation of the AuxKey is similar to that of the existing MLE, there are some notable differences as follows:

- AuxKeys can only perform Cuts or Dissolves.
- AuxKeys have independent transition rates for the Background and Keyer transitions.
- You can only preview your next shot by connecting a preview monitor to the aux bus preview output.
- AuxKey Keyers can only perform Auto Select and Self Keys.
- AuxKey Keyers have only one Keyer per AuxKey.

AuxKey Setup

AuxKey Keyer Self Keys and Auto Select Keys are both set up using the Aux Mix Key Setup Menu. This menu allows you to adjust all the same elements as the Self Key Setup Menu and Auto Key Setup Menu, with the addition of the Transition Rates for the AuxKey Keyer.

1. Use the MLE SEL Button Menu to assign the panel row to the AuxKey. Refer to the section “Selecting an Aux Bus” on page Ops 4-9 for more information.

2. Select the video signal you want to use for the key on the Key Bus of the crosspoint group. The video source name appears on the Keyer mnemonic on the Keyers Module.

3. Press SELF KEY or AUTO SELECT on the Keyers Module to select the key type. The Aux Mix Key Setup Menu is displayed for the selected Keyer.
4. Adjust the Clip and Gain of the key as follows:
   • Press Clip/Gain.
   • Use the Clip knob to adjust the clip level.
   • Use the Gain knob to adjust the gain, or softness.

5. Toggle Additive to temporarily override the shaped/unshaped key settings for the selected source.
   • On — Select this option to turn shaped keying on for the source.
   • Off — Select this option to turn unshaped keying on for the source.

6. Adjust the Transition Rates for the AuxKey as follows:
   • Press Trans Rate.

<table>
<thead>
<tr>
<th>Aux Mix Key Setup</th>
<th>Aux Key Rate</th>
<th>Aux MLE Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Group: BNC</td>
<td>Aux Key Rate</td>
<td>Aux MLE Rate</td>
</tr>
<tr>
<td>Assign: Bnc1Aux1</td>
<td>(15) Frames</td>
<td>(8) Frames</td>
</tr>
<tr>
<td>Key Fill: BNC C04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key Alpha: Back</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   Transition Rate — Aux Mix Key Menu
   • Use the Aux MLE Rate knob to adjust the transition rate of Background transitions in frames.
   • Use the Aux Key Rate knob to adjust the transition rate of Keyer transitions in frames.

Once set up, the key can be taken on-air using the transition button on the Keyers Module, or using the Transition Module.

For More Information...
   • on performing transitions, refer to the section “Performing Transitions” on page Ops 5-13.
   • on setting up the AuxKey option, refer to the section “AuxKeys” on page Eng 8-26.
Key Modifiers

In This Chapter

This chapter provides information on modifying keys with masks, borders, or 2D DVE effects. The following topics are discussed in this chapter:

- DVE Keys (Fly Key)
- 2D DVE Keys
- Squeeze & Tease DVE Key
- DVE Channel Management
- Frontside/Backside Video (Squeeze & Tease DVE Only)
- XFX Borders
- Key Trails
- Split Keys
- Key Masks
- Defaulting
DVE Keys (Fly Key)

The Fly Key function is used by both the 2D DVE and Squeeze & Tease DVE to apply 2D, or 3D video effects to a key. The Fly Key can be applied to any key type, but will use a different number of DVE channel resources depending on the type of key (video plus alpha).

Keep the following in mind when working with DVE keys:

- You can fly any type of key.
- You can fly any combination of keys in an MLE.
- You cannot fly a MultiDSK Keyer (MultiDSK option) on any switcher, or Downstream Keyer (Mix/DSK option) on the half MLE (PGM/PST) in a Half MLE switcher.
- **Self Keys, Auto Select Keys, and Chroma Keys** require 2 DVE channel resources (from the same channel card for 3D DVE) to fly. One channel for the fill and another for the alpha.
- To use a Preset Pattern Key without the Fly Key mode, press **FLY KEY** to disable the mode and display the **PST Key Setup Menu**.
- If **PST PATT** is already on and the **Fly Key** mode is off, pressing **PST PATT** again will not automatically enable **Fly Key**.
- If **FLY KEY** is enabled, changing the key type to **Self Key, Auto Select**, or **Chroma Key** automatically turns the **Fly Key** mode off and switches to the selected keying mode.
- **Advanced Picture Frame Borders** can only be applied to **Preset Pattern Keys** for Squeeze & Tease DVE keys.
- If Key 4 is in **Internal Mode**, only a single DVE channel is available (2D DVE only).
- A Color Background (**BKGD1** or **BKGD2**) cannot be assigned to channel 2 of a DVE key.
- The MLE and Keyer that a DVE menu is assigned to are shown at the top of the menu.
- Color Correction does not work on the second channel of a DVE key when using key combiner.
2D DVE Keys

The resources for the 2D DVE keys are provided from the Video Processor Board (480AR-043). Picture Frame Borders can be applied to any key type. When applied to a Chroma Key, Self Key, or Auto Select Key, the following limitations apply:

- Softness is not applied when the border size is 0.
- Size crops the key when softness is 0.
- Softness only applies inside the key.

Operating Tip — The DVE Menu button on all of the DVE menus allows you to quickly navigate between the different DVE menus.

For More Information...

- on XFX Borders, refer to the section “XFX Borders” on page Ops 8-15.

To Set Up a 2D DVE Fly Key

As you adjust the DVE key, the images on the DVE Position/Crop Menu update to show you how the key is being changed.

1. Set up the desired key type and source. If you select a Preset Pattern (PST PATT) key, the switcher will automatically fly the key.
2. On the Keyers Module, select the Keyer you want to fly and press FLY KEY.
4. Use the X Location and Y Location knobs, or the positioner, to adjust the location of the DVE key.
   - X Location — move the key from side to side.
   - Y Location — move the key up or down.
5. Use the Size knob, or twist the positioner, to adjust the size of the DVE key.
6. Press Aspect and use the X Aspect and Y Aspect knobs, or the positioner, to adjust the aspect ratio of the DVE key.
• **X Aspect** — stretch or shrink the key horizontally.
• **Y Aspect** — stretch or shrink the key vertically.

7. Press **More**.

8. Press **Crop Horizontal** and use the **Left Edge, Right Edge**, and **Both** knobs, or the positioner, to adjust the cropping of the left and right sides of the DVE key.
   • **Left Edge** — crop the left side of the key.
   • **Right Edge** — crop the right side of the key.
   • **Both** — crop both the left and right sides of the key.

9. Press **Crop Vertical** and use the **Top Edge, Bottom Edge**, and **Both** knobs, or the positioner, to adjust the cropping of the top and bottom sides of the DVE key.
   • **Top Edge** — crop the top side of the key.
   • **Bottom Edge** — crop the bottom side of the key.
   • **Both** — crop both the top and bottom sides of the key.

10. Press **Transparency** and use the **Transparency** knob, or the positioner, to adjust the transparency of the DVE key.

---

**To Apply a Picture Frame Border to a 2D DVE Key**

The Picture Frame Borders for 2D DVE keys do not support styles (**Style**) at this time.

---

**Operating Tip** — *The size of the border should be set first in order to adjust the appearance of the border.*

1. Navigate to the DVE menus for the DVE key you want to apply the border to and press **DVE Menu ➔ Border**.

2. Press **Size** and use the **Size** knob, or the positioner, to adjust the size of the border. In the size area, the dotted line is the edge of the key and the blue line is the thickness of the border.

3. Use the **Softness** knob, or the positioner, to adjust the softness of the edges of the border.

   Softness is applied to the inner and outer edges of the key as well as the border. If the border size is 0, the softness is applied to the outer edges of the key.

   In the Softness area, the dotted line is the edge of the key and the gradient at the bottom is showing the amount of softness, or fading, applied to the border.
4. Press **Color** and select the color you want to use for the border. You can select the color in the RGB or HSL color space.
Squeeze & Tease DVE Key

The resources for the Squeeze & Tease DVE keys are provided from the Squeeze & Tease Carrier board. The available channel resources depends on the number of channel cards installed.

For More Information...
- on XFX Borders, refer to the section “XFX Borders” on page Ops 8-15.

To Set Up a Squeeze & Tease DVE Key

As you adjust the DVE key, the images on the S&T MD Position/Crop Menu update to show you how the key is being changed.

1. Set up the desired key type and source. If you select a Preset Pattern (PST PATT) key, the switcher will automatically fly the key.

2. On the Keyers Module, select the Keyer you want to fly and press FLY KEY.


4. Use the X Location, Y Location, and Z Location knobs, or the positioner, to adjust the location of the DVE key.
   - X Location — move the key from side to side.
   - Y Location — move the key up or down.
   - Z Location — move the key towards or away from the screen.

5. Set the pivot point location for the rotation of the DVE key
   - Pivot Presets — press Pivot Presets and use the middle knob to select the pivot point location you want to use.
   - Pivot Location — press Pivot Location and use the X Location, Y Location, and Z Location knobs, or the positioner, to adjust the location of pivot point location.

6. Press Rotation and use the X Rotation, Y Rotation, and Z Rotation knobs, or the positioner, to adjust the rotation of the DVE key around the pivot point.
   - X Rotation — rotate the key horizontally around the y-axis.
   - Y Rotation — rotate the key vertically around the z-axis.
   - Z Rotation — rotate the key around the z-axis.
7. Press **Aspect** to toggle it on (**On**) and use the **X Aspect**, **Y Aspect**, and **Size** knobs, or the positioner, to adjust the aspect ratio of the DVE key.
   - **X Aspect** — stretch or shrink the key horizontally.
   - **Y Aspect** — stretch or shrink the key vertically.
   - **Size** — stretch or shrink the key both horizontally and vertically with a fixed aspect ratio.

8. Press **More**.

9. Press **Crop Horizontal** and use the **Left Edge**, **Right Edge**, and **Left & Right Edge** knobs, or the positioner, to adjust the cropping of the left and right sides of the DVE key.
   - **Left Edge** — crop the left side of the key
   - **Right Edge** — crop the right side of the key
   - **Left & Right Edge** — crop both the left and right sides of the key

10. Press **Crop Vertical** and use the **Top Edge**, **Bottom Edge**, and **Top & Btm Edge** knobs, or the positioner, to adjust the cropping of the top and bottom sides of the DVE key.
    - **Top Edge** — crop the top side of the key
    - **Bottom Edge** — crop the bottom side of the key
    - **Top & Btm Edge** — crop both the top and bottom sides of the key

11. Press **Transparency** to toggle it on (**On**) and use the **Transparency** knob, or the positioner, to adjust the transparency of the DVE key.

12. Toggle **Freeze** to freeze (**On**) or unfreeze (**Off**) the DVE key. You can freeze the video of the DVE key. When a DVE key is frozen, only the video in the key is frozen.

13. Press **Advanced Positioning**.
14. Press Spin and use the X Spin, Y Spin, and Z Spin knobs, or the positioner, to rotate a key in 3D space relative to the fixed reference frame of the screen, as opposed to a Pivot Point on the key itself.
   • X Spin — spin the key around the X-Axis of the screen.
   • Y Spin — spin the key around the Y-Axis of the screen.
   • Z Spin — spin the key around the Z-Axis of the screen.

15. Press Viewpoint and use the X Location, Y Location, and Z Location knobs, or the positioner, to change the perspective, or point-of-view, of the key on the screen. This can be used to create an effect where the channel appears to have a different vanishing point.
   • X Location — move the viewpoint left or right along the X-Axis.
   • Y Location — move the viewpoint left or right along the Y-Axis.
   • Z Location — move the viewpoint left or right along the Z-Axis.

16. Press Locate and use the X Locate, and Y Locate knobs, or the positioner, to move the key and viewpoint together. This is used when you want to move the key without changing its appearance or shape. The apparent angle of the key will be the same, so there is no change in perspective when the key is moved in 3D space.
   • X Locate — move the viewpoint and key right or left along the X-Axis.
   • Y Locate — move the viewpoint and key right or left along the Y-Axis.

For More Information...
   • on working with sequences, refer to the section “Using DVE Wipes and Sequences” on page Ops 14-14.

To Apply a Picture Frame Border to a Squeeze & Tease DVE Key

Operating Tip — The size of the border should be set first in order to adjust the appearance of the border.

1. Press the SEL button on the Keyers Module for the Keyer that you want to adjust the border size of the channel for. The key must already be flying.

2. Press the DVE quick navigation button to display the S&T MD Main Menu.
3. Press **Border**.

4. Press **Size** and use the **Size** knob, or the positioner, to adjust the size of the border. In the size area, the dotted line is the edge of the key and the blue line is the thickness of the border.

5. Use the **Softness** knob, or the positioner, to adjust the softness of the edges of the border.

   Softness is applied to the inner and outer edges of the key as well as the border. If the border size is 0, the softness is applied to the outer edges of the key.

   In the Softness area, the dotted line is the edge of the key and the gradient at the bottom is showing the amount of softness, or fading, applied to the border.

6. Use the **Symmetry** knob, or the positioner, to adjust the border symmetry.

   Symmetry alters the center position of the key border. As you adjust the symmetry, the relative center of the border expands outward from the actual center of the border.

   In the Softness area, the dotted line is the edge of the key and the lines show a cross section of the border and the symmetry.

7. Press **Style** and use the **Texture** and **Corners** knobs to select the style of the border.

   - **Texture** — select the texture of the border, including the number of colors used.
   - **Corners** — select the style of the corner.

8. Press **Advanced** and use the **Edge Trnsp** and **Interior Trnsp** knobs, or the positioner, to adjust the level of transparency of the outer and inner edges of the border and the level of transparency of the center of the border.

   - **Edge Trnsp** — adjust the transparency of the outer and inner edges of the border. As you adjust the Edge Transparency, the sides of the border profile move up or down.

   Operating Tip — If you adjust the Interior Transparency to the same level as the Edge Transparency, the resulting border is evenly transparent.

   - **Interior Trnsp** — adjust the transparency of the center of the border. As you adjust the Interior Transparency, the center of the border profile moves up or down.

9. Press **Color** and select the color you want to use for the border.

   Depending on the texture selected, the border could use between one and three colors (**Edit Color 1**, **Edit Color 2**, and **Edit Color 3**). You can select the colors in the RGB or HSL color space.
DVE Channel Management

You can assign additional channels to each key as long as there are sufficient DVE channel resources available. These additional channels can have different sources and positions, but must be the same key type and be in the same keyer. The channels in this combined key can be manipulated separately or together.

To manipulate both channels together, you can select both channels at the same time. Both channels can be selected when using any of the 3D tools such as crop, position, or rotation. If the channels selected have different values, for example, different positions in 3D space, the menu indicates that the values are different and no position, rotation, or cropping coordinates are displayed. The selected channel is highlighted on the Channel button.

2D DVE Channel Management

Up to two channel resources are dedicated to each key. This allows you to fly a key, or combine two preset pattern keys in the keyer. Preset pattern keys only use a single DVE channel resource and all other key types use two.

To Assign a Channel to a Keyer

You can assign multiple channels to the same keyer and selecting which is on top. Channels can also be locked together so that they move as a single object. You can choose to work with all channels simultaneously, or individually.

1. Navigate to the DVE menus for the DVE key you want to apply the border to and press DVE Menu ⇒ Channel Management.

Operating Tip — You can also press CHNL MGMT on the Keyers Module to navigate to the Channel Management Menu.

2. In the Channel Activation area, press Channel 1, Channel 2, or Both Channels to select the channels that you want to turn on.
   - Channel 1 — only turn channel 1 on.
   - Channel 2 — only turn channel 2 on.
   - Both Channels — turn both channels on.

3. In the Layering area, press Chan 1 On Top or Chan 2 On Top to select which channel is on top. The Automatic and Intersecting options are not available at this time.
• Chan 1 On Top — channel 1 is always on top of channel 2.
• Chan 2 On Top — channel 2 is always on top of channel 1.

Squeeze & Tease DVE Channel Management

The Channel Resources, in the upper left corner of the menu, shows the number of Squeeze &
Tease Channel Resources available to the MLE-pair. The channel resources provided by a single
Squeeze & Tease Carrier Board can be shared between both MLEs in the pair, or set to each one.

The Channel listing, on the Channel button, shows the Squeeze & Tease Channel that is active
in the Keyer. Squeeze & Tease Channels can require one or more Channel Resources, depending
on the type of key that is being used.

For More Information...
• on Squeeze & Tease channel resources hardware, refer to the section “Squeeze & Tease”
on page Eng 2-27.
• on fixed and floating Squeeze & Tease resources, refer to the section “Squeeze & Tease
Mode” on page Eng 12-6.

To Assign a Channel to a Keyer

You can assign multiple channels to the same keyer, allowing the channels to intersect with each
other and be locked together so that they move as a single object. You can choose to work with all
channels simultaneously, or individually.

1. Set up your first fly key in the Keyer. This is the first channel, indicated by the red 1 on
the Channel button on the S&T MD Position/Crop Menu 1-2.

Operating Tip — You can also press and hold the key type button and press the FLY KEY
button on the Keyers Module to add a channel to the Keyer.

2. Press CHNL MGMT on the Keyers Module to display the Channel Management
Menu 1-2.
3. Toggle the Channel 2 button to On to assign a second channel to the Keyer.

4. Use the Layering knob to select how you want the channel to layer in the Keyer. You can choose between the following:
   - **Auto** — Channel layering is determined based on the position, or depth, of each channel in 3D space. This is the default setting.
   - **Intersecting** — Both channels intersect. This allows you to have one channel slice through the other (Figure 8.1).

   **Note** — Using the **Intersecting** option with planes that are almost parallel to each other, or with planes that have Aspect applied, may not produce the desired effect.

   - **Chan 1 On Top** — Channel 1 always appears in front of Channel 2.
   - **Chan 2 On Top** — Channel 2 always appears in front of Channel 1.

5. Press the lit SEL button on the Keyers Module to display the S&T MD Position Crop Menu 1-2.

6. Press the Channel button to highlight channel 2. The number 2 appears red.

7. Set up your second fly key channel in the Keyer. You can switch back and forth between Channels by pressing the Channel button.

   **Operating Tip** — If you toggle the FLY KEY button Off, the channel that was assigned to the Keyer will be released and available for use.
Frontside/Backside Video (Squeeze & Tease DVE Only)

Normally, when you rotate a flying key around to expose the backside, the video image shows as a backwards representation of the displayed video signal (as if the backside of the key was transparent). For a different effect, you may wish to have the back side of a flying key display a different image than the front side.

1. Press CHNL MGMT on the Keyers Module to display the Channel Management Menu 1-2.
3. Select the channel that you want to activate the Frontside/Backside video for as follows:
   • Toggle the Channel 1 or Channel 2 button to On to activate the backside video for that channel.

   [Image: Channel Management Menu 2-2]

4. Select a video source for the backside video as follows:
   • Use the Front knob to select the crosspoint for the front side.
   • Use the Back knob to select the crosspoint for the back side.
5. Select an Auto Flip mode as follows:
   • Use the Auto Flip knob to automatically flip the backside video when the image is rotated. If you rotate an image so that the back is visible, the video appears backwards. You can choose between the following:
     › None — The backside video appears backwards when the image is rotated.
     › H Flip — The video is flipped horizontally.
     › V Flip — The video is flipped vertically.
     › H-V Flip — The video is flipped both horizontally and vertically.

Frontside/Backside Video and S&T Wipes and Sequences

When running a Squeeze & Tease Wipe, or Sequence, any Frontside/Backside and Auto Flip information contained in the wipe or sequence is not recognized. In order to run Frontside/Backside and Auto Flip effects with a wipe or sequence, the effects must be applied to the wipe or sequence when it is loaded.

Note — The Frontside/Backside Video feature cannot be used with background Squeeze & Tease Wipes.
1. Load the Squeeze & Tease Wipe or Sequence.

2. Navigate to the Channel Management Menu as follows:
   - Press CHNL MGMT on the Keyers Module to display the Channel Management Menu 1-2.
   - Press More.

3. Set up the Frontside/Backside and Auto Flip functions as required.

4. Run the Squeeze & Tease Wipe or Sequence. The Squeeze & Tease Wipe or Sequence will use the selected Frontside/Backside and Auto Flip settings.
XFX Borders

The XFX Dual Border Generator option allows you to add an independent border to any key type on the switcher. This border can surround the key, or appear as a detached shadow behind the key. Borders can also be adjusted for width, color, and transparency.

The XFX features are provided by the XFX Extra Effect Cards on the 4800AR-040 and 4800AR-041 Video Processor Boards, but is built into the 4800AR-043 Video Processor Board.

**Note** — You cannot apply a Pattern Border and an XFX Border to the same key. You must turn off the XFX Border in order to be able to turn on the Pattern Border. The Pattern Border turns off automatically when you apply an XFX Border.

1. Press the BORDER ON button on the Keyers Module to display the Border Menus. If you do not have enough XFX Border resources available, the message XFX MD Border Feature Off (unavail) appears on the menu.

2. Use the Border Mode knob on the Border Menu to select the type of border you want to apply to the key. You can choose between the following:

**Note** — Only one Border, Shadow, Outline, or Trail can be active at the same time for a given Keyer. If you select one, any others are automatically toggled off.

- **Border** — Select this border mode to apply a standard border to the selected key. The border can surround the key, or it can appear as a drop shadow that is offset to any distance or direction.
- **Shadow** — Select this border mode to apply a drop shadow to the selected key. The shadow appears as a drop shadow that is offset to any distance or direction.
- **Outline** — Select this border mode to apply an outline to the selected key. In Outline Mode, the fill for the selected key is completely transparent.
- **Trails** — Refer to the section “Key Trails” on page Ops 8-17 for information on Trails.


**Note** — If you are using Shadow Mode, there is no Size knob, or adjustment, on the Border Menu. Only Border Mode and Outline Mode have the size adjustment.
- Use the **Size** knob, or twist the positioner, to adjust the size of the border.

4. Press **Glow/Density**.

![Glow/Density — Border Menu](image)

- Use the **Glow** knob to adjust the softness of the edges of the border.
- Use the **Density** knob to adjust the transparency of the border.

5. Apply the ghost effect to the border as follows:

- Toggle **Ghost** to **On** to remove the key from the video signal, but keep the border.
  Unlike Outline, Ghost does not mask out the portion of the border that is behind the key.

---

**Operating Tip** — You can adjust the matte or wash color of the border by pressing **Border Matte** on the **Border Menu**.

If you make changes to the border and then turn it off for a particular Keyer, the settings are retained for when you turn it back on again.

**For More Information**...

- on Key Trails, refer to the section “**Key Trails**” on page Ops 8-17.
- on adjusting the matte or wash color of the border, refer to the section “**Washes and Mattes**” on page Ops 6-11.
Key Trails

The XFX Dual Border Generator option allows you to add trail effects to any key type on the switcher. Trail effects include Soft, Hard, Key, and Key Smear trails. Soft and Hard trails apply to the video in the key, and Key and Key Smear trails apply to the key itself. In the case of a shaped key, the trails are only visible within the key itself if a Soft or Hard Trail is used. Select a Key or Key Smear Trail if you need the trails to appear outside of the key.

**Important** — All Key Trails cause a one (1) frame delay in the keyer that the trails are turned on for.

**Note** — You cannot apply a Key Trail and an XFX Border to the same key. The XFX Border turns off automatically when you apply a Key Trail.

Soft Trails

Soft Trails applies a transparency to all moving objects in the shot with a decaying image behind the motion (Figure 8.2). Soft Trails are best applied to a stationary background with moving elements in the foreground.

![Figure 8.2 Soft Trails](image)

1. Press the **BORDER ON** button on the **Keyers Module** to display the **Border Menus**.
2. Use the **Border Mode** knob to select **Trails**.
3. Use the **Trails Mode** knob to select **Soft**.
4. Press **Decay**.

- Use the **Decay Rate** knob to adjust the amount that the trail fades each frame. If the decay rate is set to **0.0%**, the trail does not decay, and the image becomes static.
Hard Trails

Hard Trails applies a decaying image behind the motion with no transparency applied to the moving object (Figure 8.3). Hard Trails uses the brightness (luminosity) of the moving object to calculate the trails. To adjust this, you can use the Luminance Threshold and Luminance Range to separate the moving object from the background.

Hard Trails are best applied to a stationary background with moving elements in the foreground.

![Figure 8.3 Hard Trails](image)

**Operating Tip** — For the best results, the moving objects in the video that you want to apply trails to should be brighter than the background.

1. Press the **BORDER ON** button on the **Keyers Module** to display the **Border Menus**.
2. Use the **Border Mode** knob to select **Trails**.
3. Use the **Trails Mode** knob to select **Hard**.
4. Press **Decay/Threshold**.

**Hard Trails — Border Menu**

- Use the **Decay Rate** knob to adjust the amount that the trail fades each frame. If the decay rate is set to 0.1%, the trail decays very slowly, and the image becomes static. If the decay rate is set to 0.0%, no trail is created.

**Operating Tip** — Use the luma threshold to select the part of the video that you don't want trails applied to, the background for example. Use the luma range to adjust for variations in the background that you don't want trails applied to.

- Use the **Luma Thresh** knob to adjust for the parts of the video that trails are applied to. Pixels that are brighter or darker than the Luma Thresh, and not within the Luma Range, are used for creating trails. If the luma threshold is set to 0.0% (black) only the brightest pixels are used for creating trails.
Key Trails

Key Trails applies a decaying image behind the key, using the alpha, leaving the key video unaffected. The trail can use either the source video for the trail, or a matte color.

Note — You must be flying a key to properly use the Key Trails feature. If you are not flying a key, the trail effect may not be visible.

1. Press the BORDER ON button on the Keyers Module to display the Border Menus.
2. Use the Border Mode knob to select Trails.
3. Use the Trails Mode knob to select Key.
4. Press Decay.

Key Trails — Border Menu

- Use the Decay Rate knob to adjust the amount that the trail fades each frame. If the decay rate is set to 0.0%, the trail does not decay, and the image becomes static. If the decay rate is set to 100.0%, the trail becomes transparent.
- Use the Decay To knob to select the type of decay that is used. You can choose between the following:
  - Video — Select this option to use the video content of the key to create the trail.
  - Color — Select this option to apply a color tint to the trail. The trail appears to decay from the video image through the selected matte color. Use the Decay Color Menu to select the specific color you want to use.
5. Press Decay Color.
Color Selection

**Note** — If the Matte Limit feature is active, the RGB color space is not available. You will only be able to make color selection in the HSL color space. Refer to the section “Personality List” on page Eng 11-2 for more information.

- Select the color you want to use for the trail using the knobs, positioner, or by selecting a point on the Color Wheel.

### Key Smear Trails

Key Smear Trails applies a decaying image in front of the key, using the alpha. Unlike Key Trails, the Key Smear Trails places the trail on top of the key video, causing it to appear smeared.

**Note** — You must be flying a key to properly use the Key Trails feature. If you are not flying a key, the trail effect may not be visible.

1. Press the BORDER ON button on the Keyers Module to display the Border Menus.
2. Use the Border Mode knob to select Trails.
3. Use the Trails Mode knob to select Key Smear.
4. Press Decay.

**Key Smear Trails — Border Menu**

- Use the Decay Rate knob to adjust the amount that the trail fades each frame. If decay rate is set to 0.0%, the trail does not decay, and the image becomes static. If the decay rate is set to 100.0%, the trail becomes transparent.
- Use the Decay To knob to select the type of decay that is used. You can choose between the following:
Video — Select this option to use the video content of the key to create the trail.

Color — Select this option to apply a color tint to the trail. Because the trail is applied on top of the video, the video appears to be tinted by the matte color. Use the Decay Color Menu to select the specific color you want to use.

5. Press Decay Color.

Note — If the Matte Limit feature is active, the RGB color space is not available. You will only be able to make color selection in the HSL color space. Refer to the section “Personality List” on page Eng 11-2 for more information.

• Select the color you want to use for the trail using the knobs, positioner, or by selecting a point on the Color Wheel.
Split Keys

A Split Key allows you to assign a different alpha source for a key than the alpha/fill associations that are set up during installation, or the alpha sources that are selected by the key type. Split Keys are typically used for creative montages and for keying moving video inside key shapes.

All split key assignments are temporary and will revert back to the original setup if any other source on the crosspoint bus is selected, unless stored in a memory.

Performing a Split Key

1. Set up your key as usual.
2. Ensure that the Keyers Module is assigned to the Keyer that you want to perform the split key on.
3. Press and hold the AUTO SELECT (or SELF KEY) button on the Keyers Module.
4. Select the video source that you want to use as the new alpha on the key bus.
5. Release both buttons.
6. Fine tune the key as required. Refer to the section “Auto Select Key” on page Ops 7-9 for more information on adjusting an Auto Select key or refer to the section “Self Key” on page Ops 7-7 for more information on adjusting an Auto Select key.
Key Masks

Three types of masks are available, Box masks, Utility Bus masks, and Pattern masks. All key types can be masked, with the exception on Pattern masks, which cannot be applied to Preset Pattern Keys.

All mask types are set up from the Mask Setup Menu. From this menu you can select the type of mask you want to use, as well as adjusting various mask parameters.

Box Masks

The Box Mask uses a simple box shape to mask the key. The box mask can be adjusted for size and location, but cannot be rotated.

1. Press the MASK button on the Keyers Module.
2. Press Box Mask.

3. Adjust the position and size of the mask as follows:
   • Press Posn/Size.
   • Use the knobs or positioner to adjust the position and size of the mask.

4. Adjust the shape of the mask as follows:
   • Press Top/Left.
   • Use the knobs or positioner to adjust the location of the top-left corner of the mask.
   • Press Bottom/Right.
   • Use the knobs or positioner to adjust the location of the bottom-right corner of the mask.

5. Toggle Force to On to force the masked area of the image on screen.

6. Toggle Invert to On to reverse the mask. The portion of the image that was masked out is now visible, and the portion that was visible is masked.

Pattern Mask

The Pattern Mask uses a pattern to mask the key, rather than a box. The pattern mask can be adjusted for size, location, rotation, and multiplication.

1. Press the MASK button on the Keyers Module.
2. Toggle Force to On to force the masked area of the image on screen.
3. Toggle **Invert** to **On** to reverse the mask. The portion of the image that was masked out is now visible, and the portion that was visible is masked.

4. Press **Pattern Mask**.

5. Select the pattern you want to use on the **Pattern Mask Selection Menu**. You can also use the keypad on the memory module to select the pattern button number (**#xx**).

6. Use the positioner to adjust the position and size of the mask.

7. Press **Modify Pattern**.

8. Use the **Softness** knob to adjust the softness of the edge of the pattern.

9. Adjust the pattern parameters (**Rotation**, **H-Mult**, **V-Mult**, and **Aspect**) as required. Refer to the section “**Pattern Parameters**” on page Ops 6-5 for more information.

**For More Information...**

- on the number of pattern generators available for masks, refer to the section “**Pattern Generators**” on page Ops 6-2.

**Utility Mask**

The Utility Mask uses a video source selected on utility bus one as the mask.

---

**Note** — Depending on the Key 4 Mode that is selected, Key 4 may not have access to a Utility Bus for the mask, or may only have access to MLE-Stores on the Utility Bus.
1. Press the **MASK** button on the **Keyers Module**.

2. Press **Utility Bus Mask**.

3. Use the **Utility Bus 1 Xpt** knob, or select the video source on the Utility Bus that you want to use for the mask. Refer to the section “Selecting a Key or Utility Bus” on page Ops 4-8 for more information on selecting a Utility Bus.

4. Toggle **Force** to **On** to force the masked area of the image on screen.

5. Toggle **Invert** to **On** to reverse the mask. The portion of the image that was masked out is now visible, and the portion that was visible is masked.

**For More Information...**

- on Key 4 mode, refer to the section “**Key 4 Mode**” on page Eng 12-8.
- on setting a Key 4 Flexi mode, refer to the section “**Selecting an MLE Mode**” on page Ops 4-10.
Defaulting

To return a specific DVE Position/Crop parameter to its default settings, press and hold the indicated button on the menu, and press the CLEAR button on the Positioner Module.

- **Position** + CLEAR — Returns the selected channel to the default position (0, 0, 0).
- **Rotation** + CLEAR — Returns the selected channel to the default rotation (0, 0, 0).
- **Pivot Preset** + CLEAR — Returns the selected channel to the default pivot preset (Center).
- **Pivot Position** + CLEAR — Returns the selected channel to the default pivot position (0, 0, 0).
- **Aspect** + CLEAR — Returns the selected channel to the default aspect ration (1, 1, 1) and turns Aspect off.
- **Crop Horizontal** + CLEAR — Returns the selected channel to the default horizontal cropping (0, 0).
- **Crop Vertical** + CLEAR — Returns the selected channel to the default vertical cropping (0, 0).
- **Transparency** + CLEAR — Turns transparency off.
- **Freeze** + CLEAR — Turns freeze off.
- **Spin** + CLEAR — Returns the selected channel to the default spin setting.
- **Viewpoint** + CLEAR — Returns the selected channel to the default viewpoint (0, 0, 0).
- **Locate** + CLEAR — Returns the selected channel to the default location.

To return a specific Border parameter to its default settings, press and hold the indicated button on the menu, and press the CLEAR button on the Positioner Module.

- **Size** + CLEAR — Turns the border off.
- **Style** + CLEAR — Returns the border to the default style.
- **Advanced** + CLEAR — Returns the border to the default interior and exterior edge transparency.

*For More Information...*

- on using the positioner to default a parameter, refer to the section “Using the Positioner” on page Ops 4-37.
Memory Functions

In This Chapter

This chapter provides information on using the memory system on the Vision switcher, as well as storing and recalling memories, files, and setups.

The following topics are discussed in this chapter:

- Memory System
- Storing and Recalling Memories
- MLE Memory Attributes
- Effects Dissolve
Memory System

The Memory Modules on the Vision switcher (Figure 9.1) are used to store and recall switcher memory registers. There are two types of memory modules on the switcher, the Effects Memory Modules that are assigned to particular panel row, or MLEs, and the Global Memory Module that can store and recall memories on any, or all, panel rows.

**Figure 9.1** Vision 3 Memory Modules (4-Keyer Shown)

In addition to storing and recalling memories, the memory modules on the switcher are used to set MLE and Key transition rates, control Effect Dissolves, and set how memories are recalled.

**Effects Memory Modules**

The Effects Memory Module (Figure 9.2) of the upper panel rows are dedicated to the panel row, or MLE that they are assigned to. This allows you to quickly store and recall memories for that particular MLE.

**Figure 9.2** Effects Memory Module

In addition to storing and recalling memories, the Effects Memory Module allows you to set the Effects Dissolve, MLE Transition, and Key Transition rates for the MLE. Each module consists of a display, a numeric keypad, and function buttons on either side of the keypad.
Display

The display on the Effects Memory Module shows the current memory that is active for the module, as well as the MLE and Key rates for the panel row.

![Display of Memory System](image)

In the example shown (Figure 9.3), the active memory register (REG) is 351. This corresponds to Memory 1, on Bank 35.

The second line of the display shows the current MLE and Key rates, in frames. In this example, the MLE, or background transition, Rate is set to 15, and the Key Rate is set to 8.

Store and Recall Buttons

The Store and Recall buttons on the Effects Memory Module allow you to select whether you want to store a memory, or recall one. When working with either of these buttons, you can use the Keys Only and Effects Dissolve buttons to apply these effects. These buttons are as follows:

- **STOR** — The Store button allows you to use the keypad to enter the number of the memory register where you want to store a memory.
- **RECL** — The Recall button allows you to use the keypad to enter the number of the memory register you want to recall.
- **KEYS ONLY** — The Keys Only button allows you to recall a memory on a panel row that does not include the Program and Preset bus selection. Only the keyer selections are recalled. The Global-Store image selections stored in the memory are not loaded if the Recall Global-Store personality option is set to Attribute.
- **EFF DISS** — The Effects Dissolve allows you to have the keys from one memory slew into the keys from the one you are recalling.

Rate Buttons

The three rate buttons on the right side of the module allows you to set the various transition and effects rates for the panel row, or MLE. These buttons are as follows:

- **EFF RATE** — The Effects Rate button allows you to set a new effects dissolve rate for the panel row.
- **MLE RATE** — The MLE Rate button allows you to set a new background transition rate for the panel row. If the panel row is assigned as an AuxKey, this rate will be the background transition rate for the AuxKey.
- **KEY RATE** — The Key Rate button allows you to set a new keyers transition rate for the panel row. If the panel row is assigned as an AuxKey, this rate will be the keyer transition rate for the AuxKey.
Global Memory Module

The Global Memory Module (Figure 9.4) of the bottom, Program/Preset MLE allows you to store and recall memories on any MLE on the switcher.

![Global Memory Module](image)

In addition to storing and recalling memories, the Global Memory Module allows you to set the Effects Dissolve, Fade to Black, MLE Transition, and DSK Transition rates for the MLE. Each module consists of a display, a numeric keypad, and function buttons on either side of the keypad.

Display

The display on the Global Memory Module shows the current memory that is active for the module, as well as the MLE and Key rates for the panel row.

![Global Memory System Display](image)

In the example shown (Figure 9.5), the active memory register (REG) is 124. This corresponds to Memory 4, on Bank 12.

The second line of the display shows the current MLE, DSK, and Fade rates, in frames. In this example, the MLE, or background transition, Rate is set to 15, the DSK Rate is set to 8, and the Fade to Black Rate is set to 20.

Store and Recall Buttons

The Store and Recall buttons on the Global Memory Module allow you to select whether you want to store a memory, or recall one. When working with either of these buttons, you can use the Keys Only and Effects Dissolve buttons to apply these effects. These buttons are as follows:

- **STORE ALL** — The ALL button in the Store group allows you to use the keypad to store a memory for all the crosspoint groups, or MLEs, on the switcher.
  - **MLE X** — The MLE buttons located below the ALL button, where X is the number of the MLE, allow you to store a memory to a specific panel row, or MLE.
- **RECALL ALL** — The ALL button in the Recall group allows you to use the keypad to recall a memory for all the crosspoint groups, or MLEs, on the switcher.
  - **MLE X** — The MLE buttons located below the ALL button, where X is the number of the MLE, allow you to recall a memory to a specific panel row, or MLE.
- **+4** — The +4 buttons allows you to select an MLE above MLE 4. When the +4 button is toggled on, the MLE 1 through MLE 4 buttons become MLE 5 through MLE 8 buttons,
respectively. For example, if you want to select MLE 6, toggle the +4 button on, and press MLE 2. Both the MLE 2 and +4 buttons will remain lit.

- **UNDO** — The Undo button allows you to take back, or undo, the last memory recall. This returns the switcher to the state it was in prior to the last memory recall. The Undo button lights up after each memory recall, indicating that the action can be undone. If you perform 10 or more button presses after the memory recall, the Undo button goes out, and the memory can no longer be recalled.

- **RECALL CLIP/CC** — The functionality of the Recall Clip/CC button is set using the CC Global Recall personality option. It allows you to either recall a clip on the selected device using a Clip ID or Clip Number by entering it using the keypad on the Global Memory Module, or run a custom control by entering the bank and custom control number.

- **ATTRIB** — The Attributes button allows you to view the MLE Memory Attributes Menu, or override the attributes stored with the memory. To override attributes, press and hold the ATTRIB button while recalling the memory. Refer to the section “MLE Memory Attributes” on page Ops 9-10 for more information on this menu.

- **KEYS ONLY** — The Keys Only button allows you to recall a memory on a panel row that does not include the Program and Preset bus selection. Only the keyer selections are recalled.

- **EFF DISS** — The Effects Dissolve allows you to have the keys from one memory slew into the keys from the one you are recalling.

### Rate Buttons

The rate buttons on the right side of the module allows you to set the various transition and effects rates (in frames or fields) for the panel row, or MLE. These buttons are as follows:

- **EFF RATE** — The Effects Rate button allows you to set a new effects dissolve rate for the panel row.

- **MLE RATE** — The MLE Rate button allows you to set a new background transition rate for the panel row.

- **KEY RATE** — The Key Rate button allows you to set a new keyers transition rate for the panel row. MultiDSK keyers use an independent transition rate.

- **CLEAR** — The Clean button allows you to clear your current entry. For example, if you are entering a memory register to recall, but then decide not to recall the memory, you can press the Clear button to return the Global Memory Module to the previous state.

*For More Information...*  
- on storing or recalling a memory, refer to the section “Storing and Recalling Memories” on page Ops 9-6.
- on setting transition rates, refer to the section “Transition Rates” on page Ops 5-10.
- on setting effect dissolve rates, refer to the section “Effects Dissolve” on page Ops 9-13.
- on Auto Recall, refer to the section “Personality List” on page Eng 11-2.
- on recalling a clip on a device, refer to the section “Cueing a Clip Using the Keypad” on page Ops 11-7.
Storing and Recalling Memories

A memory register is a snapshot of the current state of a panel row, or MLE, that can include one, or multiple MLEs. Up to 500 memory registers per MLE can be stored and recalled on the switcher. Each of these memory registers can store as little as the information of one MLE, or as much as the current state of the entire switcher, including all MLEs, Aux Buses, and Squeeze & Tease settings.

Memories are stored in groups, or banks, that correspond to the first number in the memory. For example, Memory 319 is Memory 9 in Bank 31. The available slots for memories range from Memory 0 on Bank 00 through to Memory 9 on Bank 49.

Storing Memories

When you store a memory for a panel row, or MLE, you are storing the complete state of that panel row. This includes the current state of all the modules on the MLE, including keyer settings, transition rates, wipe and pattern selections, and crosspoint selections. In addition to the current state of the modules, the current settings for the various keyers, such as chroma key settings, and clip and gain settings, are also stored.

1. Select the panel row, or MLE, that you want to store the memory for. You can choose between the following:

   Note — If you want to store a memory on the Effects Memory Module, press the STORE button on that module to place it in store mode.

   • ALL — Press Store ALL in the Store group on the Global Memory Module to prepare to store the state of all MLEs on the switcher. This stores the current state of each MLE to a memory of the same number on the MLE.
   • MLE X — Press MLE X in the Store group on the Global Memory Module, where X is the number of the MLE, to prepare to store the state of that MLE. You can select multiple MLEs by pressing the MLE X buttons simultaneously.

   Operating Tip — If you want to select an MLE above MLE 4, toggle the +4 button on the Global Memory Module to on, and then press the MLE X button. Both buttons will remain lit.

2. Select the bank that you want to store the memory on as follows:

   • Press and hold the BANK button on the Global Memory Module, or Effects Memory Module.
   • Press the number 0-49 that corresponds to the Bank you want to store the memory on, then release both buttons.

3. Press the number 0-9 that corresponds to the memory register that you want to store the memory in. The selected memory register is shown on the display as REG:XX and the ENTER button lights up.

   Note — If the Auto Recall feature is turned Off, you cannot store or recall the Effects Dissolve or Keys Only setting with a memory.

4. Press ENTER to store the memory. The Change Memory Name is displayed. At this point you can choose to name the memory, or continue working with other memories.
For More Information...

- on using the naming menus, refer to the section “Using the Naming Menus” on page Eng 5-17.
- on locking or unlocking a memory, refer to the section “Locking Memories” on page Ops 9-8.
- on turning the Auto Recall feature on, refer to the section “Personality List” on page Eng 11-2.
- on memory attributes, refer to the section “MLE Memory Attributes” on page Ops 9-10.

Recalling Memories

When you recall a memory for a panel row, or MLE, the existing configuration of that panel row is replaced with the settings stored in the memory.

1. Select the panel row, or MLE, that you want to recall the memory on. You can choose between the following:

   Note — If you want to recall a memory on the Effects Memory Module, press the RECALL button on that module to place it in recall mode.

   - ALL — Press Recall ALL in the Recall group on the Global Memory Module to prepare to recall a memory to all MLEs on the switcher.
   - MLE X — Press MLE X in the Recall group on the Global Memory Module, where X is the number of the MLE, to prepare to recall a memory to that MLE. You can select multiple MLEs by pressing the MLE X buttons simultaneously.

   Operating Tip — If you want to select an MLE above MLE 4, toggle the +4 button on the Global Memory Module to on, and then press the MLE X button. Both buttons will remain lit.

2. Select the bank that you want to recall the memory from as follows:

   - Press and hold the BANK button on the Global Memory Module, or Effects Memory Module.
   - Press the number 0-49 that corresponds to the Bank you want to recall the memory from, then release both buttons.

3. Press the number 0-9 that corresponds to the memory register that you want to recall the memory from. The memory is recalled.

   Note — If the Auto Recall feature is turned Off, you cannot store or recall the Effects Dissolve or Keys Only setting with a memory.

For More Information...

- on locking or unlocking a memory, refer to the section “Locking Memories” on page Ops 9-8.
- on turning the Auto Recall feature on, refer to the section “Personality List” on page Eng 11-2.
- on memory attributes, refer to the section “MLE Memory Attributes” on page Ops 9-10.
Naming and Adding a Description to a Memory

Each memory can be given a descriptive name that appears on the menus and the display on the Global Memory and Effects Memory Modules. The description allows you to add comments to each memory, such as what is included in the memory.

1. Press HOME ⇒ Attributes ⇒ Memories Setup.

2. Use the MLE knob to select the MLE that you want to rename or add a description to.

3. Use the Memory knob to select the memory register on the selected MLE that you want to rename or add a description to.

4. Rename a memory as follows:
   • Press Rename.
   • Enter a new name for the memory.
   • Press Accept New Name.

5. Add a description to a memory as follows:
   • Press Edit Description.
   • Enter a description for the memory.
   • Press Accept.

Operating Tip — Press Copy Description & Name to All MLEs to copy the current description and memory name to the same memory register on all MLEs. You cannot copy the description to a locked memory register.

For More Information...
• on using the naming menus, refer to the section “Using the Naming Menus” on page Eng 5-17.

Locking Memories

The Memory Lock feature allows you to protect memory registers from being changed or deleted. With the memory lock enabled, you cannot overwrite the selected memory register until the memory has been unlocked.

Memory registers can be locked or unlocked either from the menu system, or through the Global Memory Module.

When working with locked memory registers, the following rules apply:
• If you try to store into a locked memory register, the keypad flashes and Memory X LOCKED is shown in the display, along with the MLEs that the memory is locked on. The MLE X buttons also flash, indicating the MLEs that the memory is locked on.
• If you lock a memory register, it is locked for all MLEs on the switcher.
• You can overwrite a locked memory register if you recall all memories from the hard drive or USB flash drive.
• When you recall an individual memory from the hard drive or USB flash drive to a memory register that is locked, you are prompted to overwrite the memory or cancel.
• If you store or recall a memory to the hard drive or USB flash drive, the lock status of the memory is retained.

To Lock A Memory From the Menu System

1. Press HOME ⇒ Attributes ⇒ Memories Setup.
2. Select the memory register you want to lock as follows:
   • Use the MLE knob to select the MLE that you want to lock the memory on.
   • Use the Memory knob to select the memory register on the selected MLE that you want to lock. As you scroll through the memory registers, the lock status of each memory register is indicated.
3. Lock an individual memory register as follows:
   • Toggle Locked to On to lock the selected memory, or Off to unlock the selected memory.
4. Lock or unlock all memory registers on a memory bank as follows:
   • Press Lock Bank to lock all memory registers on the current bank.
   • Press Unlock Bank to unlock all memory registers on the current bank.

To Lock A Memory from the Global Memory Module

1. Press and hold the Store ALL button on the Global Memory Module for a second.
2. Release the button when the Store ALL and Recall ALL buttons both light.
3. Select the Bank and Register for the memory register you want to lock or unlock. The display shows the state, LOCKED or UNLOCKED, of the selected memory register.
4. Press the number corresponding to the memory register to toggle it between locked and unlocked
5. Press ENTER on the Global Memory Module to save your settings.

For More Information...

• on storing or recalling files on the hard drive or USB flash drive, refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4.
MLE Memory Attributes

The MLE Memory Attributes Menu allows you to specify what elements are recalled with the memory, as well as adding effects to memory recalls. These elements include the crosspoint bus, keyer bus, Aux bus, and Global-Store and MLE-Store selections, as well as keyer on-air status, and Transition Module selections.

In addition to setting which sources to recall with the memory, effects such as performing an auto transition after the memory recall or running a custom control after the memory recall, can also be included.

For example, you can use MLE Memory Attributes to have a memory recall a still on Global-Store Channel 3, select that channel on the Preset Bus, and transition it on-air without changing any other sources on the MLE.

To Set Memory Attributes

1. Press HOME ⇒ Attributes ⇒ MLE Attributes.

Operating Tip — You can also press the ATTRIB button on a Memory Module to display the MLE Attributes Setup Menu. The MLE that the Memory Module is assigned to specifies the MLE that the menu is assigned to.


3. Use the MLE knob to select the MLE that you want to set up the MLE attributes for.

4. Select the crosspoint sources that you want to be recalled with the memory as follows:
   - **BKGD/PGM** — Toggle this button on to have the sources selected on the Background/Program bus recalled with the memory. The default is on.
   - **PST** — Toggle this button on to have the sources selected on the Preset bus recalled with the memory. The default is on.
   - **UTIL** — Toggle this button on to have the sources selected on the Utility bus recalled with the memory. The default is on.
   - **Key Y Xpt** — Toggle this button on to have the sources selected on the Keyer bus, where Y is the number of the keyer, recalled with the memory. Keyer parameters such as key type, clip, and gain settings are always recalled with a memory. The default is on.
5. Select the Global-Store or MLE-Store selections that you want to be recalled with the memory as follows:

**Note** — The Recall Global-Store and Recall MLE-Store options must be set to Attributes in order to be able to toggle them on or off from the MLE Memory Attributes Setup Menu. Refer to the section “Personality List” on page Eng 11-2 for information on setting these options.

- **Global-Store** — Toggle a channel on to have the stills or animations selected for that channel recalled with the memory. The default is off for all channels.
- **MLE-Store** — Toggle a channel on to have the stills or animations selected for that channel recalled with the memory. The default is on for all channels.

**Note** — If the still or animation you want to recall in a Global-Store or MLE-Store channel requires an alpha, you must also toggle the associated alpha channel on to have both the video and alpha of the still or animation recalled with the memory.

6. Select the keyer on-air status that you want to be recalled with the memory as follows:

- **Key X On/Off** — Toggle a keyer on to have the on-air status of the keyer recalled with the memory. Keyer parameters such as key type, clip, and gain settings are always recalled with a memory. The default is on.

7. Insert an auto transition after the memory recall as follows:

- Toggle **Run Auto Trans** on to have an auto transition performed after a memory is recalled. Remember to set up the transition in the Transition Module when you store the memory so that the desired transition is performed after the memory is recalled. The default is off.

**Operating Tip** — Press Default Attributes on the MLE Memory Attributes Setup Menu to return the attributes for the selected MLE to the default settings. When the attributes are not at the default settings, the ATTRIB button on the Effects Memory Module lights.

8. Select the Transition Module components that you want to be recalled with the memory as follows:

- Toggle **Next Trans Buttons** on to have the selection of the Next Transition Select buttons recalled with the memory. The default is on.
- Toggle **Transition Area** on to have the Transition Parameter and Transition Type buttons, but not the Fader, Transition or Next Transition Select buttons, recalled with the memory. The default is on.

9. Press **AuxBus**.

![Aux Bus — MLE Memory Attributes Setup Menu](image-url)
10. Toggle a *BnkXAuxY* button on to have the source selected on that Aux Bus recalled with the memory, where *X* is the number of the bank and *Y* the number of the aux. The default is off for all Aux Buses.

11. Press **Custom Control**.

![Custom Control — MLE Memory Attributes Setup Menu](image)

12. Set a custom control to be run after a memory recall as follows:
   - Use the **Bank** knob to select the custom control bank that the custom control you want to run after a memory recall is in.
   - Use the **Macro** knob to select the custom control that you want to run after a memory recall.
   - Toggle **Auto Run Custom Control** on to have the selected custom control run after a memory recall is performed on the selected MLE. The default is off.

To apply these settings to a memory you must set the MLE Memory Attributes and then save the memory. If the MLE Memory Attributes for a memory have not been set, or the memory was stored on an older software version, the default MLE Memory Attributes settings are used.
Effects Dissolve

The Effects Dissolve feature allows you to slew from one memory to another using a memory recall. The switcher will interpolate from the starting memory to the destination memory, creating a smooth, two keyframe effect.

Only elements such as clip level and pattern position can be interpolated in the effects dissolve. Other elements, such as key priority, crosspoint selection, pattern, and next transition data are recalled first, and then the switcher will slew to the recalled memory.

An effects dissolve can be performed on as many elements and MLEs as required, based on the memory that is being recalled.

**Note** — If the Auto Recall feature is turned Off, you cannot store or recall the Effects Dissolve or Keys Only setting with a memory.

To Create an Effects Dissolve

1. Create the first keyframe in your effect. For example, fly a key to create an over the shoulder shot (Figure 9.6).

   ![Source Effect](image1)

   **Figure 9.6** Source Memory — First Keyframe

2. Enter the required transition rate for the MLE you are working on. Refer to the section “Effects Rate” on page Ops 9-14 for more information on setting an effects rate.

3. Store the current effect to a memory location. This will be the first keyframe in the effect.

4. Create the second keyframe in your effect. For example, move the key to the lower right corner of the screen (Figure 9.7).

   ![Destination Effect](image2)

   **Figure 9.7** Destination Memory — Final Keyframe
5. Enter the required transition rate for the MLE you are working on. This is the effects rate for performing an effects dissolve from this memory to another.

6. Store the current effect to a memory location. This will be the final keyframe in the effect.

To play the effect, recall the memories with the effects dissolve on.

---

**Operating Tip** — Recalling another memory while an effects dissolve is in progress causes the effects dissolve to slew to the new final keyframe rather than the original one.

---

**Effects Rate**

The Effects Rate sets the speed at which an effects dissolve will be performed, in frames or fields. If you store an effects dissolve in a memory register, the effects dissolve rate stored with that memory is used. The effects rate of the destination memory is used for any effects dissolve.

You can set a default effects dissolve rate that is used when an MLE, or the switcher, is defaulted. This rate does not override the rate that is stored in the memory.

1. Press **EFF RATE** on the Effects Memory Module, or Global Memory Module, for the panel row, or MLE, that you want to set the effects rate for.

2. Use the keypad in the center of the module to enter the new duration, in frames. The new rate appears on the top line of the display as you enter it (Figure 9.8).

![New Effects Rate](image)

**Figure 9.8 New Effects Rate — Effects Memory Module Display**

3. Press **ENTER** on the Effects Memory Module to accept the new rate.

---

**For More Information...**

- on the default effects dissolve rate, refer to the section “Personality List” on page Eng 11-2.
Still-Store

In This Chapter

This chapter provides information on transferring images to and from the Vision switcher, as well as how to set up and use both the Global-Store™ and MLE-Store™ features.

The following topics are discussed in this chapter:

- Still-Store Overview
- Loading Stills
- Capturing Stills
- Adjusting On-Air Properties
- Still-Store Image Specifications
- Transferring Stills
- Managing Stills
Still-Store Overview

The Vision switcher provides two types of still-stores. The Global-Store™ which provides three, or four still-store channels switcher wide, and the MLE-Store™ option which provides four channels of still-store to the MLE that it is installed on.

- **Global-Store** — The Global-Store consists of three dedicated channels of still-store that are available as inputs to all MLEs and Aux Buses of the switcher. A fourth channel of Global-Store can be enabled from the Personality Menu. All channels can be used independently, or two can be tied together to provide separate fill and alpha channels.

- **MLE-Store** — The MLE-Store consists of four channels of still-store that are available as inputs to the MLE-pair that the XFX Card has been installed for.

Global-Store and MLE-Store come standard with enough RAM for up to 4 seconds of uncompressed 1080i playout or 25 seconds of 480i playout. The number of images increases significantly when smaller images, like logos, are used. Additional images can be loaded from the hard drive when needed.

The following tips and restrictions apply when using the still-store:

- If you are selecting a still for an MLE-Store channel, you must load that still into each MLE-Store individually, if you want it to be available across all MLE-Stores.

- If you know the number of the still you want to load, you can select the crosspoint button mapped to the still-store channel on the MLE, and then enter the still number on the keypad on the Global Memory Module.

- You can clear the still currently loaded into a channel by selecting 0 as the still number you load from the keypad on the Global Memory Module. This is the same as pressing the Eject button.

- If you select an image size that is larger than the current video format, or an image that is positioned so that a portion of the image is off screen, this may corrupt the video output.

- If you are loading an Auto Key into a still-store channel, you must have another still-store channel associated with the current one to load the alpha into.

- Corrupt files are shown with the warning “Not a valid image format” and should be deleted from the switcher.

For More Information...

- on setting up an auto key association with still-stores, refer to the section “Configuring Auto Keys” on page Eng 7-8.

- on enabling the fourth channel of Global-Store, refer to the section “Personality List” on page Eng 11-2.
Loading Stills

The switcher stores all the available still images on the hard drive. When you want to use one of these stills on a still-store channel, you must select the channel, and then load the still into this channel. This loads the still, or animation, into memory so that it is available when you select it.

A thumbnail of the still or animation appears on the menu to help to manage your stills.

1. Press HOME ➔ More ➔ Effects ➔ Still Store.

2. Select the still-store channel you want to load a still into as follows:
   • Use the Location knob to select Global-Store, or the MLE X you want to select a channel on.
   • Use the Channel knob to select the channel you want to load a still into. You can also select the channel box directly by pressing it.

3. Press Select/Manage.

4. Use the Contents knob to select the still, or directory, you want to select. You can also select the still by pressing the icon on the menu. Directories are indicated by a slash (/) at the end of the name.

5. Press Select to select the still and have it loaded.

Operating Tip — A ○ in the upper left corner of the thumbnail indicates that the original image has an alpha associated with it. A ■ in the upper right corner of the thumbnail indicates that the original image is an animation.
Assigning a Default Still

Each still-store channel can have a default still that is loaded automatically when the switcher starts up. This allows you to have the stills that you most commonly use always loaded into the still-store channels when you start the switcher up.

1. Press HOME ➔ More ➔ Effects ➔ Still Store.

2. Load the still you want to set as default into the Global-Store you want it in. This is the channel that the still will be automatically loaded into.

Operating Tip — You can press View Defaults on the Still-Store Menu 2-2 to check what is currently set as the default stills for the Global-Store or MLE-Store channels. Press Reload All Defaults to have all the default stills loaded into the channels.

3. Press Assign as Default to assign the current still as the default for the selected channel.

Viewing/Clearing Still-Store Cache

You can view what still-store images are currently loaded into cache or remove a currently loaded still to free up space. Removing a still from cache does not delete the still.

Operating Tip — You can clear the still currently loaded into a channel by selecting 0 as the still number you load from the keypad on the Global Memory Module, or by pressing Eject on the Still-Store Menu 1-2.

![Still-Store Cache Menu]

2. Use the middle knob to select the still you want to remove from cache. The number, name, dimensions, frames, and size on disk of each still is displayed.

3. Press Remove From Cache to remove the currently selected still from cache.
Capturing Stills

Still images, or short animations, can be created from any video signals available on the main Preview output or Aux Bus output. Captured stills and animations can be of the entire image, or of cropped sections of the image.

Note — You cannot capture a non-synced video source. The capture will time out after 15 seconds.

A Global-Store capture can only be performed from a Global-Store channel.

1. Press HOME ⇒ More ⇒ Effects ⇒ Still Store.
2. Press Capture. The capture button is gray when the switcher is performing the capture.

Global-Store Capture Menu

3. Press Change Directory and navigate to the directory you want to store the capture to.
5. Select the video output to capture from as follows:
6. Press Source.
7. Use the Vid Src knob to select the source video signal that you want to capture. The preview with overlay video output changes to show the selected video source for the capture. A box on the preview overlay shows the selected capture area.
8. Use the Frames knob to select the number of frames you want to capture. The maximum number of frames that you can capture at the current resolution and size is shown on the menu.
9. Use the Alpha Capture knob to select whether you want to capture the alpha of the video signal as an 8-bit alpha channel in the output Targa file.
10. Press Pos/Size and use the knobs or positioner to adjust the position and size of the capture area.
11. Press Top/Left and use the knobs or positioner to adjust the location of the top-left corner of the capture area.
12. Press Bottom/Right and use the knobs or positioner to adjust the location of the bottom-right corner of the capture area.
13. Press More ⇒ Capture to RAM. The still or animation is captured to the selected media-store channel. You can use the channel to preview the captured media item. The name of the capture is shown in red and marked as unsaved until the capture is saved to disk.
Operating Tip — You can adjust the start and end point of a captured animation using the animation properties trim feature.

14. Press Save Capture To Disk.
### Adjusting On-Air Properties

The on-air properties for a still allow you to adjust the position, display mode, and animation attributes of stills and animations.

The on-air properties for Global-Stores are applied to the image or animation directly, regardless of the channels that the image or animation are loaded in. If you adjust the on-air properties, or animation properties, of the still in one channel, these settings are applied to that image or animation in all other channels that the same image or animation is loaded into.

The on-air properties for MLE-Stores are applied to the current image, or animation, that is loaded into the channel. This allows you to load the same image into multiple channels and adjust the on-air properties independent of the other channels. All on-air properties adjustments for a channel are lost when a new image is loaded into that channel.

1. Press **HOME** ➔ **More** ➔ **Effects** ➔ **Still Store**.
2. Load the still you want to set the on-air properties for into a Global-Store or MLE-Store channel. On-air property settings are applied to the still, and not the still-store channel.
3. Press **On-Air Properties**.

![Still-Store Properties Menu](image)

4. Use the knobs or positioner to adjust the position of the still-store image.

   **Note** — You cannot position any portion of an image off-screen, as this may cause video errors. Full screen images cannot have their position adjusted.

5. In the **Video** area, select **Shaped** or **Unshaped** to assign the still-store auto key as either shaped or unshaped.

   **Note** — The **Play Mode** feature is only available for Interlaced video formats. If the native video format that the switcher is operating in is set to a Progressive video format, this knob is not available.

6. In the **Play Mode** area, select how the still-store image is displayed. You can choose between the following:
   - **Frame** — Select this option to have the entire frame of the image displayed.
   - **Swap** — Select this option to have field 1 and field 2 of the image swapped when they are displayed.
   - **Field 1** — Select this option to have only field 1 of the image displayed.
   - **Field 2** — Select this option to have only field 2 of the image displayed.
7. In the **Color Mode** area, select the color space, within the YCrCb color model, that the still-store image will be displayed in. You can choose between the following:

- **BT.601 (SD)** — Select this option to have the still-store image converted to the Standard-Definition color space.
- **BT.709 (HD)** — Select this option to have the still-store image converted to the High-Definition color space.

**Note** — *If you switch video formats between an HD and SD production, and want to use the same still-store images for both, you should select the correct color space for each still, each time you change video formats.*

8. Scale the still as follows:

- In the **Image Scaling** area, set whether the image is scaled to the current resolution the switcher is operating in. Use this option if the image you want to use is of a different resolution than the switcher is operating in.

9. Press **Media Properties** to adjust the properties of an animation.

10. In the **Reverse** area, set whether the animation plays forward or in reverse.

11. In the **Looping** area, set whether the animation will start over when it reaches the last frame of the animation.

12. In the **AutoPlay** area, set whether the animation automatically starts to play when it is taken on-air.

13. In the **Single Frame** area, set whether the animation is restricted to a single frame or not. This feature is only available for Global-Store channels.

14. In the **Play Speed** area, select **On** to enable this feature. This feature is only available for Global-Store channels.

   - Use the **Play Speed** knob to select the speed that you want the animation to play out at.

15. In the **Trim** area, select **On** to enable this feature. This feature is only available for Global-Store channels.

   - Use the **Start Frame** knob to select the frame that you want the animation to start at.
   - Use the **End Frame** knob to select the frame that you want the animation to end at.

*For More Information...*

- on shaped and unshaped auto keys, refer to the section “Assigning Input Source Types” on page Eng 7-4.
Still-Store Image Specifications

Still-store images and animations are transferred to and from the Vision switcher using the WebDAV protocol. Once transferred on to the hard drive of the switcher, the files can be loaded into the Global-Store or MLE-Store of the switcher.

Image Specifications

Still-store images and animations used on the switcher must meet the specifications outlined on the following table (Table 10.1).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Type</td>
<td>• Targa (.tga)</td>
</tr>
<tr>
<td></td>
<td>• Portable Network Graphics (.png)</td>
</tr>
<tr>
<td></td>
<td>• JPEG (.jpg, or .jpeg)</td>
</tr>
<tr>
<td>Compression</td>
<td>compressed or uncompressed</td>
</tr>
<tr>
<td>Fill only</td>
<td>24-bit</td>
</tr>
<tr>
<td>Fill and Alpha</td>
<td>32-bit</td>
</tr>
<tr>
<td>1080 formats</td>
<td>1920×1080 pixels max. image size</td>
</tr>
<tr>
<td>720 formats</td>
<td>1280×720 pixels max. image size</td>
</tr>
<tr>
<td>Max. File Size (with 1Gb MediaCache)</td>
<td>800 MB</td>
</tr>
</tbody>
</table>

File Naming Specifications

The file name can be up to 32 characters in length, but should be up to a maximum of 12 characters, so that it can be displayed on the menus properly. The name can contain letters, numbers, spaces, dashes, underscores, and, periods, but should not contain symbols such as ! @ # & * ( ) , ? ".

If you are naming an animation, each file must be numbered in the sequence that it will play out. The following restrictions apply to file names for animations:

- Each file must use a 2-digit to 5-digit number, including all the leading zeros.
- Each file in the sequence must have the same numbering scheme.
- The first file in a sequence must be numbered 00.
- The file name and number must be separated by an _.

The following is an example of a 90-frame animation using a typical numbering scheme:

- DTVB_0000.tga
- DTVB_0001.tga
- DTVB_0002.tga
- ...
- DTVB_0087.tga
- DTVB_0088.tga
- DTVB_0089.tga
Transferring Stills

Transferring stills and animations from your computer to the switcher is accomplished either by transferring files using a USB drive, or creating a WebDAV connection to the switcher. Once the connections is established, you can transfer files from the computer to the switcher.

**Note** — The switcher does not show file name extensions. If you have two files with the same name, in different file formats, you will not be able to tell them apart on the switcher.

Transferring Stills Using WebDAV

The WebDAV protocol is used to transfer stills to the switcher from a computer. This section provides information on establishing a WebDAV connection to the switcher from a computer running Windows XP®, Windows 7®, Mac OS® X 10.5, or Linux Fedora 8® operating systems. For information on establishing a connection from a computer running a different operating system, refer to the documentation that came with your computer, or contact Ross Video Technical Support.

**Important** — Do not use WebDAV to move images or animations around on the switcher. If you move a file with WebDAV, the associated on-air properties for that image or animation will be lost.

### WebDAV for Microsoft® Windows XP® Operating System

1. Click **My Network Places** on the **Start Menu** to display the **My Network Places** window.
2. Click **Add a network place** under **Network Tasks**.
3. Select **Choose another network location** in the **Add Network Place Wizard** and click **Next**.
4. Enter `http://frame_ip/stills/` in the **Internet or network address** field, and click **Next**. The default IP address of the frame is **192.168.1.1**.
5. Enter the user name and password and click **OK** to connect to the frame. The default **User name** is **user** and **Password** is **password**.
6. Enter a new name for the stills directory on the frame is required, and click **Next**.
7. Click **Finish**. The stills folder opens in a new window.

You can now copy images into the stills directory on the switcher. Additional directories can be created on the switcher, up to 4 cascading sub-directories from the root directory.

### WebDAV for Microsoft® Windows® 7 Operating System

1. Click **Computer** on the **Start Menu**.
2. Right-click on the open area on the right side of the window.
3. Click **Add a network location**.
4. Select **Choose a custom network location** in the **Add Network Location Wizard** and click **Next**.
5. Enter `http://frame_ip/stills/` in the **Internet or network address** field, and click **Next**. The default IP address of the frame is **192.168.1.1**.
6. Enter the user name and password and click OK to connect to the frame. The default User name is user and Password is password.

7. Enter a new name for the stills directory on the frame is required, and click Next.

8. Click Finish. The stills folder opens in a new window.

You can now copy images into the stills directory on the switcher. Additional directories can be created on the switcher, up to 4 cascading sub-directories from the root directory.

**WebDAV for Apple® Mac OS® X**

1. Click Go ⇒ Connect to Server... on the Finder Menu to display the Connect to Server window.

2. Enter http://frame_ip/stills/ in the Server Address field, and click Connect. The default IP address of the frame is 192.168.1.1.

3. Enter the name and password and click OK to connect to the frame. The default Name is user and Password is password. The stills folder appears under SHARED in the Finder.

You can now copy images into the stills directory on the switcher. Additional directories can be created on the switcher, up to 4 cascading sub-directories from the root directory.

**WebDAV for Linux Fedora 8®**

1. Click Places ⇒ Connect to Server on the Menu Bar Panel to display Connect to Server window.

2. On the Connect to Server window, select the following:
   - Service Type: WebDAV (HTTP)
   - Server: (The default IP address of the frame is 192.168.1.1)
   - Port: leave blank
   - Folder: /stills
   - Username: (the default user name for the frame is user)
   - Name to use for connection: (a descriptive name for the connection, for example Switcher Stills)

3. Click Connect.

4. Enter the password and click OK to connect to the frame. The default password is password. The stills folder appears under the Places menu.

You can now copy images into the stills directory on the switcher. Additional directories can be created on the switcher, up to 4 cascading sub-directories from the root directory.

*For More Information...*

- on obtaining the IP Address of the switcher, refer to the section “Network Setup” on page Eng 4-5.
- on the user name and password of the switcher, refer to the section “Vision Web Interface Account” on page Eng 6-2.

**Transferring Stills Using USB**

If you do not want to create a network connection to the switcher, you can copy stills using a USB drive. The stills must be the only files on the USB drive, and be located at the root directory.
Note — The USB drive that the stills you want to transfer are stored on must be formatted as FAT32. If the USB drive is formatted at NTFS, the transfer will not work.

1. Copy the stills that you want to transfer to the switcher to the root directory, of a blank USB drive.
2. Insert the USB drive into the USB port on the top of the Vision control panel.
3. Press HOME ➔ More ➔ Effects ➔ Still Store ➔ Select/Manage.

4. Press Copy From USB. All valid still-store images on the USB drive are copied to the USB folder on the switcher.
Managing Stills

Still Management allows you to create and delete directories and, rename, renumber, delete, and move stills.

Renaming and Renumbering Stills

Once a still-store image has been transferred onto the switcher, you can change the name or ID number of the still.

1. Press HOME \(\Rightarrow\) More \(\Rightarrow\) Effects \(\Rightarrow\) Still Store \(\Rightarrow\) Select/Manage.
2. Use the Contents knob to select the still you want to rename or renumber. Directories are indicated by a slash (\/) at the end of the name.
4. Press Rename/Renumber.

Operating Tip — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the Rename/Renumber Still Menu to enter a name.

5. Enter the new name for the still in the New Name field. The name can be no more than 32 characters in length and must be unique.

Important — The name can contain letters, numbers, and spaces, but cannot contain symbols such as ! @ # & * ( ) / , ? ‘ “.

6. Renumber the still as follows:
   - Enter a new number in the keypad on the Global Memory Module. If the number is already being used, you must renumber that still before you can use the number for the current still.
   - Press ENTER on the Global Memory Module.
Creating and Renaming Directories

Still-Store images are stored in directories on the hard drive of the switcher. Directories can be created and renamed as required.

1. Press HOME ⇒ More ⇒ Effects ⇒ Still Store ⇒ Select/Manage.

2. Create a directory as follows:
   - Use the Contents knob to select the directory in which you want to create a sub-directory. Directories are indicated by a slash (/) at the end of the name.
   - Press Create Directory.

3. Rename a directory as follows:
   - Use the Contents knob on the Select Still Menu 1-2 to select the directory that you want to rename. Directories are indicated by a slash (/) at the end of the name.
   - Press Rename.
   - Enter the name for the directory you want to create in the New Name field. The name can be no more than 32 characters in length.
   - Press Accept New Name to rename the directory.

Deleting Stills or Directories

Any still-store image, or empty still-store directory, on the switcher can be deleted. Only an empty directory can be deleted. You must delete or move the still-store images from a directory before you can delete it.

1. Press HOME ⇒ More ⇒ Effects ⇒ Still Store ⇒ Select/Manage.

2. Delete an individual still as follows:
3. Delete all the stills in a directory as follows:
   - Use the Contents knob to select the directory that you want to delete all the stills from. You must be in the directory to delete the stills.
   - Press Delete All to delete all the stills in the directory. You will be prompted to confirm the deletion.

4. Delete a directory as follows:
   - Use the Contents knob to select the directory that you want to delete.
   - Press Delete to delete the selected directory. You will be prompted to confirm the deletion.

Cut/Copy Stills

You can cut, or copy, and paste a still from one directory to another. This allows you to organize your stills without the need for a separate computer and WebDAV connections.

1. Press HOME ➔ More ➔ Effects ➔ Still Store ➔ Select/Manage.
2. Use the Contents knob to select the still that you want to move.
4. Press Cut or Copy to cut or copy the still from the current directory.
5. Use the Contents knob to select the directory that you want to paste the still to.
6. Press Paste to paste the still to the current directory.
Peripheral Control

In This Chapter

This chapter provides information and instructions for interfacing with external equipment from a Vision switcher.

Note — Only the Master Panel can connect to and control an external device. You cannot access the peripheral control menu from a Satellite Panel.

The following topics are discussed in this chapter:

- GPI Interface Control
- External Still Store Interface Control
- VTR Clip Control
- Audio Server Clip Control
- Video Server Clip Control
- Router Matrix Control
- Audio Mixer Control
- Robotic Camera Control
- Character Generator Control
- Editor Interface Control
- OverDrive Interface Control
- Monitor Wall Interface Control
GPI Interface Control

The GPI interface allows the Vision switcher to be controlled by external GPI signals. The status of the GPI Interface is shown on the Main Menu under Remote Enables and can be turned on or off from the Remote Enables Menu.

1. Press HOME ➔ More ➔ Remote Enables.

2. Toggle GPI to On to allow GPI pulses to control the switcher, or Off to turn off the GPI Interface.

For More Information...

- on setting up standard GPI, refer to the section “Standard GPI Setup” on page Eng 12-10.
External Still Store Interface Control

The Vision switcher interfaces with external still-store devices using the Intelligent Interface protocol. You can load different stills that are stored on the external still-store device directly from the switcher using the still number.

To load a still from the control panel, you must have communications with the external still-store device set up on the switcher, as well as the input source on the switcher that is connected to the device assigned to the external still-store.

1. Select the crosspoint button on the crosspoint bus that has been mapped to the input source for the external still-store. The display on the Effects Memory Module for the crosspoint group will show the current Still ID and Still Channel that are assigned to that input source.

2. Use the keypad in the center of the module to enter the number of the still you want to load.

3. Press ENTER on the Effects Memory Module to load the still.
VTR Clip Control

VTR Clips can be cued and played by selecting the Clip Register, or Clip ID, on the Remote Control Menu, or by using the keypad on the Global Memory Module.

For More Information...

- on using ROLL CLIP to play a cued clip, refer to the section “ROLL CLIP” on page Ops 5-5.

Clip Control Overview

You can recall VTR Clips using either the Clip Number or the Clip ID to recall a clip from the keypad on the Global Memory Module.

- **Clip Number** — The VTR Clip Number is the 3-digit number that corresponds to the VTR Clip Register. This is the default mode that the Global Memory System will be in when a VTR is selected as a source.

- **Clip ID** — The VTR Clip ID is the 6-digit number that is set up on the VTR itself. Clip IDs, must be numerical to be able to recall them using the keypad. Leading zero cannot be specified when entering a Clip ID. For example, entering 12 on the keypad will load Clip 12, and not Clip 000012.

All VTRs that support Clip IDs can toggle between using Clip IDs and Clip Numbers.

Cueing a Clip Using the Keypad

Clips can be recalled from the keypad on the Global Memory Module using either the Clip ID or the Clip Number.

1. Toggle Recall Clip on the Global Memory Module to show the VTR Clip ID or Clip Number on the display.
2. Enter the Clip ID, or Clip Number, using the keypad on the Global Memory Module.
3. Press Enter to cue the clip.

VTR Remote Control Menu

The Remote Control Menu allows you to cue different clips using the Clip Registers, or by using the transport controls to move to different timecodes. You can then play the clip directly, or use the ROLL CLIP button on the Transition Modules to play the clip with the next transition.

You can also access the Remote Control Menu by pressing the crosspoint button assigned to the VTR you want to control.

The timecode at the bottom of the Remote Control Menu is the time remaining for the current clip on the Program bus, or Keyer. This may not be the currently selected clip.

2. Use the Input knob to select the VTR you want to cue a clip for.
3. Press GO!!.
Note — If the switcher does not receive a response from the VTR in over 2 seconds, the switcher will report the communications with the VTR has been lost. Double check the cable connections and that the VTR is operational.

Operating Tip — The Remote Control Menu identifies the specific VTR you are controlling by the input source that it is connected to, and the communications protocol that is being used to control the VTR.

4. Use the Clip knob to select the Clip Register you want to cue. You can play or preview the clip manually using the transport controls on the menu.

Operating Tip — You can adjust the speed at which a clip is played by pressing Play Speed on the Remote Control Menu 1-2, and using the Speed knob to adjust the speed for the clip.

5. Press Cue Clip to cue the selected clip. The clip is now ready to be played using the ROLL CLIP button.
Audio Server Clip Control

Audio Server Clips can be cued and played by selecting the Clip Register, or Clip ID, on the Audio Server Menu, or by using the keypad on the Global Memory Module.

For More Information...

- on using the ROLL CLIP to play a cued clip, refer to the section “ROLL CLIP” on page Ops 5-5.

Cueing a Cut Using the Keypad

Clips can be recalled from the keypad on the Global Memory Module using the Clip Number. The keypad will automatically be assigned to clip recall when an input source that is assigned to an Audio Server is selected.

1. Press Recall Clip on the Global Memory Module to show the Audio Server Clip ID or Clip Number on the display.
2. Enter the Clip Number, using the keypad on the Global Memory Module.
3. Press Enter to cue the Clip.

Audio Server Menu

The Audio Server Menu allows you to select and play a clip/cut from the Audio Server.

1. Press HOME ⇒ Clips ⇒ Browse Audio Clips ⇒ Device.
2. Use the Device knob to select the audio server that you want to cue and play a clip on.
3. Press Cut ID.

![Audio Server Clip Control](image)

Cut ID (DigiCart) — Audio Server Clip Menu

Note — The Cut ID Menu is device specific, and may vary depending on the audio server you are selecting the clip on.

4. Use the Drive knob to select the drive on the audio server that the clip is stored on.
5. Use the Directory knob to select the directory on the audio server that the clip is stored on.
6. Use the Cut knob to select the clip.
7. Use the transport controls to Play, Pause, or Stop the clip.
Video Server Clip Control

Video Server Clips can be cued and played by selecting the Clip Number, or Clip ID, on the Remote Control Menu, or by using the keypad on the Global Memory Module.

For More Information...

- on using the ROLL CLIP, refer to the section “ROLL CLIP” on page Ops 5-5.

Clip Control Overview

You can recall Video Server Clips using either the Clip Number or the Clip ID to recall a clip from the keypad on the Global Memory Module.

- **Clip Number** — The Video Server Clip Number is the 3-digit number that corresponds to the Video Server Clip Register. This is the default mode that the Global Memory System is in when a Video Server is selected as a source.

- **Clip ID** — The Video Server Clip ID is the 6-digit number that is set up on the Video Server itself. Clip IDs, must be numerical to be able to recall them using the keypad. Leading zero cannot be specified when entering a Clip ID. For example, entering 12 on the keypad loads Clip 12, and not Clip 000012.

All Video Servers that support Clip IDs can toggle between using Clip IDs and Clip Numbers.

Cueing a Clip Using the Keypad

Clips can be recalled from the keypad on the Global Memory Module using either the Clip ID or the Clip Number. The keypad is automatically assigned to clip recall when an input source that is assigned to a Video Server is selected.

1. Toggle RECALL CLIP on the Global Memory Module to show the Video Server Clip ID or Clip Number on the display.
2. Enter the Clip ID, or Clip Number, using the keypad on the Global Memory Module.
3. Press ENTER to cue the clip.

Video Server Remote Control Menu

The Remote Control Menu allows you to cue different clips using the Clip Registers, or by using the transport controls to move to different timecodes. You can then play the clip directly, or use the ROLL CLIP button on the Transition Modules to play the clip with the next transition.

You can also access the Remote Control Menu by pressing the crosspoint button assigned to the video server you want to control.

The timecode at the top of the Remote Control Menu is the time remaining for the current clip on the Program bus, or Keyer. This may not be the currently selected clip.

2. Use the Input knob to select the Video Server you want to cue a clip for.
3. Press GO!!.
4. Use the **Clip** knob to select the Clip Register you want to cue. You can play or preview the clip manually using the transport controls on the menu.

5. Press **Cue Clip** to cue the selected clip. The clip is now ready to be played using the **ROLL CLIP** button.
Router Matrix Control

The Vision switcher allows you to control the source selection for a router that is controlled from the switcher. Source changes are made by selecting the crosspoint button that is assigned to the router, and then selecting the new router source on the **Matrix Control Menu**.

You can also access the **Router Matrix Control Menu** by pressing the crosspoint button assigned to the router you want to control.

1. Press **HOME**  ➔ **More**  ➔ **Effects**  ➔ **More**  ➔ **Remote Ctrl Select**  ➔ **Router Control**
2. Use the **Input** knob to select the output of the router you want to change the source for.
3. Press **GO!!**.

**Note** — *If the switcher does not receive a response from the router in over 2 seconds, the switcher will report the communications with the router has been lost. Double check the cable connections and that the router is operational.*

**Operating Tip** — *The Refresh Sources button allows you to poll the selected router for the list of available sources on it. If your router does not support Router Mnemonic names, the default Src and Dest designations will be used.*

4. Use the **x1**, **x10**, or **x100** knobs to select the router source that you want to assign to the selected input source. The **x10** and **x100** knobs allow you to move through the list 10 and 100 items at a time.
Audio Mixer Control

When an Audio Mixer is connected to the Vision switcher, it can be operated in one of two ways; normal Audio Follow Video (AFV) mode, or Override mode.

Audio Follow Video

The AFV mode is where an audio channel is taken to air when the input video source it is assigned to is taken to air. The audio will follow the video on and off-air like this for transitions only on MLEs that are on-air (re-entered onto the Program/Preset MLE) unless the Audio Transitions personality setting is set to all.

For example, there may be a number of camera setups in the studio, each one focusing on a different talent. When a particular camera is taken on-air, you also want the audio from the talent’s microphone to be taken on-air. When the camera is taken off-air, you also want the corresponding audio channel to be taken off-air. This is normal AFV mode operation.

Note — If you fly a key, and then expand it to full frame, the underlying video is still on-air, even though you cannot see it. The audio for both video signals will still be on-air. This is also important to remember if you are running shots from memories where you bring a key full-frame from an over the shoulder shot.

Audio Overrides

The Override mode is when the normal AFV mode has been altered, either by changing the levels, taking more or fewer channels to air, or altering the channels that will be taken to air on the next transition. Overrides are applied by using one of the audio custom controls. For example, if you have an over the shoulder shot, the audio channels for both the talent and the key would be on-air as per normal AFV. If you transition to a shot with only the VTR Clip, then the audio from the talent would be taken off-air. If you wanted both audio channels to remain, you would have to set up an override by turning on the audio crosspoint for the talent on the Preset bus. When you make the transition, the switcher takes the video off-air, but keeps the audio on.

Audio Transitions

During all audio transitions, the switcher keeps track of three separate levels for each audio channel, or group. These levels are as follows:

- **Current** — The Current level is the level of the channel, or group, that is currently on-air. This level can be adjusted using the PGM Audio Lvl custom control that is assigned to that channel, or group.
- **Preset** — The Preset level is the level of the channel, or group, that takes effect during the next transition of the audio. This level can be adjusted using the PST Audio Lvl custom control that is assigned to that channel, or group.
- **Default** — The Default level is the level that the channel, or group, was set to originally. When you perform an Audio Reset custom control, all off-air audio channels will have their preset levels changed to the default level. This will not change the Preset levels for the audio channels that are on-air.

During an Audio Transition, the switcher prepares to take the Preset audio channel to air as follows:
1. The switcher applies the normal AFV rules to the select which channels, or groups, will be taken on-air.

2. The switcher checks for preset overrides that will turn channels, or groups, off or on, depending on how they are set in the Preset Audio bus.

3. The switcher performs the audio transition by fading the Preset channels to their Preset audio levels. These levels then become the Current audio levels for those channels, or groups.

   **Note** — When an audio channel is faded off-air by dragging the level to zero on the audio mixer, that channel will return to the Default level the next time it is taken on-air.

4. The switcher then saves the Current levels of the audio channels that were taken off-air at the Preset levels for those channels, or groups. These levels will be used as the Preset levels for the next transition.

**Audio Only Transitions**

With the audio override custom controls properly set up, it is possible to perform an audio only transition. This transition does not alter the video signals on the Program or Preset bus, but transitions the audio crosspoints on those buses.

**Important** — You must hold the Bank button referred to in step one for the entire procedure. The button must be held to hold the Crosspoint Group in Audio Mixer mode.

1. Press and hold the Audio Bank custom control button to place the bottom Crosspoint Group into Audio Mixer mode. The crosspoint buttons on this Crosspoint Group are now audio crosspoints and represent the audio channels that are on-air and will be taken on-air in the next transition.

2. Select the audio crosspoint that you want to take on-air on the Preset bus.

3. Press Auto Trans on the Transition Module for the bottom Crosspoint Group to perform the audio only transition.

   **Note** — Audio Only transitions should only be performed once as they will create audio overrides. In order to properly perform your next transition, you should check the audio crosspoints and run an Audio Reset Pst custom control to return to AFV.

**Audio Level Adjustment**

You can adjust the audio level for a particular channel, or the Master level, and the Pan settings, using the Assign Audio custom control.
1. Press the custom control button that is assigned to the channel, or group, that you want to adjust the audio levels for. The Audio Menu is displayed.

Operating Tip — If a channel is muted, the word Mute is shown under the pan knob on the Audio Menu.

2. Adjust the audio level for a channel as follows:
   - Press Audio Level to select all the channels in a group, or select an individual channel. If you did not select a group, the individual channel will already be selected.
   - Use the Level knob to adjust the audio level.

3. Adjust the pan for an audio channel as follows:
   - Select the audio channel you want to adjust the pan for.
   - Use the Pan knob to adjust the pan setting. Turning the knob to the right will pan right.

4. Adjust the Master audio level as follows:
   - Press Master Level.
   - Use the Master knob to select the master level you want to adjust. If the Audio Mixer only supports one master level, you cannot adjust this knob.
   - Use the Level knob to adjust the master audio level.

For More Information...
   - on the Assign Audio custom control, refer to the section “Programming Special Functions” on page Eng 10-15.
Robotic Camera Control

The Vision switcher can interface with specific robotic camera controllers, allowing you to control the various aspects of the robotic camera.

All robotic camera control is performed from the Camera Head Control Menu. The contents and appearance of these menus is specific to the robotic camera you are controlling, and driver you are using to interface with it.

You can also access the Camera Head Control Menu by pressing the crosspoint button assigned to the robotic camera you want to control.

2. Use the Input knob to select the camera you want to control.
3. Press GO!!.

From the Camera Head Control Menu you can control all the supported commands for a given camera.

For More Information...

- on storing and recalling camera shots, refer to the section “Camera Shotbox” on page Ops 11-15.
- on storing and recalling camera shots on a FlexCAM, refer to the section “Camera ShotBox (FlexCAM)” on page Ops 11-16.

Robotic Camera Commands

This section provided a description of all of the commands available to the robotic cameras. Not all cameras support all commands.

- **2x Extender** — This command allows you to turn the 2x extender on/off/
- **AUX 1-4** — These command allow you to set the aux terminal on/off.
- **Stop** — This command allows you to stop pan, tilt, zoom, and focus movement with a duration of 0.
- **Change Screen** — This command allows you to have the operator screen change to the new shot when a shot is recalled (**Yes**), or not change when the shot is recalled (**No**).
- **Color Bar** — This command allows you to activate/deactivate a color bar signal on the video output.
• **D-Zoom** — This command allows you to turn the Digital Zoom feature of the camera on or off.

• **Duration** — This command allows you to specify the amount of time for the recall to be performed.

• **Effects** — This command allows you to apply various camera effects to the video signal before it reaches the switcher. For example, the Sony BRC-300/300P allows you to apply a **Negative** or a **Black and White** effect. Press **Picture** on the **Camera Head Control Menu** to view the white balance settings.

• **Focus** — This command allows you to manually adjust the focus of the camera. Press **Lens** on the **Camera Head Control Menu** to view the focus settings.

• **FPU Power** — This command allows you to set the FPU power terminal on/off.

• **Gain** — This command allows you to set the lens gain.
  - **R Gain/B Gain** — These commands allow you to set the R and B gain values.

• **GEN Lock Phase** — This command allows you to set an offset to the genlock (reference) signal.

• **Image Ratio** — This command allows you to adjust the image ratio of the video signal before it reaches the switcher. Press **Picture** on the **Camera Head Control Menu** to view the image ratio settings.

• **Image Stabilizer** — This command allows you to activate/deactivate image stabilization.

• **IR Receive** — This command allows you to turn the Infrared Receiver on the robotic camera on or off. When turned on, the robotic camera can be controlled from the switcher, or from an Infrared Remote Controller.

• **Iris** — This command allows you to manually open or close the iris of the camera lens. Press **Lens** on the **Camera Head Control Menu** to view the Iris settings.

• **Iris Mode** — This command allows you to set iris control to automatic or manual. When set to manual, you can adjust the Iris settings from the switcher. When Iris is set to automatic, you cannot adjust the lens settings from the switcher. Press **Lens** on the **Camera Head Control Menu** to view the Iris Mode settings.

• **Lens (Mode)** — This command allows you to set lens control to automatic or manual. When set to manual, you can adjust the Lens settings from the switcher. When Lens is set to automatic, you cannot adjust the lens settings from the switcher. Press **Lens** on the **Camera Head Control Menu** to view the Mode settings.

• **Lens Mode** — This command allows you to set how the robotic camera records the lens settings. The **Lens Mode** must be set to **Position** before you set up and store your shot. When you toggle the **Lens Mode** to **Position**, the lens returns to the default settings.

• **Neutral Density Filter** — This command allows you to set the neutral density filter (NDFilter).

• **Pan/Tilt/Zoom** — These commands allow you to manually control the Pan, Tilt, and Zoom of the camera head and lens. Press **Pan/Tilt/Zoom** on the **Camera Head Control Menu** to view these settings.

• **Pedestal (Black)/Master Pedestal** — This command allows you to adjust the Master Pedestal, or Black Levels, for picture contrast and quality. Press **Lens** on the **Camera Head Control Menu** to view the pedestal settings.

• **Pedestal/Televator/Height** — This command allows you to extend or retract the televator that the camera is mounted onto. Press **Location** on the **Camera Head Control Menu** to view the Pedestal settings.

• **Run Wiper/Wiper** — This command allows you to manually run the wiper on the camera lens or housing. Press and hold **Run Wiper** to run the wiper.
- **Set Show** — This command is used with the Recall shot command and allows you to specify the show on the camera that you want to recall the shot from.

- **Shooting Mode** — This command allows you to set the camera shooting mode to automatic or manual.
  - **Auto** — Iris, shutter, gain, white balance lock are controlled by the camera.
  - **Manual** — Iris, shutter, gain, white balance lock are controlled by the user.

- **Shutter Speed** — This command allows you to adjust the shutter speed of the robotic camera. Press **Lens** on the **Camera Head Control Menu** to view the shutter speed settings.

- **Speed x4/x1** — This command allows you to set the movement speed of the camera to 4-times normal.

- **Store/Recall Shot** — These commands allow you to store and recall the camera settings. The pan angle, tilt angle, focus position, and zoom position are stored/recalled to/from the camera memory buffer.

- **Tilt Curve** — This command allows you to select whether the camera head is mounted upside down or not. Select **Invert** if you have your camera mounted upside down on the camera mount.

- **Truck/Dolly** — This command allows you to move the camera on the camera track. Press **Location** on the **Camera Head Control Menu** to view the Truck settings.

- **Video Signal** — This command allows you to activate/deactivate the video output signal of the camera.

- **Washer** — This command cycles the wiper four times and sets the washer terminal to on.

- **White Balance/White Balance Lock** — This command allows you to match the white balance color temperature with the light source. Press **Picture** on the **Camera Head Control Menu** to view the white balance settings.

### Camera Shotbox

The **Camera Shotbox Menu** allows you to store and recall shots for the currently selected camera. As you select different camera crosspoint buttons, the **Camera Shotbox Menu** switches to the newly selected camera. You can place this menu in the upper display region for quick access to camera shots.

The Camera Shotbox is not associated with Custom Control Shot Box pages.

1. Press **Store/Recall** on the **Camera Head Control Menu**.

2. Store a shot as follows:
• Toggle **Mode** to **Store**.
• Use the **Shot** knob to select the location that you want to store your shot to. You can also select the **Shot X** button directly on the menu, where **X** is the number of the shot location you want to store the shot to.
• Press **Perform Store** to store the shot.

3. Recall a shot as follows:
   • Toggle **Mode** to **Recall**.
   • Use the **Speed/Duration** knob to select the amount of time for the recall to be performed.
   • Select the **Shot X** button you want to recall the shot from, where **X** is the number of the shot location you want to recall the shot from.
   • Press **Perform Recall** to recall the shot. You can also double-press the **Shot X** button to recall the shot immediately.

Camera ShotBox (FlexCAM)

The Camera ShotBox Menu allows you to store shots for the currently selected camera, as well as recall shots or moves (if supported). As you select different camera crosspoint buttons, the Camera Shotbox Menu switches to the newly selected camera. You can place this menu in the upper display region for quick access to camera shots.

When a shot is recalled, the camera moves at the set duration to the location specified by the shot. Because the shot does not reference the starting position of the camera, the path the camera takes to move to the next shot is unpredictable. Unlike a shot, a move does specify the starting position for the camera. This allows the path the camera takes to move from the start position to the end position in the shot to be reproducible. A camera move must be prepared before it can be executed.

This feature is available for FlexCAM devices only.

Storing a Shot

1. Press **Store/Recall** on the Camera Head Control Menu.

2. Use the **Camera** knob to select the camera that you want to store a shot on.
3. Use the **Page** knob to select the page you want to store a camera shot on.
4. Store a shot as follows:
   • Select the shot that you want to store the current camera position to. Any existing shot information is overwritten.
Recalling a Shot or Move

1. Press Store/Recall on the Camera Head Control Menu.

2. Use the Camera knob to select the camera that you want to store or recall a shot on.

3. Use the Page knob to select the page you want to store or recall a camera shot on.

4. Recall a shot as follows:
   - Select the shot you want to recall. Shots are indicated with by the straight line between the two lenses on the button.
   - Use the Duration knob to select the length of time you want the camera to take to move to the shot you are going to recall.
   - Press Recall.

   Operating Tip — Press Stop to stop pan, tilt, zoom, and focus movements of the camera as quickly as possible (0 duration).

5. Execute a move as follows:
   - Select the move you want to recall. Moves are indicated with by the wavy line between the two lenses on the button.
   - Press Prepare to prepare the shot. The camera jumps to the starting position of the move.

   Note — If the camera is moved before the move is executed, the Execute button is disabled. The move must prepared again.

   - Press Execute to run the move. The camera moves from the start position to the end position of the move. The duration of the move is defined by the move itself.

   Operating Tip — When the move is prepared, the execution of the move can be tied to a transition or with the Roll Clip functionality. The Execute Camera Move personality option must be set to enable this feature.
Managing Shots and Pages on the Switcher

You can rename pages and shots, delete shots on the switcher, and assign shots on the camera to the camera page on the switcher.

1. Press Store/Recall on the Camera Head Control Menu.

3. Use the Camera knob to select the camera that you want to manage a shot on.
4. Use the Page knob to select the page you want to manage.
5. Rename a page as follows:
   - Press Rename Page and enter a new name for the page.
6. Rename a shot as follows:
   - Select the shot that you want to rename
   - Press More ⇒ Rename Shot and enter a new name for the shot.
7. Add an empty shot or Delete a shot as follows:
   - Press Insert Shot to add an empty shot to the left the selected shot.
   - Press Remove Shot to delete the selected shot.
8. Assign a Shot from the camera as follows:
   - Select the shot that you want to assign a shot stored on the camera to. Any existing shot information is overwritten.
   - Press More ⇒ Assign Shot.
   - Select the shot on the camera you want to assign to the shot on the page.
   - Press Select.

Operating Tip — Press Assign All to assign all of the shots on the camera to the camera page on the switcher. The assignment will start with the shot selected on the camera page and continue to the end of the page.

Renaming and Deleting Shots on the Camera

1. Press Store/Recall on the Camera Head Control Menu.
2. Press More ⇒ Assign Shot.
3. Rename a shot on the camera as follows:
   • Select the shot that you want to rename.
   • Press **Rename Shot** and enter a new name for the shot.

4. Delete a shot on the camera as follows:
   • Select the shot that you want to delete.
   • Press **Delete**.
Character Generator Control

The Vision switcher can interface with character generators, allowing you to control the various aspects of the character generator, including loading and running effects, loading and navigating through a playlist, or template, and editing the character generator text directly from the control panel.

All character generator control is performed from the Character Generator Menu. The contents of this menu is specific to the character generator you are controlling.

You can also access the Character Generator Menu by pressing the crosspoint button assigned to the character generator you want to control.

1. Press HOME ⇒ More ⇒ Effects ⇒ More ⇒ Remote Ctrl Select ⇒ Character Generator.
2. Use the Input knob to select the character generator you want to control.
3. Press GO!!.

![Character Generator Menu](image)

From the Character Generator Menu you can control all the supported commands for a given character generator. Refer to the section on your specific character generator for information on the commands it supports.

Character Generator Commands

This section provides a description of all of the commands available to the character generators.

- **Channel A/B Select** — This command allows you to toggle between Channel A and Channel B. These channels are the two outputs on the character generator, and toggling between A and B allows you to control each one.
- **Change PGM Text** — This command takes you to the CG – Change PGM Text Menu, which allows you to change the tag information for an event in the PGM column.
- **Change PV Text** — This command takes you to the CG – Change PV Text Menu, which allows you to change the tag information for an event in the PV column.
- **Layer** — This command allows you to toggle layer mode On (you can enter a new layer) or Off (use the current layer).
- **List/Current View** — This command allows you to toggle between List (Lst) and Current (Crnt) view.
  - **List** — List view shows you a list of all the pages, or events, that are available. In this view you can load an event to either the PV or PGM of the character generator using the List to PV or List to PGM buttons.
Current — Current view shows you the pages, or events, that are currently listed on
the PV and PGM of the character generator.

- List to PGM — This command allows you to load a page, or event, for the Program
  channel of the character generator. The selected page will be added to the Program
  list. This command is only available in List view.

- List to PV — This command allows you to load a page, or event, for the Preview
  channel of the character generator. The selected page will be added to the Preview list.
  This command is only available in List view.

- Play Animation — This command allows you to play a template animation.

- Recall/Load CG to PGM — This command allows you to recall a page, or event, to
  the PGM Channel of the character generator using the keypad on the Global Memory
  Module. The tag information for the file is displayed in the PGM column on the menu.

- Recall/Read CG to PV — This command allows you to recall a page, or event, to the
  PV Channel of the character generator using the keypad on the Global Memory
  Module. The tag information for the file is displayed in the PV column on the menu.

- Select Directory — This command allows you to change the current directory, or
  folder, that you are using to load templates from. Enter the name of the folder in the
  Folder field.

- Select File — This command allows you to load a sequence file on the character
  generator. Enter the name of the file in the Folder/FileName field. This command is only
  available in Sequence mode. The available effects will depend on the character generator
  you are controlling.

- Sequence/Manual Mode — This commands allows you to toggle between Sequence
  (Seq.) and Manual (Man.) mode. The commands available on the menu depend on the
  mode you are operating in.

  - Sequence — In Sequence mode, the pages, or events, are all loaded up and play
    out automatically.

  - Manual — In Manual mode, you load each page, or event, individually, and take it
    to air manually.

- Swap PV <-> PGM — This command allows you to swap the templates loaded on the
  PGM with those loaded on the PV.

Notes on Character Generator Commands

- The current Mode, Channel, and Folder/FileName information is saved in non-volatile
  memory on the switcher and is stored and recalled with the Personality settings. This
  allows you to retain your character generator settings if the switcher powers down.

- Templates stored with non-numerical names cannot be recalled using the keypad on the
  Global Memory Module.

- Character generator parameters that are modified from the switcher are only in effect for
  the current session.
Editor Interface Control

The editor interface allows the Vision switcher to be controlled by an external editor. The status of the Editor Interface is shown on the Main Menu under Remote Enables and can be turned on or off from the Remote Enables Menu.

1. Press HOME ⇒ More ⇒ Remote Enables.

2. Toggle Editor to On to allow an editor to control the switcher, or Off to turn off the Editor Interface.

Note — If the switcher does not have the same bus map assigned to every bus (MLE Program/Preset, Keyers, Utility), an error message is displayed on the Main Menu indicating the bus map mismatch.
OverDrive Interface Control

In order for the OverDrive Production Control System to control the switcher, the Editor Remote Enable must be turned on.

1. Press HOME ➔ More ➔ Remote Enables.

   ![Remote Enables Menu]

2. Toggle Editor to On to allow OverDrive to control the switcher, or Off to turn off the Editor Interface.

   **Note** — If the switcher does not have the same bus map assigned to every bus (MLE Program/Preset, Keyers, Utility), an error message is displayed on the Main Menu indicating the bus map mismatch.

OverDrive and 2 MLE Switchers

OverDrive requires at least 2 Effects MLEs in order to operate properly. With the Vision 2 switcher, there is only one Effects MLE and the Program/Preset MLE. OverDrive compensates for this by using the Program/Preset MLE as an Effects MLE. This requires OverDrive to configure the switcher in a manner that will alter the way the Program/Preset MLE operates. This configuration involves how OverDrive recalls a shot and performs a transition, and how you can use the control panel when it is being controlled by OverDrive.

The following applies to the 2 MLE switchers and OverDrive when they are being used together:

- The Downstream Keyers of the switcher are used as Keyers for MLE 2. This means that they cannot be used as DSKs. If you attempt to transition a DSK on-air when MLE 2 is off-air, a warning message displayed.
- If a key is included in the shot on MLE 2, a transition of the Background and any Keyer will be required. In this case, you cannot perform a Squeeze & Tease Wipe because the Keyer is included. This only applies if Keyers are on-air in the memory recall.
- If a key is flown in the memory recall on MLE 2, a Squeeze & Tease Wipe cannot be used to transition the memory on-air. This applies whether the Keyer is on-air or not.
- You cannot preview a transition on MLE 2 as you can on MLE 1.
- Because OverDrive has to duplicate memories on MLE 2, you must duplicate your memories on MLE 1 and MLE 2.
Monitor Wall Interface Control

The Monitor Wall custom controls allow you to control various aspects of the Monitor Wall from the switcher. These includes loading a layout, changing input channels, and modifying dynamic text.

**Layouts**

The layout custom control allows you to load a specific layout on the Monitor Wall. A different custom control must be created for each layout you want to load from the switcher.

**Input Channels**

The assign input custom control allows you to assign a specific input channel to a particular monitor on the monitor wall. A different custom control must be created for each channel assignment you want to use from the switcher.

**Dynamic Text**

The modify text custom control allows you to assign specific, pre-defined, text to a particular text address. The text address must be assigned to a template for the custom control to be able to change the text. A different custom control must be created for each text change you want to make from the switcher.
Auxiliary Panels

In This Chapter

This chapter provides operational information on the Auxiliary Control Panel and Remote Aux Panels.

The following topics are discussed in this chapter:

• Auxiliary Control Panel Operation
• Remote Aux Panel Operation
Auxiliary Control Panel Operation

In addition to crosspoint buttons, all Auxiliary Control Panels include dedicated Aux Bank and Aux Bus buttons, as well as Control buttons (Figure 12.1).

- **Crosspoint Buttons** — The Crosspoint buttons allow you to select a video source on the selected bus. If the Auxiliary Control Panel is in Aux Bus mode, the crosspoint buttons select the video source being fed out of the aux bus.

  **Operating Tip** — Crosspoint buttons can be mapped as AuxKey Cut, or Transition buttons to perform transition from your Auxiliary Control Panel. Refer to the section “Editing Bus Maps” on page Eng 7-13 for information on mapping commands to crosspoint buttons.

- **Aux Bank and Bus Buttons** — The Aux Bank and Aux Bus buttons allow you to select the specific Aux Bus that you want to assign the Auxiliary Control Panel to.
- **Control Buttons** — The Control buttons allow you to switch between the operating modes, and perform various operations when in each mode.

![Figure 12.1 Auxiliary Control Panel (24-Button Shown)](image)

**Note** — The Auxiliary Control Panel must be assigned to an Internal Panel Row for menu follows and double-press actions to work. Refer to the section “Communications Setup” on page Eng 14-8 for more information.

The Auxiliary Control Panel allows you to select the video source that is being fed out of any Aux Buses on the switcher. You can select the Aux Bank and Aux Bus, and the video signal you want (Figure 12.2).

**Operating Tip** — (Internal Panel Row Auxiliary Control Panel Only) If the Aux Bus you are selecting is set up as an AuxKey, you can double-press the Assign button on the Auxiliary Control Panel to assign the AuxKey to a row on the Vision control panel. The particular panel row that the AuxKey is assigned to is the panel row that the Auxiliary Control Panel is assigned to from the Panel Modules Menu.

![Figure 12.2 Aux Bus Mode — Auxiliary Control Panel (24-Button Shown)](image)
The Control buttons on the Auxiliary Control Panel are assigned as Custom Control Shot Box buttons, allowing you to access the first 14 custom controls from the Shot Box Pages. Shot Box Pages are assigned to the Auxiliary Control Panel in the same way as they are assigned to a Custom Control Shot Box Module.

**For More Information...**

- on assigning Shot Box Pages to an Auxiliary Control Panel, refer to the section “**Custom Control Shot Box Module Setup**” on page Eng 15-2.
- on assigning a Bus Map to an Auxiliary Control Panel, refer to the section “**Assigning Panel Bus Maps**” on page Eng 7-19.
Remote Aux Panel Operation

The Remote Aux Panels are one-piece panels that provide remote control, or monitoring, capability over one, or more, of the Aux Buses on the switcher. These panels are typically located close to the destination device that they route their sources to. Video does not flow through these panels, instead, the Remote Aux Panel interfaces with the switcher to control the outputs of the Aux Bus.

Remote Aux Panel Overview

In addition to crosspoint buttons, all Remote Aux Panels include dedicated buttons for Program, all available MLEs, and Clean Feed. The Assignable Remote Aux Panel (Figure 12.3) for all Vision switchers are similar, and differ only in the number of crosspoint buttons, MLE buttons, and Assign buttons.

![Assignable Remote Aux Panel](image)

*Figure 12.3 Assignable Remote Aux Panel*

All Remote Aux Panels include an on-air LED that indicates, when lit, that the Aux Bus controls a video signal that is part of the program output.

**Note** — The Dedicated Remote Aux Panels are similar to the Assignable Remote Aux Panels, with the exception that they do not have the Aux Bus Assign Group buttons.

**For More Information...**

- on installing a Remote Aux Panel, refer to the section “Installing Auxiliary Panels” on page Eng 14-5.

Using a Remote Aux Panel

Source selection on both the Assignable Remote Aux Panel and the Dedicated Remote Aux Panel is the same as selecting sources on the crosspoint group of the control panel. The sources that are assigned to the crosspoint buttons depend on the Bus Map that has been assigned to the Aux Bus the Remote Aux Panel is controlling.

The Assignable Remote Aux Panel can be assigned to any of either the first 10 or 12 Aux buses on the switcher, depending on the Remote Aux Panel you are using. The Remote Aux Panel can be assigned to the first 12.

To assign the Remote Aux Panel to a particular Aux bus, you must use the assign buttons on the Remote Aux Panel. These buttons are used in conjunction with each other to select a particular Aux bus, as shown in the following table (Table 12.1).

**Note** — The Aux Buses that the buttons on the Remote Aux Panel are mapped to depends on the Aux Bus range that was assigned to the External Link port.
Table 12.1 Aux Bus Button Mapping to Aux Bus Outputs

<table>
<thead>
<tr>
<th>Aux Bus to Control</th>
<th>Remote Aux Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank1: Aux1</td>
<td>Assign 1</td>
</tr>
<tr>
<td>Bank1: Aux2</td>
<td>Assign 2</td>
</tr>
<tr>
<td>Bank1: Aux3</td>
<td>Assign 3</td>
</tr>
<tr>
<td>Bank1: Aux4</td>
<td>Assign 4</td>
</tr>
<tr>
<td>Bank1: Aux5</td>
<td>Assign +4 and Assign 1</td>
</tr>
<tr>
<td>Bank1: Aux6</td>
<td>Assign +4 and Assign 2</td>
</tr>
<tr>
<td>Bank1: Aux7</td>
<td>Assign +4 and Assign 3</td>
</tr>
<tr>
<td>Bank1: Aux8</td>
<td>Assign +4 and Assign 4</td>
</tr>
<tr>
<td>Bank2: Aux1</td>
<td>Assign +8 and Assign 1</td>
</tr>
<tr>
<td>Bank2: Aux2</td>
<td>Assign +8 and Assign 2</td>
</tr>
<tr>
<td>Bank2: Aux3</td>
<td>Assign +8 and Assign 3</td>
</tr>
<tr>
<td>Bank2: Aux4</td>
<td>Assign +8 and Assign 4</td>
</tr>
</tbody>
</table>
Squeeze & Tease Basic Operation

In This Chapter

This chapter provides a basic introduction to the Squeeze & Tease option for the Vision switcher. The following topics are discussed in this chapter:

• Operational Overview
• Working in 3D Space

Note — The operational description provided in this chapter refer only to the 3D capabilities of flying keys.
Operational Overview

The Squeeze & Tease option operates by manipulating keys in 3 dimensional space. This allows you to position keys in front of, or behind, other keys, and make keys appear larger or smaller than they are. You can also apply environmental effects to the keys such as lighting, or apply video manipulation effects such as colorization. To apply any of the Squeeze & Tease effects to a key, you must have the FLY KEY button in the Keyers Module or Downstream Keyers Module on. When Squeeze & Tease resources are applied to a Keyer, the selected key type (Self Key, Auto Select, Chroma Key, or PST PATT) is said to be Flying. You can fly any type of key, provided you have the available channel resources.

When you fly a key, the video signal for the key is contained in an image. By positioning or rotating, or applying other linear, environmental, or color effects to the image, you are defining how you want the switcher to display the video signal for that flying key.

The image can be positioned anywhere in the virtual 3D world; however, it is only visible on screen if it is within the Visible Area (Figure 13.1). This allows you to perform transition effects where the image appears to fly in from one side. The image is being taken from a position outside of the Visible Area into the Visible Area.

![Figure 13.1 Image Overview](image_url)
Working in 3D Space

In order to maximize the features of the Squeeze & Tease option, it helps to have a basic understanding of three-dimensional (3D) space (Figure 13.2). Three axes (X, Y, and Z) are used to define 3D space. The position of an image on each of the three axes determines its location in 3D space.

- **X** — Refers to the horizontal (left-right) position of the image on the screen.
- **Y** — Refers to the vertical (up-down) position of the image on the screen.
- **Z** — Refers to the distance (forwards-backwards) of the image to the screen.

![Figure 13.2 Basics of 3D Space](image)

**Image Location in 3D Space**

The center point of the screen is the zero point. Each axis has a positive and negative region.

- Moving an image to the left of the center (or zero) point locates it in **-X space**.
- Moving an image to the right of the center point locates it in **+X space**.
- Moving an image below the center point locates it in **-Y space**.
- Moving an image above the center point locates it in **+Y space**.
- Moving an image closer to you locates it in **-Z space**.
- Moving an image away from you locates it in **+Z space**.

**Position Coordinates**

The 3D space you work with in this system has upper and lower limits. Position coordinates are used to define an image location in 3D space and are shown as a unit measurement on the menus. A change in position of 1.000 units is equal to a move of 1 full screen. For example, to move the image two screens to the right, adjust the X-Axis value to 2.000.

Changing the location of an image in 3D space does not affect the size or shape of the image. However, when an image is moved forward, it appears larger on the screen. When located at a greater distance in 3D space, it appears smaller.

Position coordinates can be adjusted using the positioner or the knobs on the menu.

- You can move the image **144.000** full screen widths in either direction on the **X-Axis**.
- You can move the image **144.000** full screen heights in either direction on the **Y-Axis**.
- You can move the image **400.000** full screen widths in either direction on the **Z-Axis**.
You may want to think of the 3D working area as a cube with a defined width (X-Axis), height (Y-Axis), and depth (Z-Axis) (Figure 13.3).

**Note** — The Z-Axis works somewhat differently than the other axes because it is the equivalent of 400 screen widths in each direction. Images can be moved on the Z-Axis until they become so small they disappear from view.

### Screen and Image Location

You can manipulate images in different ways within 3D space to achieve creative results.

When working with images, keep in mind that 3D space extends beyond the visible area of the screen. Images can be positioned and manipulated outside of the viewable area to create some interesting effects.

The viewpoint is the point in space that the image is viewed from (Figure 13.4).

![Figure 13.4 Screen and Image Locations in 3D Space](image)

The visible area is the area within 3D space that can be seen from the viewpoint (Figure 13.5).
Images can be manipulated outside the visible area to create specific effects. For example, an image can be rotated in such a way that it appears to roll into view from a point outside the screen and roll out of view on the other side.

It is also possible to move an image to a point behind the viewer. For example, you can manipulate an image so that it appears to come towards the viewpoint and keeps going until it passes by the viewer. For this effect, the image will get larger as it moves towards the viewpoint and then disappear.

You can also create a circular motion effect where the image sweeps across the screen in a large arc that appears to continue behind the viewer.

**Perspective**

Since you are viewing 3D images on a two-dimensional surface (the screen), it is important to recognize how depth is perceived. This involves understanding relative size, parallax, and viewpoint perspective.

**Relative Size**

When working with the Z-Axis, images that are closer appear larger than images further away. Zooming the image changes the distance between the image and the viewpoint, but does not change the size of the image (Figure 13.6). Images that are closer also appear over top of images that are further away.
Operating Tip — Using the positioner to center the image when it is very far away can be difficult. It is recommended that you use the knobs or the CLEAR button to center the image if you are moving it along the Z-Axis. Refer to the section “Image Centering” on page Ops 13-9 for more information.

Parallax Effect

If you are manipulating two images at once, you may notice that the image closer to you appears to be moving faster than the one that is further away (Figure 13.7). This effect is known as motion parallax. It occurs because images that are closer to you move further across your field of view than images in the distance.

Although both images are moving at the same rate, the closer image will reach the end of the field of view first, giving the impression that it was moving faster.

Viewpoint and Perspective

Another effect you may notice when you move an image left or right on the X-Axis is that it appears to change its angle of rotation (Figure 13.8). The image appears to move in a sweeping motion, although its angle of rotation remains unchanged. This is because the viewpoint is not being moved along with the image. Since the image is moving but the viewpoint is not, you are seeing the image from a different angle.

The same effect can be seen when moving an image up or down on the Y-Axis when using a fixed viewpoint (Figure 13.9). If the image is moved higher in 3D space, you see the image as if you are looking up at it.
In Squeeze & Tease, you can change the viewpoint to create a different perspective. You can also choose to have the viewpoint repositioned along with the image to eliminate perspective effects.

**Image Rotation**

Rotation can occur around the X, Y, or Z-Axes. Rotation values are shown as a spin number on the menus.

The pivot point of the rotation (point of rotation) can be set to any point on or off the plane of the image to produce a variety of creative effects. The default pivot point is the center of the image.

**Note** — *Changing the position of an image in 3D space does not change the pivot point. The pivot point is relative to the image. For example, if you adjust the pivot point to the top right-hand corner of the image, then move the image, the pivot point will still be at the top right-hand corner of the image.*

A rotation of **1.000** is equal to a **360°** rotation (one complete revolution).

- A rotation value of **0.250** is equal to a **90°** rotation.
- A rotation value of **0.500** is equal to a **180°** rotation.

Rotation can be adjusted from **0.001** to **20.000** in either direction (-20.000 to +20.000), so you can create an effect that involves up to 40 complete rotations. The greater rotation value (negative or positive), the more times the image spins around the pivot point.
X-Axis Rotation

The image rotates horizontally about the Y-Axis (Figure 13.10). A positive rotation spins the image from left to right and a negative rotation spins it from right to left.

Y-Axis Rotation

The image rotates vertically about the X-Axis (Figure 13.11). A positive rotation will spin the image from top to bottom and a negative rotation will spin it from bottom to top.

Z-Axis Rotation

The image rotates about the Z-Axis (Figure 13.12). A positive rotation will spin the image clockwise and a negative rotation will spin the image counter-clockwise.

Note — As you rotate an image, the relative directions of rotation (the positive and negative rotation) may swap if you switch from one axis to another without centering the image.
In the menu, an R is shown to indicate its orientation.

![Image Orientation](image.png)

**Image Centering**

The **CLEAR** button on the **Positioner Module** is used to reset the image to the default image settings.

- Press the **CLEAR** button once to reset the values on the current menu.
- Double-press the **CLEAR** button to reset all of the image values.

You can also reset specific parameters (for example, Z location) using the **CLEAR** button and the **F** buttons on the touchscreen. Press and hold the Squeeze & Tease parameter you want to default, and press the **CLEAR** button on the **Positioner Module**.

**Conclusion**

The rest of the chapter discusses the operation of the Squeeze & Tease system. Now that you understand the basic concepts of how the system works, the best way to learn how to create specific effects is with some hands-on practice to get a “feel” for the system. Use the positioner to try different image placements and experiment by changing the pivot point and rotation values. In the end, your knowledge of position and rotation coordinates will help you manipulate your images creatively and accurately for repeatable results.

*For More Information...*

- on Keyers, refer to the section “**Keyers Module**” on page Ops 7-2.
- on flying keys, refer to the section “**DVE Keys (Fly Key)**” on page Ops 8-2.
- individual centering images, refer to the section “**Image Centering**” on page Ops 13-9
DVE Sequences and Wipes

In This Chapter

This chapter provides detailed instructions for using the Sequences and DVE Wipe features.

The following topics are discussed in this chapter:

- Sequence Overview
- Creating and Editing 2D DVE Sequences
- Creating and Editing Squeeze & Tease Sequences
- DVE Wipes
- Saving and Loading Sequences and Wipes
- Using DVE Wipes and Sequences
Sequence Overview

A Sequence is a series of keyframes, or effects, that are created, saved, and run directly from your switcher. You can use any of the DVE functions to manipulate the keyframes in a sequence. For example, a sequence might consist of a channel, or object, that rotates across the screen, moves to a specific location in 3D space and acquires a border or any other DVE effect. The switcher interpolates, or fills in, the shots between the keyframes to produce a fluid motion effect.

Note — A sequence must be created and used on a flying key. A Squeeze & Tease wipe that is created from a sequence can be run on either a background or a key.

The following example (Figure 14.1) shows a simple sequence with four keyframes:

![Figure 14.1 Example of a Four Keyframe Sequence](image)

1. The channel starts in the bottom left corner.
2. The channel rotates and moves to the position shown in Keyframe 1.
3. The channel rotates and moves to the position in Keyframe 2.
4. The channel moves to the position shown in Keyframe 3.
5. The channel acquires a border and moves to the position shown in Keyframe 4.

Note — When attempting to run a sequence on a background rather than a key, it automatically runs as a dissolve. You cannot select PST BKGD or Trans PV with sequence mode.
Creating and Editing 2D DVE Sequences

A sequence is created by inserting keyframes of how you want the channel to appear, and how long you want the switcher to take to move from one keyframe to the next. Each keyframe has a duration that is used when the sequence is moving to that keyframe.

DVE Sequences Menu

There are a number of buttons on the DVE Sequences menu that allow you to quickly manage your sequences.

- **Previous** — move to the previous keyframe in the sequence.
- **Next** — move to the next keyframe in the sequence.
- **Cut** — cut the current keyframe.
- **Copy** — copy the current keyframe.
- **Paste** — paste the keyframe from the clipboard to after the current keyframe.
- **Paste Over** — paste the keyframe from the clipboard over the current keyframe, replacing the current keyframe.
- **Insert** — insert a keyframe after the current keyframe.
- **Insert Over** — insert a keyframe over the current keyframe, replacing the current keyframe.
- **Delete** — delete the current keyframe.
- **Delete Workspace** — delete all keyframes in the sequence.

To Create or Edit a 2D DVE Sequence

**Operating Tip** — If you are editing a keyframe, highlight the keyframe you want to edit, make the required changes and press **Insert Over**. This replaces the existing keyframe with the newly edited one. Don’t forget to save your sequence.

1. Navigate to the DVE menus for the DVE key you want to create a sequence for and press **DVE Menu ⇒ Sequence**.

Operating Tip — Press **Runtime** to navigate to the **DVE Sequence Runtime** menu.
2. Position the key where you want the sequence to start.
   If the sequence is run as a sequence, the key moves to the first keyframe at the duration set for the first keyframe. If the sequence is run as a wipe, the duration of the first keyframe is set to zero.

3. Press Duration and use the Frames knob to set the number of frames it will take for the sequence to move to this keyframe.

   Operating Tip — If you do not want to enter a specific duration, you can insert a Hold in the sequence by toggling Hold to On. When the sequence reaches this point, it will wait until you press Auto Trans again.

Because this is the first keyframe, the sequence will only use this duration if the sequence is being run in reverse.

4. Use the Type knob to select the type of motion you want to use to move to this keyframe.
   - **Smooth** — key accelerates slowly at the start and decelerates slowly at the end of the sequence. The motion between the keyframes is a straight line.
   - **Spline** — key accelerates slowly at the start and decelerates slowly at the end of the sequence. The motion between the keyframes is a user modifiable spline-curve that smoothly moves the key through each keyframe.
   - **Linear** — key moves from keyframe to keyframe at a constant velocity. This produces a step-motion effect.

5. If you selected Spline as the type of motion, press Spline Params and use the Tension, Bias, and Continuity knobs to adjust the appearance of the motion.
   - **Tension** — adjust how tight or loose the curve is. Lower tension gives a looser, more sweeping curve while tightening the tension brings the curve closer to a straight line
   - **Bias** — balance how much influence the previous and next keyframes have on the spline through the current keyframe. Increased bias places more importance on the smoothness between the previous and current points, while a decreased bias places more importance on the smoothness between the current and next points.
   - **Continuity** — adjust how smoothly the path passes through the keyframes. The standard spline path moves smoothly through each keyframe, but by adjusting the continuity you can make the path effectively come to a point at a keyframe and then abruptly move away towards the next keyframe.

6. If you plan on using the sequence as a DVE wipe, press Wipe Modifier and use the Wipe knob to select how you want the wipe to transition.
   - **None** — a cut is performed at the end of the sequence. This is designed for sequences that end with the key off-screen or not visible on the screen.
   - **Dissolve** — dissolves the key as the sequence progresses, based on the Dissolve At value. Use the Dissolve At knob to set the percentage of the way through the sequence that the dissolve will start.
   - **Slide Off** — moves the key directly off-screen in the direction that the key was last moving. This is done by moving the key in the X and/or Y axis.

7. Press Insert to insert the keyframe.

8. Insert additional keyframes as required.
Creating and Editing Squeeze & Tease Sequences

A Squeeze & Tease DVE sequence is created by inserting keyframes of how you want the channel to appear, and how long you want the switcher to take to move from one keyframe to the next. Each keyframe has a duration that is used when the sequence is moving to that keyframe.

S&T MD Sequences Menu

There are a number of buttons on the S&T MD Sequences menu that allow you to quickly manage your sequences.

- **Previous Keyframe** — move to the previous keyframe in the sequence.
- **Next Keyframe** — move to the next keyframe in the sequence.
- **Insert Keyframe** — insert a keyframe before the current keyframe.
- **Overwrite Keyframe** — insert a keyframe over the current keyframe, replacing the current keyframe.
- **Cut Keyframe** — cut the current keyframe.
- **Copy Keyframe** — copy the current keyframe.
- **Paste Keyframe** — paste the keyframe from the clipboard to after the current keyframe.
- **Delete Keyframe** — delete the current keyframe.
- **Delete Workspace** — delete all keyframes in the sequence.

To Create or Edit a Squeeze & Tease Sequence

**Operating Tip** — If you are editing a keyframe, highlight the keyframe you want to edit, make the required changes and press **Overwrite Keyframe**. This replaces the existing keyframe with the newly edited one. Don’t forget to save your sequence.

1. Press the **SEL** button on the **Keyers Module** for the Keyer that you want to create a sequence in. The **S&T MD Position/Crop Menu 1-2** is displayed. The key must already be flying.
2. Press **Copy Up** on the **Lower Display Region** to copy the **S&T MD Position/Crop Menu** to the **Upper Display Region**.
3. Press the **DVE** quick navigation button to display the **S&T MD Main Menu** in the **Lower Display Region**.
4. Press **Sequence**.

**Operating Tip** — If there is already sequence information loaded on the Keyer, you can press **Delete Workspace**.

5. Press **Swap** on the **Lower Display Region** to swap the **S&T MD Position/Crop Menu** and the **S&T MD Sequence Menu**. Placing the **S&T MD Position/Crop Menu** in the **Lower Display Region** allows you to use the positioner to adjust the channel.
Note — If you are creating a Squeeze & Tease wipe that uses WARP effects, you must apply the WARP to all keyframes in the sequence. If you want to use the wipe as a Background transition, start with the channel full screen.

6. Create **Keyframe 1** for the sequence by positioning the channel how you want the sequence to start.

7. Set the duration for **Keyframe 1** as follows:
   - Press **Duration**.
   - Use the **Frames** knob to select the number of frame (amount of time) the switcher will take to move to this keyframe. This duration is only used when the sequence is being run in reverse.

Operating Tip — If you do not want to enter a specific duration, you can insert a Hold in the sequence by toggling the **Hold** to On. When the sequence reaches this point, it will wait until you press **Auto Trans** again.

8. Select the type of rotation you want for the keyframe as follows:
   - Use the **Rotate** knob to select the type of rotation you want to be performed when the channel moves to this keyframe. You can choose between the following:
     - **Normal** — Select this option if you have defined the rotation using the **S&T MD Position/Crop Menu**.
     - **Spin** — Select this option if you are using the **Spin** feature of the **Advanced Position Menu**. Refer to the section “Spin” on page Ops 13-11 for more information on setting up a spin.

9. Select the type of motion you want for the keyframe as follows:
• Use the **Type** knob to select the type of motion you want to be perform when the channel moves to this keyframe. You can choose between the following:
  - **Smooth** — The channel accelerates slowly at the start and decelerates slowly at the end of the sequence. The motion between the keyframes is a straight line. Proceed to **Step (11.)** to set up the rotation of the keyframe.
  - **Spline** — The channel accelerates slowly at the start and decelerates slowly at the end of the sequence. The motion between the keyframes is a user modifiable spline-curve that smoothly moves the channel through each keyframe. Proceed to **Step (10.)** to set up the rotation of the keyframe.
  - **Linear** — The channel moves from keyframe to keyframe at a constant velocity. This produces a step-motion effect. Proceed to **Step (11.)** to set up the rotation of the keyframe.

10. If you selected **Spline** as the type of motion, adjust the spline parameters as follows:
   - Press **More ⇒ Spline Params**.

   ![Spline Parameters — S&T MD Sequence Menu 2-3](image)

   **Spline Parameters — S&T MD Sequence Menu 2-3**

   • Use the **Tension** knob to affect how tight or loose the curve is. Lower tension gives a looser, more sweeping curve while tightening the tension brings the curve closer to a straight line.
   • Use the **Bias** knob to balance how much influence the previous and next keyframes have on the spline through the current keyframe. Increased bias places more importance on the smoothness between the previous and current points, while a decreased bias places more importance on the smoothness between the current and next points.
   • Use the **Continuity** knob to affect how smoothly the path passes through the keyframes. The standard spline path moves smoothly through each keyframe but by adjusting the continuity, you can make the path effectively come to a point at a keyframe and then abruptly move away towards the next keyframe.
   • Press **Back**.

11. Press **Insert Keyframe** to insert **Keyframe 1** into the sequence.

12. Add additional keyframes as required. Proceed to **Step (13.)** to insert the final keyframe and complete the sequence.

**Operating Tip** — *If you want to adjust a keyframe that has already been created. You can select the keyframe, modify it as required, and then press Overwrite Keyframe. The selected keyframe will be overwritten with the current channel selections.*

13. Position the channel for the last keyframe.

14. Select a wipe modifier as follows:
• Press **More** $\Rightarrow$ **Wipe Modifier**.

![Wipe Modifier — S&T MD Sequence Menu 2-3](image)

• Use the **Wipe** knob to select how you want the wipe to transition off-air. You can choose between the following:
  
  › **Knife Edge** — This wipe modifier finishes with the channel 90 degrees to the screen (edge on to the screen).
  
  › **Slide Off** — This wipe modifier moves the channel directly off-screen in the direction that the channel was last moving. This is done by moving the channel in the X and/or Y axis.
  
  › **Spin Off** — This wipe modifier rotates the image off the screen based on the rotation that is applied to the channel between the last two keyframes. The speed and direction of rotation between the two keyframes determines the speed and direction for the channel moving off screen.
  
  › **Dissolve** — This wipe modifier dissolves the channel as the sequence progresses, based on the **Dissolve At** value. The **Dissolve At** value is the percentage of the way through the sequence that the dissolve will start.
  
  › **None** — This wipe modifier performs a cut at the end of the sequence. This is designed for sequences that end with the channel off-screen or not visible on the screen.

• Press **Back**.

15. Press **Insert Keyframe** to insert the last keyframe.

Now that you have created a sequence, you must save it to a sequence register.

**For More Information...**

- on storing and recalling sequences, refer to the section “**Saving and Loading Sequences and Wipes**” on page Ops 14-11.
- on the supplied wipes, refer to the section “**DVE Wipes and Sequences**” on page Ops 17-2.
- on supplied sequences, refer to the section “**DVE Wipes and Sequences**” on page Ops 17-2.

Sequences are created to move and modify a channel in a series of predetermined effects. You create sequences using the various Squeeze & Tease menus.

**Note** — If you want to run a sequence with multiple channels, ensure the sequence was created with multiple channels. Running a sequence created with a single channel on a Keyer with multiple channels active will only move the first channel.
To Modify Multiple Keyframes

The Modify Keyframes feature allows you to apply a modification to one or multiple keyframes in the sequence. Once selected, you can either modify all of the keyframes by the same value, relative to their current position, or to the exact same, or absolute, position.

**Note** — You cannot modify lighting parameters across multiple keyframes. To adjust the lighting parameters of a sequence, you must Overwrite each keyframe individually.

1. Load the sequence you want to modify.
2. Press the DVE quick navigation button.
3. Press **Sequence**.
4. Modify the keyframe as desired. It does not matter which keyframe you modify, but the keyer or channel you modify is the one that the changes are applied to.
5. Press **More** ⇒ **Modify Keyframes**.

![S&T MD Modify Keyframes Menu]

**Operating Tip** — If a keyframe contains multiple channels, the parameters for each channel is calculated separately. The total number of parameters being modified is displayed.

6. Select the modification type as follows:
   - Toggle **Modify Type** to **Abs** or **Rel**.
     - **Abs** — Select **Absolute** to have all parameters changed to the same value, regardless of their previous settings. For example, changing the position of a keyframe, when modifying multiple keyframes, moves all the selected keyframes to the exact same position.
     - **Rel** — Select **Relative** to have all parameters changed by the same value. For example, changing the position of a keyframe, when modifying multiple keyframes, moves all selected keyframes by the same amount and in the same direction.

7. Select the modification range as follows:
   - Use the **Start KF** knob to select the first keyframe in the sequence that you want to edit.
   - Use the **End KF** knob to select the last keyframe in the sequence that you want to edit.

8. Press **Perform Modify** to apply the changes to all the selected keyframes.
9. Save your sequence.
DVE Wipes

A DVE Wipe is a Sequence that performs a transition, either on a background or keyer. To create a wipe, you must first create a sequence that will take a key, with one or multiple channels, through the required effect and end with it off-screen, or not visible in some other way.

DVE wipes can either be created from sequences, or you can use one of the pre-created sequences and wipes provided with your switcher software. The sequences and wipes are pre-installed when you purchase a new switcher.

To load new sequences unto your switcher, you must copy the wipes from the CD to a USB flash drive. Then you recall the sequences on your Vision control panel.

For More Information...

• on the pre-created sequences and wipes, refer to the section “DVE Wipes and Sequences” on page Ops 17-2.
• on recalling sequences from a USB flash drive, refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4.
• on storing and recalling sequences, refer to the section “Saving and Loading Sequences and Wipes” on page Ops 14-11.
• on using a sequence or wipe, refer to the section “Using DVE Wipes and Sequences” on page Ops 14-14.
Saving and Loading Sequences and Wipes

Sequences can be saved, renamed, and loaded from the menu. The MLE and Keyer that a sequence is loaded onto is listed on the menu below the title, along with the duration, number of keyframes, and number of channels of the selected sequence.

**Note** — If a sequence contains a hold, the time of the hold is not included in the Duration value on the menu.

Saving and Naming a Sequence

You can save a sequence to any one of the 100 registers on the switcher. Once saved to a register, you can rename the sequence to give it a more descriptive name.

1. Press **Load/Save Sequence**.

   ![DVE Sequence Load/Save Menu](image)

   **DVE Sequence Load/Save Menu**

2. Use the **Sequence** knob to select a register that you want to save the sequence to. Registers with a green dot next to them already contain a sequence.

3. Press **Save Sequence** to save the sequence to the selected register.

4. Press **Rename Sequence**.

   ![Sequence Name Menu](image)

   **Sequence Name Menu**

**Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the **Sequence Name Menu** to enter a name.
5. Enter the new name for the sequence in the New Name field. The name can be no more than 14 characters in length.

6. Press Accept New Name to store the new name.

Once you have saved the sequence, you can assign it to one of the pattern buttons so that it can be easily selected when you press the DVE button on the Transition Module.

For More Information...
• on performing a DVE transition, refer to the section “Wipe Transitions” on page Ops 6-3.
• on copying sequence to the switcher, refer to the section “Copying Sequences to the Switcher” on page Ops 17-5.

Loading a Sequence

You can load a sequence into a keyer either for editing, or so that you can run the sequence on that keyer. You can set a default sequence rate that is used when an MLE, or the switcher, is defaulted. This rate overrides the duration stored in the sequence.

1. Press Load/Save Sequence.

2. Use the Sequence knob to select the sequence you want to load. Only registers with a green dot next to them contain sequences.

   Operating Tip — You can delete the currently selected sequence by pressing Delete Sequence. This clears the sequence from the currently selected register.

3. Press Load Sequence to load the sequence.

   For More Information...
   • on the default sequence rate, refer to the section “Personality List” on page Eng 11-2.
DVE Wipe Pattern Button Assignment

The Squeeze & Tease MD Pattern Button feature lets you assign Squeeze & Tease Wipes to buttons on the Pattern Menu.

1. Press HOME ⇒ Setup ⇒ Personality ⇒ 3D Pattern Bttn Assign.

2. Use the Button knob to select the pattern button on the Pattern Menu that you want to assign a wipe or sequence to.

3. Use the Sequence knob to select the wipe, or sequence, that you want to assign to the selected button.
Using DVE Wipes and Sequences

Once you have created and saved your sequence, you can use it either as a sequence on a Keyer, or as a transition on a Keyer or Background. The sequence is selected either through the Pattern Selection Menu, or by entering the sequence number on the keypad.

This section shows the 2D DVE menus, but the procedures also apply to the Squeeze & Tease MD menus.

DVE Wipe Transitions

A DVE Wipe can be performed on either a Keyer or a Background, depending on the number of available DVE channel resources.

Keep the following in mind when working with DVE transitions:

- The switcher dynamically allocates DVE channel resources to produce the wipe effect. If there are not enough channel resources available, a dissolve is performed instead.
- There is a single frame of delay at the start of DVE transitions.

To run a DVE Transition

1. Select the video sources on the buses that you want to transition.
2. Select Background or a Keyer as the next transition on the Transition Module of the MLE.
3. Press the DVE button on the Transition Module.

Operating Tip — When you press DVE on the Transition Module, 2D MLEx WIPE# is shown on the display of the Global Memory Module. Enter the number of the sequence you want to load using the keypad on the Global Memory Module and press ENTER to load the sequence.

4. Select the sequence you want to use for the transition.

Note — The Direction and Flip Flop features are only available for background transitions. The buttons are gray if a key only transition is selected.

5. Toggle Direction to select either Rev or Fwd.
The sequence runs either forward, going from the first keyframe to the last, or in reverse, going from the last keyframe to the first.

6. Toggle **Flip Flop** to select either **On** or **Off**.

   With Flip/Flop toggled **On**, the sequence will run forward and then reverse.

7. Perform the transition using the fader, or by pressing the **AUTO TRANS** or **CUT** button on the **Transition Module**.

*For More Information...*

- on how to set up and perform a transition, refer to the section “Performing Transitions” on page Ops 5-13.
- on the pre-loaded patterns, refer to the section “DVE Wipes and Sequences” on page Ops 17-2.

### Running a Sequence

A Sequence can be performed only on a Keyer that is flying a key. Unlike the Squeeze & Tease wipes, sequences do not perform transitions.

You can set a default sequence rate that is used when an MLE, or the switcher, is defaulted. This rate overrides the duration stored in the sequence.

### To Run a Sequence

1. Select the video sources on the buses that you want to use.

2. Select a **Keyer** as the next transition on the **Transition Module** of the MLE.

3. Press the **SEQ** button on the **Transition Module**.

### Operating Tip — When you press **SEQ** on the Transition Module, 3D MLEX SEQ# is shown on the display of the **Global Memory Module**. Enter the number of the sequence you want to load using the keypad on the **Global Memory Module** and press **ENTER** to load the sequence. The second line of the display shows the duration of the loaded sequence.

### Sequence — DVE Wipe List Menu

4. Select the sequence you want to use for the transition.

5. Toggle **Direction** to select either **Rev** or **Fwd**.

   The sequence runs either forward, going from the first keyframe to the last, or in reverse, going from the last keyframe to the first.

6. Toggle **Flip Flop** to select either **On** or **Off**.
With Flip/Flop toggled On, the sequence runs forward and then reverse.

7. Adjust the sequence as follows:
   - Press Modify Sequence.
   - Adjust the sequence as required. Refer to the section “To Modify Multiple Keyframes” on page Ops 14-9 for more information on modifying a sequence.

8. Run the sequence using the fader, or by pressing the AUTO TRANS or CUT button on the Transition Module.

To Run Multiple Sequences

You can run multiple sequences at once just as you would run a single sequence.

1. Set up a sequence in each keyer that you want to run a sequence on.
2. Select the Keyers as the next transition on the Transition Module of the MLE.
3. Press the SEQ button on the Transition Module.

4. Run the sequences using the fader, or by pressing the AUTO TRANS or CUT button on the Transition Module.

Operating Tip — You can run or pause an individual sequence by toggling Key X to Start or Pause.

For More Information...

- on setting up and perform a transition, refer to the section “Performing Transitions” on page Ops 5-13.
- on the pre-loaded patterns, refer to the section “DVE Wipes and Sequences” on page Ops 17-2.
- on creating or modifying a sequence, refer to the section “Creating and Editing 2D DVE Sequences” on page Ops 14-3.
- on the default sequence rate, refer to the section “Personality List” on page Eng 11-2.
Lighting & Preprocessor Effects

In This Chapter

This chapter provides detailed instructions for setting up and applying Squeeze & Tease Lighting and Preprocessor Effects.

The following topics are discussed in this chapter:

- Lighting
- Preprocessor Effects
Lighting

Lighting effects allow you to apply ambient and directional lighting effect to Squeeze & Tease channels in 3D space. Lighting is applied to each channel of a Keyer, although a lighting effect can be applied to all the channels in the same Keyer.

- **Directional Lighting** — A directional light source emits light in all directions, like a light bulb. The amount of light that is projected onto a channel depends on the distance the channel is from the light source and the intensity of the light. Directional light can be used to define sharp edges and deepen shadows to provide the appearance of depth.

- **Ambient Lighting** — Ambient lighting affects the lighting level for the entire channel. The entire channel is illuminated with a uniform lighting, much like daylight in the real world.

Applying Lighting Effects

Lighting effects are applied to individual channels. If you select both channels in the same Keyer, you can apply the exact same lighting effect to both channels to make it appear as a single lighting effect is being applied to multiple channels.

1. Press the SEL button on the Keyers Module for the Keyer that you want to apply lighting to the channel for. The S&T MD Position/Crop Menu 1-2 is displayed. The key must already be flying.
2. Press the DVE quick navigation button to display the S&T MD Main Menu 1-2.
3. Press Lighting.

![S&T MD Lighting Menu](image)

4. Use the Lighting knob to turn lighting on or off.
   - **None** — Select this option to turn lighting Off.
   - **Natural** — Select this option to turn lighting On.
5. Adjust the level of the ambient light as follows:
   - Press Lighting Setup.
   - Use the Ambient knob, or the positioner, to select the amount of ambient light you want.
6. Turn on a directional light as follows:
   - Press Lighting Setup.
   - Use the Intensity knob, or the positioner, to select the intensity of the directional light.
7. Select a preset position or lighting level as follows:
   • Press **Presets**.

   ![Preset — S&T MD Lighting Menu](image)

   • Use the **Presets** knob to select the lighting or position preset you want to use. You can choose between the following:
     › **Other** — Select this option to manually position the light.
     › **Center** — Select this option to have the directional light placed at the center and slightly in front of the channel at the current intensity.
     › **Top Left** — Select this option to have the directional light placed at the top left corner and slightly in front of the channel at the current intensity.
     › **Top Right** — Select this option to have the directional light placed at the top right corner and slightly in front of the channel at the current intensity.
     › **Close** — Select this option to have the directional light placed at the center of the channel at the current intensity.
     › **Dim** — Select this option to apply a low intensity directional and ambient light.
     › **Ambient Only** — Select this option to apply only the ambient lighting, ignoring the directional lighting effects. This allows you to turn the lighting on for a sequence so that lighting effect can be added smoothly.

8. Adjust the position of the directional light source as follows:
   • Press **Position**.

   ![Position — S&T MD Lighting Menu](image)

   • Use the **X Location** knob, or the positioner, to adjust the horizontal position of the light source.
• Use the **Y Location** knob, or the positioner, to adjust the vertical position of the light source.
• Use the **Z Location** knob, or the positioner, to adjust the distance the light source is from the center point.

9. Turn Auto Follow on or off as follows:
   • Toggle **Auto Follow** to **On** to enable this feature.
     › **On** — The directional light source remains at a relative position to the center of the channels. This helps to keep the light constant when moving the channel in a sequence or a wipe.
     › **Off** — The directional light source remains at a fixed position in 3D space and does not move with the associated channels.

10. Adjust the luminance clipping of the directional and ambient light as follows:
    • Press **Luminance Clipping**.

    ![Luminance Clipping — S&T MD Lighting Menu](image)

    • Use the **Min. Light** knob to adjust the minimum luminance threshold level.
    • Use the **Max. Light** knob to adjust the maximum luminance threshold level.
Preprocessor Effects

Preprocessor effects allow you to perform a number of static effects to a channel. These effects are applied directly to the channels and are not associated with other Squeeze & Tease MD effects, such as a wipe.

You can apply multiple Preprocessor effects to the same channel without affecting other channels, or other Preprocessor effects. Multiple effects on the same channel are cumulative, producing a combined effect.

Operating Tip — You can use the Channel button on the S&T MD Preprocessor Menu to select the individual channel, or group of channels, that you want to apply a preprocessor effect to.

Defocus

The Defocus effect adds a horizontal and vertical blur to the image on the channel.

1. Press the SEL button on the Keyers Module for the Keyer that you want to apply preprocessor effect to the channel for. The S&T MD Position/Crop Menu 1-2 is displayed. The key must already be flying.

2. Press the DVE quick navigation button to display the S&T MD Main Menu 1-2.

3. Press Preprocessor.

4. Toggle Defocus to On to apply this effect.

5. Use the Horiz. Defocus knob, or positioner, to adjust the amount of horizontal defocus.

6. Use the Vert. Defocus knob, or positioner, to adjust the amount of vertical defocus.

7. Use the Overall knob, or positioner, to adjust the amount of horizontal and vertical defocus.

Mosaic

The Mosaic effect transforms the image on the channel into an arrangement of tiles. The size of the tiles can be adjusted both horizontally and vertically.
1. Press the **SEL** button on the **Keyers Module** for the Keyer that you want to apply preprocessor effect to the channel for. The **S&T MD Position/Crop Menu 1-2** is displayed. The key must already be flying.

2. Press the **DVE** quick navigation button to display the **S&T MD Main Menu 1-2**.

3. Press **Preprocessor**.

4. Toggle **Mosaic** to **On** to apply this effect.

5. Use the **Horiz. Tiles** knob, or positioner, to adjust the size, in pixels, of horizontal tiles.

6. Use the **Vert. Tiles** knob, or positioner, to adjust the size, in pixels, of vertical tiles.

7. Use the **Overall** knob, or positioner, to adjust the size, in pixels, of horizontal and vertical tiles.

**Posterize**

The Posterize effect adjusts the amount of luminance and chrominance ranges of the image on the channel.

1. Press the **SEL** button on the **Keyers Module** for the Keyer that you want to apply preprocessor effect to the channel for. The **S&T MD Position/Crop Menu 1-2** is displayed. The key must already be flying.

2. Press the **DVE** quick navigation button to display the **S&T MD Main Menu 1-2**.

3. Press **Preprocessor**.

4. Toggle **Posterize** to **On** to apply this effect.
5. Use the **Luma** knob, or positioner, to adjust the luminance range of the image on the channel.

6. Use the **Chroma** knob, or positioner, to adjust the chrominance range of the image on the channel.

7. Use the **Overall** knob, or positioner, to adjust both the luminance and chrominance ranges.

### Colorize

The Colorize effect replaces the existing colors in the image on the channel with the varying shades of the selected color.

1. Press the **SEL** button on the **Keyers Module** for the Keyer that you want to apply preprocessor effect to the channel for. The **S&T MD Position/Crop Menu 1-2** is displayed. The key must already be flying.

2. Press the **DVE** quick navigation button to display the **S&T MD Main Menu 1-2**.

3. Press **Preprocessor**.

4. Toggle **Colorize** to **On** to apply this effect.

![Colorize — S&T MD Preprocessor Menu](image)

5. Use the **Hue** knob, or positioner, to select the color you want to use.

6. Use the **Saturation** knob, or positioner, to select the lightness of the color you selected.

### Strobe

The Strobe effect alternates between freezing and playing the live video of the channel.

1. Press the **SEL** button on the **Keyers Module** for the Keyer that you want to apply preprocessor effect to the channel for. The **S&T MD Position/Crop Menu 1-2** is displayed. The key must already be flying.

2. Press the **DVE** quick navigation button to display the **S&T MD Main Menu 1-2**.

3. Press **Preprocessor**.

4. Toggle **Strobe** to **On** to apply this effect.
5. Use the **Mode** knob to select **Frame** or **Field** based strobe. This depends on the native reference format that the switcher is operating in. If the switcher is operating in a Progressive Scan reference format, you will only be able to select **Frame**.

6. Use the **Live Fields (or Live Frame)** knob, or positioner, to select the number of field (or frames) of live video before the frozen ones.

7. Use the **Frozen Fields (or Frozen Frames)** knob, or positioner, to select the number of frozen fields (or frames) after the live ones.
WARP Effects

In This Chapter

This chapter provides information on using Squeeze & Tease MD WARP. Warp effects can be combined with any other Squeeze & Tease MD effect, such as preprocessor and lighting effects.

**Note** — Squeeze & Tease MD WARP cannot be used with a 1080p video format. If the switcher is operating in this video format, the WARP feature will not be available.

The following topics are discussed in this chapter:

- WARP Resources
- Selecting a WARP Effect
- Film WARP
- Globe WARP
- Heart WARP
- Lens Flare WARP
- Magnify WARP
- Melt WARP
- Obscure WARP
- Page Roll WARP
- Pixie Dust WARP
- Ripple WARP
- Sand WARP
- Split WARP
- Star WARP
- Stretch WARP
WARP Resources

Each WARP card installed in the frame provides a single WARP resource that is available to the MLE-pair that the Squeeze & Tease MD Carrier is installed for. Each Squeeze & Tease MD Carrier provides a maximum of 2 WARP cards that can be applied either to a single MLE, or one to each MLE.

One WARP resource is required to provide a single WARP effect (Table 16.1). A single WARP effect can be a WARP that is applied to a keyer, or a Squeeze & Tease MD wipe that contains a WARP effect. If a WARP is used in a transition, only a single WARP resource is consumed, even if multiple video signals are being transitioned.

Table 16.1 WARP Resource Usage

<table>
<thead>
<tr>
<th>Scenario</th>
<th>WARP Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applying WARP effect to channel</td>
<td>1</td>
</tr>
<tr>
<td>Running a Sequence containing a WARP effect in a keyer</td>
<td>1</td>
</tr>
<tr>
<td>Running a Squeeze &amp; Tease wipe with a WARP effect on...</td>
<td></td>
</tr>
<tr>
<td>• Background</td>
<td>1</td>
</tr>
<tr>
<td>• Background and Keyer</td>
<td>1</td>
</tr>
<tr>
<td>• Keyer</td>
<td>1</td>
</tr>
<tr>
<td>• Two Keyers</td>
<td>2</td>
</tr>
</tbody>
</table>

Using WARP Resources

If you try to use an additional WARP resource when all the WARP resources are already consumed, the switcher will give you the option to cancel the action, or take one of the currently used WARP resources. If you choose to take one of the WARP resources, the effect being generated by that WARP resource will be lost. For example, if the WARP resource is being used as part of a sequence, the sequence will be unloaded when you take the WARP resource. If the WARP resource is being used in a Squeeze & Tease MD wipe, the transition type will be changed to a dissolve when you take the WARP resource.

If the WARP effect you are trying to perform requires two WARP resources, you will be asked to either confirm the taking of the WARP resources from the other effects, or to cancel the action.

Once sufficient WARP resources have been taken, the new effect can be created, unless the effect was being created by one of the following:

- Memory Recall
- Keyer Copy or Swap
- MLE Copy

In these cases, the action was performed without the requested WARP resources. You must perform the action again to have the WARP resources assigned to the effect.
Selecting a WARP Effect

To apply a WARP effect to a key you must select the MLE and Keyer that you want to apply the effect to, select the effect, and then activate the WARP engine. The key must be flying.

1. Press the SEL button on the Keyers Module for the Keyer that you want to apply the WARP to. The S&T MD Position/Crop Menu 1-2 is displayed. The key must already be flying.

Note — Squeeze & Tease MD WARP effects are applied full screen. If your key is not at full screen, the WARP effect may not appear as expected or desired.

2. Press the DVE quick navigation button to display the S&T MD Main Menu 1-2.
3. Press More ⇒ WARP.

4. Use the Category knob to select Favorites.
5. Use the WARP knob to select the WARP you want to use.
6. Press Select to activate the WARP.

Depending on the WARP you activated, you will have to set up the parameters for the WARP.
Film WARP

The Film WARP applies an effect to the key video to make it appear as if it was produced during different ages, such as the 1900s or 1920s, or that it is amateur video.

1. Select and activate the Film WARP effect on the keyer you want to apply it to.
2. Press Film.

3. Select a film preset and adjust it as follows:
   - Use the Film Presets knob to select the type of Film effect you want to use.
   - Use the Noise knob, or the positioner, to select the amount of visual noise you want in the effect.
   - Use the Resolution knob, or the positioner, to select the apparent resolution of the video with the effect applied.
   - Use the Line Scratch knob, or the positioner, to select the amount of scratch lines on the key video.
   - Use the Rand. Scratch knob, or the positioner, to select the amount of random scratches that appear on the key video.
   - Use the Film Jump knob, or the positioner, to select the amount of film jump, or jitter, of the key video.
5. Press Light.
Use the **Flash** knob, or the positioner, to select the number of times the lighting effect flashes.

Use the **Intensity** knob, or the positioner, to select the intensity of the light used in the lighting effect.

Use the **Radius** knob, or the positioner, to select the radius of the lighting effect.

6. Press **Color**.

Use the **Luminance** knob, or the positioner, to adjust the luminance of the film effect.

Use the **Saturation** knob, or the positioner, to adjust the saturation of the film effect.

Use the **Hue** knob, or the positioner, to adjust the hue of the film effect.

7. Press **Sensitivity**.
• Use the **Red** knob, or the positioner, to adjust amount of red in the key video.
• Use the **Blue** knob, or the positioner, to adjust the amount of blue in the key video.
• Use the **Luma Contrast** knob, or the positioner, to adjust the luminance and contrast of the key video.
Globe WARP

The Globe WARP wraps the key video around a globe shape. Once formed, lighting and movement effects can be added to the globe.

1. Select and activate the Globe WARP effect on the keyer you want to apply it.
2. Press Rotation.

3. Create the globe as follows:
   - Use the Creation knob, or the positioner, to select 100%. You can only apply the parameters of the WARP to the key when it is fully created.
   - Use the X-Rot knob, or the positioner, to rotate the key video around the globe horizontally.
   - Use the Y-Rot knob, or the positioner, to rotate the key video around the globe vertically.

5. Press Movement.
• Use the X-Rate knob, or the positioner, to adjust the amount of horizontal movement, or rotation, of the globe.
• Use the Y-Rate knob, or the positioner, to adjust the amount of vertical movement, or rotation, of the globe.


• Use the Type knob to select the type of light source that will be applied to the globe. You can choose between the following:
  › None — Select this option to turn off the lighting.
  › Natural — Select this option to use a natural looking light source.
  › White — Select this option to use a harsh, white light source.
• Use the Highlight knob, or the positioner, to adjust the brightness of the light.
• Use the Shadow knob, or the positioner, to adjust the amount of shadow.

7. Press Light Pos.
Globe (Light Position) — S&T WARP Menu

- Use the **Gleam Size** knob, or the positioner, to adjust the size of the gleam on the globe produced by the light source.
- Use the **Z Rot.** knob, or the positioner, to rotate the light source around the globe in the Z-Axis.
- Use the **X-Y Rot.** knob, or the positioner, to rotate the light source around the globe in the X and Y-Axes.
Heart WARP

The Heart WARP places the key video inside a heart shape. As you create the WARP, the heart shape will shrink down around the key and then it will fly off with the key. The direction and speed that it moves is determined by the settings. The color of the border of the heart can also be changed.

1. Select and activate the Heart WARP effect on the keyer you want to apply it.
2. Press **Position**.

   ![Heart (Position) — S&T WARP Menu](image)

3. Create the heart as follows:
   - Use the **Size/Creation** knob, or the positioner, to move the heart through the path of the WARP.
   - Use the **X-Pos** knob, or the positioner, to adjust the horizontal position of the center point of the heart on screen.
   - Use the **Y-Pos** knob, or the positioner, to adjust the vertical position of the center point of the heart on screen.

4. Press **Rotation**.

   ![Heart (Rotation) — S&T WARP Menu](image)

   - Use the **X-Rotation** knob, or the positioner, to adjust the number of horizontal rotations the heart does along the path of the WARP.
   - Use the **Y-Rotation** knob, or the positioner, to adjust the number of vertical rotations the heart does along the path of the WARP.
   - Use the **Z-Rotation** knob, or the positioner, to adjust the number of clockwise, or counter-clockwise, rotations the heart does along the path of the WARP.

5. Press **Border**.
Heart (Border) — S&T WARP Menu

- Use the **Size** knob, or the positioner, to adjust the size of the border on the heart.

6. Press **Border Color**.

Heart (Border Color) — S&T WARP Menu

- Use the **Luminance** knob, or the positioner, to adjust the luminance of the border color.
- Use the **Saturation** knob, or the positioner, to adjust the saturation of the border color.
- Use the **Hue** knob, or the positioner, to adjust the hue of the border color.

7. Press **Movement**.

Heart (Movement) — S&T WARP Menu

- Use the **X-Rate** knob, or the positioner, to adjust the rate at which the heart will fly off in the X-Axis.
- Use the **Y-Rate** knob, or the positioner, to adjust the rate at which the heart will fly off in the Y-Axis.
- Use the **Z-Rate** knob, or the positioner, to adjust the rate at which the heart will fly off in the Z-Axis.
Lens Flare WARP

The Lens Flare WARP creates a point light source and a series of lens flare effects on the key video. This WARP can be adjusted for position, lighting, color, and how the lens flares appear.

1. Select and activate the Lens Flare WARP effect on the keyer you want to apply it.

2. Press **Position**.

3. Adjust the center position of the light source for the lens flare as follows:
   - Use the **Center (X)** knob, or the positioner, to adjust the horizontal position of the center point of the light source on screen.
   - Use the **Center (Y)** knob, or the positioner, to adjust the vertical position of the center point of the light source on screen.
   - Use the **Size** knob, or the positioner, to adjust the size of the light source and lens flares.

4. Press **Lighting**.

   - Use the **Fade** knob to select **Color** to apply a washout light to the key video.
   - Use the **Brightness** knob, or the positioner, to adjust the brightness of the light source, flares, and washout light.

5. Press **Placement**.
Lens Flare (Placement) — S&T WARP Menu

- Use the Auto-Follow knob to turn this feature on or off.
  - Off — Select this option to manually adjust the distance that the lens flares are from the light source.
  - On — Select this option to have the switcher automatically adjust the distance the lens flares are from the light source.
- Use the Angle knob, or the positioner, to adjust the angle of the lens flares compared to the center of the screen.
- Use the Distance knob, or the positioner, to adjust the distance between the lens flares and light source. The Auto-Follow option must be set to Off.

6. Press Color.

Lens Flare (Color) — S&T WARP Menu

- Use the Luminance knob, or the positioner, to adjust the luminance of the effect.
- Use the Saturation knob, or the positioner, to adjust the saturation of the effect.
- Use the Hue knob, or the positioner, to adjust the hue of the effect.

7. Press Flare Options.
Add natural text here.
**Magnify WARP**

The Magnify WARP creates an area within which the background video, that the WARP is applied to, is magnified. This WARP can be adjusted for position, shape, borders, and rotation.

1. Select and activate the Magnify WARP effect on the keyer you want to apply it.
2. Press **Position**.
3. Adjust the position of the magnified area as follows:
   - Use the **X-Position** knob, or the positioner, to adjust the horizontal position of the magnified area on screen.
   - Use the **Y-Position** knob, or the positioner, to adjust the vertical position of the magnified area on screen.
   - Use the **Size** knob, or the positioner, to adjust the size of the magnified area.
4. Press **Shape**.
5. Press **Effects**.
Use the **Background** knob to select whether the background is visible or not.

- **Hide** — Select this option to have the background region that is not being magnified not shown.
- **Show** — Select this option to have the background region that is not being magnified shown.

Use the **Edge Effect** knob to turn borders for the lens effect on or off.

- **Off** — Select this option to not have borders applied to the edges of the magnified area.
- **On** — Select this option to have borders applied to the edges of the magnified area.

Use the **Angle (deg.)** knob, or the positioner, to adjust the angle of the magnified area.
Melt WARP

The Melt WARP creates an effect that makes the key appear to melt, distorting the key video. The Melt can move up, down, left, or right.

1. Select and activate the Melt WARP effect on the keyer you want to apply it.
2. Press Melt.

3. Adjust the type of melt as follows:
   - Use the Type knob to select how the key video appears to melt.
   - Use the Direction knob to select the direction that the melt will progress in.
   - Use the Amplitude knob, or the positioner, to adjust the size of the peaks in the effect.


5. Press Curve.
Melt (Curve) — S&T WARP Menu

- Use the **Slope** knob, or the positioner, to adjust the angle of the melt.
- Use the **Phase** knob, or the positioner, to adjust the position of the waves across the trailing edge of the melt.
Obscure WARP

The Obscure WARP creates a pixelation effect bound in an oval or rectangle that can be positioned over part of the key video.

1. Select and activate the Obscure WARP effect on the keyer you want to apply it.

2. Press **Pixelation**.

   ![Obscure (Pixelation) — S&T WARP Menu](image)

3. Adjust the pixelation of the effect as follows:
   - Use the **(X)** knob, or the positioner, to adjust the size of the pixels horizontally.
   - Use the **(Y)** knob, or the positioner, to adjust the size of the pixels vertically.
   - Use the **Overall** knob, or the positioner, to adjust the size of the pixels both horizontally and vertically at the same time.

4. Press **Position**.

   ![Obscure (Position) — S&T WARP Menu](image)

   - Use the **Center (X)** knob, or the positioner, to horizontally adjust the position of the obscure over the key video.
   - Use the **Center (Y)** knob, or the positioner, to vertically adjust the position of the obscure over the key video.
   - Use the **Size** knob, or the positioner, to adjust the size of the obscure over the key video.

5. Press **Shape**.
• Use the **Aspect** knob, or the positioner, to adjust the aspect ratio of the obscure shape.
• Use the **Shape** knob to select the shape of the obscure.

6. Press **Effects**.

• Use the **Background** knob to select whether the key video outside of the obscure is shown (**Show**), or hidden (**Hide**).
• Use the **Edge Effect** knob to turn the edge effect **On** or **Off**. The Edge Effect adds an embossing effect to the edge of the obscure.
• Use the **Angle (deg.)** knob, or the positioner, to select the rotation of the embossing effect around the obscure.
Page Roll WARP

The Page Roll WARP allows you to roll up the key as you would a piece of paper. You can adjust the angle, direction, and tightness of the roll.

**Note** — A Page Roll requires 2 Squeeze & Tease channel resources for all key types, even a Preset Pattern key. A wipe created using a Page Roll will only require one Squeeze & Tease channel resource.

1. Select and activate the Page Roll WARP effect on the keyer you want to apply it.
2. Press **Position**.

![Page Roll (Position) — S&T WARP Menu](image)

3. Adjust the appearance of the effect as follows:
   - Use the **Roll** knob, or the positioner, to adjust the amount of the key that is rolled.
   - Use the **Radius** knob, or the positioner, to adjust the tightness of the roll.
   - Use the **Angle** knob, or the positioner, to adjust the direction, or angle, that the roll is performed in.

4. Press **Light**.

![Page Roll (Light) — S&T WARP Menu](image)

- Use the **Model** knob to select either a **Natural** (brighten the highlight) or **White** (blends the highlight) light source.
- Use the **Gleam** knob, or the positioner, to adjust the intensity of the highlight along the top of the roll.
- Use the **Shadow** knob, or the positioner, to adjust the intensity of the shadow inside and below the roll.
Pixie Dust WARP

The Pixie Dust WARP creates an exploded pixelation effect bound in an oval or rectangle that can be positioned over part of the key video.

1. Select and activate the Pixie Dust WARP effect on the keyer you want to apply it.
2. Press Randomness.

   ![Pixie Dust (Randomness) — S&T WARP Menu]

   - Use the Variation knob, or the positioner, to adjust the amount of variation in the random distribution of pixels in the effect. The greater the variation, the fuzzier the image appears.
   - Use the Softening knob, or the positioner, to adjust the amount of softness around the edges of the effect.
   - Use the Movement knob to select Yes (pixels will appear to move) or No (image is static) to apply movement to the effect.


   ![Pixie Dust (Position) — S&T WARP Menu]

   4. Adjust the pixelation of the effect as follows:
      - Use the (X) knob, or the positioner, to adjust the horizontal position of the effect.
      - Use the (Y) knob, or the positioner, to adjust the vertical position of the effect.
      - Use the Size knob, or the positioner, to adjust the size of the effect.

4. Press Shape.
Pixie Dust (Shape) — S&T WARP Menu

- Use the **Aspect** knob, or the positioner, to adjust the aspect ratio of the pixie dust effect area.
- Use the **Pattern** knob to select the shape of the pixie dust effect area.
Ripple WARP

The Ripple WARP creates a ripple effect, like dropping a rock into a pool of water.

1. Select and activate the Ripple WARP effect on the keyer you want to apply it.
2. Press Wave.

3. Adjust the waves of the effect as follows:
   - Use the Amplitude knob, or the positioner, to adjust the perceived height of the waves.
   - Use the Frequency knob, or the positioner, to adjust the number of waves.


   - Use the Center (X) knob, or the positioner, to horizontally adjust the position of the center of the ripples.
   - Use the Center (Y) knob, or the positioner, to vertically adjust the position of the center of the ripples.

5. Press Lighting.
Ripples (Lighting) — S&T WARP Menu

- Use the **Intensity** knob, or the positioner, to adjust the intensity of the lighting on the waves of the effect.

6. Press **Movement**.

Ripple (Movement) — S&T WARP Menu

- Use the **Continuous** knob, or the positioner, to adjust the amount of motion there is in the waves moving away from the center. At **0.0%** there is no movement.
- Use the **Waterdrop** knob, or the positioner, to adjust the intensity of the waterdrop effect at the center of the ripple effect.
Sand WARP

The Sand WARP creates an effect that looks like a sand storm removing the key to reveal the background. The effect can progress from left to right, or right to left.

1. Select and activate the Sand WARP effect on the keyer you want to apply it.

2. Press **Sand**.

3. Adjust the sand of the effect as follows:
   - Use the **Direction** knob to select the direction that the effect will progress in.
   - Use the **Opacity** knob, or the positioner, to adjust the opacity of the grains of sand.
   - Use the **Progression** knob, or the positioner, to adjust the position of the trailing edge of the effect.

4. Press **Wind**.

   - Use the **Oscillation** knob, or the positioner, to adjust the oscillation in the sand. Changing this in a sequence creates the illusion of movement in the sand.
   - Use the **Velocity** knob, or the positioner, to adjust the perceived velocity of the wind.
   - Use the **Direction** knob, or the positioner, to adjust the direction of the wind, within the direction that the effect is progressing in.

5. Press **Edge Peaks**.
Use the Frequency knob, or the positioner, to adjust the number of peaks along the trailing edge of the effect.

Use the Amplitude knob, or the positioner, to adjust the size of the peaks along the trailing edge of the effect.

6. Press **Edge Curves**.

Use the Slope knob, or the positioner, to adjust the angle of the peaks along the trailing edge of the effect.

Use the Phase knob, or the positioner, to adjust the position of the peaks along the trailing edge of the effect.
Split WARP

The Split WARP allows you to split the key in half and move both halves away from each other in opposite directions.

1. Select and activate the Split WARP effect on the keyer you want to apply it.
2. Press Position.

3. Adjust the movement of the effect as follows:
   - Use the Movement knob to select the direction of the movement of the two pieces.
   - Use the Amplitude knob, or the positioner, to adjust the amount of distance between the two pieces.

4. Press Axis.

   • Use the Position knob, or the positioner, to adjust the position of the split between the two pieces.
   • Use the Angle knob, or the positioner, to adjust the angle of the split between the two pieces.
Star WARP

The Star WARP places the key video inside a star shape. As you create the WARP, the star shape will shrink down around the key and then fly off with the key. The direction and speed that it moves is determined by the settings.

The color of the border of the star can also be changed.

1. Select and activate the Star WARP effect on the keyer you want to apply it.

2. Press Position.

3. Create the star as follows:
   - Use the X-Pos knob, or the positioner, to adjust the horizontal position of the center point of the star on screen.
   - Use the Y-Pos knob, or the positioner, to adjust the vertical position of the center point of the star on screen.
   - Use the Size/Creation knob, or the positioner, to move the star through the path of the WARP.

4. Press Rotation.

   - Use the X-Rotation knob, or the positioner, to adjust the number of horizontal rotations the star does along the path of the WARP.
   - Use the Y-Rotation knob, or the positioner, to adjust the number of vertical rotations the star does along the path of the WARP.
   - Use the Z-Rotation knob, or the positioner, to adjust the number of clockwise, or counter-clockwise, rotations the star does along the path of the WARP.
5. Press **Shape**.

   ![Star (Shape) — S&T WARP Menu](image)

   - Use the **Num Pts** knob, or the positioner, to adjust the number of points on the star.
   - Use the **Pt Size** knob, or the positioner, to adjust the size of the points on the star.
   - Use the **Border Size** knob, or the positioner, to adjust the size of the border on the star.

6. Press **Border Color**.

   ![Star (Border Color) — S&T WARP Menu](image)

   - Use the **Luminance** knob, or the positioner, to adjust the luminance of the border color.
   - Use the **Saturation** knob, or the positioner, to adjust the saturation of the border color.
   - Use the **Hue** knob, or the positioner, to adjust the hue of the border color.

7. Press **Movement**.
Star (Movement) — S&T WARP Menu

- Use the **X-Rate** knob, or the positioner, to adjust the rate at which the star will fly off in the X-Axis.
- Use the **Y-Rate** knob, or the positioner, to adjust the rate at which the star will fly off in the Y-Axis.
- Use the **Z-Rate** knob, or the positioner, to adjust the rate at which the star will fly off in the Z-Axis.
Stretch WARP

The Stretch WARP allows you to stretch the key both horizontally and vertically.

1. Select and activate the Stretch WARP effect on the keyer you want to apply it.
2. Press Aspect.

3. Use the X Aspect knob, or the positioner, to adjust the size of the key horizontally.
4. Use the Y Aspect knob, or the positioner, to adjust the size of the key vertically.
Appendix A: Pre-loaded Effects

In This Appendix

This appendix provides a brief description of the pre-programmed Squeeze & Tease wipes and sequences and the standard wipes that are supplied with your Vision switcher.

The following topics are discussed in this appendix:

- DVE Wipes and Sequences
- Copying Sequences to the Switcher
- Standard Wipes
- Vision Slots
DVE Wipes and Sequences

This section provides descriptions of the pre-loaded DVE wipes and sequences that are provided with the Vision software. Two files are provided, one with WARP sequences, and without the WARP sequences.

<table>
<thead>
<tr>
<th>No</th>
<th>WARP</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>00</td>
<td>PageRoll</td>
<td>Roll Down from Top Right to Bottom Left</td>
</tr>
<tr>
<td>--</td>
<td>01</td>
<td>LensFlar</td>
<td>Lens flare from Top Left to White Flash</td>
</tr>
<tr>
<td>--</td>
<td>02</td>
<td>Ripple</td>
<td>Liquid Ripple out from Center</td>
</tr>
<tr>
<td>--</td>
<td>03</td>
<td>Melt</td>
<td>Melt down</td>
</tr>
<tr>
<td>--</td>
<td>04</td>
<td>PixyDust</td>
<td>Pixelate out with animation</td>
</tr>
<tr>
<td>--</td>
<td>05</td>
<td>Globe</td>
<td>Shrink to Globe and Roll off Left</td>
</tr>
<tr>
<td>--</td>
<td>06</td>
<td>Heart</td>
<td>Shrink to Heart with border and Fly back to Top Right</td>
</tr>
<tr>
<td>--</td>
<td>07</td>
<td>Sandstrm</td>
<td>Roll over Left to Right with Transparency and Melt</td>
</tr>
<tr>
<td>--</td>
<td>08</td>
<td>Stretch</td>
<td>Stretch Horizontally</td>
</tr>
<tr>
<td>--</td>
<td>09</td>
<td>HorzSplit</td>
<td>Split in Center and Halves move out</td>
</tr>
<tr>
<td>00</td>
<td>10</td>
<td>PushLt</td>
<td>Push Left</td>
</tr>
<tr>
<td>01</td>
<td>11</td>
<td>PushRt</td>
<td>Push Right</td>
</tr>
<tr>
<td>02</td>
<td>12</td>
<td>PushUp</td>
<td>Push Up</td>
</tr>
<tr>
<td>03</td>
<td>13</td>
<td>PushDn</td>
<td>Push Down</td>
</tr>
<tr>
<td>04</td>
<td>14</td>
<td>PushUpLt</td>
<td>Push to Upper Left Corner</td>
</tr>
<tr>
<td>05</td>
<td>15</td>
<td>PushUpRt</td>
<td>Push to Upper Right Corner</td>
</tr>
<tr>
<td>06</td>
<td>16</td>
<td>PushDnLt</td>
<td>Push to Lower Left Corner</td>
</tr>
<tr>
<td>07</td>
<td>17</td>
<td>PushDnRt</td>
<td>Push to Lower Right Corner</td>
</tr>
<tr>
<td>08</td>
<td>18</td>
<td>RotateX</td>
<td>Rotate in the X-Axis to a Knife Edge</td>
</tr>
<tr>
<td>09</td>
<td>19</td>
<td>RotateY</td>
<td>Rotate in the Y-Axis to a Knife Edge</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>SwingRt</td>
<td>Pivot Point on Right Edge, Rotate in X-Axis to the Right and Back</td>
</tr>
<tr>
<td>11</td>
<td>21</td>
<td>SwingLt</td>
<td>Pivot Point on Left Edge, Rotate in X-Axis to the Right and Back</td>
</tr>
<tr>
<td>12</td>
<td>22</td>
<td>SwingUp</td>
<td>Pivot Point on Top Edge, Rotate in Y-Axis Up and Back</td>
</tr>
<tr>
<td>13</td>
<td>23</td>
<td>SwingDwn</td>
<td>Pivot Point on Bottom Edge, Rotate in Y-Axis Down and Back</td>
</tr>
<tr>
<td>14</td>
<td>24</td>
<td>SwngUpLt</td>
<td>Pivot Point on Top Edge, Rotate Up and then Left</td>
</tr>
<tr>
<td>15</td>
<td>25</td>
<td>SwngUpRt</td>
<td>Pivot Point on Top Edge, Rotate Up and then Right</td>
</tr>
<tr>
<td>16</td>
<td>26</td>
<td>SwngDnLt</td>
<td>Pivot Point on Top Edge, Rotate Down and then Left</td>
</tr>
<tr>
<td>17</td>
<td>27</td>
<td>SwngDnRt</td>
<td>Pivot Point on Top Edge, Rotate Down and then Right</td>
</tr>
<tr>
<td>18</td>
<td>28</td>
<td>RotXBack</td>
<td>Push away while Rotating in the X-Axis</td>
</tr>
<tr>
<td>19</td>
<td>29</td>
<td>RotYBack</td>
<td>Push away while Rotating in the Y-Axis</td>
</tr>
<tr>
<td>20</td>
<td>30</td>
<td>DiveRt</td>
<td>Rotate Back and Right</td>
</tr>
<tr>
<td>No</td>
<td>WARP</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----</td>
<td>------</td>
<td>----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>21</td>
<td>31</td>
<td>DiveLt</td>
<td>Rotate Back and Left</td>
</tr>
<tr>
<td>22</td>
<td>32</td>
<td>DiveUp</td>
<td>Rotate Back and Up</td>
</tr>
<tr>
<td>23</td>
<td>33</td>
<td>DiveDn</td>
<td>Rotate Back and Down</td>
</tr>
<tr>
<td>24</td>
<td>34</td>
<td>WalkDown</td>
<td>Move Back, then Walk the video Down</td>
</tr>
<tr>
<td>25</td>
<td>35</td>
<td>WalkUp</td>
<td>Move Back, then Walk the video Up</td>
</tr>
<tr>
<td>26</td>
<td>36</td>
<td>AspectX</td>
<td>Compress Horizontally to Knife Edge</td>
</tr>
<tr>
<td>27</td>
<td>37</td>
<td>AspectY</td>
<td>Compress Vertically to Knife Edge</td>
</tr>
<tr>
<td>28</td>
<td>38</td>
<td>ZoomOut</td>
<td>Push Forward, then Back</td>
</tr>
<tr>
<td>29</td>
<td>39</td>
<td>ZoomIn</td>
<td>Push Away, then Back</td>
</tr>
<tr>
<td>30</td>
<td>40</td>
<td>DeFocusRt</td>
<td>Defocus, then Push Right</td>
</tr>
<tr>
<td>31</td>
<td>41</td>
<td>DeFocusLt</td>
<td>Defocus, then Push Left</td>
</tr>
<tr>
<td>32</td>
<td>42</td>
<td>MosaicLt</td>
<td>Mosaic, then Push Left</td>
</tr>
<tr>
<td>33</td>
<td>43</td>
<td>MosaicRt</td>
<td>Mosaic, then Push Right</td>
</tr>
<tr>
<td>34</td>
<td>44</td>
<td>TwirlLt</td>
<td>Twirl around the Y-Axis, then Push Left</td>
</tr>
<tr>
<td>35</td>
<td>45</td>
<td>TwirlRgt</td>
<td>Twirl around the Y-Axis, then Push Right</td>
</tr>
<tr>
<td>36</td>
<td>46</td>
<td>KnifEdge</td>
<td>Twirl to Knife Edge</td>
</tr>
<tr>
<td>37</td>
<td>47</td>
<td>Tornado</td>
<td>Video gets stuck in a Tornado</td>
</tr>
<tr>
<td>38</td>
<td>48</td>
<td>SpinOut</td>
<td>Spin and Push Forwards, then Back</td>
</tr>
<tr>
<td>39</td>
<td>49</td>
<td>SpinIn</td>
<td>Spin and Push Away, then Back</td>
</tr>
<tr>
<td>40</td>
<td>50</td>
<td>TopLtUp</td>
<td>Pivot Point at Top Left Corner, Rotate and Push Up</td>
</tr>
<tr>
<td>41</td>
<td>51</td>
<td>TopLtDwn</td>
<td>Pivot Point at Top Left Corner, Rotate and Push Down</td>
</tr>
<tr>
<td>42</td>
<td>52</td>
<td>TopRtUp</td>
<td>Pivot Point at Top Right Corner, Rotate and Push Up</td>
</tr>
<tr>
<td>43</td>
<td>53</td>
<td>TopRtDwn</td>
<td>Pivot Point at Top Right Corner, Rotate and Push Down</td>
</tr>
<tr>
<td>44</td>
<td>54</td>
<td>BtmLtUp</td>
<td>Pivot Point at Bottom Left Corner, Rotate and Push Up</td>
</tr>
<tr>
<td>45</td>
<td>55</td>
<td>BtmLtDwn</td>
<td>Pivot Point at Bottom Left Corner, Rotate and Push Down</td>
</tr>
<tr>
<td>46</td>
<td>56</td>
<td>BtmRtUp</td>
<td>Pivot Point at Bottom Right Corner, Rotate and Push Up</td>
</tr>
<tr>
<td>47</td>
<td>57</td>
<td>BtmRtDwn</td>
<td>Pivot Point at Bottom Right Corner, Rotate and Push Down</td>
</tr>
<tr>
<td>48</td>
<td>58</td>
<td>10000lbs</td>
<td>Falls, then Bounces (when run in reverse)</td>
</tr>
<tr>
<td>49</td>
<td>59</td>
<td>NailFall</td>
<td>Swings on Nail Point, then Falls Down</td>
</tr>
<tr>
<td>50</td>
<td>60</td>
<td>SpinLtUp</td>
<td>Pivot on Left Center, then Up</td>
</tr>
<tr>
<td>51</td>
<td>61</td>
<td>SpinLtDn</td>
<td>Pivot on Left Center, then Down</td>
</tr>
<tr>
<td>52</td>
<td>62</td>
<td>SpinRtUp</td>
<td>Pivot on Right Center, then Up</td>
</tr>
<tr>
<td>53</td>
<td>63</td>
<td>SpinRtDn</td>
<td>Pivot on Right Center, then Down</td>
</tr>
<tr>
<td>54</td>
<td>64</td>
<td>SpinUpLt</td>
<td>Pivot on Top, then Left</td>
</tr>
<tr>
<td>55</td>
<td>65</td>
<td>SpinUpRt</td>
<td>Pivot on Top, then Right</td>
</tr>
<tr>
<td>56</td>
<td>66</td>
<td>SpinDnLt</td>
<td>Pivot on Bottom, then Left</td>
</tr>
</tbody>
</table>
### Table 17.1 DVE Wipes and Sequences

<table>
<thead>
<tr>
<th>No</th>
<th>WARP</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>57</td>
<td>67</td>
<td>SpinDnRt</td>
<td>Pivot on Bottom, then Right</td>
</tr>
<tr>
<td>58</td>
<td>68</td>
<td>SepiaSpn</td>
<td>Move Away to 1/2 size, change color to Sepia, then rotate in X-Axis to a Knife Edge</td>
</tr>
<tr>
<td>59</td>
<td>69</td>
<td>Photo</td>
<td>Move Away to 1/2 size, Light Flash, Posterize and change to black and white, add white frame and de-posterize while Rotating Forward</td>
</tr>
<tr>
<td>60</td>
<td>70</td>
<td>Key forw</td>
<td>Over the shoulder Top Left moves Forward to Bottom Right</td>
</tr>
<tr>
<td>61</td>
<td>71</td>
<td>Key back</td>
<td>Reverse of Key forw</td>
</tr>
</tbody>
</table>
Copying Sequences to the Switcher

The sequences and wipes that are included with your Vision QMD/X switcher can be found on the Product Resources CD. To copy the sequences to the switcher you must use the web interface to load the sequences into a Setup on the switcher.

1. Locate the sequence file you want to upload to the switcher.
   - Sequences.tgz — Contains 3D and WARP sequences.
   - Sequences_No-WARP.tgz — Contains only 3D sequences. You must rename this file to Sequences.tgz for upload to the switcher.

2. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

3. Enter your username and password as follows when the Login Dialog Box appears. The default Name is user and Password is password.

4. Click File Sets to display the File Sets Page. All the populated Setups on the switcher are shown in blue.

5. In the Number field, enter the 2-digit number for the Setup on the switcher that you want to copy the sequences to. If any Setup files exist in that location, they will be replaced with the new files. All the populated Setups on the switcher are shown in blue.

6. In the Filename field, enter the location of the Sequences.tgz file on the computer.

   Operating Tip — You can use the Browse... button to display the file browser dialog, and then locate the file you want to upload.

7. Click Upload set and OK to copy the sequences to the switcher.

To load the sequences on the switcher, you must recall the S&T MD Sequences from the Setup that you copied the sequences to.

For More Information...

- on recalling sequences on the switcher, Refer to the section “Recalling Registers” on page Eng 13-9.
Standard Wipes

Wipes fall into several different categories on the switcher, depending on how they appear when being performed.

Classic Wipes

Classic wipes, (Figure 17.1), are the most basic type of wipe, that involve some pattern that expands, or shrinks, to reveal the destination video.

Rotary Wipes

Rotary wipes, (Figure 17.2), unlike Classic wipes, involve rotation of a pattern to reveal the destination video.
Matrix Wipes

Matrix wipes, (Figure 17.3), use a series of blocks to create the pattern for the wipe.

Special Wipes

Special wipes, (Figure 17.4), use unique shapes as the pattern for the wipe.
Vision Slots

The Vision control panel incorporates a special mode in which pseudo-random information is statistically measured on a cumulative basis.

2. Double-press the blank button to the left of the EXIT button to display the Slot Machine Menu. The buttons and indicators on the control panel go dark, and the transition progress bar on one of the Transition Modules lights up.

3. Move the Fader on Transition Module to the upper limit, if it is not already there. The fader handle acts as the arm on the slot machine and must be started from the upper limit position.

4. Move the Fader from the upper limit to the lower limit to simulate the pull of the slot machine arm. The columns spin around and eventually settle on three play line symbols. Winnings are calculated based on the table shown in the upper display region. The more credits you win, the faster the buttons on the control panel flash.
Appendix B: Color Correction Parameters

In This Appendix

This appendix provides an overview of the principles behind color correction on the Vision switcher.

The following topics are discussed in this appendix:

• Color Correction Overview
• Proc Amp Color Correctors
• RGB Color Correctors

For More Information...

• on using a Proc Amp or RGB Color Corrector, refer to the section “Color Correction” on page Ops 4-27.
Color Correction Overview

The Vision switcher utilizes two types of color correctors: Proc Amp color correctors and RGB color correctors. Proc Amp color correctors work on the luminance and chrominance components of the video signal while RGB color correctors work on a video signal that the switcher first converts to an RGB format.
Proc Amp Color Correctors

The Proc Amp Color Corrector option provides the following parameters for video signal correction:

- Overall, Chrominance, Luminance, Cr, and Cb Gain
- Black, Cr, and Cb Offset
- Luminance Gamma
- Hue Rotation

The graph below (Figure 18.1) illustrates a video signal with no Proc Amp adjustments applied. The horizontal axis represents signal values before any changes are applied and the vertical axis represents signal values after any changes are applied. The solid black line running from A to B represents an unmodified video signal where A is the minimum signal value and B is the maximum. You can look at any point on the line and the output value matches the input value. This line is represented in the graphs throughout the remainder of this section to provide a standard which serves to illustrate the effects of various Proc Amp color corrector adjustments.

![Figure 18.1 Video Signal with No Proc Amp Adjustments Applied](image)

In practice, video generating equipment have limits to the signals they produce. These limits are represented by the Output Min and Output Max lines in the graph. Some Proc Amp color corrector adjustments cause the video signal to be clipped. This occurs when the modifications to the video signal result in a signal value that is outside the range that the equipment can generate. Any further modifications to the video signal cause no further changes and it remains at the limit. The signal is said to be clipped.

Gain

Gain represents the range of signal values present in a video signal from a lowest to a highest point (from black to white for example). Increasing gain expands this range, while decreasing gain compresses this range. Clipping occurs if applied gain changes cause output signal values to fall outside the allowable range. The following graph (Figure 18.2) illustrates the general effect of increased and decreased gain.
The Vision switcher can perform 5 types of Proc Amp gain corrections:

- **Overall Gain** — Affects both chrominance and luminance video signal components simultaneously. Increasing overall gain causes an increase in contrast while also making colors more saturated and vivid. Decreasing overall gain causes a decrease in contrast while desaturating colors.

- **Chroma Gain** — Affects both chrominance video signal components (Cr and Cb) simultaneously. Increasing chroma gain causes the video signal colors to become increasingly saturated and more vivid. Decreasing chroma gain desaturates color from the video signal until it is black and white.

- **Lum Gain** — Affects the luminance video signal component. Increasing lum gain expands the contrast of the video signal (i.e. bright regions get brighter and dark regions get darker). Decreasing lum gain shrinks the contrast of the video signal (i.e. bright regions and dark regions tend towards a middle brightness region).

- **Cr Gain** — Affects the Cr component of the chrominance video signal. Increasing Cr gain causes the video signal colors to become increasingly saturated with red. Decreasing Cr gain desaturates red from the video signal.

- **Cb Gain** — Affects the Cb component of the chrominance video signal. Increasing Cb gain causes the video signal colors to become increasingly saturated with blue. Decreasing Cb gain desaturates blue from the video signal.

**Offsets**

Offsets shift the video signal by a set amount. Depending on the offset applied, different parts or all of the video signal may be affected. Clipping occurs if applied offsets cause output signal values to fall outside the allowable range. The following graph (Figure 18.3) illustrates the general effect of adding positive or negative offsets to a video signal.
The light gray line represents an offset applied to the entire video signal, causing the output signal values to be shifted by the offset amount from the input signal values.

The dashed line represents an offset applied to the B section of the video signal. The full offset is applied to the B end of the video signal and decreases down to no offset being applied at the A end of the video signal.

The dotted line represents an offset applied to the A section of the video signal. The full offset is applied to the A end of the video signal and decreases down to no offset being applied at the B end of the video signal.

The Vision switcher can perform 3 types of Proc Amp offset corrections:

- **Black Offset** — Affects the A section of the video signal and how much, if any, of the input video signal values are mapped to black in the output signal. Increasing the black offset increases the amount of input signal that is mapped to black in the output signal, thereby darkening the shadow areas. Decreasing the black offset decreases the amount of input video signal that is mapped to black in the output signal, effectively lightening the shadow areas. Further decreasing of the black offset decreases the output signal so none of it is black.

- **Cr Offset** — Affects the Cr component of the chrominance video signal. Increasing Cr offset causes the entire video signal to shift towards red, taking on a red tint. Decreasing Cr offset causes the entire video signal to shift away from red, taking on a green tint.

- **Cb Offset** — Affects the Cb component of the chrominance video signal. Increasing Cb offset causes the entire video signal to shift towards blue, taking on a blue tint. Decreasing Cb offset causes the entire video signal to shift away from blue, taking on a yellow tint.
Gamma

The previous corrections are all linear. No matter which correction was applied, the output versus input mapping is still a straight line. Gamma corrections introduce non-linear corrections to a video signal. A gamma correction can be described as taking a point on the output versus input video signal line and pulling it perpendicularly away from the line. The result is a Bezier curve between the start, the new point and the end point. The following graph (Figure 18.7) illustrates the effect of adding positive and negative gamma corrections to a video signal.

The point C, called the Gamma Offset point can be any point along the AB line. The Gamma Value indicates how far perpendicularly off the line the Gamma Offset point is moved. Once the Gamma Offset point and Gamma Value are determined, a Bezier curve is drawn from point A, through point C and ended at point B.

The Vision switcher can perform gamma corrections to the luminance component of a video signal. Luminance gamma corrections allow for selective brightening or darkening of portions of the video signal. Generally, increasing the gamma value brightens the video signal in the location of the gamma offset point. Decreasing the gamma value, darkens the video signal in the location of the gamma offset point. Therefore, by moving the gamma offset point, you can select which part of the input video signal receives the most brightening or darkening.

Hue Rotate

Hue rotate affects the color of the entire video signal by rotating the input video hues. This produces an output video signal with colors that are shifted from their original hues. The following diagram (Figure 18.8) shows a color wheel. By rotating colors around the wheel, hue values will shift. The diagram shows a clockwise rotation where yellows become orange, reds
become magenta, blues become green. The more rotation applied, the further around the wheel colors are shifted.

\[\text{Figure 18.8} \quad \text{Color Wheel and Hue Rotate}\]
The RGB Color Corrector option provides the following parameters for video signal correction:

- Red, Green, and Blue Gain
- Red, Green, and Blue Offset
- Red, Green, and Blue Lower Offset
- Red, Green, and Blue Gamma

RGB color correctors are provided as an alternative method for modifying color and brightness in a video signal. The Vision switcher converts the video signal values from Y-Cr-Cb (Luminance, Chrominance) to RGB. Once any corrections are applied to the RGB values, the switcher converts them back to Y-Cr-Cb.

The following graph (Figure 18.9) illustrates a single channel (red in this case) of an RGB signal with no color corrections applied. The horizontal axis represents signal values before any changes are applied and the vertical axis represents signal values after any changes are applied. The solid black line running from A to B represents an unmodified video signal where A is the minimum signal value and B is the maximum. You can look at any point on the line and the output value matches the input value. This line is represented in the graphs throughout the remainder of this section to provide a standard which serves to illustrate the effects of various RGB color corrections.

![Figure 18.9: Red Component with No RGB Color Corrections Applied](image-url)

**Gain**

Gain represents the range of signal values present in a video signal from a lowest to a highest point (from 0 to 100% for an RGB component). Increasing the gain expands this range while decreasing the gain compresses this range. Clipping occurs if applied gain changes cause output signal values to fall outside the allowable range. The following graph (Figure 18.10) illustrates the general effect of increased and decreased gain.
Generally, increasing the gain for a specific color component causes the video signal colors to become increasingly saturated with that color. Similarly, decreasing the gain for a specific color component progressively removes that color component from the output video signal.

Offsets

Offsets shift the video signal by a set amount. Depending on the offset applied, different parts of the video signal may be affected. Clipping occurs if applied offsets cause output signal values to fall outside the allowable range. The following graph (Figure 18.11) illustrates the general effect of adding positive or negative offsets.

The dashed line represents an upper offset applied to the B section of the video signal. The full offset is applied to the B end of the video signal and decreases down to no offset being applied at the A end of the video signal.

The dotted line represents a lower offset applied to the A section of the video signal. The full offset is applied to the A end of the video signal and decreases down to no offset being applied at the B end of the video signal.

The Vision switcher can perform upper and lower offsets on each RGB component:

- **Offset** — Shifts the selected color component (R, G, or B) of the video signal by a set amount. The offset affects how much, if any, of the input video color component is mapped to 100% of that color and how much, if any, is mapped to 0% in the output signal. Increasing the offset increases the amount of input signal values that will be mapped to 100% and decrease the amount of input signal values that will be mapped to 0% in the output signal. Decreasing the offset decreases the amount of input video signal that will be mapped to 100% and increases the amount of input video signal that will be mapped to 0% in the output signal. It is possible to increase the offset so no part of the output signal contains 100% of the color component or decrease the offset so no part of
the output contains 0% (i.e. some amount of color component is present in all output values).

- **Lower Offset** — Affects the A section of the video signal and how much, if any, of the input video color component (R, G, or B) is mapped to 0% (i.e., no color component) in the output signal. Increasing the lower offset decreases the amount of input signal values that will be mapped to 0%. It is possible to increase the lower offset so all parts of the video signal contain some of the color component (i.e., there are no output values with a 0% color component). Decreasing the lower offset increases the number of input video signal values that will be mapped to 0%.

### Gamma

The previous corrections are all linear. No matter which correction was applied, the output versus input mapping is still a straight line. Gamma corrections introduce non-linear corrections to a video signal. A gamma correction can best be described as taking a point on the output versus input video signal line and then pulling it perpendicularly away from the line. The resulting line is a Bezier curve that flows smoothly from the start, through the new point and then continues to the end point. The following graph (Figure 18.12) illustrates the effect of adding positive and negative gamma corrections to an RGB component of a video signal.

![Figure 18.12 Effects of Increased and Decreased Gamma (Red Component)](image)

The point C, called the Gamma Offset point can be any point along the AB line. The Gamma Value indicates how far perpendicularly off the line the Gamma Offset point is moved. Once the Gamma Offset point and Gamma Value are determined, a Bezier curve is drawn from point A, through point C and ends at point B.

Generally, increasing the gamma value adds more of the component to the video signal in the location of the gamma offset point. Decreasing the gamma value reduces the amount of the component in the video signal in the location of the gamma offset point. Moving the gamma offset point allows you to select which part of the input video signal receives the gamma correction. For example, if you increase the red gamma correction to the part of the video signal that has no red component you will add red to those areas while having little effect on areas that already contain a significant amount of red. This allows you to add a red tint to the image while minimizing the amount of red-clipping that occurs.

The Vision switcher can perform gamma corrections on each RGB component.
Glossary of Terms

**Active Video Lines** — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

**Aspect Ratio** — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

**Auto Transition** — An automatic transition in which the manual movement of the fader handle is simulated electronically. The transition starts when the **AUTO TRANS** button is pressed and takes place over a pre-selected time period, measured in frames.

**Border** — Effects created around the edges of a pattern or on a keyer. If an optional Dual Border Generator Card is installed, several border, shadow, and outline effects are available on that keyer as well.

**Border Generator** — Circuitry that generates various border effects on keys created by the switcher.

**Chroma Key** — An effect in which video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

**Chrominance** — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance, and hue.

**Cut** — An instantaneous switch from one video signal to another.

**Dissolve** — A transition from one video signal to another in which one signal is faded down, while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

**Downstream Keyer (DSK)** — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

**External Key** — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

**Fade-to-Black** — A controlled change of the on-air picture signal level down to black level.

**Field** — One half of a complete picture (or frame) interval containing all of the odd, or all of the even, lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).

**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device which typically allows switcher automatic transition functions to be controlled remotely.
**Hue** — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

**Internal Key** — The use of a primary input to produce a key effect.

**Key** — An effect produced by “cutting a hole” in the background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same, or separate, sources.

**Key Fill** — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

**Key Invert** — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The **KEY INV** button selects this effect.

**Key Mask** — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

**Key Source** — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

**Key Video** — See Key Source.

**Linear Keys** — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. The **KEY MEM** button allows the user to store the Clip and Gain settings required to match the incoming key signal to your requirements.

**Line Frequency** — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

**Luminance Key** — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

**Mask** — See Key Mask.

**Matte** — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

**Matte Key** — A key effect in which the fill video is a matte, provided by one of the internal matte generators.

**Memory** — The memory feature provides storage and recall of complete switcher setups.

**MIX** — See Dissolve.

**MLE** — An abbreviation for multi-level effects.

**PGM Output** — The on-air video output of the system.

**Primary Input** — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labelled “KEY”, “PGM”, and “PST”.

**PV Output** — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

**Self Key** — A key effect in which the same video signal serves as both the key signal and key fill.

**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.
**Tally** — An indicator which illuminates when the associated button, or control, is selected or is on-air.

**Termination** — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

**Transition** — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

**Transition Preview** — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

**Video** — The electrical signal produced by a camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.
# Index

## Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+4</td>
<td>Button, Global Memory</td>
</tr>
<tr>
<td></td>
<td>Button, Preview Bus</td>
</tr>
</tbody>
</table>

## Numerics

### 2D DVE

- Assign Channels: Ops 8-10
- Fly Key: Ops 8-3
- Picture Frame Borders: Ops 8-4
- Setup: Ops 8-3
- 2x Extender, Robotic Camera: Ops 11-13

### 3D DVE

- Picture Frame Borders: Ops 8-8
- Sequences: Ops 14-5
- 4-Keyers option: Ops 2-2

## A

### Abbreviations

- Ops 1-5

### A-D, definition

- Ops 1-5

### Adjusting, Touchscreen Display

- Ops 3-4

### AFV, Audio Mixers

- Ops 11-10

### All Stop, Robotic Camera

- Ops 11-13

### Alpha

- Key: Ops 7-2

### Assign

- Color Correctors to Aux Buses: Ops 4-33

### Assigning 2D DVE Channels

- Ops 8-10

### Assigning S&T Channels

- Ops 8-11

### ATTRIB

- Button: Ops 9-4

### Attributes

- Auto Trans: Ops 9-11
- Aux Bus: Ops 9-12
- Bus Selection: Ops 9-10
- Custom Control: Ops 9-12
- Global-Store: Ops 9-11
- Keyer on-air status: Ops 9-11
- MLE Memory: Ops 9-10
- MLE-Store: Ops 9-11
- Transition Module: Ops 9-11

### Audio Mixers

- Operation: Ops 11-10
- AFV: Ops 11-10
- Audio Only Transitions: Ops 11-11
- Overrides: Ops 11-10

### Audio Only Transitions, Audio Mixers

- Ops 11-11

### Audio Server Menu

- Ops 11-6

### Audio Servers

- Clip Control: Ops 11-6
- Cue Clip: Ops 11-6
- Auto Flip, Frontside/Backside Video: Ops 8-13
- Auto Select Keys: Ops 7-9
- MultiDSK: Ops 7-26

### Auto Trans

- Memory Attributes: Ops 9-11
- AUX 1-4, Robotic Camera: Ops 11-13

### Aux Buses

- Color Correction: Ops 4-33
- assigning: Ops 4-33
- removing: Ops 4-33
- Memory Attributes: Ops 9-12
- Quick Navigation: Ops 3-11, Ops 3-12
- selecting: Ops 4-9
- Aux, definition: Ops 1-5
- Auxiliary Control Panels: Ops 12-1
- Operation: Ops 12-2
- AuxKeys: Ops 7-28
- setup: Ops 7-28

### B

- B Gain, Robotic Camera: Ops 11-14
- Back Button: Ops 3-6
- Background Bus: Ops 4-6
- Background Generators: Ops 6-11
- creating mattes: Ops 6-13
- creating washes: Ops 6-11

### Banks

- Memory: Ops 9-6

### Basics

- menu system: Ops 3-5
- switcher: Ops 4-1
- Black Offset, Proc Amp: Ops 18-5
- BORD ON/OFF: Ops 7-4

### Borders

- Picture Frame
  - defaulting: Ops 8-26

### Borders, XFX

- Ops 8-15

### Bottom MLE

- reference description: Ops 1-4

### Box Mask

- Ops 8-23

### BT.601 (SD) Color Space

- Ops 10-9

### BT.709 (HD) Color Space

- Ops 10-9

### Buses

- copy: Ops 4-40
- swap: Ops 4-40

### Buttons

- Back: Ops 3-6
- CLEAR: Ops 4-38
- Copy Down: Ops 3-6
- Copy Up: Ops 3-6
- Forward: Ops 3-6

### Transitions

- Ops 11-10

### Audio Servers

- Clip Control: Ops 11-6
- Cue Clip: Ops 11-6
- Auto Flip, Frontside/Backside Video: Ops 8-13
- Auto Select Keys: Ops 7-9
- MultiDSK: Ops 7-26

### Auto Trans

- Memory Attributes: Ops 9-11
- AUX 1-4, Robotic Camera: Ops 11-13

### Aux Buses

- Color Correction: Ops 4-33
- assigning: Ops 4-33
- removing: Ops 4-33
- Memory Attributes: Ops 9-12
- Quick Navigation: Ops 3-11, Ops 3-12
- selecting: Ops 4-9
- Aux, definition: Ops 1-5
- Auxiliary Control Panels: Ops 12-1
- Operation: Ops 12-2
- AuxKeys: Ops 7-28
- setup: Ops 7-28

### B

- B Gain, Robotic Camera: Ops 11-14
- Back Button: Ops 3-6
- Background Bus: Ops 4-6
- Background Generators: Ops 6-11
- creating mattes: Ops 6-13
- creating washes: Ops 6-11

### Banks

- Memory: Ops 9-6

### Basics

- menu system: Ops 3-5
- switcher: Ops 4-1
- Black Offset, Proc Amp: Ops 18-5
- BORD ON/OFF: Ops 7-4

### Borders

- Picture Frame
  - defaulting: Ops 8-26

### Borders, XFX

- Ops 8-15

### Bottom MLE

- reference description: Ops 1-4

### Box Mask

- Ops 8-23

### BT.601 (SD) Color Space

- Ops 10-9

### BT.709 (HD) Color Space

- Ops 10-9

### Buses

- copy: Ops 4-40
- swap: Ops 4-40

### Buttons

- Back: Ops 3-6
- CLEAR: Ops 4-38
- Copy Down: Ops 3-6
- Copy Up: Ops 3-6
- Forward: Ops 3-6
HOLD (positioner) ..................... Ops 4-38
LINK .............................................. Ops 4-38
Positioner (on the joystick) .......... Ops 4-38
Preview Bus
  +4 .............................................. Ops 4-15
  MLE ............................................ Ops 4-15
  MLE PGM ................................. Ops 4-15
  MLE PV ................................. Ops 4-15
  PGM ................................. Ops 4-15, Ops 4-16
  PV ........................................ Ops 4-15
  SRC ........................................ Ops 4-15
Swap ............................................ Ops 3-6

C
Camera ShotBox ................................. Ops 11-16
Camera Shotbox ................................. Ops 11-15
Capture, screen ............................... Ops 3-17
Capturing Stills ............................... Ops 10-6
Cb Gain Proc Amp ............................ Ops 18-4
Cb Offset Proc Amp ............................ Ops 18-5
Center
  Preview Overlay ............................ Ops 4-19
Centering Squeeze & Tease ................. Ops 13-9
Centering, Fly Key ............................ Ops 8-26
CG, definition ................................. Ops 1-5
Change PGM Text, Character Generator .... Ops 11-20
Change PV Text, Character Generator ...... Ops 11-20
Change Screen, Robotic Camera .......... Ops 11-13
Channel A/B Select, Character Generator .. Ops 11-20
Channel Control
  Assigning .................................... Ops 8-10, Ops 8-11
  Frontside/Backside Video ................. Ops 8-13
  Auto Flip .................................... Ops 8-13
  Wipes and Sequences ........................ Ops 8-13
Layering ........................................ Ops 8-12
Channel Management .......................... Ops 7-6
Channel Management, DVE .................... Ops 8-10
Channel Resources (S&T) vs. Channels ... Ops 8-11
Character Generators
  Operation .................................... Ops 11-20
  Change PGM Text ............................ Ops 11-20
  Change PV Text ............................ Ops 11-20
  Channel A/B Select ........................ Ops 11-20
  List to PGM .................................. Ops 11-21
  List to PV .................................... Ops 11-21
  List/Current View ........................... Ops 11-20
  Play Animation ............................. Ops 11-21
  Recall to PV ................................. Ops 11-21
  Select Directory ........................... Ops 11-21
  Select File ................................... Ops 11-21
  Seq/Man Mode ............................... Ops 11-21
  Swap PVPGM ................................. Ops 11-21
Chroma Gain, Proc Amp ....................... Ops 18-4
Chroma Keys ................................. Ops 7-11
Advanced Mode Settings ...................... Ops 7-16
Background .................................... Ops 7-18
Edge Erode ................................... Ops 7-20
Edge Softness ................................. Ops 7-20
Foreground ................................... Ops 7-20
Luminance ................................... Ops 7-21
Shadow ....................................... Ops 7-17
Spill Suppress ................................. Ops 7-20
Transition ..................................... Ops 7-18
Translucency ................................. Ops 7-18
Alpha .......................................... Ops 7-22
Basic Mode Settings ......................... Ops 7-13
Background ................................... Ops 7-13
Edge Sensitivity .............................. Ops 7-15
Edge Softness ................................. Ops 7-15
Foreground ................................... Ops 7-13
Spill Suppress ................................. Ops 7-14
Color Map ..................................... Ops 7-22
Initializing ................................... Ops 7-11
Operating Modes .............................. Ops 7-11
Chrominance (Cb) Gain Proc Amp .......... Ops 18-4
Chrominance (Cb) Offset Proc Amp ....... Ops 18-5
Chrominance (Cr) Gain Proc Amp .......... Ops 18-4
Chrominance (Cr) Offset Proc Amp ....... Ops 18-5
Classic Wipes ................................. Ops 17-6
Clean Feed
  Layer Mode .................................... Ops 4-11
Clear Button, Positioner Module .......... Ops 4-38
CLEAR, Button ................................ Ops 9-5
Clip Control
  Audio Server ................................. Ops 11-6
  Audio Servers
    Audio Server Menu ........................ Ops 11-6
    Cue Clip .................................... Ops 11-6
  Video Servers ............................... Ops 11-7
    Clip Control Menu ........................ Ops 11-7
    Cue Clip .................................... Ops 11-7
  VTRs ......................................... Ops 11-4
    Clip Control Menu ........................ Ops 11-4
    Cue Clip .................................... Ops 11-4
  Clipping ..................................... Ops 18-3
  Color Bar, Robotic Camera ................. Ops 11-13
  Color Correction ........................... Ops 4-27
  Color Scheme Quick Navigation .......... Ops 3-11
  Continuous Pattern Rotation .............. Ops 6-7
Control Panel
  buttons ...................................... Ops 1-3
  Modules ..................................... Ops 2-2
  overview .................................... Ops 2-1
  reference description ........................ Ops 1-4
  Vision 1 .................................... Ops 2-6
  Vision 1M .................................. Ops 2-5
  Vision 2 .................................... Ops 2-5
  Vision 2M .................................. Ops 2-4
  Vision 2X ................................... Ops 2-3
  Vision 3 .................................... Ops 2-3
  Vision 3M ................................... Ops 2-4
  Vision 4 .................................... Ops 2-2
Conventions, documentation ............... Ops 1-3
Copy
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buses</td>
<td>Ops 4-40</td>
</tr>
<tr>
<td>Keyers</td>
<td>Ops 4-41</td>
</tr>
<tr>
<td>using control panel</td>
<td>Ops 4-41</td>
</tr>
<tr>
<td>using menus</td>
<td>Ops 4-41</td>
</tr>
<tr>
<td>MLE</td>
<td>Ops 4-39</td>
</tr>
<tr>
<td>Squeeze &amp; Tease Channels</td>
<td>Ops 4-43</td>
</tr>
<tr>
<td>Copy Down Button</td>
<td>Ops 3-6</td>
</tr>
<tr>
<td>Copy MLE Contents</td>
<td>Ops 4-39</td>
</tr>
<tr>
<td>using panel buttons</td>
<td>Ops 4-39</td>
</tr>
<tr>
<td>Copy Up Button</td>
<td>Ops 3-6</td>
</tr>
<tr>
<td>Copying S&amp;T Wipes to the Switcher</td>
<td>Ops 17-5</td>
</tr>
<tr>
<td>Copying Stills From USB</td>
<td>Ops 10-12</td>
</tr>
<tr>
<td>Cr Gain Proc Amp</td>
<td>Ops 18-4</td>
</tr>
<tr>
<td>Cr Offset Proc Amp</td>
<td>Ops 18-5</td>
</tr>
<tr>
<td>Creating a Sequence</td>
<td>Ops 14-3, Ops 14-5</td>
</tr>
<tr>
<td>duration</td>
<td>Ops 14-6</td>
</tr>
<tr>
<td>Motion</td>
<td>Ops 14-6</td>
</tr>
<tr>
<td>spline</td>
<td>Ops 14-7</td>
</tr>
<tr>
<td>rotation</td>
<td>Ops 14-6</td>
</tr>
<tr>
<td>wipe modifier</td>
<td>Ops 14-7</td>
</tr>
<tr>
<td>Crosspoint Buses</td>
<td>Ops 4-5</td>
</tr>
<tr>
<td>background bus</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>key bus</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>preset bus</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>Crosspoint Group</td>
<td>Ops 4-5</td>
</tr>
<tr>
<td>Crosspoint Buses</td>
<td>Ops 4-5</td>
</tr>
<tr>
<td>background bus</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>key bus</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>preset bus</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>display</td>
<td>Ops 4-6</td>
</tr>
<tr>
<td>overview</td>
<td>Ops 2-9</td>
</tr>
<tr>
<td>SEL button</td>
<td>Ops 4-8</td>
</tr>
<tr>
<td>Custom Control</td>
<td>Ops 9-12</td>
</tr>
<tr>
<td>Memory Attributes</td>
<td>Ops 9-12</td>
</tr>
<tr>
<td>Custom Controls</td>
<td>Ops 1-7</td>
</tr>
<tr>
<td>Quick Navigation Button</td>
<td>Ops 3-12</td>
</tr>
<tr>
<td>Customer service</td>
<td>Ops 1-7</td>
</tr>
<tr>
<td>Cuts</td>
<td>Ops 5-7</td>
</tr>
<tr>
<td>Definitions</td>
<td>Ops 8-26</td>
</tr>
<tr>
<td>abbreviations</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>terms</td>
<td>Ops 1-4</td>
</tr>
<tr>
<td>Deleting a Sequence</td>
<td>Ops 14-12</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Ops 8-26</td>
</tr>
<tr>
<td>abbreviations</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>terms</td>
<td>Ops 1-4</td>
</tr>
<tr>
<td>Documenting</td>
<td>Ops 1-6</td>
</tr>
<tr>
<td>abbreviations</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>conventions</td>
<td>Ops 1-3</td>
</tr>
<tr>
<td>related publications</td>
<td>Ops 1-6</td>
</tr>
<tr>
<td>terms</td>
<td>Ops 1-4</td>
</tr>
<tr>
<td>Downstream Keyer Module</td>
<td>Ops 2-8</td>
</tr>
<tr>
<td>overview</td>
<td>Ops 2-8</td>
</tr>
<tr>
<td>Downstream Keyers</td>
<td>Ops 7-2</td>
</tr>
<tr>
<td>DSK</td>
<td>Ops 9-5</td>
</tr>
<tr>
<td>definition</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>DSK RATE, Button</td>
<td>Ops 9-5</td>
</tr>
<tr>
<td>DSK, see Downstream Keyer Module</td>
<td>Ops 8-15</td>
</tr>
<tr>
<td>Dual Border Generator</td>
<td>Ops 11-14</td>
</tr>
<tr>
<td>DVE</td>
<td>Ops 8-10</td>
</tr>
<tr>
<td>Channel Management</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>Fly Key</td>
<td>Ops 8-2</td>
</tr>
<tr>
<td>rules</td>
<td>Ops 8-2</td>
</tr>
<tr>
<td>Position/Crop</td>
<td>Ops 8-26</td>
</tr>
<tr>
<td>defaulting</td>
<td>Ops 8-26</td>
</tr>
<tr>
<td>running</td>
<td>Ops 14-14</td>
</tr>
<tr>
<td>Wipes</td>
<td>Ops 14-15</td>
</tr>
<tr>
<td>DVE Quick Navigation Button</td>
<td>Ops 3-12</td>
</tr>
<tr>
<td>DVE Wipes</td>
<td>Ops 14-10</td>
</tr>
<tr>
<td>DVR, definition</td>
<td>Ops 1-5</td>
</tr>
<tr>
<td>E</td>
<td>Ops 11-22</td>
</tr>
<tr>
<td>Editors</td>
<td>Ops 11-22</td>
</tr>
<tr>
<td>interface control</td>
<td>Ops 11-22</td>
</tr>
<tr>
<td>EFF DISS</td>
<td>Ops 9-13</td>
</tr>
<tr>
<td>Button</td>
<td>Ops 9-4</td>
</tr>
<tr>
<td>EFF RATE</td>
<td>Ops 9-14</td>
</tr>
<tr>
<td>Button</td>
<td>Ops 9-4</td>
</tr>
<tr>
<td>Effects Dissolve</td>
<td>Ops 9-13</td>
</tr>
<tr>
<td>Rate</td>
<td>Ops 9-14</td>
</tr>
<tr>
<td>Effects Keyers</td>
<td>Ops 7-2</td>
</tr>
<tr>
<td>Border Buttons</td>
<td>Ops 7-4</td>
</tr>
<tr>
<td>Channel Management Button</td>
<td>Ops 7-6</td>
</tr>
<tr>
<td>Fly Key Button</td>
<td>Ops 7-4</td>
</tr>
<tr>
<td>Independent Transitions</td>
<td>Ops 5-9</td>
</tr>
<tr>
<td>Key Invert Button</td>
<td>Ops 7-4</td>
</tr>
<tr>
<td>Key Memory Button</td>
<td>Ops 7-4</td>
</tr>
<tr>
<td>Key Modifier Buttons</td>
<td>Ops 7-3</td>
</tr>
<tr>
<td>Key Preview Buttons</td>
<td>Ops 7-4</td>
</tr>
<tr>
<td>Key Transition Buttons</td>
<td>Ops 7-5</td>
</tr>
<tr>
<td>Key Type Buttons</td>
<td>Ops 7-3</td>
</tr>
<tr>
<td>Mask Button</td>
<td>Ops 7-4</td>
</tr>
<tr>
<td>Matte Fill Button</td>
<td>Ops 7-4</td>
</tr>
</tbody>
</table>
Show Alpha Button ..............................Ops 7-5
Effects Memory Modules ..............................Ops 9-2
Display ..................................................Ops 9-3
Rate Buttons .....................................Ops 9-3, Ops 9-5
Effects, Robotic Camera ..............................Ops 11-14
Electronics frame
reference description ..............................Ops 1-4
End-of-life disposal ....................................Ops 1-8
Environmental Information ..............................Ops 1-8
External Device
Audio Mixers
Operation ..................................................Ops 11-10
Character Generators
Operation ..................................................Ops 11-20
Editors
interface control ..................................Ops 11-22
Monitor Walls
interface control ..................................Ops 11-24
OverDrive
interface control ..................................Ops 11-23
Robotic Camera
Camera Shotbox .....................................Ops 11-15
Operation ..................................................Ops 11-13
Routers
matrix control ....................................Ops 11-9
Still Store
interface control ....................................Ops 11-3
External Panel Rows
Matrix ....................................................Ops 4-21
External Still Stores
interface control .....................................Ops 11-3

F
Fade to Black
operation ...........................................Ops 4-36
performing ...........................................Ops 4-36
setting the rate .....................................Ops 4-36
Fade to Black Module ..............................Ops 2-8
Fader ....................................................Ops 5-2
Transitions .........................................Ops 5-13, Ops 5-15
Fail
Frame Indicator .....................................Ops 3-3
Panel Indicator .......................................Ops 3-3
File Storage ...........................................Ops 9-1
Fill, Key ..................................................Ops 7-2
Film WARP ............................................Ops 16-4
Flexi Mode, Key 4 ....................................Ops 4-10
FLY KEY ..................................................Ops 7-4
Fly Key
Position/Crop
defaulting ...........................................Ops 8-26
rules ....................................................Ops 8-2
Fly Key, 2D DVE ...........................................Ops 8-3
Fly Key, Squeeze & Tease DVE ....................Ops 8-6
Focus, Robotic Camera ..............................Ops 11-14
Forward Button .......................................Ops 3-6
FPU Power, Robotic Camera ..............................Ops 11-14
Frame
reference description ..............................Ops 1-4
Frame Fail Indicator ....................................Ops 3-3
Frontside/Backside Video ..............................Ops 8-13
Auto Flip .............................................Ops 8-13
Wipes and Sequences ....................................Ops 8-13
FTB, see Fade to Black
Full MLE
reference description ..............................Ops 1-4
Full reset .............................................Ops 2-13
Function buttons .....................................Ops 3-3

G
Gain
Proc Amp .............................................Ops 18-3
croma ....................................................Ops 18-4
chrominance (Cb) .....................................Ops 18-4
chrominance (Cr) .....................................Ops 18-4
luminance .............................................Ops 18-4
overall ....................................................Ops 18-4
RGB Color Corrector ..................................Ops 18-8
Gain, Robotic Camera ....................................Ops 11-14
Gamma
Proc Amp .............................................Ops 18-6
RGB Color Corrector ..................................Ops 18-10
GEN Lock Phase, Robotic Camera ....................Ops 11-14
Global Memory Module ..............................Ops 9-4
overview ....................................................Ops 2-9
Global Memory Modules
Display .............................................Ops 9-4
Global-Store ............................................Ops 10-1
clear current still .....................................Ops 10-2
image specifications .................Ops 10-10
Managing .............................................Ops 10-14
Directories
creating ..............................................Ops 10-15
deleting ..............................................Ops 10-15
renaming ..............................................Ops 10-15
renaming/renumbering .............................Ops 10-14
Still
deleting ..............................................Ops 10-15
moving ..............................................Ops 10-16
Memory Attributes .....................................Ops 9-11
on-air properties .....................................Ops 10-8
autoplay ..............................................Ops 10-9
color mode .............................................Ops 10-9
looping ..............................................Ops 10-9
play mode .............................................Ops 10-8
play speed .............................................Ops 10-9
position ..............................................Ops 10-8
reverse ..............................................Ops 10-9
scale image .............................................Ops 10-9
single frame .........................................Ops 10-9
trim .................................................Ops 10-9
overview .............................................Ops 10-2
Still
capturing ..............................................Ops 10-6
default ............................................... Ops 10-4
loading ........................................ Ops 10-3
transferring stills .......................... Ops 10-11
USB ............................................... Ops 10-12

WebDAV
Fedora 8 .................................... Ops 10-12
Mac OS X .................................. Ops 10-12
Windows 7 .................................. Ops 10-11
Windows XP .................................. Ops 10-11

View Cache .................................... Ops 10-4
Globe WARP ................................... Ops 16-7
GPI I/Os
interface control .......................... Ops 11-2
GPI Output Control ....................... Ops 4-23
GPI Shotbox ................................. Ops 4-23

H
Half MLE
reference description .................. Ops 1-4
Hard Drive .................................. Ops 9-1
Hard Trails .................................. Ops 8-18
HD, definition .............................. Ops 1-5
Heart WARP .................................. Ops 16-10
Help
online manuals ............................. Ops 3-13
pop-up ....................................... Ops 3-13

Hide OVLY
Preview Overlay .......................... Ops 4-20
H-Mult ........................................... Ops 6-8
HOLD button .................................. Ops 3-2
Hold Button, Positioner Module ........ Ops 4-38
Hold Quick Navigation Button ......... Ops 3-11
HOME button ............................... Ops 3-2
Home Quick Navigation Button ......... Ops 3-11
Horizontal Multiplications ............ Ops 6-8

Hue Rotation
Proc Amp ....................................... Ops 18-6

I
Icons
positioner .................................... Ops 3-9
ID, definition ................................ Ops 1-5
Image Ratio, Robotic Camera ........... Ops 11-14
Image Specifications, Still-Store ........ Ops 10-10
Image Stabilizer, Robotic Camera ...... Ops 11-14
Independent Key Transitions .......... Ops 5-9
Install Quick Navigation Button ....... Ops 3-11
Interface, menu ............................. Ops 3-2
Introduction, Vision panel ............... Ops 2-1
IR Receive, Robotic Camera ............. Ops 11-14
Iris, Robotic Camera ....................... Ops 11-14

K
Key 4 Mode .................................... Ops 4-10
Key Bus ........................................ Ops 4-10
KEY INV ........................................ Ops 7-4

KEY MEM ........................................ Ops 7-4
Key Over, see Key Prior
KEY PRIOR
Transition Module ......................... Ops 5-4
Transitions .................................. Ops 5-21
KEY PV .......................................... Ops 7-5
KEY RATE
Button ........................................ Ops 9-3
Setting ....................................... Ops 5-11
Key Trails .................................... Ops 8-17
Hard ........................................... Ops 8-18
Key ........................................... Ops 8-19
Key Smear .................................... Ops 8-20
Soft ........................................... Ops 8-17

Key Types .................................... Ops 7-3
Auto Select Key .............................. Ops 7-9
Chroma Key ................................... Ops 7-11
Preset Pattern Key ......................... Ops 7-24
Self Key ....................................... Ops 7-7

Keyboard Shortcuts ........................ Ops 3-7

Keyer Rate
setting ....................................... Ops 5-11
Vision 2 ...................................... Ops 5-12

Keys
copy .......................................... Ops 4-41
using control panel ....................... Ops 4-41
using menus .................................. Ops 4-41
Memory Attributes ......................... Ops 9-11
swap .......................................... Ops 4-41
using control panel ....................... Ops 4-42
using menus .................................. Ops 4-41

Keyers Modules ............................ Ops 7-2
channel management ...................... Ops 7-6
Key Modifiers ............................... Ops 7-3
Border ........................................ Ops 7-4
Fly Key ....................................... Ops 7-4
Key Invert .................................... Ops 7-4
Key Memory .................................. Ops 7-4
Mask .......................................... Ops 7-4
Matte Fill .................................... Ops 7-4

Key Preview .................................. Ops 7-4
KEY PV ........................................ Ops 7-5
SHOW ALPHA ................................ Ops 7-5
Key Type ..................................... Ops 7-3
overview ...................................... Ops 2-7
transition ...................................... Ops 7-5

Keys ........................................... Ops 7-1, Ops 8-1
Alpha ......................................... Ops 7-2
AuxKeys ...................................... Ops 7-28
setup ......................................... Ops 7-28
Fill ........................................... Ops 7-2
Masking ...................................... Ops 8-23
box mask ..................................... Ops 8-23
pattern mask .................................. Ops 8-23
utility mask .................................. Ops 8-24
MultiDSK .................................... Ops 7-26
Split .......................................... Ops 8-22
Auto Trans ........................................... Ops 9-11
Aux Bus ........................................... Ops 9-12
bus selection ....................................... Ops 9-10
Custom Controls ..................................... Ops 9-12
Global-Store selection ............................. Ops 9-11
Keyer on-air status ................................... Ops 9-11
Transition Module .................................... Ops 9-11
MLE RATE
Button ................................................... Ops 9-3
Setting ................................................... Ops 5-10
Vision 2 ............................................. Ops 5-12
MLE RATE, Button ..................................... Ops 9-5
MLE reset
all ................................................. Ops 2-11
individual ........................................... Ops 2-12
individual (1-4) ...................................... Ops 2-12
individual (5-8) ...................................... Ops 2-12
MLE SEL Button Menu ........................... Ops 4-8
Key 4 Flexi Mode .................................... Ops 4-10
Lock Bus ............................................. Ops 4-8
Quick Preset ......................................... Ops 4-12
select key bus ....................................... Ops 4-8, Ops 4-9
select MLE .......................................... Ops 4-11
MLE-Store ........................................... Ops 10-1
clear current still .................................... Ops 10-2
image specifications .............................. Ops 10-10
Managing ............................................. Ops 10-14
Directories
creating ........................................... Ops 10-15
deleting ........................................... Ops 10-15
renaming ........................................... Ops 10-15
renaming/renumbering ............................ Ops 10-14
Stills
deleting ........................................... Ops 10-15
moving ........................................... Ops 10-16
Memory Attributes ................................... Ops 9-11
on-air properties ................................. Ops 10-8
autoplay ........................................... Ops 10-9
color mode ........................................... Ops 10-9
looping ............................................. Ops 10-9
play mode ........................................... Ops 10-8
play speed ........................................... Ops 10-9
position ............................................. Ops 10-8
reverse ............................................. Ops 10-9
scale image .......................................... Ops 10-9
overview ........................................... Ops 10-2
Stills
default .............................................. Ops 10-4
loading .............................................. Ops 10-3
transferring stills ................................... Ops 10-11
USB ................................................... Ops 10-12
WebDAV
Fedora 8 ........................................... Ops 10-12
Mac OS X .......................................... Ops 10-12
Windows 7 ......................................... Ops 10-11
Windows XP ....................................... Ops 10-11
View Cache ......................................... Ops 10-4
Modifying Keyframes .................................. Ops 14-9
Modules
Downstream Keyer ................................... Ops 2-8
Effects Memory ....................................... Ops 9-2
Display .............................................. Ops 9-3
Rate Buttons ....................................... Ops 9-3, Ops 9-5
Fade to Black ....................................... Ops 2-8
Global Memory ....................................... Ops 2-9, Ops 9-4
Display .............................................. Ops 9-4
Keyer ................................................... Ops 7-2
channel management .............................. Ops 7-6
key modifiers ....................................... Ops 7-3
Border ............................................... Ops 7-4
Fly Key ............................................. Ops 7-4
Key Invert .......................................... Ops 7-4
Key Memory ......................................... Ops 7-4
Mask ................................................... Ops 7-4
Matte Fill ........................................... Ops 7-4
key preview ......................................... Ops 7-4
KEY PV ........................................... Ops 7-5
SHOW ALPHA ........................................... Ops 7-5
key type ............................................. Ops 7-3
transition .......................................... Ops 7-5
Keyers ................................................... Ops 2-7
Memory System ...................................... Ops 2-6
Positioner ........................................... Ops 2-9, Ops 4-37
Preview ............................................. Ops 2-7, Ops 4-15
Preview Bus ......................................... Ops 4-16
Preview Overlay .................................... Ops 2-8, Ops 4-17
Transition ........................................... Ops 2-6, Ops 5-2
fader ................................................... Ops 5-2
next transition select ............................ Ops 5-3
transition buttons ................................... Ops 5-6
transition parameters .............................. Ops 5-3
transition type ....................................... Ops 5-5
Monitor Walls
interface control ..................................... Ops 11-24
MORE button ......................................... Ops 3-3
Move Execute, Camera ................................ Ops 11-16
MultiDSK ........................................... Ops 7-26
Auto Select Key ..................................... Ops 7-26
Self Key ............................................. Ops 7-26
MultiPanel ........................................... Ops 4-21
External Panel Rows .............................. Ops 4-21
Master Panel ......................................... Ops 4-21
MultiPanel Menu .................................... Ops 4-21
operational notes ..................................... Ops 4-22
Satellite Panel ....................................... Ops 4-21

N
Naming a Sequence ................................... Ops 14-11
Naming Memories .................................... Ops 9-8
Navigation Area ..................................... Ops 3-7
Navigation Area, menu ............................ Ops 3-7
Neutral Density Filter, Robotic Camera ... Ops 11-14
Next Quick Navigation Button .................... Ops 3-11
Next Transition Select Buttons .................... Ops 5-3
defaulting ........................................... Ops 4-28
defaulting all ................................... Ops 4-33
input based corrections ...................... Ops 4-27
operation ........................................... Ops 4-28
overview .......................................... Ops 4-27, Ops 18-2
Parameters ........................................... Ops 18-1, Ops 18-3
clipping ........................................... Ops 18-3
gain ................................................... Ops 18-3
gamma ............................................... Ops 18-6
hue rotation ........................................ Ops 18-6
offset .................................................. Ops 18-4
PST BKGD ........................................... Ops 5-4
PST PATT, definition .............................. Ops 1-5
PV, definition ........................................ Ops 1-5
Punchpad ............................................. Ops 3-7
PV, definition ........................................ Ops 1-5
Q
QMD/X
  4-Keyers option .................................... Ops 2-2
Quick Navigation ..................................... Ops 3-3, Ops 3-11
Aux Bus ........................................... Ops 3-11, Ops 3-12
Color Scheme ....................................... Ops 3-11
Custom Controls ................................... Ops 3-12
Diagnostics .......................................... Ops 3-11
DVE .................................................... Ops 3-12
Hold .................................................... Ops 3-11
Home ............................................... Ops 3-11
Install ............................................... Ops 3-11
Manuals ............................................. Ops 3-11
More ................................................... Ops 3-3
Next .................................................... Ops 3-11
Pers .................................................... Ops 3-11
R
R Gain, Robotic Camera ........................... Ops 11-14
Rates, Effects Dissolve .............................. Ops 9-14
Rates, Transition .................................... Ops 5-10
keyer ................................................... Ops 5-11
MLE .................................................... Ops 5-10
Vision 2 ............................................. Ops 5-12
RECALL CLIP ........................................ Ops 11-7
Button .................................................. Ops 9-4
Recall to PV, Character Generator .............. Ops 11-21
Re-entry ............................................. Ops 4-13
Reference Description
  Bottom MLE ........................................ Ops 1-4
  Control Panel .................................... Ops 1-4
  Frame .............................................. Ops 1-4
  Full MLE .......................................... Ops 1-4
  Half MLE ......................................... Ops 1-4
  Master Panel .................................... Ops 1-4
  Operator .......................................... Ops 1-4
  Satellite Panel ................................... Ops 1-4
  SDI .................................................. Ops 1-4
  Setup .............................................. Ops 1-4
Storage Device ....................................... Ops 1-4
Switcher ............................................... Ops 1-4
User ................................................... Ops 1-4
Video System ........................................ Ops 1-4
Related publications ................................... Ops 1-6
Remote Aux Panels ................................... Ops 12-1
operation ........................................... Ops 12-4
overview .......................................... Ops 12-4
Remote Enables
  Editor ............................................... Ops 11-22
  GPI .................................................. Ops 11-2
  OverDrive ........................................... Ops 11-23
Removing Color Correctors from Aux Buses ........................... Ops 4-33
Repair policy ........................................... Ops 1-7
Reset
  All MLEs ........................................... Ops 2-11
  full .................................................. Ops 2-13
  Individual MLE ................................... Ops 2-12
  individual MLEs .................................. Ops 2-11
  Individual MLEs (1-4) ............................. Ops 2-12
  Individual MLEs (5-8) ............................. Ops 2-12
  software .......................................... Ops 2-11
  State ............................................... Ops 2-14
  system ............................................. Ops 2-11
  Restart, switcher .................................... Ops 2-13
Restrictions, transitions .............................. Ops 5-13
RGB Color Correctors
  aux bus assignment ................................ Ops 4-33
  aux bus corrections .............................. Ops 4-27
  bus based corrections ........................... Ops 4-27
  copying ............................................ Ops 4-34
  defaulting ........................................ Ops 4-31
  defaulting all ..................................... Ops 4-33
  input based corrections ........................... Ops 4-27
  operation .......................................... Ops 4-30
  overview .......................................... Ops 4-27
Parameters ........................................... Ops 18-1, Ops 18-8
gain ................................................... Ops 18-8
gamma ............................................... Ops 18-10
offset ................................................ Ops 18-9
overview .......................................... Ops 18-2
Ripple WARP ......................................... Ops 16-25
Robotic Cameras
  Camera ShotBox .................................... Ops 11-16
  Camera Shotbox ................................... Ops 11-15
  Move Execute ..................................... Ops 11-16
Operation ........................................... Ops 11-13
  2x Extender ....................................... Ops 11-13
  All Stop ........................................... Ops 11-13
  AUX 1-4 ............................................ Ops 11-13
  B Gain ............................................. Ops 11-14
  Change Screen .................................... Ops 11-13
  Color Bar ......................................... Ops 11-13
  Digital Zoom ..................................... Ops 11-14
  Duration .......................................... Ops 11-14
  Effects ............................................ Ops 11-14
  Focus .............................................. Ops 11-14

Vision Operator's Manual (v18.0 MD)  Index • IX–9
FPU Power .......................... Ops 11-14
Gain ........................................ Ops 11-14
GEN Lock Phase ..................... Ops 11-14
Image Ratio ............................ Ops 11-14
Image Stabilizer ....................... Ops 11-14
IR Receive .............................. Ops 11-14
Iris .......................................... Ops 11-14
Lens Mode .............................. Ops 11-14
Neutral Density Filter (ND Filter) Ops 11-14
Pan/Tilt/Zoom .......................... Ops 11-14
Pedestal .................................. Ops 11-14
Pedestal (Black) ........................ Ops 11-14
R Gain ...................................... Ops 11-14
Run Wiper .............................. Ops 11-14
Set Show ............................... Ops 11-15
Shooting Mode .......................... Ops 11-15
Shutter Speed .......................... Ops 11-15
Speed ........................................ Ops 11-15
Store/Recall ............................ Ops 11-15
Tilt Curve ............................... Ops 11-15
Truck ....................................... Ops 11-14
Video Signal ........................... Ops 11-15
Washer ..................................... Ops 11-15
White Balance .......................... Ops 11-15
Shot Recall ............................ Ops 11-16
ROLL CLIP ............................. Ops 5-5
Rotary Wipes ........................... Ops 17-6
Rotation ................................. Ops 6-7, Ops 13-7
  continuous ............................ Ops 6-7
  transition ............................. Ops 6-7
  user ....................................... Ops 6-8
X-Axis ..................................... Ops 13-8
Y-Axis ..................................... Ops 13-8
Z-Axis ..................................... Ops 13-8
Routers
  Matrix Control .......................... Ops 11-9
  Routing, video .......................... Ops 4-2
  RU, definition .......................... Ops 1-5
Run Wiper, Robotic Camera .......... Ops 11-14
Running a Sequence ................. Ops 14-15
Running Multiple Sequences ...... Ops 14-16

S
Safe Title, Preview Overlay .......... Ops 4-19
Sand WARP ............................. Ops 16-27
Satellite Panel .......................... Ops 4-21
  reference description .................. Ops 1-4
Saving a Sequence .................... Ops 14-11
Screen capture menu process ....... Ops 3-17
SD, definition .......................... Ops 1-5
SDI ........................ reference description .................. Ops 1-4
SEL Buttons
  Crosspoint Group ...................... Ops 4-8
  Key 4 Flexi Mode ...................... Ops 4-10
  Quick Preset .......................... Ops 4-12
  select key bus ....................... Ops 4-8, Ops 4-9
  select MLE ............................ Ops 4-11
  Select Directory, Character Generator Ops 11-21
  Select File, Character Generator .... Ops 11-21
  Selecting WARP Effects .......... Ops 16-3
  Selection Area ........................ Ops 3-6
  Selection Area, menu ................. Ops 3-6
  Selection knobs ........................ Ops 3-3
  Self Keys .............................. Ops 7-7
MultiDSK .................................... Ops 7-26
Seq/Man Mode, Character Generator Ops 11-21
Sequences .......................... Ops 14-2
  creating .............................. Ops 14-3, Ops 14-5
  deleting .............................. Ops 14-12
  duration .............................. Ops 14-6
  loading ............................... Ops 14-12
  modify keyframes ........................ Ops 14-9
  Motion ................................. Ops 14-6
    spline .................................. Ops 14-7
    naming .................................. Ops 14-11
    rotation .............................. Ops 14-6
    running .............................. Ops 14-15
    running multiple .................... Ops 14-16
    saving ............................... Ops 14-11
    wipe modifier ......................... Ops 14-7
Service, customer .......................... Ops 1-7
Set Show, Robotic Camera .......... Ops 11-15
Setups
  reference description ................ Ops 1-4
  Shadows, XFX .......................... Ops 8-15
Shooting Mode, Robotic Camera .......................... Ops 11-15
Shot Recall, Camera .......................... Ops 11-15
Shotbox, Camera .......................... Ops 11-15
SHOW ALPHA .......................... Ops 7-5
Shutter Speed, Robotic Camera .......................... Ops 11-15
SmartConversion .......................... Ops 4-24
  status ................................. Ops 4-24
  Soft key labels ......................... Ops 1-3
  Soft Trails ............................. Ops 8-17
  SoftPanel .............................. Ops 3-14
  Installation .......................... Ops 3-14
Software
  reset ................................. Ops 2-11
Source ID, Preview Overlay .......... Ops 4-18
Special Wipes .......................... Ops 17-7
Speed, Robotic Camera ................... Ops 11-15
Split Keys ............................. Ops 8-22
Split Video ............................. Ops 8-22
Split WARP ............................. Ops 16-29
Squeeze & Tease
  3D Space ............................. Ops 13-3
    coordinates .......................... Ops 13-3
    Perspective .......................... Ops 13-5
    parallax .............................. Ops 13-6
    relative size .......................... Ops 13-5
    viewpoint ........................... Ops 13-6
    Rotation .............................. Ops 13-7
    X-Axis .............................. Ops 13-8
Transitions .................................. Ops 5-1, Ops 5-7
Transition Type Buttons .................. Ops 5-5
Transition Rotation, Pattern .......... Ops 6-7
Transition Preview ......................... Ops 5-4
Transition Parameters Buttons .......... Ops 5-3
System ........................................ Ops 2-11
System Power button ...................... Ops 3-3

T
TD, definition .................................. Ops 1-5
Technical support .......................... Ops 1-7
Tilt Curve, Robotic Camera ............ Ops 11-15
Time Clock
 Preview Overlay .......................... Ops 4-19
Title, menu .................................. Ops 3-6
Touchscreen
 lower display region ..................... Ops 3-3
 power button ........................... Ops 3-3
 upper display region .................... Ops 3-3
Touchscreen Display
 adjusting .................................. Ops 3-4
 Touchscreen interface .................. Ops 3-2
Trails, XFX .................................. Ops 8-17
 Hard ...................................... Ops 8-18
 Key ....................................... Ops 8-19
 Key Smear .................................. Ops 8-20
 Soft ...................................... Ops 8-17
TRANS LIMIT .............................. Ops 5-5, Ops 5-17
 setting .................................. Ops 5-17
TRANS PV .................................. Ops 5-4
Transferring Stills ......................... Ops 10-11
USB ........................................ Ops 10-12
WebDAV
 Fedora 8 .................................. Ops 10-12
 Mac OS X ................................. Ops 10-12
 Windows 7 ............................... Ops 10-11
 Windows XP ........................... Ops 10-11
Transition Buttons ......................... Ops 5-6, Ops 7-5
Transition Limit .......................... Ops 5-5, Ops 5-17
 setting .................................. Ops 5-17
Transition Module ......................... Ops 5-2
 fader .................................. Ops 5-2
 Memory Attributes ....................... Ops 9-11
 next transition select .................... Ops 5-3
 overview .................................. Ops 2-6
 transition buttons ....................... Ops 5-6
 transition parameters .................... Ops 5-3
 transition type .......................... Ops 5-5
Transition Parameters Buttons .......... Ops 5-3
Transition Preview ......................... Ops 5-4
Transition Rotation, Pattern .......... Ops 6-7
Transition Type Buttons .................. Ops 5-5
Transitions .................................. Ops 5-1, Ops 5-7
Cuts ......................................... Ops 5-7
Dissolves .................................. Ops 5-7
 white flash .................................. Ops 5-19
 Independent Key .......................... Ops 5-9
 Key Priority .................................. Ops 5-21
 manual (fader) .......................... Ops 5-13, Ops 5-15
 Performing .................................. Ops 5-15
 Rates ...................................... Ops 5-10
 keyer .................................. Ops 5-11
 MLE ......................................... Ops 5-10
 Vision 2 .................................. Ops 5-12
 restrictions .................................. Ops 5-13
 Squeeze & Tease Wipe .................... Ops 5-8
 Wipe ...................................... Ops 5-8
 Wipes
 direction .................................. Ops 6-3
 flip/flop .................................. Ops 6-3
 wipes ...................................... Ops 6-3
 Transitions, Audio Mixers ............... Ops 11-10
 Audio Only .................................. Ops 11-11
 Truck, Robotic Camera ................. Ops 11-14
 Type, Key .................................. Ops 7-2
 Types of Wipes .......................... Ops 17-6
 Classic .................................. Ops 17-6
 Matrix ..................................... Ops 17-7
 Rotary ..................................... Ops 17-6
 Special .................................... Ops 17-7

U
UltraChrome .................................. Ops 7-11
 Advanced Mode Settings ................. Ops 7-16
 Background .................................. Ops 7-16
 Edge Erode .................................. Ops 7-20
 Edge Softness ............................. Ops 7-20
 Foreground .................................. Ops 7-19
 Luminance .................................. Ops 7-21
 Shadow ..................................... Ops 7-17
 Spill Suppress ............................. Ops 7-20
 Transition .................................. Ops 7-18
 Translucency .................................. Ops 7-18
 Alpha .................................. Ops 7-22
 Basic Mode Settings ..................... Ops 7-13
 Background .................................. Ops 7-13
 Edge Sensitivity .......................... Ops 7-15
 Edge Softness ............................. Ops 7-15
 Foreground .................................. Ops 7-13
 Spill Suppress ............................. Ops 7-14
 Color Map .................................. Ops 7-22
 Initializing .................................. Ops 7-11
 Operating Modes ......................... Ops 7-11
 UNDO
 Button ....................................... Ops 9-4
 Unlocking Memories ...................... Ops 9-8
 UP ONE button .......................... Ops 3-2
 Up/Down Converters ..................... Ops 4-24
 status .................................. Ops 4-24
 Upper Display Region .................... Ops 3-3
 USB
transition ...................................Ops 6-7
user ............................................Ops 6-8
Size ...................................................Ops 6-5
Vertical Multiplication ......................Ops 6-8
Wipe Modulation ..............................Ops 6-9
Squeeze & Tease ......................Ops 5-8, Ops 14-1
creating ......................................Ops 14-3
modify keyframes ...........................Ops 14-9
Transitions
direction ...........................................Ops 6-3
flip/flop ............................................Ops 6-3
Transitions ................................................Ops 6-3
Types .....................................................Ops 17-6
Classic ............................................Ops 17-6
Matrix .............................................Ops 17-7
Rotary .............................................Ops 17-6
Special ............................................Ops 17-7
user wipe .................................................Ops 6-4
Wipes, Patters, Washes, and Mattes ..........Ops 6-1

X
XFX Effects .................................................Ops 8-15
Borders ............................................Ops 8-15
Outlines ..........................................Ops 8-15
Shadows ............................................Ops 8-15
Trails ...............................................Ops 8-17
Hard .................................................Ops 8-18
Key .................................................Ops 8-19
Key Smear ....................................Ops 8-20
Soft ...............................................Ops 8-17